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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Use help icons @ to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Sales and Operations Planning Overview

Overview of Sales and Operations Planning

Oracle Sales and Operations Planning aligns organizations around an integrated operating plan to meet strategic
business goals. You can align the enterprise, analyze plan performance, and act to create and execute new plans.

By aligning the enterprise, you can:
- Adopt a step-by-step best practice approach.
Harness collective knowledge by using the enterprise social collaboration.
- Collaborate on plans or planning cycles.
Ensure continuity and provide accountability by using planning notes.
- Arrive at a consensus enterprise operating plan.
By analyzing the plan to make better decisions, you can:
- Analyze plan performance with preconfigured dashboards, layouts, and reports.
- Configure analytics to meet your unique needs.
Manage by exception to focus on what is most important.
Integrate with Microsoft Excel.
Demonstrate how plans have changed by using plan archives and waterfall charts.
By creating plans to act, you can:
Plan at an aggregate level for strategic time horizons.
Run quick simulations within Sales and Operations Planning to evaluate new plans.
- Select the best plan after comparing with other plans.
Link tactical planning with Sales and Operations Planning and execute on strategic decisions.

In summary, Sales and Operations Planning enables you to implement a continuous and forward-looking process. The
Sales and Operations Planning process profitably aligns product, demand, and supply plans at an aggregate level with
your strategic and financial objectives.

Business Flows for Sales and Operations Planning

Use Sales and Operations Planning, a modern planning cloud solution, to manage your sales and operations planning
process.

You can perform the following in the Sales and Operations Planning work area:

Process data collection and load planning data from external sources
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- Create and manage plans
« Conduct the Product Review, Demand Review, Supply Review, Financial Review, and Executive Review stages

- Automate a portion of the planning processes or run a subset of the processes

- Analyze and adjust your data at any stage
The following figure illustrates the Sales and Operations Planning business flow steps.

Load Planning Data from
Files

|

h 4

Data Collection

Manage Plans | I— Load Measglr:nssﬁnm Other

|

.

Process Review Stages ——» Approval and Execution

Data Collection

Data collection is the first step of the planning business flow. You can collect and transform the data from various Oracle
Fusion Cloud Supply Chain & Manufacturing (SCM) applications to the Supply Chain Planning repository. The data that
you collect can be of three types:

Master data: Primarily sourced from Oracle Supply Chain Management Cloud.
Demand data: Two potential sources of demand data are:

o Sales order data that flow from the Oracle Order Management Cloud.

o Shipment history from the Oracle Materials Management Cloud.

- Supply data: Supply data is collected from three sources:
o Oracle Inventory Management Cloud
o Oracle Manufacturing Cloud
o Oracle Purchasing Cloud

Load Planning Data from Files

Apart from collecting data from an Oracle Fusion source system, you can also collect data from an external source
system. Use the predefined collection templates (XLSM files) to collect data from an external source system.

Use these collection templates to collect bills of resources and planning measures data from external
sources by using the file-based data import (FBDI) template: ScpBillOfResourcesimportTemplate.xlsm and
ScpMeasuresimportTemplate.xlsm. Or, use the Create Bills of Resources scheduled process to automatically create bills

of resources for planning assembly items in a sales and operations plan.

Note: To create bills of resources at the category level, you must use the FBDI template,
ScpBillOfResourcesimportTemplate.xlsm
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Manage Plans

In the Manage Plan stage, you create and manage sales and operations plans. You can create a plan and then define the
plan based on your business requirement.

The Manage Plans page is for integrated plan management. The following are some of the tasks that you can perform
from the Manage Plans page:
- Create and define plans
- Create a copy of existing plans
- Open an existing plan
Run plans in batch mode
Perform data refresh on your plans

- Approve plans

Load Measures from Other Plans

Loading measures from other plans is an optional step. If you have a valid supply plan, demand plan, or demand and
supply plan, you can load measures from these plans to a sales and operations plan. The plans can be from the Demand
Management, Supply Planning, Demand and Supply Planning, or Planning Central work area. For example, if the
shipment forecast is managed in Demand Management or Planning Central, you can use the Load Measures from Other
Plans task to load the shipment forecast in Sales and Operations Planning.

Process Review Stages

During the process review stages, you work with stakeholders to manage the product life cycle, balance demand and
supply, and review the financial feasibility to execute the plan. The process review includes the following stages:
Product Review
Demand Review
« Supply Review
Financial Review

Executive Review

Note: For more information about each of the process review stages, see the Manage Planning Cycles chapter in the
Using Sales and Operations Planning guide.

Approval and Execution

In the approval and execution stage, you decide upon the best plan among alternative simulation plans using plan
comparison. After you get an approval for the consensus operating plan from all stakeholders, you execute the plan in
your tactical planning process.
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Related Topics
» Overview of Planning Cycles in Sales and Operations Planning

« Overview of Sales and Operations Plans
« How You Collect Different Data Types for Supply Chain Planning
« How You Load Planning Data from Files

Overview of Supply Chain Planning Work Areas

The Oracle Fusion Cloud Supply Chain Planning solution is composed of products designed for specific supply chain
planning business processes and tasks.

You perform these processes and tasks by using work areas. Each of the Oracle Supply Chain Planning products
provides access to one or more work areas.

The Supply Chain Planning work areas that you can use are determined by these factors:
- The products that your enterprise has licensed and configured
- The security privileges assigned to your user account
To use the Supply Chain Planning work areas, you must be aware of these points:
Navigation to work areas
List of Supply Chain Planning work areas and the products to which they're applicable

Navigation to Work Areas

You can use different paths to navigate to a specific work area including:

From the Navigator: Click the Navigator icon to see the work areas that you have access to. The Supply Chain
Planning work areas are listed within the Supply Chain Planning heading. The work area names are links. Click a
specific work area link to access that work area.

From the Springboard: On your home page you might have one or more springboard icons that represent

a group of work areas, such as the group of Supply Chain Planning work areas. Click on the Supply Chain
Planning springboard to access a set of icons, each of which represents a specific Supply Chain Planning work
area. Click a specific icon to access that work area.

List of Supply Chain Planning Work Areas

The following table lists the Supply Chain Planning work areas and the Oracle Fusion Cloud Supply Chain Planning
modules that are applicable to each of the work areas.

Work Area Modules
Demand Management Oracle Demand Management
Supply Planning Oracle Supply Planning
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Work Area Modules
Demand and Supply Planning Both of these products must be configured:

- Oracle Demand Management

- Oracle Supply Planning

Planning Central Oracle Planning Central

Sales and Operations Planning Oracle Sales and Operations Planning

Backlog Management Oracle Backlog Management

Production Scheduling Oracle Production Scheduling

Replenishment Planning Oracle Replenishment Planning

Plan Inputs Use the Plan Inputs work area to perform tasks that don't require creating or accessing a plan.

This work area can also be opened from other Supply Chain Planning work areas.

Note: If a plan that has been created in the Planning Central work area is opened from either the Supply Planning
or the Demand and Supply Planning work area, then that plan will no longer be accessible from the Planning Central
work area.

The Global Order Promising work area is bundled within the Oracle Fusion Cloud Order Management solution.

Related Topics

Overview of the Sales and Operations Planning Work Area
Overview of the Supply Planning Work Area

Overview of the Demand Management Work Area
Overview of the Order Promising Work Area

Overview of the Replenishment Planning Work Area

Overview of the Sales and Operations Planning Work
Area

Use the Sales and Operations Planning work area to configure, view, and analyze your real world business processes.

You can use the Sales and Operations Planning work area to do the following:

- View multiple plans and plan inputs simultaneously.
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Use predefined page layouts or create page layouts to view plan data tailored for your organization.
To access the Sales and Operations Planning work area and open a plan:

In the Navigator, click the Sales and Operations Planning link.
In the Sales and Operations work area, click Manage Plans from the Tasks drawer.
On the Manage Plans page, use the search feature to locate an existing plan.
Select the plan and click Actions.
5. Select Open to open the Edit Plan page for your plan. Your plan name appears in the Edit Plan page header.
The Edit Plan page consists of two main areas:

PUWUN

Header

- Configurable pane

Header

The header area contains the page layout information and actionable buttons, such as Save Layout, Change, Open,
Actions, Save, and Cancel. The header area displays the plans, simulation sets, and plan inputs that are currently
opened.

You can create your own page layout or use the predefined layout. The Executive Review Summary tile set is the default
layout for Sales and Operations Planning when you open or edit a plan. You can also save a layout so that every time
you open the Edit Plan page, the saved layout opens.

Configurable Pane

You can display the content of your plan in the configurable pane area, which is located below the header area. You can
add multiple panes on the page to display your content. The Page Layout drop-down list in the header area determines
the number of panes in your planning interface page.

Access Tasks as Quick Actions on a Home Page

Some tasks that are accessible by using the tasks panel drawer in a supply chain planning work area are also available
from the home page as quick actions.

Click the Show More link on the home page to display all of the available quick actions for which you have access. You
don't have to first navigate to a supply chain planning work area to take an action. For example, use quick actions to
create a sourcing rule to purchase components from a new supplier without having to first select a planning work area.

In addition, there are work area-specific preferences that enable you to change your default page layout without having
to first launch the work area. These preferences are useful if you configured a content-heavy default page layout that's
taking too long to load. In such cases, you can change your default page to a different page layout that opens quicker
and then edit the content-heavy page layout to make it perform better.

Here's some additional information about quick actions on a home page:

- You must have the applicable privileges associated with the task to see the task as a quick action on the
home page. Each quick action is secured by its related privilege or privileges. For example, if you have the
Manage Planning Sourcing privilege, then you should see the Manage Sourcing Rules task in the tasks panel
drawer in the work area. You should also see the task as a quick action on the Supply Chain Planning or Order
Management (in the case of Global Order Promising) home pages.
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- You must have access to the work area to see the associated manage preferences quick actions. For example,

you must have access to the Supply Planning work area to see the Edit Supply Planning Preferences quick
action.

- You can't navigate to any other Ul or open other tabs. When you click a quick access link, the Ul opens in the

page, but you aren't in a work area.

- You can only return to the Supply Chain Planning home page when you close out of a task that you initiated

from the Supply Chain Planning home page.

Manage Page Layouts

You can create and manage your page layouts. Use the Manage Page Layout action to modify the properties of your
existing page layouts.

You access a plan interface page by opening a plan from the Manage Plans page in the Sales and Operations Planning
work area.

This topic discusses how to do the following:

- Create a page layout

Edit a page layout
Manage a page layout
Use the Plan Summary page layout

Create a Page Layout

Page layouts are reusable across plans, simulation sets, and plan inputs. You can create page layouts or copy and then
edit a page layout to create page layouts that are tailored to specific business needs.

To create a page layout:

1.
. Click the Plans panel tab.

v s

In the Navigator, click the Sales and Operations Planning work area.

In the Plans panel drawer, expand the Plans list.

Open a plan for which you want to create a page layout.

From the Page Layout drop-down list, click Create.

Specify the following details and click Save and Close:
o Enter a page layout name and description.

o Select the access level as Public or Private.
- Select Public to make the plan accessible for all users.
- Select Private to restrict the plan accessible to you and to a list of users that you want to provide
access.
This creates an empty pane page layout.
Click the Change drop-down list and select any layout.
For example, select a two pane horizontal layout.
Click Open and select the pane and add the content using the Open Table, Graph, or Tile Set dialog.
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8. C(lick Save Layout.

Edit a Page Layout

You can edit an existing page layout in two ways:

Use the Save button to save the current page layout as it's currently displayed. For example, you can change
the current page layout from a one pane layout to two pane layout. The next time you use this page, the layout
appears as a two pane layout.

- You can also change a page layout using the Manage action from the page layout drop-down list.

- You can't edit the predefined page layouts. You can copy and then edit the copy.

Manage a Page Layout

You can use Manage Page Layout to perform the following:

Edit the page layouts that you created. You can move one pane to other using Manage page layouts. However,
if you're using a public page layout, where you're not the owner, then you can't make changes to the layout. You
can only set the layout to your default layout.

- Change the layout that's used as your default layout when you initially open a plan, simulation set, or plan
inputs.

Delete layouts that you created, but are no longer needed.

Use a Page Layout

The default page layout in Sales and Operations Planning is the Executive Review Summary. It contains a set of infotiles
and high-level graphics that you can use to review the business value of a plan. Using tiles, you can view the key metrics
of your plan. You can further drill to the predefined analytics from the tables or graphs displayed in this layout.

The Executive Review Summary page layout is the Executive Review Summary tile set report presented in a single
pane layout. There are other predefined tile set reports, which are also known as plan summary dashboards. Sales
and Operations Planning has a summary dashboard for each of the five standard stages of the sales and operations
planning process:

Product Review Summary

Demand Review Summary
« Supply Review Summary

Financial Review Summary

Executive Review Summary

Using a summary dashboard, you can do the following:

Measure the performance of a plan.
Review plan information through the individual Key Performance Indicators (KPIs).
Perform plan analysis using the contextual based navigation.

- Copy and configure the components of a plan summary layout for your specific need.

You also have the predefined Product Lifecycle Management page layout that you can use to manage product
introductions and retirements.
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You can use a page layout in an open plan by using the Page Layout drop down list.

Related Topics
« Overview of Planning Cycles in Sales and Operations Planning

Planners for Supply Chain Planning

How You Define Planners for Supply Chain Planning

Planners are the people in your organization who are responsible for a set of items, their inventory levels, supply and
demand, and so forth. For example, some typical titles of planners are Material Planner, Supply Chain Planner, and
Demand Planner.

All supply chain planning products use planners. You can define a specific person as a supply chain planner for
the Oracle Fusion source system or for any other source system. You can also associate a planner to an item at the
organization level.

Use the ScpPlannersimportTemplate.xlsm import template to create the CSV file for the Load Planning Data from Files
task for planners. You can also use the Manage Planners page to define supply chain planners for each source system.
Access the Manage Planners page from a Supply Chain Planning work area. Click the Tasks panel drawer and then click
the Manage Planners link.

For Oracle Fusion source systems, associate the employee identification number with the planner name because Oracle
Purchasing requires a valid employee identification number. When a planner releases a planned order, purchasing
checks the employee identification number before creating the purchase requisition.

For external source systems, determine if the employee identification number is required when releasing planned
orders. If required, use the Manage Planners page to associate the planner with their employee identification number.
Or, you can use the ScpPlannersimportTemplate.xlsm template to associate the employee identification number with
the planner name.

Use Oracle Product Hub to assign planners at the item-organization level. During data collections, the planning
processes collect the planner-item-organization assignment. Planners can then use the planner name to search the
data on most of the demand and supply planning pages.

Update Planner Data with New Employee Information

If a planner's employee information (such as employee number, employee name, or email) changes, then that
information can be updated in the planners table in several ways.

For external source systems, the collection process looks for the employee number in the data managed by Oracle
Fusion Cloud Human Capital Management.

If the employee number is available in the employee data managed by Oracle Fusion Cloud Human Capital

Management, then its respective details (employee name and email) are extracted and populated in the
planners table.
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If the employee number isn't available in the employee data managed by Oracle Fusion Cloud Human Capital
Management, then the collection process populates the employee number as provided in the comma-
separated values (CSV) file in the planners table.

Employee details are updatable only once during the initial collection process. For example, in the first collection run,
123456 is provided for an employee number. If you change the employee number to 100100 on the second collection
run, then the latest employee details aren’t reflected in the planners table. To change a planner’s employee information,
you can select a different employee by using the Manage Planners Ul or you can mass update planners.

There are two methods to mass update planners. They both involve removing planner data and then collecting the
planner data again with any changes.

Method A

1. In one of the Supply Chain Planning work areas, select the Manage Planners task.
2. Delete all the planners who need their employee information updated.
3. Collect the planner data again by using the Load Planning Data from Files scheduled process.

Method B

Note: Method B will purge planner data for all planners.

-—
.

In the Scheduled Processes work area, click Schedule New Process.
In the Schedule New Process dialog box, search for and select the Purge Data Repository process.
In the Process Details dialog box:
a. Select the Source System.
b. Set Purge Global Entities = Yes.
c. Inthe Reference Data tab, move Planners to Selected Entities.
d. Click Submit.
The scheduled process purges the planner data.
. Collect the planner data again by using the Load Planning Data from Files scheduled process.

WwN

1N

How You Reassign Item Definitions to a Different Planner

When a planner leaves an organization and that planner's items need to be reassigned, there are two ways you can
reassign the planner’s item definitions.

Don't change the planner code but instead reassign the existing code to a different employee on the Manage
Planners page. In this case, there’s no need to change the planner codes for the item.

- Create one or more new planner codes (or use an existing one) and then either:
o Manually reassign the items to those one or more new planners individually.

o Use the item mass changes feature in the Product Information Management work area.

Overview of Supply Chain Planning Plan Types

When you create a plan, plan type is the first choice that you make. After you run a plan, you can't edit the plan type.

10
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Oracle Fusion Cloud Supply Chain Planning provides these types of plans, which you can create, edit, run, and so on,
depending on the work area that you have access to:

Plan Type

Demand Plan

Supply Plan

Demand and Supply Plan

Sales and Operations Plan

Backlog Plan

Replenishment Plan

Related Topics

Use This Plan Type

- When you want to perform collaborative
and statistical demand forecasting.

- When you want to use a demand plan as
a demand schedule for a supply plan or
replenishment plan.

When you want to generate a supply schedule.

For an integrated demand and supply planning.

For aggregate planning.

For backlog management.

For replenishment planning.

Work Areas the Plan Type is Available

Demand and Supply Planning
Demand Management
Planning Central

Replenishment Planning

Demand and Supply Planning
Planning Central

Supply Planning

Demand and Supply Planning

Planning Central

Sales and Operations Planning

Backlog Management

Replenishment Planning

- Actions to Manage Your Plans

Manage Notes

Use Notes in Supply Chain Planning to document and communicate important information about your plan.

You can use notes to provide reasons for any changes made to a plan or to record decisions and assumptions that led to
those changes. You can save these notes for future reference or to provide details to other users. Participants in the plan
management process can annotate the data with notes to document changes and assumptions.

The notes functionality is available in the Demand Management, Supply Planning, Planning Central, and Sales and
Operations work areas. You can create notes for the following:

- Plans
- Planning level members, such as items, organization, and customers

- Planning combinations, such as a specific item-organization-date-measure combination
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Exceptions

When you create a note, you must specify a note type. Note types enable notes to be categorized, which you can use as
search criteria. The following lists the predefined note types:

- General

- Assumption
Decision
Issue
Possibility
Risk
Reference

- Special

You also specify whether the note is private or public. Private notes are visible only to the user who created the note.
Public notes are visible to all the users with whom the object is associated.

From the Demand Management or the Sales and Operations work area, you can access the Notes table to display
planning level members for Product hierarchies. You can create a layout to view the Notes table as part of the layout
instead of as a dialog box. The Notes table is not available for Supply Planning or Planning Central.

Notes for Plans

You can create notes for plans. When you copy a plan, any notes associated with the plan are copied into the new plan.

To create a note for a plan, do the following:

Open the Plan Options page for your plan, and click the Manage Notes icon.
In the Manage Notes dialog box, click Actions > Create.

In the Create Note dialog box, add your notes.

Click OK.

Click Save and Close.

u b WNA

Notes for Planning Level Members

You can associate notes with planning-level members, such as items, organizations, and customers. You can create
notes at any level of the hierarchy, such as on an individual item, on a brand, or on a product category.

Notes that you create on planning level members at lower levels in the hierarchy are visible when you open Manage
Notes from an aggregate level. Notes that you create on level members aren't plan-specific. This means that a note
associated with a level member is visible from any plan that contains that member.

To create a note on a level member, select the level member, and select Create Note from the Actions menu.

To view, edit, or delete an existing note, select the level member, and select Manage Notes from the Actions menu.

Notes for Planning Combinations

You can associate notes for the planning combinations, such as a specific item, organization, date, and measure
combination. Planning combinations appear as cells within a table.

12
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You can create a note at any level; however, they are only visible at the level at which they are created. For example, if
you create a note at a brand, month, and measure combination, you can't view that note at the item, day, and measure
level.

If you copy a plan, then any plan-specific notes on planning combinations are also copied.

To create a note for the planning combinations, do the following:

1. Select the cell in the table.

2. Select Create Note from the Actions menu.
3. Add your notes.

4. C(lick Save and Close.

To view, edit or delete an existing note on a planning combination, do the following:

1. Select the Note icon from the table's cell level.
2. Select Manage Notes from the Actions menu.

Note: If you create a note on a planning combination, and the associated measure is shared across plans, then the
note isn't plan-specific. In this case, the note is visible across all plans. If you create a note on a planning combination,
and the associated measure isn't shared across plans, then the note is plan-specific. In this case, the note is visible
within the plan in which you created it.

Notes for Exceptions

You can associate notes with exceptions. Notes on exceptions persist across plan runs. If an exception still exists after
a plan is run again, then any notes associated with the exception are retained. When an exception is resolved, the
exception is removed from the application. In that case, any notes associated with the exception are also removed.

To create notes for an exception, do the following:
1. Click the Note icon on the table row of the exception.

2. Add your notes.
3. Click Save and Close.
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2 Tables, Graphs, Analysis Sets, Tiles, and Tile
Sets

Manage Tables, Graphs, Analysis Sets, Tiles, and Tile
Sets

Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

You can configure the entities for tables, graphs, analysis sets, tiles (also referred to as infotiles), or tile sets by using the
Selector Tool.

You can also create and manage groups on the Selector Tool page and associate your tables and graphs with the group.
Navigate to the Selector Tool from an open plan or from the Actions menu on a table or graph toolbar.

To create a table, graph, analysis set, tile set, or tile, open the Selector Tool:

1. From an open plan, click Actions and then select Manage Tables, Graphs, and Analysis Sets.
2. Inthe Manage Tables, Graphs, and Analysis Sets dialog box, click Actions and then select Create.
3. Select one of the following to open the Selector Tool:

o Table

o Graph

o Analysis Set

o Tile Set

o Tile

4. Depending on your selection, the Selector Tool dialog box opens with the following tabs:

Tab Table Graph Analysis Set Tile
Measures Yes Yes Yes Yes
Hierarchies Yes Yes No Yes
Members Yes Yes Yes Yes
Measure Filters Yes Yes No Yes
Layout Yes Yes No Yes
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Tab Table Graph Analysis Set Tile
Comparison Options Yes Yes No No
Details No No Yes No

Note: In the Selector Tool, the member values displayed are based on what's configured in the Member Identifier to
Display column on the Configure Planning Analytics page, Levels and Attributes tab. For example, for item, you can
configure your tables and graphs to show the item description instead of the item name, which is what also appears
when you're in the Selector Tool.

Measures

Use the Measures tab to select measures for a table or graph by moving measures from the Available Measures pane to
the Selected Measures pane. The measures that you select determine the content of the other tabs. The dimensions of
the measures determine the dimensions available on the Hierarchies tab and the dimension members on the Members
tab. For example, if a measure has the Product, Organization, and Time dimensions, those dimensions and their
hierarchies are visible on the other tabs. You can display the available measures by measure group or alphabetically by
using the Tree View or List View icon.

A measure is usually a named time series of values that represent the following at a particular intersection of the
Customer, Organization, Product, Supplier, and Resource dimensions:

- Historical performance (Bookings History). This measure isn't applicable for supply planning.
- Future projections (Shipments Forecast)

- A key performance indicator (KPI), such as Gross Margin Percentage, or a derived calculation, such as Projected
Available Balance

The planning process aggregates measure data from lower levels to higher levels or computes KPIs and derives
calculations from other values at the same level as needed. The planning process can also allocate or spread updates
made at an aggregate level to the affected cells at lower levels. Measures can be expressed in different units of measure,
such as inches, dollars, kilos, or liters. Depending on the context, you can display, update, or compare measures that are
in different units. The planning process can convert values among different units and among different currencies (for
monetary values).

When plans are archived, you can retrieve measures from the archived time periods and show them on a plan table. See
the View Planning Measures from Archived Time Periods topic to learn more. However, for Demand and Supply Plans,
the Demand History Buckets option determines whether the archived period is shown or not.

Note: Text-based measures aren't supported in graphs and aren't displayed in the Available Measures pane on the
Measures tab of the Selector Tool during the configuration of graphs.

Hierarchies
Use the Hierarchies tab to select the dimensions, hierarchies, and levels to include or exclude in the table or graph.
For each dimension, select the hierarchies and levels that you want to include in the graph or table. Checking the

box in the Display column includes that dimension in the table or graph. Expand the dimension to view the available
hierarchies. Expand the hierarchy to view the levels of the hierarchy. Checking a level includes it in the table or graph. If
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multiple levels are checked, the top level is displayed in the table or graph by default. Each level in the table or graph can
be expanded until all checked levels are visible. The Show Unassociated check box determines whether the measure
values that aren't associated with a specific dimension in the table or graph are hidden or displayed. For example, a
table could include Shipments Forecast and Net Resource Availability. Shipments Forecast has product, organization,
and time as dimensions. Net Resource Availability has resource, organization, and time as dimensions. With the check
box selected, the Resource column displays the word Unassociated when you view Shipments Forecast rows.

For a demand plan that uses a hybrid time hierarchy, only the hierarchy that was selected as the planning calendar on
the Scope tab on the Plan Options page is displayed for the Time dimension along with the other, corresponding hybrid
time hierarchies that were created when the Create Hybrid Time Hierarchies scheduled process was run.

You can select the levels of only one hybrid time hierarchy.

Members

You use the Members tab to manually select dimension members by moving members from the Available Members
pane to the Selected Members pane. If no selections are made on this tab for a dimension, the graph or table displays
the dimension starting at the top level checked on the Hierarchies tab. For example, if you selected the Gregorian
Calendar hierarchy with Quarter and Month on the Hierarchies tab, the graph or table displays all quarters; each quarter
has an icon to drill to its months.

Measure Filters

Use the Measure Filters tab to filter results based on measure values across dimension member combinations that meet
the criteria that you specify. You can filter your measure data to return only multidimensional combinations that meet
the measure criteria for selected dimensions of the measure.

Note: The measures listed are those that are of data type number, currency, or percent that aren't dimensioned by
time. Measures that are time dimensioned and of data types date and text are excluded from the list. If the table
contains any configure-to-order (CTO) measures, then the Measure Filters tab is disabled.

When you create or edit a table or graph, make your selections on the Measures, Hierarchies, and Members tabs. Next,
on the Measure Filters tab, specify the measure criteria to apply across combinations of your dimension selections, such
as Item and Customer. The table or graph displays only the combinations that meet your specified measure criteria.

You can compare measures to fixed values or to other measures, and you can apply multiple measure conditions:

Multiple AND conditions are allowed
Multiple OR conditions are allowed

- Combinations of AND and OR conditions aren't allowed.

You can apply the measure filters in a table or graph to a linked table or graph in the Manage Links dialog box. On the To
Table, Graph, or Layout tab, select the Include measure filters check box. This check box is enabled after you select the
Pass user-specified parameters check box.

Layout

Use the Layout tab to format tables, graphs, or tiles. The following are the key layout options for tables, graphs, and
tiles:

- Tables: Use table layout options to drag and drop dimensions to change the table layout and configure drill

settings.
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- Graphs: Use the graph layout options to select the graph type and the formatting options for the graph type
that you select. In the Filters section, you can specify the filter criteria that you want displayed in the graph.

- Tiles: Use the tile layout options to select the graph type and add tables and graphs to the content area of the
tile you're creating.

Comparison Options

The Comparison Options tab is applicable only for tables and graphs. On the Comparison Options tab, you can compare
your current plan with an archived version or an alternate plan. Use this tab to compare how specific measures have
varied over time. The Comparison Options tab contains three sections: Waterfall Analysis, Trend Analysis, and Plan
Comparison.

Note: The Comparison Options tab isn't available in the Oracle Planning Central work area.

- In the Waterfall Analysis section, you can compare selected measures in a table or a graph with an archived
plan.

Select the Use MAPE calculations check box if you have scheduled your plan archival process. Mean absolute
percentage error (MAPE) calculations use the system administrator archive and not an on-demand archive.

In the Measure Archives to Use list, select one or more archives to reference. The number of weeks refers to
how long ago the archive was created. The planning process uses the following logic for when to use an archive:

o Match the exact dates. If multiple versions of an archive are within the waterfall time frame, use the
closest, most current version.

o If no match is found on the exact date, use the match closest inside the range, which is +3/-3 days of a
selected weekly waterfall time frame, or +15/-15 days for a monthly archive.

o If no match is found within +3/-3 days of a selected weekly waterfall time frame, or +15/-15 days for a
monthly archive, then nothing is returned.

For example, if you select 4 weeks ago, the planning process searches for the archive 4 weeks prior to today's
date, for instance, March 6. If your archives are stored at the month level and nothing is found on February 5,
the planning process searches for the most recent archive within +15/-15 days.

- In the Trend Analysis section, you can provide the number of archives that you want to reference. The planning
process selects the latest archives. For example, you have five archives, where number five is the latest archive
and you have selected 3 in the Number of Previous Versions to Include field. The planning process selects
archive number five, four, and three for the comparison. The difference between Waterfall Analysis and Trend
Analysis is that in Waterfall Analysis you can choose an archive created within each selected time frame that
you want to compare. In Trend Analysis, you can select the number of archives that you want to compare, and
only the latest archives are used for comparison.

- The Plan Comparison section pertains to both archived plans and alternate plans that you consider for
comparison. You can select the type of difference to display in tables or graphs for comparison. For example,
you can choose to view the difference in percentage or absolute percentage.

18
ORACLE



Oracle Fusion Cloud SCM Chapter 2
Using Sales and Operations Planning Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Related Topics
- Use Advanced Options in the Selector Tool

» Use Table Drilling

« Create a Tile in Supply Chain Planning

» Create a Tile Set in Supply Chain Planning

« How You Use Levels and Attributes in Supply Chain Planning

Use Advanced Options in the Selector Tool

You can use the Advanced Filter dialog box to filter data and select specific members that fulfill some criteria.

Click the Advanced Filter icon on the Members tab to open the Advanced Filter dialog box. You can use the following
filter criteria tools:

- Levels: Select by level. Select the members in a level such as Customer Site for the Customer dimension, or
Period for the Time dimension.

- Family: Select parent or child of a dimension member. Select members based on a parent or child relationship,
such as selecting the Days in a Week.

- Attributes: Select based on name. For example, select members based on items whose name contains
Economy.

- Measure Criteria: Select based on meeting measure criteria. Select members that meet the criteria, such as
Products for which the gross margin is greater than a particular value.

- Time Range: Select a range of dates. Select time periods based on a range, a start date, or today's date.

The advanced filter criteria tools are used in conjunction with action keywords to refine selections. The following four
actions determine how to apply the criteria:

- Replace with: Replace the current selection, if any, with members meeting the criteria.
- Add: Add members meeting the criteria to the current selection.

- Keep: Keep only the members in the current selection that meet the criteria.

- Remove: Remove the members from the current selection that meet the criteria.

You can apply filter criteria tools sequentially to refine your selection. For example, select all the items for a category,
and then keep the top 10 items based on sales.

Click the Show Results button to see the filtered list of members based on the criteria. Removed members are shown
below the filtered list. You have the option of accepting the results or resetting to the previous members.

When you accept the results, the criteria used to retrieve the accepted members appear in the Criteria Steps section on
the tab. These criteria are evaluated when the table or graph is displayed. You can remove criteria steps.

Note: Ensure that the criteria steps defined for each dimension are needed and relevant. Remove all unwanted or
unnecessary criteria steps so that your table or graph displays the correct information.

- Toremove a step, click the Remove icon in a row.
- To view the result of removing a criteria, click Show Criteria Change.
- To accept the Show Criteria Change results, click Accept and then OK.
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- To make the change permanent, click Save or Save and Close.
- To view the results without making the change permanent, click Apply and Close.

Related Topics
« Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Create an Analysis Set

An analysis set is a named set of criteria that can contain selected measures, dimension members, or both measures
and dimension members.

Use the Apply Analysis Set and Save as Analysis Set buttons to apply previously made selections or to save the
selections made in the Selector Tool.

Applying an existing analysis set to a table or graph is a quick way to select the measures and dimension members that
you frequently use.

You have the option to save measures and dimension members. You can save the dimension members as a list or as

a script. For example, you can select the top 10 items based on sales for January. If saved as a list, the same 10 items
would always be displayed in the table or graph, regardless of the current month. However, as sales data changes over
time, you would want to see the top items in the current month in your table or graph. To accomplish this, save the
dimension members in a script that would evaluate the criteria whenever the table or graph is displayed.

Related Topics
« Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Create a Tile in Supply Chain Planning

A tile is a component used to present a graphical summary of the data. A tile is also referred to as an infotile in Oracle
Fusion Cloud Supply Chain Planning.

Each tile has one or more related tables or graphs with predefined drill-to actions to display additional information
about that key performance indicator (KPI).

To create a tile:

1. In a Supply Chain Planning work area, open a plan.

2. Click Actions > Manage Tables, Graphs, and Analysis Sets.

3. Inthe Manage Tables, Graphs, and Analysis Sets dialog box, in the Search Results region, click Actions and then
select Create > Tile.

4. Inthe Selector Tool - Create Tile dialog box, on the Measures tab, select the required measures and move them

from the Available Measures pane to the Selected Measures pane.

On the Hierarchies tab, select the dimensions, hierarchies, and levels to include or exclude in the tile.

6. Onthe Members tab, select the required dimension members and move them from the Available Members
pane to the Selected Members pane. If you don't select a dimension member, the tile displays the dimension
starting at the top level selected in the Hierarchies tab.

7. On the Layout tab, do the following:

o Select the graph type for the infotile.

ui
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o Expand the Content Area panel, and then click the Add Row button. You can add up to four tables or
graphs to display them in the content area for that tile.
8. C(lick Save and Close.

Related Topics
« Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

» Create a Tile Set in Supply Chain Planning

Set Measure Targets for Use in Tiles

You can enter or update goals for a measure to track performance against the goals. Set targets by editing a measure
and updating the measure goal. When the plan summary displays the measure, the goal or target for that measure is
visible.

You can define goals only for measures that are of data type currency, number, or percent.

For global goals, you can provide a low range or a high range. The ranges are displayed on the user interface when you
view a measure in comparison with its goal. Global goals are measure level parameters and aren't defined specifically for
a data population.

To enter or update measure target goals, follow these steps:

1. Open the Manage Planning Measures page:

a. InaSupply Chain Planning work area, open a plan.

b. On the Edit Plan page, click the Tasks panel tab.

c. Inthe Tasks panel drawer, click the Manage Planning Measures link.
On the Manage Planning Measures page, select the measure and click the Edit icon.
3. On the Edit Measure page, navigate to the Advanced tab, Goals subtab.
4. Inthe Goals subtab, select whether low values or high values are better.

For example, high values are better for Gross Margin, but low values are better for Demand at Risk.

5. Inthe Global Goals section, provide a low range or a high range.
6. Click Save and Close.

N

Create a Tile Set in Supply Chain Planning

You can create a tile set to group individual tiles.

Tiles are also referred to as infotiles in Oracle Supply Chain Planning. Creating tile sets can be useful in cases where you
want to track various metrics on a single page. You can add tile sets to a pane in a page layout.

Tip: Before you create a tile set, check whether you need to create the tiles that you will be adding to the tile set.

To create a tile set:

1. In a Supply Chain Planning work area, open a plan.

2. (Click Actions > Manage Table, Graphs, and Analysis Sets.

3. On the Search table toolbar, from the Actions menu, select Create > Tile Set.
4. Inthe Selector Tool - Create Tile Set dialog box, specify these details:
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o Enter a name and description for the tile set.
o Select a group for the tile set.

5. From the Available Tiles pane, select the tiles to include in the tile set and move them to the Selected Tiles pane.
6. Click Save and Close.

Related Topics
» Create a Tile in Supply Chain Planning

Use Table Drilling

After you create a table, use drilling in the table to expand and collapse the levels within the hierarchy by which you can
view different levels of aggregation.

When viewing a table or graph, the dimensions and hierarchies selected on the Hierarchies tab are visible. The top
selected level is visible; use drilling to view lower levels.

To drill across hierarchies or dimensions, the levels must be adjacent. Drilling is automatically available for the levels
within the predefined hierarchies, but you can also configure drill pairs to drill across hierarchies or dimensions.

To display a table showing Final Shipments History with the ability to drill from customer to item, the columns Customer
and Iltem must be adjacent:

1. On the Layout tab, use the View menu to select Configure Drill Settings.
2. Click the Add Row icon to add a new drill pair.
3. Inthe Drill From column, select Customer. In the Drill To column, select Item.
With this configuration, you can view the shipments history values by item for each customer in the table.

Note: Drilling is only active between the adjacent levels in the table.

Related Topics
» Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

« Use Advanced Options in the Selector Tool
» Use Table Linking

Use Table Linking

You can link a table or graph to another table or graph or a page layout by selecting Manage Links from the Actions
menu on the toolbar.

The links enable you to pass the context of a table or graph to another table or graph or a page layout.
In the Manage Links dialog box, you can use these tabs:

- To Table, Graph, or Page Layout: Create a link to another table or graph or to a page layout.

From Table or Graph: Link to the open table or graph from another table or graph.
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Use the Add Row icon to add a link.

Enable dynamic linking: Select this check box to enable dynamic linking. If selected, then the target table or
graph is refreshed when the selections in the source table or graph change.

Pass highlighted selections and selected members: If you select this option, then whatever you highlight in
the current table or graph is passed as the context along with the filters in the Selector Tool to the target table,
graph, or page layout.

Pass user-specified parameters: If you select this option, then you can select the level and context of the source
table or graph to pass as link parameters to the target table, graph, or page layout.

Include measure filters: Select this check box to apply measure filters that you defined on the Measure Filters
tab in the Selector Tool to a linked table or graph. This check box is enabled:

o After you select the Pass user-specified parameters option.

o If the From Table contains measure filters.

Note: If you're linking a summary table that lists configure-to-order (CTO) items to a detail table that lists the CTO
items along with their option classes and options, select the Pass highlighted selections and selected members
option.

After you define the link, use the Drill icon on the toolbar to drill to the linked table, graph, or page layout.

Related Topics
« Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

» Use Advanced Options in the Selector Tool
« Use Table Drilling

Link to External Systems

Overview of Linking to External Systems with Context

You can link a table or graph in your Oracle Fusion Cloud Supply Chain Planning module to supporting information in an
external system to gain a deep understanding of your data and aid your decision making.

Note: You can create links to external systems from only pivot tables and not regular tables.

When you're analyzing data in a table or graph in the Demand Management, Demand and Supply Planning, Planning
Central, Replenishment Planning, Sales and Operations Planning, or Supply Planning work area, you might need to view
additional information that resides in an external system. Using this functionality, you can link your table or graph to an
object in the external system. For example, you can link your table or graph to a predefined or user-defined analysis or
report in Oracle Transactional Business Intelligence (OTBI), Oracle Analytics Cloud, or Oracle Analytics Publisher.

While specifying the link, you can pass dimensions, levels, and level members in your table or graph along with the link
so that it opens the external system object with the context of the data in your table or graph. You can also pass the plan
name or ID along with the link to restrict the displayed data in OTBI, Analytics Cloud, or Analytics Publisher.
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How You Set Up Links to External Systems
To set up links to an external system, you must do the following:

1. Set up the application integration for the external system.
2. Configure a table or graph with a link to the external system.

Additional Points About Links to External Systems
Note these additional points about links to external systems:

- Any link that you create from a table or graph to an external system is tied to that table or graph and your user
credentials.
When you log on to an Oracle Supply Chain Planning module, you can use the link in the table or graph from
all plans that include the table or graph. Others with the required role and privileges can also use the link in the
table or graph from all plans that include the table or graph.
However, you can edit or delete the link only if you created it.

During data migration, when you export a table that contains a link to an external system and subsequently
import the table, the link is available in the table.

- When you duplicate the table or graph, you can choose to include the links to the external system in the copy.

Related Topics
 Structure of a Link to an External System

- Set Up the Application Integration for an External System
« Create a Link to an External System
- Use a Link to an External System

Structure of a Link to an External System

This topic explains the structure of a link to an external system from a table or graph in an Oracle Fusion Cloud Supply
Chain Planning module. The topic also provides examples of such links.

Alink to an external system consists of these parts:

Base URL: You supply this part of the link in the Full URL field on the Create Application Integration page. The
link must include the host information and can also include the port details. This part is displayed in the Base
URL field in the Create Link to External System dialog box and can't be modified.

For example, the base URL could be as follows: https://...oracle.com

Page or report path: You supply this part of the link in the Page Path field in the Create Link to External System
dialog box. This path is appended to the base URL and contains details about the page or report in the external
system to which you're creating the link.

Along with the page path, you can also pass the name or ID of the Oracle Supply Chain Planning plan you're

in to restrict the displayed information in the linked, predefined or user-defined analysis or report in Oracle
Transactional Business Intelligence (OTBI), Oracle Analytics Cloud, or Oracle Analytics Publisher.

An example of the report path without the plan context is as follows: /analytics/saw.dll?
Dashboard&PortalPath=%2Fshared%2FCustom%2FSCP%2FSalesOrders_Booking_Rpt
%2FSO_Bookings_Rpt4&Page=page%201&Action=Navigate, where SO_Bookings_Rpt4 is the name of the
report.
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An example of the report path with the plan context is as follows: /analytics/saw.dll?Dashboard&PortalPath=
%2Fshared%2FCustom%2FSCP%2FPL_OTBI_report2%2FDM_Plan_Details&Page=page
%201&Action=Navigate&col3=%22Plan%22.%22Plan%20Name%22&val3=#PlanName#

You must provide the plan context only when the page or report in the external system has a filter for the plan
context, and you want to review the information by plans. For example, a link to an external web page doesn't
require plan context.

Linking parameters: You supply this part of the link in the Linking Parameters section on the To External
System tab in the Manage Links dialog box. The linking parameters contain details about the dimensions,
levels, and level members in the table or graph. This information is appended to a combination of a base URL
and page or report path and opens the external system object with the context of the data in your table or
graph.

For example, the linking parameters could be as follows: "Distributed Order Orchestration - Fulfillment Lines

Real Time"."Order Header Detail"."Ordered Date"&opl1=bet&vall=timestamp '#StartDate# 00:00:00' timestamp
'#EndDate# 23:59:00'

After the link is encoded, when it's accessed from a table or graph, and the runtime values for the contextual
parameters are passed, the linking parameters would look as follows: &col1=%22Distributed%200rder
%200rchestration%20-%20Fulfillment%20Lines%20Real%20Time%22.%220rder%20Header%20Detail %22.
%220rdered%20Date%22&0p1=bet&vall=%22timestamp%20%272022-06-01%2000%3A00%3A00%27%22+
%22timestamp%20%272022-06-30%2000%3A00%3A00%27%22

The resulting, concatenated link opens the external system object with the context of the selected data in your table or
graph.

Example of a Link to an OTBI or Analytics Cloud Report or Analysis

You must meet these requirements while creating a link from a table or graph to a report or analysis in OTBI or Analytics
Cloud:

In the Parameter field on the To External System tab in the Manage Links dialog box, enter the names in the
col<number> format. For example, the parameter names could be coll, col2, col3, and so on.

In the Value field on the To External System tab, enter the names for the subject areas and columns to which
you're passing tokens, and enclose this information in quotation marks.

Then, enter the tokens in the val<number> =<token name> format. The token names mustn't be within double
quotation marks.

If required, include operators, which you must preface in the op<number> format (for example, op2=bet).
This example depicts how the linking parameters would look before the link is encoded:
col1="Submitted Date (Booked Date) - UTC"."Submitted Date"&val1=timestamp '#MemberName# 00:00:00"'
col2="Fulfillment Line Details"."Demand Class Meaning"&val2=#MemberName#
col3="Product"."Product Number"&val3=#MemberName#
col4="Planning Date 1"."Period Start Date"&op4=bet&val4=#StartDate# #EndDate#

After the link is encoded, the linking parameters would look as follows: &col1=%22Submitted+Date+%28Booked
+Date%29+-+UTC%22.%22Submitted+Date%22&val1=%22timestamp+%27<date from selection context>
+00%3A00%3A00%27%22&col2=%22F ulfillment+Line+Details%22.%22Demand+Class+Meaning%22&val2=
%22<member name from selection context>%22&col3=%22Product%22.%22Product+Number%22&val3=
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%22<member name from selection context>%22&col4=%22Planning%20Date%201%22.%22Period%20Start%20Date
%22&0p4=bet&vald=%22<start date from selection context>%22+%22<end date from selection context>%22

Note: Ensure that the numbers for the parameter, value, and operator names are the same for a combination of a
parameter and value.

Example of a Link to an Analytics Publisher Report
You must meet these requirements while creating a link from a table or graph to a report in Analytics Publisher:

In the Parameter field on the To External System tab in the Manage Links dialog box, enter the access
parameters for Analytics Publisher.
Some examples of access parameters are as follows:

o _paramsp_itemname

o _paramsp_fromdate

o _paramsp_todate

o _paramsp_customer

In the Value field on the To External System tab, enter the token names.

Match the access parameters for Analytics Publisher to the available token names for links to external systems.
This example depicts how the linking parameters would look before the link is encoded:
_paramsp_itemname=#MemberName#
_paramsp_fromdate=#StartDate#
_paramsp_todate=#EndDate#
_paramsp_customer=#MemberName#

After the link is encoded, the linking parameters would look as follows: &_paramsp_itemname=<member name from
selection context>&_paramsp_fromdate=<start date from selection context>&_paramsp_todate=<end date from
selection context>&_paramsp_customer=<member name from selection context>

Related Topics
» Overview of Linking to External Systems with Context

- Set Up the Application Integration for an External System
» Create a Link to an External System
- Use a Link to an External System

Set Up the Application Integration for an External System

You must specify the application integration for an external system before you can link to it from a table or graph in your
Oracle Fusion Cloud Supply Chain Planning module. You must have administrator privileges to perform this procedure.

1. In the Setup and Maintenance work area, on the Tasks panel tab, select Manage Setup Content.
The Manage Setup Content page opens.
2. Under Topology Definition, select Manage Integration of Additional Applications.
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The Manage Integration of Additional Applications page opens.
3. Click Actions > Create.

The Create Application Integration page opens.
4. In Application Name, enter the name of the external system.

Note: The name must start with "SCP_EXT_LINK_". Otherwise, you can't select the application integration in the
Application Name field in the Create Link to External System dialog box.

5. In Full URL, enter the base portion of the URL to the external system. The URL must include the host information
and can also include the port details. The page path and linking parameters are appended as context to this URL.

For example, you can enter "https://...oracle.com” in the field.

When you create the link for the table or graph, this URL is displayed in the Base URL field in the Create Link to
External System dialog box and can't be modified. The information you specify in the Page Path field in the dialog
box and on the To External System tab in the Manage Links dialog box is appended to this base URL.

6. In Partner Name, enter any value you require.
In Security Policy, ensure that None is selected.
8. Click Save and Close.

~

Related Topics
» Overview of Linking to External Systems with Context

 Structure of a Link to an External System
- Edit the Application Integration for an External System
- Create a Link to an External System

Edit the Application Integration for an External System

You can edit or delete the application integration for an external system to which you're linking tables or graphs from
your Oracle Fusion Cloud Supply Chain Planning module. You must have administrator privileges to perform this
procedure.

1. In the Setup and Maintenance work area, on the Tasks panel tab, select Manage Setup Content.
The Manage Setup Content page opens.

2. Under Topology Definition, select Manage Integration of Additional Applications.
The Manage Integration of Additional Applications page opens.

3. Search for your application integration, and select it.
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4. Do one of the following:

o To edit the application integration, follow these steps:
i. Click Actions > Edit.

The Edit Application Integration page opens.

You can't edit the application and partner names.
ii. Edit the value in the Full URL field.

The URL must include the host information and can also include the port details.
iii. In Security Policy, ensure that None is selected.
iv. Click Save and Close.
o To delete the application integration, follow these steps:
i. Click Actions > Delete.

A dialog box is displayed.
ii. Click Yes.
What to do next

After editing or deleting the application integration, you must modify the external links that use the application
integration. Otherwise, the external links won't work.

Related Topics
« Overview of Linking to External Systems with Context

« Structure of a Link to an External System

« Set Up the Application Integration for an External System
- Create a Link to an External System

- Edit a Link to an External System

Create a Link to an External System

After specifying an external system's application integration, you can create a link to the system from a table or graph in
your Oracle Fusion Cloud Supply Chain Planning module by supplying the page path and linking parameters.

Tip: To create a link to a page or report in an external system, examine the target URL. Then, enter the required
information for the base URL, page or report path, and linking parameters so that the rendered link meets the external
system's requirements. Use supported tokens instead of actual values in the linking parameters to pass contextual
values during runtime.

1. In your table or graph in the Demand Management, Demand and Supply Planning, Planning Central, Replenishment
Planning, Sales and Operations Planning, or Supply Planning work area, click Actions > Manage Links.

The Manage Links dialog box opens.

Note: You can create links to external systems from only pivot tables and not regular tables.

2. On the To External System tab, click the Create icon.
The Create Link to External System dialog box opens.
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3. In Name, enter a unique name for the combination of the application integration and page path for which you're
creating the link.

This name is displayed when you click Actions > Drill To > External Links in the table or graph.
4. In Description, enter the link description.

5. In Application Name, select the application integration that was previously specified on the Create Application
Integration page.

The base URL that you entered on the page is displayed in the Base URL field and can't be changed.

Tip: You can reuse the same application integration in links to external systems so long as you don't need to
change the base URL.

6. In Page Path, enter the path to the page or report in the external system.

To restrict the displayed data to the current plan in the linked, predefined or user-defined analysis or report in Oracle
Transactional Business Intelligence (OTBI), Oracle Analytics Cloud, or Oracle Analytics Publisher, specify these
tokens:

o #PlanName#: Append this token to the page path to pass the name of the current plan in the Oracle Supply
Chain Planning work area.

o #Planld#: Append this token to the page path to pass the ID of the current plan in the Oracle Supply Chain
Planning work area.
Ensure that the path doesn't contain the host or port details because they're derived from the application
integration.

7. Click OK.
The link is displayed on the To External System tab in the Manage Links dialog box.
8. With the link name selected, in the Linking Parameters section, click the Add Row icon.
A blank row appears in the Linking Parameters section.
You can save the link only when it has at least one valid combination of a parameter and value.

9. In Dimension, select a dimension that you want to pass along with the link to the external system.
The available dimensions are those selected for the table or graph on the Hierarchies tab in the Selector Tool.
The Level field becomes available.

If you selected the Time dimension, the Date Format field is enabled.

10.Select a level that you want to pass along with the link to the external system.
The available levels are those selected for the table or graph on the Hierarchies tab in the Selector Tool.

11. In Parameter, enter a unique name for the parameter through which you want to pass the dimension, level, and
value to the external system page or report.

Ensure that the name meets the external system's nomenclature rules for parameters.
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12. In Value, enter a token for passing the selected level member in the table or graph. The information in this field
should be in the decoded format for URLs.

You can specify these tokens:

o #MemberName#: Use this token to pass the member name. For example, the token can contain the name
of the item, organization, customer, week, or month.

o #Memberld#: Use this token to pass the internal ID of the member.

o #StartDate#: Use this token to pass the start date of the time bucket for your selection in the table or
graph.
o #EndDate#: Use this token to pass the end date of the time bucket for your selection in the table or graph.
When you use the link, the tokens are replaced by the actual values for your selection in the table or graph.
13. In Date Format, select the format in which the value for the Time dimension must be passed to the external system
page or report.
14.Configure additional parameters by repeating Steps 8 through 13.

15. Click Save and Close.

The link is added to the External Links group that's available when you click Actions > Drill To > External Links for
the table or graph.

Related Topics
« Overview of Linking to External Systems with Context

« Structure of a Link to an External System
- Edit a Link to an External System
- Set Up the Application Integration for an External System

Edit a Link to an External System

You can edit or delete a link to an external system from a report or graph in your Oracle Fusion Cloud Supply Chain
Planning module.

Before you start
You can edit or delete the link only if you created it.

Here's what to do

1. Inyour table or graph in the Demand Management, Demand or Supply Planning, Planning Central, Replenishment
Planning, Sales and Operations Planning, or Supply Planning work area, click Actions > Manage Links.
The Manage Links dialog box opens.

2. On the To External System tab, select the link that you want to edit.

The linking parameters for the link are displayed.
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3. To edit the link, follow these steps:
a. Click the Edit icon on the toolbar above the link name.
The Edit Link to External System dialog box opens.
b. Change the name, description, application integration, and page path.
Ensure that the link name is unique.

The value in the Base URL field is populated according to the selected application integration and can't be
changed.

Ensure that the page path doesn't contain the host or port details because they're derived from the
application integration.
c. Click OK.
4. To edit the linking parameters, follow these steps:
o To add a parameter, click the Add Row icon for the linking parameters.

In the new row that appears, specify the dimension, level, parameter name, value, and date format.

Ensure that the parameter name is unique.
o To modify a parameter, click it, and change the values for the dimension, level, parameter name, value, and
date format.

Ensure that the parameter name is unique.
o To delete a parameter, select it, and click the Delete icon for the linking parameters.

You can delete the parameter only if at least one valid combination of a parameter and value remains for

the link.

5. To delete the link, follow these steps:
a. Click the Delete icon on the toolbar above the link name.
b. Click Yes in the displayed dialog box.

6. Click Save and Close.

Related Topics
» Overview of Linking to External Systems with Context

 Structure of a Link to an External System
- Create a Link to an External System
« Set Up the Application Integration for an External System

Use a Link to an External System

This topic explains how you can use a link to an external system from a table or graph in your Oracle Fusion Cloud
Supply Chain Planning module.

Prerequisites for Using Links to an External System
You can use the link to an external system if these conditions are met:

- You must have the privileges to view the data in the external system.

Otherwise, you can't view the data in the external system when you click the link.

- The application integration for the external link must exist.
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- You can open the link only if it has at least one valid combination of a parameter and value.

After the link is configured, if the underlying table or graph is edited, and dimensions are removed, the affected
combinations of parameters and values are automatically deleted. Consequently, the link might become invalid.
- You must select a cell, column, or row of the table or an area of the graph before clicking the link.

- You must select values for the levels that have been configured in the link.

Otherwise, an error message is displayed.

Tip: To identify the required levels, examine the configuration of the link on the To External System tab in the
Manage Links dialog box.

- You must select a value that's associated with or assigned to a level and then click the link.

- You can select multiple values only if they're contiguous.

1. In the Demand Management, Demand and Supply Planning, Planning Central, Replenishment Planning, Sales and
Operations Planning, or Supply Planning work area, open your table or graph.

2. Make a selection.

3. Click Actions > Drill To > External Links, and select a link.
The external link opens on a new tab of your web browser.

What to do next

Note these additional points while using links to external systems:

Every time you click the link to the external system, it opens on a new tab of your web browser.

- After clicking the link, if you change the selection in your table or graph, the data on the page or report in the
external system isn't refreshed.

You must click the link anew to view the external system data on a new tab of your web browser according to
the changed context in your table or graph.

Related Topics
« Overview of Linking to External Systems with Context

 Structure of a Link to an External System
« Set Up the Application Integration for an External System
» Create a Link to an External System

Graph Layout Options

The graph layout option is available in the Selector Tool dialog box, on the Layout tab when you create or edit a graph
using the Manage Tables, Graphs, and Analysis Sets option.

In the Graph Layout Options section, you can define the type of graph and configure layouts and the dimension of axes.
In the Filters section you can specify the filter criteria that you want displayed in the graph.

The layout options vary according to the type of graph. For example, a bar graph has X and Y-axis layout options
whereas a Pie chart doesn't have any X or Y axis. General Options is common for all layout options and includes generic
information for a graph such as title, font, and position of the graph. You can also preview a graph from the Layout
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preview mode, you can format measures, change the layout, and modify the drill

The following types of graphs are available:

- XandY axes graphs
o Vertical bar
o Horizontal bar
o Line graph

- XandY axes graphs with additional parameters

o Area graph
o Combination graph
o Bubble graph

- Pie graph

- Sunburst graph and Treemap graph

- Funnel graph and Radar graph

- Gauge graph

For graphs with an X, Y, or dual Y axes, you can select up to three entities in total: measures are mandatory, and you can
select one or two dimension hierarchies. A dual Y-axis graph requires the measures on the Y axis. You must select one
measure for the Y2 axis in the Y2 -Axis panel. Axis title and tick label rotation options are available for all axes. Tick label
options are also available for the X-axis. For example, skip a certain number of labels for legibility. The Formatting panel
contains visual effect options for the graph, such as 2 dimension or 3 dimension, and bar or line style.

Here's additional information about some of the graphs:

Graph Type

Combination

Bubble

Sunburst

Treemap

Funnel and Radar

Gauge

ORACLE

Comments

A Combination graph includes an area, bar, and line. The measures represented by each of these
options are specified in the Formatting panel.

A Bubble graph requires selections for the bubble component of the graph in addition to the X and Y
axes options. Select the hierarchy and the bubble sizing measure in the Bubble panel.

A Sunburst graph is comprised of rings. Select the number of rings to display. Each ring represents
a level of the hierarchy. The rings are divided into sectors for each member of the level. The size and
color of the sector is determined by the measures selected for those options.

A Treemap graph is comprised of rectangles. Select the depth of the rectangles for a hierarchy. The
rectangles for a level of the hierarchy are nested within the parent level rectangle. The size and color of
the rectangles are determined by the measures selected for those options.

Funnel and Radar graphs require only a hierarchy and measure selection.

Gauge graphs, which are used in infotiles, require measures with goals defined.
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Related Topics
« Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Configure Filters for Graphs

You can configure graphs that specify filter criteria that enables you to page through data in the graph by one or more
hierarchy levels. For example, you might want to filter for product category when analyzing your plan.

After you analyze one product category, you can select another product category to review from the filter bar above the
graph. Specify the filter criteria in the Selector Tool dialog box, Layout tab, Filters section.

The hierarchy levels that you selected on the Hierarchies tab are available to select as filters. You can select one or more
levels of a hierarchy for a filter. However, if you also selected the hierarchy for the X-axis or Y-axis, then you can't select
all of the hierarchy levels for filters. At least one hierarchy level must be used for the X-axis or Y-axis.

The members of the levels that you select are used to filter the data shown in your graph. You can select the level
member value of interest from a set of values in the filter bar above the graph.

Let's work through an example of setting up filters for a graph:

1. In the Selector Tool dialog box, on the Hierarchies tab, select the Time, Product, Organization, and Customer
dimensions.

All levels are selected by default. The levels that you select for the dimensions become visible in the Filters
section.

On the Layout tab, in the X-Axis section, select Gregorian Calendar.

In the Y-Axis section select the Product hierarchy and Measures.

In the Filters section, select to filter on Quarter and Zone.

Click Apply and Close.

When you display the graph, you can see the Quarter and Zone filters above the graph. Months are on the X-Axis and
items are on the Y-Axis. The months shown are determined by the selected quarter, based on the Gregorian calendar.
So, for Quarter 1, the graph displays January, February, and March on the X-Axis. Levels not selected on the axes or in
the Filters section, such as Organization, aren't included in the graph.

uhWN

For the X-axis and Y-axis, if one or more levels are selected on the Hierarchies tab, such as Year, Quarter, and Month,
the graph displays with the highest level. You can drill to lower levels that aren't selected in the Filters section.

Note: Filters for graphs are similar to filters for tables. However, you can't drag and drop filters onto the X-axis or Y-
axis of the graph.

Set Your Axis Scale

Use Axis Scale Options to refine your scale.

- Axis Scale Options applies to the Y axis and Y2 axis and you can use it only for bar, line, area, or combination
graphs.

Minimum is the starting point of the axis.
Maximum is the ending point of the axis.
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- Increment is the increase in values between maximum and minimum.

Specify the behavior.
- Automatic. Promising automatically adjusts the scale for the Y axis and the Y2 axis.
- Manual. You have to manually specify the scale for the Y axis and the Y2 axis.

Assume you set Minimum to 3, Maximum to 10, and Increment to 2. The graph will display 3 as the lowest value, 10 as
the highest value, and 5, 7, and 9 as incremental values for the Y axis or the Y2 axis.

Format How Measures Are Displayed in Tables and
Graphs

You can make measure formatting changes to tables and graphs to reflect your individual preferences or requirements
for how you want the tables or graphs to display.

For example, you can override the name of a measure and its measure of unit. When you format measures in a planning
table or graph, your measure formatting can't be overridden by another user. Any formatting changes done by other
users, including the owner of the table or graph, don't take precedence over your changes. To make user-specific
measure formatting changes, open a table or graph and select View > Format Measures to open the Format Measures
dialog box.

If you're the owner of the table or graph, then your formatting changes are visible to you and to other users who haven't
defined their own formatting. These changes can include overriding the measure label, applying conditional formatting,
or changing the unit of measure that you want displayed in your table or graph. Formatting changes made by others
won't impact your specific measure formatting.

If you're not the owner of the table or graph, then any measure formatting you define takes precedence over the
owner's measure formatting and is visible only to you. For example, if you change decimal positions to O (zero) for all
measures in a table, you're the only user that sees those changes. When you save your measure formatting, you'll no
longer see future formatting changes made by the table or graph owner. For example, if you save measure formatting
and then the table owner adds conditional formatting on a measure, you won't see that conditional formatting.

Use the Reset to Default button in the Format Measures dialog box to remove your user-specific measure formatting.

- If you're the owner of the table or graph, then your measure formatting is removed. Any measure formatting by
non-owners won't be impacted.

- If you're not the owner of the table or graph, then all of your measure formatting is removed. The table or graph
displays all existing measure formatting saved by the owner of the table or graph.

If you duplicate a measure, the duplicated measure is added as the last measure in the table. For example, you can
duplicate a measure with a different currency or unit of measure. If you're the owner of the table, the duplicated
measure is visible to you and to other users who haven't defined their own formatting. If you're not the owner of the
table, the duplicated measure is visible only to you. You can reorder the duplicated measures, but you must save your
layout to preserve the measure order.

You can make user-specific measure formatting changes in the following work areas:
- Demand Management
- Demand and Supply Planning
- Planning Central
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Replenishment Planning
- Sales and Operations Planning

« Supply Planning

Configure Color by Measure to Display in Graphs

You can configure the color by measure and then use that color for every graph that the measure appears in. For
example, always show Final Shipments Forecast in blue and Final Sales Forecast in green.

This functionality is helpful when viewing a specific measure in several graphs in one layout. You can also specify the
color to display for a measurein a specific graph.

The configure color by measure to display in graphs functionality is available in the following Supply Chain Planning
work areas:
Demand Management
Demand and Supply Planning
Planning Central
Replenishment Planning
- Sales and Operations Planning

« Supply Planning

Configure Color by Measure for All Graphs

When you configure graphs, you can have a consistent color for a specific measure in your graphs. For example, you
have multiple graphs that display the forecast. You can quickly identify the forecast measure by using the same color for
the measure in all of your graphs.

To configure a graph color for a specific measure to use in all graphs, select the graph color for the measure in the Edit
Measure dialog box.

In a Supply Chain Planning work area, click the Tasks panel tab.

In the Tasks panel drawer, click the Manage Planning Measures link in the Configuration section.

On the Manage Planning Measures page, select a measure, click Actions, and then select Edit.

In the Edit Measure dialog box, click the Advanced tab.

In the Properties subtab, click the Graph Color drop down arrow and select a color to use for the measure in all
graphs.

VARUWND

Configure Color by Measure for a Specific Graph

You can configure a color for a measure in a specific graph, which overrides the color configured for the measure in the
Edit Measure dialog box.

To configure a graph color for a specific measure for a specific graph, select the graph color for the measure in the
Format Measures dialog box.

1. In an open table or graph, click View and then select Format Measures.
2. Inthe Format Measures dialog box, in the Graph Color column, click the drop down arrow and select a color to
use.
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Automatically Assign Graph Color

If a graph color is already configured for a measure for all graphs, but you want the graph color assigned automatically
for that measure for a specific graph, then select the Assign Graph Color Automatically check box on the Format
Measures page.

1. In an open table or graph, click View and then select Format Measures.

2. Inthe Format Measures dialog box, in the Assign Graph Color Automatically column, click the check box in
the row for the measure.

Tips and Considerations for Assigning Graph Colors to Measures

The following is additional information about the configure color by measure to display in graphs functionality:

Duplicate Colors: You might have a situation where you have two measures with the same color in a graph.
If the color you configure for a measure is the same color as one of the colors automatically assigned to a
measure in a specific graph, then you must select a different color for the measure you're configuring.

Predefined measures: By default, predefined measures initially don't have a graph color selected on the
Manage Planning Measures page. In this case, when used in a graph the planning process automatically
assigns a color for the measure.

Bar, line, and radar graphs: Only measures located in the Y-axis display the graph color settings. This is only in
case the measures aren't combined with one or more hierarchies in the Y-axis. Automatically-assigned colors
are used in this case.

Plan Comparison: When comparing plans, the configured measure color in the graph is honored only for the
measure itself. The measures that represent the compared plans get an automatically-assigned color, selected
randomly by the planning process.

« Archive Plan: When archiving a plan and using Waterfall Analysis or Trend Analysis graphs, the configured
measure color is honored only for the measure itself. The measures that represent the archive get an
automatically-assigned color, selected randomly by the planning process.

Export and Import: When exporting and importing measure settings from one environment to another, the
export and import keeps the graph color settings in Manage Planning Measures and Format Measures.

- Graph Types: The graph color functionality isn't available for the following graph types:
o Pie
o Sunburst
o Treemap
o Gauge
o Funnel
o Bubble

Related Topics
- How You Manage Planning Measures

» Predefined Measures in Supply Chain Planning
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How You Can Edit Measures at an Aggregate Time Level

This topic explains how you can edit measures at an aggregate time level in tables in demand, demand and supply,
replenishment, sales and operations, and supply plans.

You can edit a measure with an edit range that's set to only the future at an aggregate time level in only those table cells
that don't contain time periods for the past. For example, if the current date is Wednesday, August 11, 2021, and you're
viewing the data at a weekly level, you can't edit the forecast for the week starting August 09 or any aggregate level
such as the year 2021. Instead, you can edit the forecasts for the days of August 11 and later as well as the weeks starting
August 16 and later.

You can edit a measure with an edit range that's set to only the history at an aggregate time level in only those table
cells that don't contain time periods for the future. For example, if the current date is Wednesday, August 11, 2021, and
you're viewing the data at a weekly level, you can't edit the history for the year 2021. Instead, you can edit the history for
the days before August 11 and the weeks starting August 02 and earlier.

The same behavior applies when you summarize data across time in tables. For example, the Adjusted Shipments
Forecast measure has an edit range that's set to only the future. If you summarize the measure by time in a table, the
summarized value is editable only if all the included values are editable. If the current month is August 2021, you can't
edit the summary for 2021, but you can edit the summary for 2022.

The same behavior also applies to plans with aggregate planning time levels. For example, if the planning time level
is week, and the current month is August 2021, you can't edit measures at aggregate time levels such as quarter and
year if the underlying weeks aren't editable. Instead, you can view the data at the weekly level to update the values for
editable weeks.

The edit ranges of measures are enforced at the Hybrid time level in demand plans. For example, for the week starting
Monday, December 31, 2029, there are two Hybrid time level members, one starting on Monday, December 31, 2029,
and the other starting on Tuesday, January 01, 2030. If the forecasting time level is set to week, and the plan is run on
Wednesday, January 02, the forecast would begin on Monday, December 31. But, the first Hybrid time level member is
before the plan run date and considered as history. Therefore, any measure with an edit range that's set to the future,
such as Adjusted Shipments Forecast, isn't editable for the first Hybrid time level member.

Thus, data integrity is ensured because you can't make changes to the values of measures outside of their configured
edit ranges.

How Time Periods Are Calculated and Displayed in
Tables, Graphs, and the Selector Tool

This topic explains how time periods are calculated and displayed in tables, graphs, and the Selector Tool in the Demand
Management, Demand and Supply Planning, Planning Central, Replenishment Planning, and Sales and Operations
Planning work areas.
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Settings That Affect the Calculation and Display of Time Periods

The following settings affect the calculation and display of time periods in tables and graphs for a demand, demand and
supply, replenishment planning, or sales and operations plan:

- The value in the Demand History Days field in the Demand: Advanced Options dialog box that you open from
the Demand tab on the Plan Options page

- The selection on the Time Range tab of the Advanced Filter dialog box that's available on the Members tab in
the Selector Tool

- The selected members for the Time dimension on the Members tab in the Selector Tool

- Shared measures

The following settings affect the calculation and display of available members for the Time dimension on the Members
tab in the Selector Tool for the plan:
- The value in the Demand History Days field

- The planning horizon

The default value for the Demand History Days field is 182 days.

Note: If data isn't available, blank rows are displayed for the time periods included in tables and graphs. Also, the
amount of historical data that's considered for the forecast depends on the value in the Historical Buckets field on
the Demand tab on the Plan Options page.

How Time Periods Are Calculated and Displayed

Time periods are calculated and displayed in a table or graph as follows:

If you select members of the Time dimension on the Members tab in the Selector Tool, they're displayed in the
table or graph.

If you don't select members of the Time dimension on the Members tab in the Selector Tool, time periods are
displayed as follows:

o If the table or graph has shared measures, time periods are displayed for the combination of the demand
history days and planning horizon.

o If the table or graph doesn't have shared measures, time periods are displayed for the planning horizon.

The display of available members for the Time dimension on the Members tab in the Selector Tool is for the
combination of the demand history days and planning horizon.

Related Topics
» Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets
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Measure Data in Tables

How You Can Edit Measure Data

While working in one of the Supply Chain Planning work areas, you might be editing measure data in a table.

The following table provides a list of some features you can use when doing so, and where each feature is located:

Feature Location

Configure Summaries View menu

Data Calculation Options Table toolbar

Lock and Unlock Cells If at least one summary is configured:

Action menu, table toolbar, right-click in cell

Related Topics
- Manage Data Calculations When Editing Measure Data in a Supply Chain Planning Table

» How You Lock Cells While Editing Measure Data or Allocating Values in a Table

Copy and Paste Values in Tables

Use the Copy and Paste options in the Actions menu for a table to copy cell values and paste them in editable cells. You
can also copy values from one table to another within the same plan.

Pasting overwrites any existing values, and any measures that are dependent on the overwritten measures are
recalculated.

If your data is in an external application such as Microsoft Excel, you can use the following procedure to copy and paste
your data:

1. Copy your data from the external application.
2. Inyour work area table, click the first editable cell from which you want the data to be pasted, and select
Actions > Paste from Clipboard. The Paste from Clipboard dialog box opens.

3. Press Ctrl+V to paste your content in the dialog box. You can further edit your data in the dialog box.

4. C(lick Paste and Close. The copied content is pasted into the editable cells of the table.
Alternatively, you can export your table data to Microsoft Excel using the Export icon, work with your data in that
application, copy your data, and bring it back into your table by using the Paste from Clipboard option. To copy data
between plans, export the table data to Microsoft Excel from one plan, and use the Paste from Clipboard option to
copy data into the other plan.
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Note: You can paste values in only those cells that fall within your plan horizon. The number and orientation of the
cells from which data is copied and the cells into which data is pasted must match. Only numeric data can be copied
and pasted. Non-editable cells that are within a range of editable cells are skipped when data is pasted, and a warning
is displayed to this effect.

Related Topics
- How can | highlight editable cells in a table?

Manage Data Calculation Options When Editing Measure Data in a
Table

When you are working in a Supply Chain Planning work area, you might be editing measure data in tables that include
dependent measures.

You can use the Data Calculation Options menu to determine when calculations are performed. You access the Data
Calculation Options menu from the table toolbar for the table you are editing.

The Data Calculation Options choices are:

Enable Automatic Calculations

- Calculate Now

Enable Automatic Calculations

When you edit data with this option selected, each time you edit a value, calculations are performed for any applicable
summaries or other measures that include an expression. The Enable Automatic Calculations choice is the default
selection.

Calculate Now

To choose when calculations are performed, you must first deselect Enable Automatic Calculations. When you make
edits with the Enable Automatic Calculations choice deselected, you must click the Calculate Now choice when you want
calculations to be performed. Calculations will be performed for all edits made since the last time calculations were
performed.

If you save a table after making edits, any needed calculations will be performed, but you must refresh the table to see
the results.

How You Lock Cells While Editing Measure Data or Allocating
Values in a Table

When you are working in a Supply Chain Planning work area, you might be editing measure data in a table.

When you have locked cells, edits, including those that spread allocations to other cells, do not change locked cells.

I Note: You must configure at least one summary to enable the Lock and Unlock actions.
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Lock cells by performing one of the following:

- Click the Lock action in the Actions menu.
- Click the Lock icon on the table toolbar.

Right-click in an editable cell.

Related Topics
» How do | enable the Lock and Unlock actions for a table while editing measure data in a Supply Chain Planning
table?

« Can lunlock all cells at once while editing measure data in a Supply Chain Planning table?

How do | enable the Lock and Unlock actions for a table when
editing measure data?

Configure at least one summary to enable the Lock and Unlock actions. Use the View menu for the table to configure
summaries.

Can | unlock all cells at once when editing measure data in a table?

Yes, you can unlock all cells at once by using the Unlock All action from the Actions menu. This action is available in the
Actions menu only if you have configured summaries.

How can | highlight editable cells in a table?

In the View menu for a table, select Highlight Editable Cells to provide a background color for cells that contain editable
measures.

Do note that any conditional formatting that has been applied to an editable measure or a table takes precedence over
the highlight color. You can choose to save your page layout with this setting.
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5 Planning Data Collections

Overview of Data Collections for Supply Chain Planning

To run plans from one of the Supply Chain Planning work areas, you must collect data into a planning data repository.
Order promising and order management processes also use the planning data repository to promise and manage
orders.

To collect data into the planning data repository, you can perform these tasks from one of the Supply Chain Planning
work areas:

- Collect Planning Data: Use this task when you collect data from the Oracle Fusion source system.
Load Planning Data from Files: Use this task when you collect data from a completely external source system.

Depending on your security privileges, you may need to manually add these tasks. In the Setup and Maintenance work
area, use the following:

- Offering: Supply Chain Planning
Functional Area: Supply Chain Planning Configuration
- Task: Collect Planning Data

The following figure illustrates the collections processes that you can use to populate the planning data repository.

Full

Collect
Planning Data

Planning
Data
Repository

CSV Files

Load Planning
Data from Files
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Collect Planning Data

There are two steps involved in the data collection process. The Collect Planning Data process first pulls data from the
Oracle Fusion source system into staging tables. The process then loads data from the staging tables into the planning
data repository.

On the Collect Planning Data page, use the following tabs to select what data you want to collect:

Reference Data
Demand Planning Data

-+ Supply Planning Data

Most of the reference data are global entities. Global entities are common for all source systems. For example, Units of
Measure (UOM) is common for all source systems. The supply planning and demand planning data are transactional
data. Most of the transactional data are local entities. Local entities are specific to each source system. For example, On-
hand Quantity is specific for each source system.

You can also select collection filters to further refine what data you want to collect. You can save your selections to
collection templates.

Load Planning Data from Files
Use this option to populate the planning data repository using CSV files:

To load the planning data from files, follow these steps:

1. Create the CSV files. To create the CSV files, you can use a predefined set of Microsoft Excel files as import
templates.

2. Import the CSV files. From the navigator, click File Import and Export, and create a new import. Specify scm/
planningDatalLoader/Import for the account.

3. Submit the Load Planning Data from Files process. When you submit the process, the process first pushes the
data from the CSV files into the staging tables. The process then loads the data from the staging tables into the
planning data repository.

Related Topics
» How do | update existing setup data?

Global Entities

Within data collections, Oracle Fusion Cloud Supply Chain Planning refers to certain business entities as global entities.

Global entities are specific for each instance and are common for all source systems. They are common without regard
to whether they are collected from the Oracle Fusion source system or collected from an external source system using
the file-based data import (FBDI) method.

When collecting data for a global entity, the planning data repository stores only one record for each instance of the
global entity. The data collections process removes the source system reference from the global entity and stores the
data in the data repository. If the data collections process collects the same instance of a global entity from more than
one source system, the data repository stores the value from the last collection.
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For example, the following scenario describes the collection method of the global entity called units of measure (UOM)
from three source systems, namely source system A, B, and C respectively.

- Source system A has an instance of UOM. During the collection of UOMs from source system A, the kilogram
UOM is collected. This is the first time the kilogram UOM is collected. The data collections process creates a
kilogram record in the data repository.

- Source system B does not have any instances of UOM. During the collection of UOMs from source system B,
the data collections process does not collect the kilogram value. Since there was no record for the kilogram
UOM in source system B, the data collections process does not change the kilogram record in the data
repository. The record of the kilogram value from source system A is still valid.

- Source system C has an instance of UOM. During the collection of UOMs from source system C, the kilogram
UOM is again collected. The data collections process registers the kilogram record in the data repository to
match the values from source system C.

Note: When you use the FBDI collection method, the global entity files require a source system. The collections
framework validates that the source system matches each record's source system. A source system identifier marks
each data record.

In Supply Chain Planning, the following entities are classified as global entities:

- Order Orchestration Reference Objects
Units of Measure and UOM Conversions
Demand Classes
« Currency and Currency Conversion Class
- Shipping Methods (Carrier, Mode of Transport, Service Level)
« Customer and Customer Site
- Suppliers and Supplier Sites
Regions and Zones
- Approved Supplier List
-« Supplier Capacity

Planners

Data Collection Types for Supply Chain Planning

When you collect planning data, one of the parameters you specify for the Collect Planning Data task is the Collection
Type parameter.

You can select this task from any of your Supply Chain Planning work areas. For the Collection Type parameter, you can
select one of the following values:

Targeted: Choose the Targeted collection type when you want to collect a significant volume of source system
data. Typically, you use the Targeted collection type in scenarios such as bulk upload of transaction data,
instance upgrade, and change in collection filters.

- Net change: Choose the Net change collection type when you want to collect changed data and new records
since the last successful collection cycle.
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- Automatic selection: Choose the Automatic collection type when you want the planning process to decide and
automatically select an appropriate collection type for each of the entities.

Targeted

You use the Targeted collection type when you want to perform a complete refresh of the data in the data repository.
In this mode, the planning process deletes the existing data for the selected entities from the data repository. Next, if
subsequently collected from the source, the data for the selected entities replaces the deleted data.

Note: For the following data collection entities, you can use only the Targeted collection type: Item Costs, Resource
Availability, Fiscal Calendars, and all Shipment and Booking History data.

Net change

When you use the Net Change collection type, you collect data incrementally. The Net Change collection type collects
only changed or new data. Collecting data using the Net Change collection type is usually faster than using the Targeted
collection type. You typically use the Net Change collection type when you have previously performed a Targeted
collection, and now you want to keep your planning data current with your execution system data. You cannot select the
demand planning data when the collection type is Net Change.

Automatic selection

You use the Automatic collection type when you are not sure which collection type to select and you want the planning
process to decide the collection type for each entity. The planning process evaluates each entity on multiple factors,
such as the last collected date for an entity, and decides whether to perform a Targeted or a Net Change collection for
the entity. You can manually select the entities that you want to collect or you can use one of the predefined templates
to select your entities. If you select one of the predefined templates, you can't make any changes in the Reference Data,
Demand Planning Data, and Supply Planning Data tabs.

Manage Planning Source Systems for Data Collections

To populate the planning data repository, also known as the order orchestration and planning data repository, you
collect data from the Oracle Fusion source system.

On the Manage Planning Source Systems page in one of the Supply Chain Planning work areas, enable organizations for
collections. Depending on your security privilege, you can also enable organizations from the Setup and Maintenance
work area.

Go to the Setup and Maintenance work area, then go to the task:
- Offering: Supply Chain Planning
Functional Area: Supply Chain Planning Configuration

- Task: Manage Planning Source Systems

The Oracle Fusion Source System

The Oracle Fusion source system is included as a source system for data collection. Supply chain planning, order
orchestration, and order promising processes use data that are stored in the planning data repository. You ensure the
Collections Allowed check box is enabled and manage which organizations you enable for collections.
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To open the Manage Trading Community Source Systems page, navigate to the Setup and Maintenance work area and
use the following:

- Offering: Supply Chain Planning
Functional Area: Supply Chain Planning Configuration
- Task: Manage Trading Community Source System

External Source Systems

You can also allow collections for external source systems if you will be loading planning data from files for Oracle
Fusion Global Order Promising. You must first define the external source system on the Manage Trading Community
Source Systems.

There are two types of external source systems: Others and External.

Version External

The version External source system indicates that the source system is not connected to any other Oracle Fusion

Cloud Applications Suite. This source system is not integrated with the Product Information Management work area,
Oracle Trading Community Model, and Oracle Order Management. The external source system is also referred as a
completely external source system. You cannot enable any other source system settings that are related to other Oracle
Fusion applications. You can select the Collections allowed check box now or later depending on when you want to start
collecting data. This enables the source system for data collections using the file-based import process.

Version Others

The version Others source system indicates that the source system is connected to other Oracle Fusion Applications
Suite. This source system is integrated for the Product Information Management work area, Oracle Trading Community
Model, and Oracle Fusion Cloud Order Management. The following conditions are applicable when the external source
is Others.

External system data for Items, Item Structures, and Catalogs is uploaded to the Product Information
Management work area

External system data for Customers, Customer Sites, Regions and Zones is uploaded to Oracle Oracle Trading
Community Model

External system data for Sales Orders is uploaded to Oracle Fusion Cloud Order Management

For more information on types of data that can be collected for each source system, see the Import Templates Used to
Create CSV Files for Supply Chain Planning topic.

Organizations Enabled for Data Collections
The process for enabling organizations varies depending on the version of the source system.

To enable organizations for data collections when the source system version is Oracle Fusion, perform the following
steps:

1. Click the Manage Organization List button for your Oracle Fusion source system.
2. C(lick the Refresh Organization List button to update the organizations list.

When adding organizations to the Oracle Fusion source system to be collected into planning, you must click the
Refresh Organization List button and then enable the organizations for collections.
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3. Select the Enable for Collections check box for the organizations from which you want to collect data.

Tip: When performing collections during your initial setup, collect order orchestration reference objects from the
predefined Oracle Fusion source system, and consider collecting organizations. After enabling organizations for
collection, collect organizations first. You can confirm the collection results on the Supply Network Model page.

To enable organizations for data collections when the source system version is External (completely external source
system), upload organizations using the file-based import process. The organizations are automatically enabled for
collections.

To enable organizations for data collections when the source system version is Others, perform the following steps:

1. Define an organization as an item-organization in the product data model.

2. Upload the organization using the file-based import process and associate the organization with Others source
system.

Related Topics
» Import Templates Used to Create CSV Files for Supply Chain Planning

- Considerations for Enabling Organizations for Data Collections
- Define Flexfield Mappings

How the Order Orchestration and Order Promising
Processes Use the Collected Planning Data

You perform data collections to populate the planning data repository. In addition to being used by Supply Chain
Planning processes, the collected data is used by Oracle Order Management order orchestration processes and by
Oracle Global Order Promising processes.

Data Collections

You must perform data collections to populate the planning data repository, also called the order orchestration and
planning data repository, with data from the Oracle source system or from a completely external source system. When
you load data from an external source system, use the XLSM files to organize your data in the required format and then
convert the data into CSV files. You can then upload the CSV files to the planning data repository.

Order Orchestration

Order orchestration processes use some reference data directly from the planning data repository. You must perform
data collections for the order orchestration reference entities even if you are not using the Supply Chain Planning work
areas.

Note: Before collecting data from your Oracle source system, you must define at least one organization for the
source system. After you have set up at least one organization, you must update the organization list on the Manage
Planning Source Systems page and then enable at least one of the organizations for collections. If you have not
enabled any organization, then the collections process ends with an error.
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Order Promising

The Global Order Promising processes use an in-memory copy of the data from the planning data repository. When
order orchestration processes send a scheduling request or a check availability request to Oracle Global Order
Promising, the order promising processes use the data stored in main memory to determine the response to send back
to order orchestration. You must refresh the Global Order Promising data store after every collections so that the main
memory always reflect the current.

Related Topics
» Collect Data for Global Order Promising

How You Enable Cross-References of Entities by Data
Collections

Cross-references enable you to locate the correct source value for each cross-referenced entity. When you enable
entities for cross-referencing, data collection pays attention to the cross-references that you have set up for certain
values.

To enable cross-referencing of entities, click the Manage Planning Data Collection Processes task from your supply
chain planning work area. Select the source system from the list, and then enable the available entities that you want to
cross-reference during data collections.

You can view the cross-referenced data for each entity on the Cross-Reference Relationships for Collected Data page in
the Plan Inputs work area.

How Planning Processes Collect Different Work
Definitions and Item Structures

You may be concerned that the work definition and item structure data in your supply chain planning work area does
not match with what was defined in Oracle Manufacturing.

You may be concerned that the work definition and item structure data in your supply chain planning work area does
not match with what was defined in Oracle Fusion Cloud Manufacturing.

You don't need to worry. The planning application collects and uses data based on how the work definitions and item
structures are defined and associated in the manufacturing source system.

Work Definitions and Item Structures in the Source System

The work definition is a primary source of data for the planning application. The planning process uses the work
definition of make order items to determine component and resource requirements. In case the work definition is not
defined, the planning process uses the defined item structure, but to plan for components only. If a work definition

is defined and no item structure is associated to it, then you can manually add ad hoc components to it. If an item
structure is associated to it, you can still add ad hoc components to the work definition, alongside the components in
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the item structure. Remember that while a work definition can be associated with only one item structure, one item

structure can be associated with several work definitions within the parent item.

Work Definitions and Item Structures in the Planning Data Repository

In the manufacturing source system, the work definitions and item structures for an item can be defined and associated
in different ways. The following table lists the most common source system combinations and how the collections and

run plan processes proceed accordingly:

Oracle Manufacturing Definition

Only item structure is defined for an item. No
work definition is defined.

Only work definition is defined for an item. No
item structure is defined.

Both item structure and work definition are
defined for the item.

Both item structure and work definition are
defined for the item, but the work definition
does not refer to the item structure. Ad hoc

components are assigned to the work definition

operations.

ORACLE

Item Structure Name and Work Definition
Name in the Planning Data Repository

Item structure name exists, no work definition
name

Work definition name exists, no item structure
name

Both work definition name and item structure
name exist

Work definition name exists, no item structure
name

Planning Collections Processes

The planning process collects the item structure
information but does not collect information for
routing, operations, or item resources.

The planning process uses item structure to
plan components and does not plan resources.

The planning process collects the work
definition information to populate the item
structure and routing information.

The planning process populates the component
information and operation sequence number

in the item structure based on the ad hoc
components and operation assignment
available in the work definition.

The planning process uses the work definition
information to plan both components and
resources.

The planning process uses the components
that are associated with the work definition to
plan. The planning process does not consider
any components of item structure that are not
associated with the work definition. You can
override the item structure component usage
within the work definition.

The planning process collects component
attributes (such as component effectivity)
from the item structure if the components are
associated with the work definition.

The planning process uses the work definition
to plan resources.

The planning process collects the components
from the work definition and not from the
item structure in the Oracle Fusion Product
Information Management solution.

The process plans components based on work

definition operation assignments and plans
resources based on the work definition.
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Enable External Data Collection for the Oracle Fusion
Source System

Enable external data collection if you want to load transactional data from external systems. Typically, you do this if
some of your supply chain processes are managed in external applications. You load the transactional data from these
applications using file-based data imports (FBDI).

You can use external data sources for these functional areas: Inventory and Materials Management, Procurement, Order
Management, and Manufacturing. When you enable external data collection for a functional area, be aware of these
restrictions:

- You can't use configure-to-order, drop shipment, and back-to-back fulfillment.

- The entities associated with the functional area are no longer available for Oracle Fusion source collection. For
example, if you enable Order Management, the Sales Orders entity won't be available on the Collect Planning
Data page for you to select for Oracle Fusion source collection.

This table lists the entities for each functional area.

Functional Area Entities

Inventory and Materials Management On-hand Quantity and Transfer Orders

Procurement Purchase Orders and Requisitions

Order Management Sales Orders and Reservations

Manufacturing Work Order Supplies, Resource Availability, Resources, Work Definitions, and Item Structures

Enable External Data Collection

Use these steps to enable external data collection:

1. Select the Manage Planning Source Systems task in the Tasks panel from any Supply Planning work area
page. Or use this task in the Setup and Maintenance work area:
o Offering: Supply Chain Planning
o Functional Area: Supply Chain Planning Configuration
o Task: Manage Planning Source Systems

2. Inthelist of source systems, select the row that has Oracle Fusion in the Version column.
In the Actions menu, click Select Data Sources.

4. Select the Enable External Data check box, and then select the functional areas that you want to source
transactional entities for.

w
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Note: Every time you enable or disable external data collection, you must run a targeted data collection to ensure
complete refresh of data in the data repository.

Related Topics
» How You Load Planning Data from Files

Collect Planning Data from the Oracle Fusion Source
System

How You Collect Different Data Types for Supply Chain Planning

When you collect data, you collect data from three categories: reference data, demand data, and supply data. On the
Collect Planning Data page there is a tab for each of these categories.
The collected data are stored in the planning data repository.

The following figure illustrates the three categories of data that you collect from the Oracle Fusion source system to the
planning data repository.
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Explanation of Callouts

1. Reference data is primarily sourced from Oracle Fusion Cloud SCM

2. Demand data comes from Oracle Fusion Cloud Order Management and Oracle Fusion Cloud Inventory
Management

3. Supply data is sourced from Oracle Inventory Management, Oracle Fusion Cloud Manufacturing, and Oracle
Fusion Cloud Purchasing
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Reference Data

The collection process begins with reference data, which is primarily sourced from Oracle Fusion Cloud SCM. You collect
the data collection entities, such as basic item, resource, organization, customers and suppliers, and calendar data.

Note: Oracle Sales and Operations Planning uses the Bill of Resources entity to link the make items with their
associated components and resource requirements. For more information on collecting Bill of Resources from an
external source system, see the Loading Planning Data from Files section.

You also use Oracle Fusion Cloud Supply Chain Planning to collect the following items:

Item structures: To explode item-level demand into component demands and supplies.
- Work Definitions: To assign the component and resource requirements for make items.
Units of measure: To align plan data and to convert plans from one set of units to another.

- Costs: To review plans in financial terms and evaluate the financial impact of planning decisions.

Demand Data
You collect demand data from two potential sources:

- Sales orders that flow from Oracle Fusion Cloud Order Management: You can use this as the basis of the
demand forecast, while current orders can consume the demand in near-term forecast time buckets.

- Shipment history from Oracle Fusion Cloud Inventory Management: You can use this to generate a shipments
forecast.

Supply Data

You collect supply data from three sources:
- Oracle Inventory Management: This provides data related to on hand inventory, reservations, material transfers,
in-transit supplies, and receipts.
- Oracle Manufacturing: This provides work in process status and any manufacturing work orders.

- Oracle Purchasing: This provides purchase requisitions and purchase orders.

Related Topics
» How You Load Planning Data from Files

* Run the Load Planning Data from Files Process
« Import Templates Used to Create CSV Files for Supply Chain Planning

Collection Filters and Collection Templates

You use collection filters and collection templates when you need to collect some common set of entities repeatedly.

The collection filters and collection templates are located on the Collect Planning Data page. To open the Collect
Planning Data page, click the Collect Planning Data task from one of the Supply Chain Planning work areas.
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Depending on your security privileges, you can also open the Collect Planning Data page from the Setup and
Maintenance work area. In the Setup and Maintenance work area, use the following:
- Offering: Supply Chain Planning
Functional Area: Supply Chain Planning Configuration

- Task: Collect Planning Data

Collection Filters

Use collection filters to improve the performance and efficiency of the collections process, and to avoid accumulation of
irrelevant data in the planning data repository. You can use several filter criteria while performing collections, such as by
employing catalogs, order types, and price lists. You can also use date-based filters for collecting shipment and booking
history information.

Enabling Collection Filters

To enable collection filters, you must first run the schedule process called Load Filter Names for Planning Data
Collection from the Scheduled Processes work area. When you run the scheduled process, the filters get enabled in the
Collect Planning Data page. Then, you can apply the filters from the next collection.

Collection Templates

Use collection templates when you want to collect a set of data repeatedly over a period. You can select either one of the
predefined templates that serves your specific need, or you can create your own template and save it for future use.

When you select a predefined template from the list, the Collection Type field is defaulted to Automatic selection and
you cannot edit the field. Also, when you select a predefined template, the Select Collection Filters field is disabled.

You can create a collection template on the Collect Planning Data page by selecting the data collection entities and
saving the template for future use. For example, if you frequently collect certain supply planning transactional entities,
such as On Hand, Purchase Orders, and Purchase Requisitions, then save these entities as a collection template. It
reduces the overhead of selecting the same entities for subsequent collection cycles.

If the template file contains any error during the upload process, rectify the issue found in the log file and upload the
template file again.

Collect Data Using the Targeted Collection Type

To perform a complete refresh of the data repository used by the Supply Chain Planning products, run a targeted
collection.

You can run the targeted collection immediately or you can schedule the process to run later. Demand planning data
can only be collected by using the Targeted collection type.

Note: Before collecting demand planning data, you must successfully run the Load Filter Names for Planning Data
Collection scheduled process.

Perform the following steps to collect reference data, demand planning data, and supply planning data using the
Targeted collection type.

1. Access the Collect Planning Data page from a Supply Planning work area or the Setup and Maintenance work
area.
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o If you are in one of the Supply chain Planning work areas:

i. Click the Tasks panel tab.
ii. In the Tasks panel drawer, click the Collect Planning Data link.
o If you are in the Setup and Maintenance work area, then select the following:

- Offering: Supply Chain Planning
- Functional Area: Supply Chain Planning Configuration
- Task: Collect Planning Data

2. On the Collect Planning Data page, complete the following steps.

o On the Parameters tab:

i. Select your source system.
ii. Forthe collection type, select Targeted.

Demand planning data can only be collected by using the Targeted collection type.
iii. Click Select Collection Filters to select the collection filters.
o On the Reference Data subtab, move the required reference entities to the Selected Entities area.

o On the Demand Planning Data subtab, set options to collect the historical demand data in the planning
data repository. The planning process uses the historical demand data for statistical forecasting.

- Collection Time Frame Options: You can specify a fixed or rolling date range for which to collect
data.

The Fixed Date Range option enables you to collect history data within a fixed date range that you
specify.

The Rolling Date Range option enables you to collect the history data for the number of days that
you specify. For example, if you forecast weekly, specify 7 in the Number of Days to Collect field
to collect the demand history data once per week. The data collections collect the demand history
data for the latest week.

Select Roll off time periods automatically to truncate the history data by the number of days that
you specify in the Number of days to keep field each time you run collections for the demand
history data. For example, if you prefer to forecast each week based on the history data of 52
weeks, select the Roll off time periods automatically check box and specify Number of days

to keep as 364 days. This setting ensures that as you collect data every week, you keep the most
recent history of 52 weeks and automatically purge history data older than 52 weeks.

- History Measures and Attributes: Select your shipments history and bookings history measures.

- Collection for ETO Items: Select Collect history from associated base models to collect
bookings and shipments history for Engineer to Order (ETO) items from the associated base
models. When you don't select this option, the history is collected from the standard ETO items.
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- History Data Options: To collect only specific order types, select from the Order Types to Include
list of values. By default, all order types are included.

Select Organization - Consumption Inventory Transactions to Include to collect consumption
inventory transactions at the organization level. You can collect only the transfer orders inventory
transactions or all consumption inventory transactions.

Select Subinventory - Consumption Inventory Transactions to Include to collect consumption

inventory transactions at the subinventory level. You can collect only the transfer orders inventory
transactions or all consumption inventory transactions for the organizations that you enabled for

subinventory planning.

Select the Collect amount data for history check box to collect amount data.
- Additional Options: Select additional options for collections.

Collect Price Lists: Collect the price lists specified in the collections filter for price lists, or collect all
price lists if no filter is specified.

Collect Configure to Order Data: If you selected history measures and attributes, then select the
relevant check boxes to collect shipment history options and booking history options.

Sales Organization Hierarchy: Select Enable sales organization hierarchy collection to collect
one or more sales hierarchies.

o On the Supply Planning Data subtab:

i. Move the required supply entities to the Selected Entities area.

ii. If you collect resource availability, then select a date range type: Fixed or Relative to collection
run date.

If you selected Fixed, then provide a start date and an end date for collecting resource availability.

If you selected Relative to collection run date, then enter a number of days in the Collection
Window in Days field. The number that you enter determines a collection window in days to
collect resource availability based on a rolling time window. That rolling time window adjusts itself,
based on the date that you run collections. For example, if you specify 90, then resource availability
is collected for the next 90 days each time from the date of the collection run.

Note: You can save your date range type selection for resource availability collection as a
collection template to use later.

iii. You can collect the existing data for the resource availability.

iv. You can also regenerate the resource availability data and then collect the data. If you select the
Regenerate data, and then collect option, the collections process runs the Update Resource
Availability Job scheduled process first and then collects the resource availability data.

3. (Optional) Click the Schedule tab and set collections to run as soon as possible or schedule to run at a different
time.

4. Click Submit to start the collections process.

Monitor the collection status using the Scheduled Processes page.

6. Review the collected data in the Plan Inputs work area.

w
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Related Topics
- Verify the Load Planning Data from Files Process

« Review Data in the Planning Data Repository
« Set Up Forecast Consumption for Transfer Orders

Collect Data Using the Net Change Collection Type

You can collect data from the Oracle Fusion source system by running the net change collection or by scheduling to run
the process later.

Before running a Net Change collection, you must run a Targeted collection for the selected entities. After the first
Targeted collection, you can run Net Change collections.

Perform the following procedure to collect reference data and supply planning data using the net change collection
type:
1. If you are in one of the Supply Chain Planning work areas, then click the Tasks panel tab. In the Tasks panel

drawer, click the Collect Planning Data task. If you are in the Setup and Maintenance work area, then use the
following:

o Offering: Supply Chain Planning
o Functional Area: Supply Chain Planning Configuration
o Task: Collect Planning Data
2. Complete the following parameters for the Collect Planning Data process:

a. Select your source system.
b. Select the collection type as Net change.

Note: You cannot make any changes to the filter criteria and demand planning data in the net change
collection type.

c. Inthe Reference Data tab, move the required reference entities to the Selected Entities area.
d. Inthe Supplies Planning Data tab, move the required supply entities to the Selected Entities area.
3. (Optional) Click the Schedule tab and set collections to run as soon as possible or schedule to run at a different
time.
4. Click Submit to initiate the collections process.
Monitor the collection status using the Scheduled Processes page.
6. Review the collected data in the Plan Inputs work area.

ui

Related Topics
 Verify the Load Planning Data from Files Process

- Review Data in the Planning Data Repository
» How do | update existing setup data?
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Enable Organization Group Collection for the Net Change
Collection Type

You can use organization groups to limit the net change data collection from a source system to specific organizations.

Using organization groups for collection also eliminates the chances of data overlap when multiple instances of net
change collections are run at a time. Planners can run collections for their organizations without waiting for each other.

Let's take a simple example where your organization considers only the D1and D2 distribution centers in your source
system for shipments to your customers. In such a case, you can create an organization group, assign D1and D2 to the
organization group, and collect net change data specifically for this group.

Note: Before you begin, ensure that you have your organization groups created. A supply planner creates and
manages organization groups using the Manage Organization Groups button on the Maintain Supply Network Model

page.

Do these to collect net change data for an organization group.

1. Access the Collect Planning Data page or Load Planning Data from Files page from a Supply Planning work
area.

2. Select the source system. Organization groups are managed within the source systems.

3. Select the Net Change collection type. You can select an organization group for data collection only when the
collection type is Net Change.

4. Enable the organization group collection, and then select an organization group.

5. Perform the net change data collection. Refer to the Collect Data Using Net Change Collection Type topic in this
chapter for instructions.

Note: After selecting your organization group and other data collection entities, you can also save your selections as
a template. Refer to the Collection Filters and Collection Templates topic in this chapter for additional information.

Related Topics
» Collect Data Using the Net Change Collection Type

« Collection Filters and Collection Templates
» How You Maintain Your Supply Network Model

Load Planning Data from Others and External Source
Systems

How You Load Planning Data from Files

You upload data using CSV files for specific business objects using the targeted or net change method.
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Note: To create the CSV files, you can use a set of Microsoft Excel template files that are provided for this purpose.
You can download the templates from the File-Based Data Import (FBDI) for SCM guide in the Oracle Help Center.

Chapter 3
Planning Data Collections

You use the targeted mode when you want to refresh data for selected entities in the planning data repository. You use
the net change mode to collect data incrementally. The net change collections mode collects only the changed or new
data. Data collection using the net change mode is fast compared to the targeted mode. The net change mode is used
to retain planning data to current with that of the executing system.

The following figure illustrates the process of collecting data from files.

Prepare the Data Files

Run the Load Process

Verify the Load Process

Review the Loaded Data

To load planning data from files, you perform the following steps:

P UWUNA

Create CSV files using Microsoft Excel template
Run the process to load planning data from files
Verify the load planning data process

Review the loaded data

Related Topics

Create CSV Files to Load Planning Data

Import Templates Used to Create CSV Files for Supply Chain Planning
Run the Load Planning Data from Files Process

Verify the Load Planning Data from Files Process

Review Data in the Planning Data Repository

ORACLE
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Create CSV Files to Load Planning Data

To perform the Load Planning Data from Files task in one of the Supply Chain Planning work areas or Setup and
Maintenance work area, you must prepare the data you want to load.

You must create the necessary CSV files used to create files for import. This procedure explains how to create CSV files
to prepare planning data for loading.

1. Locate the applicable file import templates (XLSM files) in the following guide: File-Based Data Import (FBDI) for
SCM. Extract the templates to a local space.

For additional information about creating and importing CSV files, see the following section in the
Implementing Common Features for SCM guide: External Integration chapter, External Data Integration
Services for Oracle Cloud section.

2. Open the template file for the entity you are preparing and complete the file import template worksheet.

You must enable the macros in the template file before generating the CSV file.

CAUTION: For the cells that contain dates, ensure that the data is set to the correct format in the data type.
For example, date must be set to YYYY/MM/DD.

3. After you finish preparing the data in the worksheet, generate the CSV file. The Generate CSV File button is
located in the Instructions and CSV Generation worksheet of the workbook.

4. When you save the generated CSV file, you must use the suggested name of the entity. You can add
underscore and add additional characters to the file name. For example, you can name the CSV file as
ShipmentHistory_abc.csv and you can name the file as LoadingCSV.zip.

5. Compress the CSV file into a zipped file format using a compression utility. You can provide any name to the
zipped file.

Note: You can include multiple CSV files in a single compressed file for a source system. The load process
uploads them in a sequential order. Select the CSV files and compress them directly. Do not compress the
parent folder that contains the files.

This completes the preparation of a file that you will upload to collect planning data.

Related Topics
« How You Load Planning Data from Files

» Run the Load Planning Data from Files Process

Data Collection Sequence

This topic explores the sequence that you should follow for data collection.

Data collection involves collecting entities in a predefined sequence. The collected entities form the basis for supply
planning calculations. To have accurate data, you must ensure to collect the entities in a proper sequence. You cannot
collect some entities without collecting their precursor entities. The data collection sequence is very crucial when you
collect data from an external source system using CSV files.

60
ORACLE



Oracle Fusion Cloud SCM Chapter 3
Using Sales and Operations Planning Planning Data Collections

If you run targeted collections for all entities, you can ignore the sequence for collections because targeted collections
automate the collection sequence for all entities within a single collections request. If you collect many entities in a
single request, collections will process them according to the sequences shown in this topic. If you collect only a few
entities, then you must be aware of the collections sequence information. For example, you should not collect work
orders before you collect items or resources.

To make the workflow simple, the collection sequence is divided into two parts - Part A and Part B. The collection
entities in Part B are dependent on the collection entities in Part A. You must collect the entities in Part A before you
collect the entities in Part B. Also, the collection entities are grouped together for easier presentation. The data groups
in Part A are:

- Collections Sequence Part A for Item Data
- Collections Sequence Part A for Region, Location, and Customer Data
- Collections Sequence Part A for Currency, Calendar, Demand Class, and UOM Data

The data groups in Part B are:

- Collections Sequence Part B for Sales Order and Assignment Sets
- Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Every collection sequence in Part A starts with defining a source system where the collected data will reside. If you are
collecting data to the same source system, you define the source system only once. Then, use the same source system
to collect all the entities.

The following figure provides an overview of the data collection sequence. The overview shows how Part A and Part B
fit together to form a complete data collection flow.

Data Collection Sequence Overview

PartA

Collection Sequence
Part A for Currency,

Collection Sequence
Part A for Region,

Collection Sequence

cggg:i'ngeu";fﬁd é—ﬂfiat'":'ﬂ. gﬂ?a Part A for Item Data
Data ustomer Da
Continue to
. . Collection Sequence |
R OE B B W ... .................... : palt B : .....................
Part B . } —— ¢S
. , ollection Sequence
Collection Sequence Part B for Work
Part B for Sales
P — Orders, Work
; Definition, tem
Assignment Sets Structure

Collections Sequence Part A for Item Data

The following image shows the collections sequence to follow while collecting Item data from external source systems.
This image represents only half of the entities for collecting Item data.
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Note: The Organization entity is marked with an asterisk because you can collect other entities such as Planner, Item
Cost, Subinventory, Carrier, Calendar Assignment, Supplier, and Supplier Site after collecting Organization. For more
information on the collection sequence for these entities, see the Collections Sequence Part A for Currency, Calendar,
Demand Class, and UOM Data figure. Refer to the entities that are collected after Organization. Also, ensure that you
collect Location before collecting Supplier Site.

Collection Sequence Part A for tem Data

Define Source —r - T
System —» Create Organizations * Organization
|
]
Load UCM » Load ltems in PIM ltems

4 . . B

Customer Specific
é"DM Class hem Relationships ke Relationship hem Costs
onversions

v ¥ L
Item Structure Item Catalog Safety Stock Lewvel

] ¥ ]

Continue to
Itecrg Shuchure Gatalog Clatlegurg.r Collection Sequence
mponent Association Part B

.

lterm Category

When you collect the data described here, continue to the collection sequence Part B described in the following
subsections.

- Collection Sequence Part B for Sales and Order and Assignment Sets

- Collection Sequence Part B for Work Orders, Work Definition, and Item Structure
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Collections Sequence Part A for Region, Location, and Customer Data

The following image shows the collections sequence to follow while collecting Regions and Customers data from
external source systems. This image represents only half of the entities for Item data.

Collection Sequence Part A for Region, Location, and
Customers Data

Define Source Load Customers,

System Regions in TCA |

Load Customer Sites

in TCA
v -k 3
Location Customer Region
L ]
v [
Customer Sites Ship Methods
v ¥ L J
Sourcing Rules,
Customer Specific ,
Calendar ; | Sourcing
Assignments Item Relationships Assignments, Saurce
Organization,
'L Receipt Organization
Continue to
Collection Sequence
PartB

When you collect the data described here, continue to the collection sequence Part B described in the following
subsections.
- Collection Sequence Part B for Sales and Order and Assignment Sets

- Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Collections Sequence Part A for Currency, Calendar, Demand Class, and UOM Data

The following image shows the collections sequence to follow while collecting Currency, Calendar, Demand Class, and
UOM data from external source systems. Also, ensure that you collect Location before collecting Supplier Site.
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Note: The Calendar entity is marked with an asterisk because there are other entities that are associated with
Calendar that you must collect in a sequence. To collect other entities associated with Calendar, see the Calendar
Upload Sequence figure.

Collection Sequence Part A for Currency, Calendar, Demand
Class and UOM Data

Define Source
System

Currency Calendar* Demand Class UOM
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¥
Y
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Continue from the
previous diagram,
. after Organization -

Flanner Subinventory Carrier Supplier

hem Cost Supplier Site
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When you collect the data described here, continue to the collection sequence Part B described in the following
subsections.
- Collection Sequence Part B for Sales and Order and Assignment Sets

- Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Collection Sequence for Calendar Data

The following image shows the collections sequence to follow for collecting the Calendar data. Calendar data is a part
of the data collection in Part A. You collect the Calendar data in the following subsection: Collection Sequence Part A for
Currency, Calendar, Demand Class, and UOM Data.
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Calendar Upload Sequence

Calendar

Calendar Shifts Calendar Exceptions Period Start Days Week Start Dates

v h J

Calendar Workday Gergj:sii::trda r

patam Collection

Collections Sequence Part B for Sales Order and Assignment Sets

The following image shows the collections sequence to follow while collecting Sales Order and Assignment Sets data
from external source systems. The data entities in Part B are dependent on Part A. So, you must collect entities listed in

Part A before you collect the entities in Part B.
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Collections Sequence Part B for Sales Orders and Assignments Sets
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Planning Data Collections

Collection Sequence Part B for Work Orders, Work Definition, and Item Structures

The following image shows the collections sequence to follow while collecting Work Orders, Work Definition, and Item
Structure data from external source systems. The data entities in Part B are dependent on Part A. So, you must collect

entities listed in Part A before you collect the entities in Part B.
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Collection Sequence Part B for Work Orders, Work Definitions,
and Item Structures
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Templates Used to Create CSV Files

You can use the Microsoft Excel templates (XLSM files) to prepare the data for the supported collection entities.

The templates are listed in the following guide: File-Based Data Import (FBDI) for SCM. Extract the templates to a local
drive, enter appropriate data as described in the template, and generate CSV files. Compress the CSV files to a zipped
file format and upload the .zip file to the Universal Content Manager using the File Import and Export utility. The data is
then loaded from the Universal Content Manager to the planning data repository.

Collect Data from the Oracle Fusion Source

The following table lists the collections entities that can be loaded into the planning data repository for the Oracle
Fusion source. The Collection Entity column provides the name of the entities for which you can collect the data.
The XLSM File Name column provides the template name that you will download for the respective collection entity.
Download the XLSM template from the File-Based Data Import (FBDI) for SCM guide. The Link in Data Import Guide
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column provides the name of the topic in the FBDI guide from where you will download the template. For example, to
collect data for the Item Costs collection entity, refer to the Item Cost Import topic in the FBDI guide.

Collections Entity

ltem Costs

Customer Specific Item Relationships

Planners

Item Suppliers

Demand Classes

Allocation Assignments and Allocation Rules

ATP Assignments and ATP Rules

Supply Update Rules

Measures

Booking History

Option Booking History

Shipment History

Option Shipment History

Price Lists

Causal Factors

Forecast Measures

ORACLE

Link in Data Import Guide

Supply Chain Planning Item Cost

Supply Chain Planning Item Substitute

Supply Chain Planning Planners

Supply Chain Planning Approved Supplier List

Supply Chain Planning Demand Classes

Supply Chain Planning Planning Allocation
Rules

Supply Chain Planning Available-to-Promise
Rules

Supply Chain Planning Real Time Supply
Updates

Supply Chain Planning Measures

Supply Chain Planning Bookings History

Supply Chain Planning Option Bookings History

Supply Chain Planning Shipments History

Supply Chain Planning Option Shipments
History

Supply Chain Planning Price List

Supply Chain Planning Causal Factors

Supply Chain Planning Forecast Measures

XLSM File Name

ScpltemCostimportTemplate.xlsm

ScpltemSubstitutelmportTemplate.xlsm

ScpPlannersimportTemplate.xIlsm

ScpApprovedSupplierListimportTemplate.xlsm

ScpDemandClassimportTemplate.xlsm

ScpPlanningAllocationRulesimportTemplate.xlsm

ScpATPRulesimportTemplate.xlsm

ScpRealTimeSupplyUpdatesimportTemplate.xlsm

ScpMeasuresimportTemplate.xlsm

Note:

You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.

ScpBookingHistorylmportTemplate.xlsm

ScpOptionBookingHistorylmportTemplate.xlsm

ScpShipmentHistorylmportTemplate.xIlsm

ScpOptionShipmentHistorylmportTemplate.xIlsm

ScpPriceListimportTemplate.xlsm

ScpCausalFactorsimportTemplate.xlsm

ScpForecastMeasurelmportTemplate.xlsm

69



Oracle Fusion Cloud SCM
Using Sales and Operations Planning

Collections Entity

Fiscal Calendars

Forecasts

Safety Stock Levels

Supplier Capacity

Planned Order Supplies

Sourcing Rule and Assignments

Cross-Reference Mapping Information

Link in Data Import Guide

Supply Chain Planning Fiscal Calendars

Supply Chain Planning External Forecasts

Supply Chain Planning Safety Stock Levels

Supply Chain Planning Approved Supplier
Capacity

Supply Chain Planning Planned Order Supply

Supply Chain Planning Sourcing Rules

Supply Chain Planning Cross-Reference Data

Collect Data from External Source - Version Others

Chapter 3
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XLSM File Name

Note:

This template has been superseded

by the generic template
ScpMeasuresimportTemplate.xlsm, but
will continue to be supported. Future
enhancements will be made only to the
generic measures template.

ScpFiscalCalendarlmportTemplate.xlsm

ScpExternalForecastimportTemplate.xIsm

ScpSafetyStockLevellmportTemplate.xlsm

ScpApprovedSupplierCapacitylmportTemplate.xlsm

ScpPlannedOrderSupplylmportTemplate.xIsm

Note:
This template is only used to load planned
order supply to Global Order Promising.

ScpSourcinglmportTemplate.xlsm

ScpCrossReferenceDatalmportTemplate.xIsm

The following table lists the collections entities that can be loaded into the planning data repository from an external
source, where the version is Others. The Collection Entity column provides the name of the entities for which you can
collect the data. The XLSM File Name column provides the template name that you will download for the respective
collection entity. Download the XLSM template from the File-Based Data Import (FBDI) for SCM guide. The Link in Data
Import Guide column provides the name of the topic in the FBDI guide from where you will download the template. For
example, to collect data for the Items and Item Costs collection entities, refer to the Item Cost Import topic in the FBDI

guide.

Collections Entity
Item Costs

Customer Specific Item Relationships

Planners

ORACLE

Link in Data Import Guide

Supply Chain Planning Item Cost

Supply Chain Planning Item Substitute

Supply Chain Planning Planners

XLSM File Name

ScpltemCostimportTemplate.xlsm

ScpltemSubstitutelmportTemplate.xlsm

ScpPlannersimportTemplate.xlsm
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Collections Entity

Organizations (Warehouses) and Organization
Site (Including Organization Site - Internal
Location Mapping)

Subinventories

Suppliers and Supplier Sites

Item Suppliers

Interlocation Shipping Networks

Currencies, Currency Conversion Types, and
Currency Conversion Rates

Units of Measure, Units of Measure
Conversions, and Units of Measure Class
Conversions

Calendars, Calendar Exceptions, Calendar
Shifts, Week Start Dates, Period Start Dates,
and Calendar Shift Workday Pattern

Calendar Associations

Demand Classes

Ship Mode of Transport, Ship Class of Service,
and Carrier

Allocation Assignments and Allocation Rules

ATP Assignments and ATP Rules

Supply Update Rule

Freight Terms, FOB Points, Invoicing and
Accounting Rules, Shipment Priorities, Payment
Terms, Return Reason, Tax Classification Code,
Tax Exemption Reason, Sales Credit Type,
Activity Type, Document Categories, Payment
Methods, and Receipt Methods

ORACLE

Link in Data Import Guide

Supply Chain Planning Organizations

Supply Chain Planning Subinventories

Supply Chain Planning Suppliers

Supply Chain Planning Approved Supplier List

Supply Chain Planning Interlocation Shipping
Methods

Supply Chain Planning Currencies

Supply Chain Planning Units of Measure

Supply Chain Planning Calendars

Supply Chain Planning Calendar Assignments

Supply Chain Planning Demand Classes

Supply Chain Planning Carriers

Supply Chain Planning Planning Allocation
Rules

Supply Chain Planning Available-to-Promise
Rules

Supply Chain Planning Real Time Supply
Updates

Supply Chain Planning Order Orchestration
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XLSM File Name

ScpOrganizationimportTemplate.xIlsm

ScpSublnventorylmportTemplate.xlsm

ScpPlanningSupplierlmportTemplate.xlsm

ScpApprovedSupplierListimportTemplate.xlsm

ScplinterLocationShipMethodsImportTemplate.xlsm

ScpCurrencylmportTemplate.xlsm

ScpUOMImportTemplate.xIsm

ScpCalendarimportTemplate.xlsm

ScpCalendarAssignmentsimportTemplate.xlsm

ScpDemandClassimportTemplate.xlsm

ScpCarrierlmportTemplate.xlsm

ScpPlanningAllocationRulesimportTemplate.xlsm

ScpATPRulesimportTemplate.xlsm

ScpRealTimeSupplyUpdatesimportTemplate.xlsm

ScpOrderOrchestrationimportTemplate.xlsm
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Collections Entity

Measures

Booking History

Option Booking History

Shipment History

Option Shipment History

Price Lists

Causal Factors

Forecasts Measures

Fiscal Calendars

Forecasts

User-Defined Hierarchies

Safety Stock Levels

Supply Reservations to Sales Orders

On Hand

ORACLE

Link in Data Import Guide

Supply Chain Planning Measures

Supply Chain Planning Bookings History

Supply Chain Planning Option Bookings History

Supply Chain Planning Shipments History

Supply Chain Planning Option Shipments
History

Supply Chain Planning Price Lists

Supply Chain Planning Causal Factors

Supply Chain Planning Forecast Measures

Supply Chain Planning Fiscal Calendars

Supply Chain Planning External Forecast

Supply Chain Planning User-Defined
Hierarchies

Supply Chain Planning Safety Stock Levels

Supply Chain Planning Reservations

Supply Chain Planning Supply On Hand
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XLSM File Name

ScpMeasuresimportTemplate.xIsm

Note:

You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.

ScpBookingHistorylmportTemplate.xIsm

ScpOptionBookingHistorylmportTemplate.xlsm

ScpShipmentHistorylmportTemplate.xlsm

ScpOptionShipmentHistorylmportTemplate.xlsm

ScpPriceListimportTemplate.xIsm

ScpCausalFactorsimportTemplate.xlsm

ScpForecastMeasurelmportTemplate.xlsm

Note:

This template has been superseded

by the generic template
ScpMeasuresimportTemplate.xlsm, but
will continue to be supported. Future
enhancements will be made only to the
generic measures template.

ScpFiscalCalendarlmportTemplate.xlsm

ScpExternalForecastimportTemplate.xlsm

ScpUser-DefinedHierarchylmportTemplate.xlsm

ScpSafetyStockLevellmportTemplate.xlsm

ScpReservationlmportTemplate.xlsm

ScpOnhandimportTemplate.xIsm
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Collections Entity

Purchase Orders, Purchase Requisitions, PO in
Receiving, and In Transits

Transfer Orders

Supplier Capacity

Resources and Resource Shifts

Resource Availability

Work Definition (Including mapping between
Item Structures and Work Definitions), Work
Definition Operations, and Work Definition
Operation Resources

Work Order Supply

Work Order Material Requirements

Work Order Resource Requirements

Planned Order Supplies

Sourcing Rule and Assignments

Cross Reference Mapping Information

Key Customer Options

Link in Data Import Guide

Supply Chain Planning Purchase Order
Requisitions

Supply Chain Planning Transfer Orders

Supply Chain Planning Approved Supplier
Capacity

Supply Chain Planning Resources

Supply Chain Planning Resource Availability

Supply Chain Planning Routings

Supply Chain Planning Work Order Supplies

Supply Chain Planning Work Order Component
Demands

Supply Chain Planning Work Order Operation
Resources

Supply Chain Planning Planned Order Supply

Supply Chain Planning Sourcing Rules

Supply Chain Planning Cross-Reference Data

Supply Chain Planning Key Customer Options

Collect Data from External Source - Version External
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XLSM File Name

ScpPurchaseOrderRequisitionlmportTemplate.xlsm

ScpTransferOrderlmportTemplate.xlsm

ScpApprovedSupplierCapacitylmportTemplate.xlsm

ScpResourcesimportTemplate.xlsm

ScpResourceAvailabilitylmportTemplate.xlsm

ScpRoutingsimportTemplate.xlsm

ScpWorkOrderSuppliesimportTemplate.xlsm

ScpWIPComponentDemandsimportTemplate.xlsm

ScpWIPOperationResourcelmportTemplate.xIlsm

ScpPlannedOrderSupplylmportTemplate.xIsm

Note:
This template is only used to load planned
order supply to Global Order Promising.

ScpSourcinglmportTemplate.xlsm

ScpCrossReferenceDatalmportTemplate.xIsm

ScpKeyCustomerOptionsimportTemplate.xlsm

The following table lists the collections entities that can be loaded into the planning data repository from an external
source, where the version is External. The Collection Entity column provides the name of the entities for which you can
collect the data. The XLSM File Name column provides the template name that you will download for the respective
collection entity. Download the XLSM template from the File-Based Data Import (FBDI) for SCM guide. The Link in Data
Import Guide column provides the name of the topic in the File-Based Data Import (FBDI) for SCM guide from where
you will download the template. For example, to collect data for the ltems and Item Costs collection entities, refer to the
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Item Cost Import topic in the File-Based Data Import (FBDI) for SCM guide. All the planning-related entity names are
prefixed with Supply Chain Planning in the FBDI guide.

Collection Entities

ltems

ltem Costs

Item Relationships

Catalogs, Categories, and Item Categories

[tem Structures

Bill of Resources

Planners

Customers and Customer Sites

Regions

Zones

Region-Zone Mapping

Locations and Region-Location Mapping

Organizations and Organization Sites

Subinventories

Suppliers and Supplier Sites

Item Suppliers (Approved Supplier List)

Interlocation Shipping Networks and Transit
Times

Currencies and Currency Conversions

Units of Measure, Units of Measure
Conversions, and Units of Measure Class
Conversions

ORACLE

Link in FBDI Guide

Supply Chain Planning ltems

Supply Chain Planning Item Cost

Supply Chain Planning Item Substitute

Supply Chain Planning Catalogs

Supply Chain Planning Item Structures

Supply Chain Planning Bill of Resources

Supply Chain Planning Planners

Supply Chain Planning Customers

Supply Chain Planning Regions

Supply Chain Planning Zones

Supply Chain Planning Region Zone Mappings

Supply Chain Planning Locations

Supply Chain Planning Organizations

Supply Chain Planning Subinventories

Supply Chain Planning Suppliers

Supply Chain Planning Approved Supplier List

Supply Chain Planning Interlocation Shipping
Methods

Supply Chain Planning Currencies

Supply Chain Planning Units of Measure

XLSM File Name

ScpltemIimportTemplate.xlsm

ScpltemCostimportTemplate.xlsm

ScpltemSubstitutelmportTemplate.xlsm

ScpCataloglmportTemplate.xlsm.xlsm

ScpBillofMateriallmportTemplate.xlsm

ScpBillOfResourcesimportTemplate.xlsm

ScpPlannersimportTemplate.xIlsm

ScpCustomerlmportTemplate.xlsm

ScpRegionsimportTemplate.xIlsm

ScpZonesimportTemplate.xlsm

ScpRegionZoneMappinglmportTemplate.xlsm

ScplLocationsimportTemplate.xlsm

ScpOrganizationimportTemplate.xIlsm

ScpSublnventorylmportTemplate.xlsm

ScpSupplierimportTemplate.xlsm

ScpApprovedSupplierListimportTemplate.xlsm

ScplinterLocationShipMethodsimportTemplate.xlsm

ScpCurrencylmportTemplate.xlsm

ScpUOMImportTemplate.xIlsm
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Collection Entities

Calendars, Calendar Exceptions, Shifts, Shift
Workday Pattern, Week Start Dates, and Period
Start Dates

Calendar Associations

Demand Classes

Carrier, Ship Mode of Transport, and Ship Class
of Service

GOP Allocation Rules and Rule Assignments

GOP ATP Rules and Rule Assignments

GOP Supply Update Rules

Order Orchestration Reference Objects: Freight
Terms, FOB Points, Invoicing and Accounting
Rules, Shipment Priorities, Payment Terms,
Return Reason, Tax Classification Code, Tax
Exemption Reason, Sales Credit Type, Activity
Type, Document Categories, Payment Methods,
and Receipt Methods

Cross Reference Mapping Information

Measures

Booking History

Option Booking History

Shipment History

Option Shipment History

ORACLE
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Supply Chain Planning Calendars

Supply Chain Planning Calendar Assignments

Supply Chain Planning Demand Classes

Supply Chain Planning Carriers

Supply Chain Planning Planning Allocation
Rules

Supply Chain Planning Available-to-Promise
Rules

Supply Chain Planning Real Time Supply
Updates

Supply Chain Planning Order Orchestration

Supply Chain Planning Cross-Reference Data

Supply Chain Planning Measures

Supply Chain Planning Bookings History

Supply Chain Planning Option Bookings History

Supply Chain Planning Shipments History

Supply Chain Planning Option Shipments
History

Chapter 3
Planning Data Collections

XLSM File Name

ScpCalendarimportTemplate.xlsm

ScpCalendarAssignmentsimportTemplate.xlsm

ScpDemandClassimportTemplate.xlsm

ScpCarrierlmportTemplate.xlsm

ScpPlanningAllocationRulesimportTemplate.xlsm

ScpATPRulesimportTemplate.xlsm

ScpRealTimeSupplyUpdatesimportTemplate.xlsm

ScpOrderOrchestrationimportTemplate.xlsm

ScpCrossReferenceDatalmportTemplate.xIsm

ScpMeasuresimportTemplate.xlsm

Note:

You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.

ScpBookingHistorylmportTemplate.xlsm

ScpOptionBookingHistorylmportTemplate.xlsm

ScpShipmentHistorylmportTemplate.xlsm

ScpOptionShipmentHistorylmportTemplate.xlsm
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Collection Entities

Price Lists

Causal Factors

Forecast Measures

Fiscal Calendars

Measures, Sales and Operations Planning
Backlog, Inventory, and Production History

User-Defined Hierarchies

Forecasts

Sales Orders

Safety Stock Levels

Supply Reservations to Sales Orders

On Hand

Purchase Orders, Purchase Requisitions, PO in
Receiving, In Transits

Transfer Orders (including expense type
transfers)

ORACLE
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Supply Chain Planning Price Lists

Supply Chain Planning Causal Factors

Supply Chain Planning Forecast Measures

Supply Chain Planning Fiscal Calendars

Supply Chain Planning Measures

Supply Chain Planning User-Defined
Hierarchies

Supply Chain Planning External Forecasts

Supply Chain Planning Sales Orders

Supply Chain Planning Safety Stock Levels

Supply Chain Planning Reservations

Supply Chain Planning Supply On Hand

Supply Chain Planning Purchase Order
Requisitions

Supply Chain Planning Transfer Orders
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XLSM File Name

ScpPriceListimportTemplate.xlsm

ScpCausalFactorsimportTemplate.xlsm

ScpForecastMeasurelmportTemplate.xlsm

Note:

This template has been superseded

by the generic template
ScpMeasuresimportTemplate.xlsm, but
will continue to be supported. Future
enhancements will be made only to the
generic measures template.

ScpFiscalCalendarlmportTemplate.xlsm

ScpMeasuresimportTemplate.xlsm

Note:

You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.

ScpUser-DefinedHierarchylmportTemplate.xlsm

ScpExternalForecastimportTemplate.xIsm

ScpSalesOrderlmportTemplate.xlsm

ScpSafetyStockLevellmportTemplate.xlsm

ScpReservationlmportTemplate.xlsm

ScpOnhandimportTemplate.xlsm

ScpPurchaseOrderRequisitionimportTemplate.xlsm

ScpTransferOrderlmportTemplate.xlsm
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Collection Entities

Supplier Capacity

Resources, Resource Shifts

Resource Availability

Work Definition (including mapping between
Item Structures and Work Definitions), Work
Definition Operations, Work Definition
Operation Resources

Work Order Supply

Work Order Material Requirements

Work Order Resource Requirements

Planned Order Supplies

Sourcing Rule and Assignments

Key Customer Options

Related Topics

Link in FBDI Guide

Supply Chain Planning Approved Supplier
Capacity

Supply Chain Planning Resources

Supply Chain Planning Resource Availability

Supply Chain Planning Routings

Supply Chain Planning Work Order Supplies

Supply Chain Planning Work Order Component
Demands

Supply Chain Planning Work Order Operation
Resources

Supply Chain Planning Planned Order Supply

Supply Chain Planning Sourcing Rules

Supply Chain Planning Key Customer Options

« Run the Load Planning Data from Files Process

Chapter 3
Planning Data Collections

XLSM File Name

ScpApprovedSupplierCapacitylmportTemplate.xlsm

ScpResourcelmportTemplate.xlsm

ScpResourceAvailabilitylmportTemplate.xlsm

ScpRoutingsimportTemplate.xlsm

ScpWorkOrderSuppliesimportTemplate.xlsm

ScpWIPComponentDemandsimportTemplate.xlsm

ScpWIPOperationResourcelmportTemplate.xIsm

ScpPlannedOrderSupplylmportTemplate.xlsm

Note:
This template is only used to load planned
order supply to Global Order Promising.

ScpSourcinglmportTemplate.xlsm

ScpKeyCustomerOptionsimportTemplate.xlsm

Run the Load Planning Data from Files Process

To load planning data from files, first you must prepare the data you want to load.

ORACLE
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To prepare the data, download the relevant XLSM template, update the XLSM template with required data, and create
the necessary CSV files for upload. This procedure explains how to load planning data from files after you have
prepared the data and created CSV files.

1. From the Navigator, use the File Import and Export page to upload the previously prepared and zipped CSV
files to the Universal Content Manager. Use the account scm/planningDatalLoader/Import to upload the zipped
file.

Note: For more information about uploading files to the Universal Content Manager server, see the following
section in the Implementing Common Features for SCM guide: External Integration chapter, External Data
Integration Services for Oracle Cloud section.

2. From one of the Supply Chain Planning work areas or Setup and Maintenance work area, Supply Chain
Planning offering, select the Load Planning Data from Files task.

3. Complete the following parameters on the Load Planning Data from Files page:

a. Select the source system.
b. Select Collection Type: Net change or Target.
c. Select the .zip file you previously imported into the Universal Content Manager.
4. Click Submit. Make a note of the process ID. You will need this process ID to review the status of the process.

Related Topics
» Create CSV Files to Load Planning Data

Load Planning Data from Files for a Selected Group of
Organizations

When you load planning data from files with the collection type set to Targeted, you can enable organization group
collection and then select an organization group.

Data is collected for only the organizations in the organization group, and the purge of data prior to the load of the
new data is also done for only the organizations in the organization group. In other words, previously collected data
for organizations that aren't included in the organization group will be retained when you're doing targeted collections
using the file-based data import (FBDI) process.

Note: Enabling organization group collection isn't applicable to entities for demand management, such as history,
measure, and price list.

Parameters for Load Planning Data from Files
The parameters for the Load Planning Data from Files task:

- Source System: The source system for the data determines which organization groups are applicable.
- Collection Type: You must select the Targeted collection type to enable organization group collection.
Data File: The file previously uploaded to the universal content manager.

Enable Organization Group Collection: You must have selected Targeted for the collection type to select Yes for
this parameter.
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- Organization Group: You must have selected Yes for the Enable Organization Group Collection parameter to
select an organization group.

Organization Groups
The list of organization groups you can select from for the Organization Group parameter is determined by:

- Which source system you select for the Source System parameter

- What organization groups are set up for that source system

Organization groups are set up using the Maintain Supply Network Model task, Manage Organization Groups dialog.
On the Maintain Supply Network Model page, Organizations tab, you click the Manage Organization Groups button to
create or manage organization groups.

Example

Here's an example that shows how data is retained for organizations in other organization groups when you load
planning data for a selected organization group.

For this example, let's say you have 3 organizations and 2 organization groups, and the source for your data is the EX1
source system.

- Organization group OG1includes organization M1
- Organization group OG2 includes organizations B1 and B2

First you load planning data for the OG1 organization group for the Work Order Supplies entity. 2 rows of data are
collected for the OG1 organization group.

Item Organization Order Type Order Quantity Suggested Due Date
ltem 1 EX1:M1 Work order 10 2/14/22
Item 2 EX1:M1 Work order 15 2/11/22

Then you load planning data for the OG2 organization group for the Work Order Supplies entity.

- 3 rows of data are collected for the OG2 organization group

- The 2 rows that were previously collected for the OG1 collection group are retained

Item Organization Order Type Order Quantity Suggested Due Date
ltem 1 EX1:M1 Work order 10 2/14/22

ltem 2 EX1:M1 Work order 15 2/11/22

ltem 1 EX1:B1 Work order 1 2/09/22

ltem 1 EX1:B2 Work order 16 1/31/22
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Item Organization Order Type Order Quantity Suggested Due Date
ltem 2 EX1:B2 Work order 10 2/09/22

Applicable Entities

You can use file-based data import (FBDI) to load data for a selected group of organizations using the Targeted
collection type for these entities:
Source Entities

From an Oracle Fusion Cloud SCM source External Forecasts

«  Planned Order Supply
- Safety Stock Levels

From an Oracle Fusion Cloud SCM source - OnHand
only when the Enable External Data option
has been enabled for the entities in the

Manage Planning Source System task - Purchase Orders and Purchase Requisitions

- Transfer Orders

- Sales Order and Associated Reservations
- Work Order Component Demands

- Work Order Supplies, Work Order By-Product and Co-Product Supplies, Work Order Operation
Resources

- Resource Availability

From an external source - External Forecasts
- Movement Requests
- Planned Order Supply
« Purchase Orders and Purchase Requisitions
« Reservations
- Safety Stock Levels
- Sales Orders
- Transfer Orders
- OnHand
- Work Order Component Demands

- Work Order Supplies, Work Order By-Product and Co-Product Supplies, Work Order Operation
Resources

« Resource Availability

Loading data for a selected group of organization isn't applicable to:

- Entities for demand management, such as History, Measures, Price Lists

- Entities categorized as reference entities
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Additional Details

Here are a few more details to know about loading planning data from files for a selected group of organizations:

If you have included the History, Measure, or Price List entities in a data file used during a targeted collection
with organization group collection enabled, targeted collections will be done for these entities, but will be done
for all organizations, not for only the organizations in the group.

If you have included reference data entities in a data file used during a targeted collection with organization
group collection enabled, these entities will be ignored during collections.

Data security created and enabled at organization level for any role isn't applied to the Manage Organization
Groups task.

If you also use the Collect Planning Data task to collect some of your data, note that you can use organization
groups for the Net Change collection type, but not for the Targeted collection type. For the Targeted collection
type for the Collect Planning Data task, you use the Organizations Filter for Transaction Data filter instead.

- You can submit the Load Planning Data from Flat Files process multiple times to specify a different organization
group for each submission. The submissions are processed serially in the order of submission.

- You can specify an organization group when you submit the Load Planning Data from Flat Files process for the
Targeted collection type from the Scheduled Processes work area or when using a scheduled process job set.

- You can specify an organization group when you submit the Load Planning Data from Flat Files process for the
Targeted collection type from the Enterprise Resource Planning integration service.

Improve Performance of Measure Disaggregation

Overview of Improving Performance While Disaggregating Measure Data

While importing data at an aggregate level to stored measures for Oracle Fusion Cloud Supply Chain Planning, you can
improve the performance by enabling multithreading for the disaggregation process.

While using the file-based data import (FBDI) template named Supply Chain Planning Measures, you can import data at
the stored levels or aggregate levels of the stored levels. For example, if your measure is configured with the dimension
levels of Item, Organization, Sales Rep, Customer Site, Demand Class, and Day, you can import data at these stored
levels or aggregate levels, such as product category, business unit, sales organization level, customer, demand class,
and month.

Measure data that's collected at an aggregate level is disaggregated to the stored levels during the data refresh step in a
plan run or when you incrementally refresh a plan after loading new measure data.

By default, the process for disaggregating the measure data is single-threaded. Consequently, long processing times
can result when there's a large volume of measure data to disaggregate.

To improve performance, you can configure disaggregation to run as a multithreaded process. The disaggregation
process runs in parallel for different time ranges within the time range for the collected measure data.

The multithreaded process runs in 90-day increments by default. For example, if you've collected measure data at an
aggregate level for the past year (365 days), then the process runs five disaggregation jobs in parallel, four jobs of 90
days each and one job for the remaining five days of data.
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You can do the following:

Enable multithreading for measure data disaggregation for all plans in the Demand Management, Demand and
Supply Planning, Planning Central, Replenishment Planning, Sales and Operations Planning, or Supply Planning
work area.

Enable multithreading for measure data disaggregation for a single plan that's enabled for demand forecasting.

- Override the default of 90 days for the multithreaded process.

Related Topics
« Enable Multithreading for Measure Data Disaggregation for All Plans
- Enable Multithreading for Measure Data Disaggregation for a Single Plan

« Override the Default Value for the Multithreaded Process

Enable Multithreading for Measure Data Disaggregation for All Plans

You can enable multithreading for measure data disaggregation for all demand, demand and supply, replenishment,
sales and operations, or supply plans.

Before you start
You may need to work with someone who has administration privileges to make these profile-related changes.

Here's what to do

1. In the Demand Management, Demand and Supply Planning, Plan Inputs, Planning Central, Replenishment Planning,
Sales and Operations Planning, or Supply Planning work area, on the Tasks panel tab, under Configuration, select
Manage Planning Profile Options.

The Manage Planning Profile Options page opens.

2. Search for the SCP_PARAMETER_OVERRIDES profile option code.

3. If the SCP_PARAMETER_OVERRIDES profile option code exists, then click the New icon.
A new row appears for the profile value.

4. Add the profile value as follows:

o Profile Level: Select Site to set the value globally for all users. Select User to set the value for a specific user,
in which case you must then select a user. User-level values take precedence over the site-level value.

o Profile Value: Enter enableParallelDisaggMeasure=true.

Note: You can enter multiple profile values for a profile level provided you separate them with the space
or semicolon. Whether you can select the site or user depends on the enabled levels in the profile option.

5. Click Save and Close.
6. If the SCP_PARAMETER_OVERRIDES profile option code doesn't exist, then follow these steps:
a. Inthe Setup and Maintenance work area, go to the Manage Profile Options task.
The Manage Profile Options page opens.
b. Click New.
The Create Profile Option page opens.
c. Create the profile option as follows:
Profile Option Code: SCP_PARAMETER_OVERRIDES
Profile Display Name: SCP_PARAMETER_OVERRIDES
Application: Planning Common
Module: Planning Common
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- Start Date: Current date
Leave the remaining fields blank.

7. Click Save and Close.

8. For the profile option levels for the profile option, select the check boxes under the Enabled and Updatable columns
for both the Site and User levels.

9. Click Save and Close.

10.In your work area, open the Manage Planning Profile Options page.
11. Search for the SCP_PARAMETER_OVERRIDES profile option code.
12. Set the profile level and value as previously explained.

13. Click Save and Close.

Related Topics
» Overview of Improving Performance While Disaggregating Measure Data

- Enable Multithreading for Measure Data Disaggregation for a Single Plan
 Override the Default Value for the Multithreaded Process

Enable Multithreading for Measure Data Disaggregation for a Single Plan

You can enable multithreading for measure data disaggregation for a single, forecast-enabled plan in the Demand
Management, Demand and Supply Planning, Planning Central, Replenishment Planning, or Sales and Operations
Planning work area.

1. In your work area, open the Plan Options page for your forecast-enabled plan.
2. Onthe Demand tab, click Select Advanced Options.
The Demand: Advanced Options dialog box opens.
3. In Forecasting Control Parameters, in Parameter Overrides, enter enableParallelDisaggMeasure=true.

Note: You can enter multiple values in the Parameter Overrides field provided you separate them with the
number sign (#).

H

. Click Done.
. Save your plan.

wn

Related Topics
» Overview of Improving Performance While Disaggregating Measure Data

- Enable Multithreading for Measure Data Disaggregation for All Plans
 Override the Default Value for the Multithreaded Process

Override the Default Value for the Multithreaded Process

After you've enabled multithreading for the measure disaggregation process for all plans in your work area or a single,
forecast-enabled plan, you can override the default value of 90 days for the process.

Before you start
You may need to work with someone who has administration privileges to make these profile-related changes.

Here's what to do
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1. In the Setup and Maintenance work area, go to the Manage Profile Options task.
The Manage Profile Options page opens.
2. Click New.
The Create Profile Option page opens.
3. Create a profile option as follows:
o Profile Option Code: MSC_DISAGG_PERF_BATCH_SIZE

o Profile Display Name: MSC_DISAGG_PERF_BATCH_SIZE
o Application: Planning Common
o Module: Planning Common
o Start Date: Current date
Leave the remaining fields blank.

4. Click Save and Close.

5. For the profile option levels for the profile option, select the check boxes under the Enabled and Updatable columns
for both the Site and User levels.

6. Click Save and Close.

7. In the Demand Management, Demand and Supply Planning, Plan Inputs, Planning Central, Replenishment Planning,
Sales and Operations Planning or Supply Planning work area, on the Tasks panel tab, in Configuration, select
Manage Planning Profile Options.

The Manage Planning Profile Options page appears.
8. Search for the MSC_DISAGG_PERF_BATCH_SIZE profile option code.
9. Click the New icon.

A new row appears for the profile value.
10. Add the profile value as follows:

o Profile Level: Select Site to set the value globally for all users. Select User to set the value for a specific user,
in which case you must then select a user. User-level values take precedence over the site-level value.

o Profile Value: Enter the number of days for processing in each parallel job.
11. Click Save and Close.

Related Topics
» Overview of Improving Performance While Disaggregating Measure Data

- Enable Multithreading for Measure Data Disaggregation for All Plans
- Enable Multithreading for Measure Data Disaggregation for a Single Plan

Collections for Oracle Replenishment Planning

This topic explains how collections are done for Oracle Replenishment Planning.

Collections are done at the organization level.

Collections are also done for all subinventories of organizations that are marked for subinventory-level planning on the
Organizations tab on the Maintain Supply Network Model page.
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Collected Business Objects That Are Relevant for Replenishment Planning

This table lists the collected business objects that are relevant for replenishment planning:

Oracle Fusion Cloud Applications

Oracle Fusion Cloud Procurement
and Oracle Fusion Cloud Inventory
Management

Oracle Fusion Cloud Product Lifecycle
Management

Oracle Cost Management, Oracle Order
Management, and others

Related Topics

Business Object

Purchase orders and requisitions

Suppliers

Approved supplier lists
Units of measure (UOMs)
Transfer orders

Shipping methods
Subinventories

On-hand inventory

Items
Organizations

Catalogs

Item costs

Currencies

Calendars and fiscal calendars
Sales orders

Bookings history

Shipments history

Transfer order history

Price lists

» How You Maintain Your Supply Network Model

» How You Set Up Replenishment Planning for Subinventories

Collection of Consumption Data for Oracle

Replenishment Planning

This topic discusses the collection of consumption inventory transactions or point-of-sale (POS) data from Oracle
Fusion Inventory Management for the generation of consumption-based forecasts in Oracle Replenishment Planning.

ORACLE

85


https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20074545

Oracle Fusion Cloud SCM Chapter 3
Using Sales and Operations Planning Planning Data Collections

To generate consumption-based forecasts for your replenishment plan, make these selections on the Collect Planning
Data page:

- On the Parameters tab, for the Targeted collection type, under History Data Options on the Demand Planning
Data tab, in Organization - Consumption Inventory Transactions to Include, select the types of consumption
inventory transactions you want to collect at the organization level. If you select Transfer orders, historical
transfer orders at the organization level are collected. If you select All, all historical consumption inventory
transactions at the organization level are collected.

- In Subinventory - Consumption Inventory Transactions to Include, select the types of consumption
inventory transactions you want to collect at the subinventory level. If you select Transfer orders, both
historical transfer orders and historical movement requests at the subinventory level are collected. If you select
All, all historical consumption inventory transactions at the subinventory level are collected.

Consumption-based forecasting provides you with these benefits:

- You can improve the effectiveness of your forecast by basing it on demand signals that are closest to your
customers.

Thereby, you can effectively compute your policy parameters and calculate and release your replenishment
orders.

- Inthe retail and healthcare sectors, you can model stores and departments as subinventories. By collecting
consumption inventory transactions at the subinventory level, you can generate forecasts at this level.

Historical Transaction Collections for Consumption-Based Forecasting at
the Organization Level

When you select All in the Organization - Consumption Inventory Transactions to Include field, all historical
transactions are collected at the organization level from Inventory Management for consumption-based forecasting
except for those listed in this table:

Transaction Action Transaction Source Transaction Type

Issue from stores Purchase Order Return to Supplier

Issue from stores Sales Order Sales Order Issue

Issue from stores Transfer Order Return Transfer Order Return with Scrap

Item Transaction Collections for Consumption-Based Forecasting at the
Subinventory Level

When you select All in the Subinventory - Consumption Inventory Transactions to Include field, all item transactions
are collected at the subinventory level from Inventory Management for consumption-based forecasting except for those
listed in this table:

Transaction Action Transaction Source Transaction Type

Direct organization transfer Transfer Order Return Transfer Order Return Transfer
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Transaction Action Transaction Source Transaction Type
Intransit shipment Transfer Order Return Transfer Order Return Shipment
Issue from stores Purchase Order Return to Supplier
Issue from stores Transfer Order Return Transfer Order Return with Scrap
Staging transfer Transfer Order Return Transfer Order Return Pick

Difference Between Consumption History and Shipments History

While shipments history includes the history for shipped sales orders, consumption history includes the shipments
history as well as the consumption-related history that falls under transaction actions such as Issue from stores.

Measures for Storing Collected or Uploaded Consumption Data

If you're collecting consumption data from Inventory Management, the collected data is stored in the measure that you
select in the Shipments History Measures field under History Measures and Attributes on the Demand Planning Data
tab.

If you're uploading consumption data from an external source, use the file-based data import (FBDI) template named
Supply Chain Planning Measures (ScpMeasuresimportTemplate.xlsm) to import consumption data into the predefined
Consumption History measure.

In the import template, enter #ignore under the Customer Level Name and Demand Class Level Name columns if you
don't want to specify these levels. Don't enter values in the columns for level member names.

ERP Integrations REST Service

Use of ERP Integrations REST Service in Collections

You can upload all reference and transactional data to Oracle Fusion Cloud Supply Chain Planning from an external
source using the ERP Integrations REST service. This external source can be data from Oracle E-Business Suite, Oracle
Fusion Cloud Applications, or third-party source. In Collections, this REST service is used to upload data and submit the
collection job set.

Overview

This service updates all key changes in supply chain operations like unexpected changes in inventory levels or
manufacturing capacities in your application in real-time. Hence when compared to the system that relies on batch
integration and synchronizes data only on periodic basis, this system provides accurate results.
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Note: To upload data for Oracle Supply Chain Planning products, use of ERP Integrations REST service is preferred
over use of ERP Integrations SOAP Service.

ERP Integrations REST Service

The ERP Integrations REST service that is available as part of Oracle Fusion Cloud Financials is used with Oracle Fusion
Cloud Supply Chain Planning products to import bulk data, upload files to UCM server, and to load planning data from
flat files. The REST resource name is ERP Integrations and it supports multiple POST operations.

This topic provides specific guidelines on how to use these REST operations with Oracle Supply Chain Planning
products. For the Oracle Financials documentation regarding the ERP Integrations REST service, refer to the REST API
for Oracle Fusion Cloud Financials book, ERP Integrations task, in Oracle Help Center.

Import Bulk Data

The ERP Integration Service importBulkData is the main REST operation that’s used to import data for Oracle Supply
Chain Planning. This is a multistep operation that invokes the following subprocesses to complete the data load:

1. Upload file content to UCM Server

2. Loads data into Planning staging tables

3. Launches Load Planning Data from Files scheduled process
4. Launches the Collect Planning Data Job Set

This operation is completed in a single API call and also handles encrypted data files and decrypts them as part of
upload.

Here are the specific parameters that are used in the importBulkData REST operation.

- JobName: For Oracle Supply Chain Planning data loads, this parameter must be specified as
JobName: /oracle/apps/ess/scm/advancedPlanning/collection/configuration/CSVController

- Parameter List: This parameter contains a comma separated list of the parameter values. This is used by the
Load Planning Data from Files scheduled process that is launched as part of this REST service operation. Here
are the parameters that are used in the parameter list.

Parameters

Scheduled Process Internal Maps to the displayed Expected Value Parameter Details

Parameter parameter of this process

Parameter 1 Source System Source System Source system code of the
source system for which the
data is being uploaded. This
code is specified during the set
up of the source system

Parameter 2 Collection Type Tor2 Type of collections to be

launched. Valid values are:

o 1denotes Targeted
Collection type
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Parameter 9
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Maps to the displayed
parameter of this process

Data File

Not displayed

Not displayed

Not displayed

Not displayed

Not displayed

Organization Group

Expected Value

Zip File name

Not used

Document ID (DId) Value

Instance ID

Apps Version

Not used

Organization Group

Chapter 3
Planning Data Collections

Parameter Details

o 2denotes Net change
Collection type

Name of the zip file to be
uploaded.

Specify as #NULL.

Document ID of the zip file to be
uploaded to UCM.

Optional when using
importBulkData operation but
mandatory when using the
submitEssJobRequest operation.

Internal ID of the source
system specified in Parameter
1 (instance code). This is stored
internally as MSC_APPS_
INSTANCES.INSTANCE_ID

and can be derived using the
following SQL query:

SELECT instance_id FROM
msc_apps_instances
WHERE instance_code =
'<instance code>'

Internal value of the version of
the source system specified in
Parameter 1 (instance code).
This is stored internally as MSC_
APPS_INSTANCES.APPS_VER
and can be derived using the
following SQL query:

SELECT apps_ver FROM
msc_apps_instances
WHERE instance_code =
'<instance code>'

Specify as #NULL.

This is optional. It is required
only if the user wants to

run collections for a specific
organization group. The value
is the name of the organization
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Scheduled Process Internal Maps to the displayed Expected Value Parameter Details
Parameter parameter of this process

group. If not specifying, use
#NULL.

Parameters File

You must include the special parameters file Supply Chain Planning ERP Integration Service Parameters that’s generated
using the ScpErpintegrationServiceParamsimportTemplate.xlsm template file when using ERP Integrations REST service
with Oracle Supply Chain Planning products. This parameters file is the file that provides metadata that you need to
include in the zip file along with other CSV files to load data in the ERP Integrations Flow. This file contains the following
parameters:

- Source System Code (Parameter 1in the Parameters table)
- Collection Type (Parameter 9 in the Parameters table)
- Organization Group (Parameter 9 in the Parameters table)

If the input zip file does not contain ScpErplntegrationServiceParams.csy, then the mode of collections is defaulted to
Net change and the Load Planning Data from Flat Files schedule process reads the value of instance code from the
respective data files.

The ScpErplntegrationServiceParams.csv meta data file is required only when your loading data using the ERP
Integration importBulkData operation and isn’t required when you submit the Load Planning Data from Flat Files
process either from the Scheduled Processes page or using the submitEssJobRequest operation.

Note: Oracle Supply Chain Planning data loads using importBulkData operation don’t need any other properties files
like jobDetails.properties that are required for other product areas.

Upload File to UCM

The uploadfiletoUCM operation uploads a file to the UCM server in a single step based on the document specified in the
REST operation.

Here is the parameter that is used to complete the operation.
DocumentAccount: For Oracle Supply Chain Planning data loads, this parameter must be specified as

DocumentAccount": "scm$/planningDataloader$/import$

The REST response includes the Documentld as one of the data elements.

Load Planning Data from Flat Files
The submitEssJobRequest operation is used to load planning data from flat files. It submits the collections job set with a
set of parameters in a single step.

When loading data for Oracle Supply Chain Planning products, use the following parameters and respective guidelines
to complete the operation.

- JobPackageName: This parameter must be specified as
JobPackageName:oracle/apps/ess/scm/advancedPlanning/collection/configuration
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- JobDefName: This parameter must be specified as
JobDefName: CSVController

Documentld: Use the document ID from the response of uploadFileToUCM operation.

ESSParameters: This parameter must include a list of values as indicated for the Parameter List parameter of
importBulkData operation. For example,
ESSParameters:EX8,2,UOM.zip,#NULL,289568,300100110961358,3,#NULL,#NULL

The REST response includes the Rgstld as one of the data elements. This data element is the process ID of the
submitted scheduled process which in this case is the Load Planning Data from Files process. This process is completed
only after total flow including Collect Planning Data job set is launched and completed.

For other Oracle Supply Chain Planning processes, like the Publish Data and Release Plan processes, the recommended
approach is to use the respective REST services under Oracle Supply Chain Planning group and not use the
submitEssJobRequest operation. For example:

For Publish Data — use Supply Chain Planning/Supply Chain Plans/Publish Data
For Release Plan — use Supply Chain Planning/Supply Chain Plans/Releases
For Archive Plan — use Supply Chain Planning/Supply Chain Plans/Archives

Note: loadAndimportData operation isn't recommended for use with Oracle Supply Chain Planning products because
with this operation you can’t upload encrypted data files.

Verify Collection Processes

Verify the Load Planning Data from Files Process

Perform the following steps to verify the process status of the uploaded file and review log file for any errors or
warnings.

1. In the Navigator, click Scheduled Processes.

2. Inthe search area, enter the process ID you noted when you submitted during the Load Planning Data from
Files process. Click Search.

3. Monitor the process to verify completion.
If the process completes with warnings, select the request that shows the warning status and click the View
Log button to review the details.

4. For the rows with errors, resolve the issues found in the log file, and then upload the CSV file again. To load only
the revised rows, use the Net Change option.

Review Data in the Planning Data Repository

You can review the data collected or loaded into the planning data repository using two different options. The option
you use depends on which data collection entities you want to review.
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To review the data collected or loaded into the planning data repository, use one of the following options:
Review data using the Plan Inputs page layout
Review data using the Maintain Supply Network Model page
To review the following entities, use the Maintain Supply Network Model page:
- Organizations
« Customers
- Suppliers
- Carriers
Interlocation Shipping Networks

To review data that's not part of the supply network model, use the Plan Inputs page layout. You can view the following
data in the Plan Inputs page layout

- Supply data
Demand data

You can view Carriers and Suppliers using either option.
Review Data Using the Plan Inputs Page Layout
Perform the following steps to review the planning data that you loaded.

1. In the Navigator, click Plan Inputs.
2. From the Plans menu, right-click Plan Inputs, and click Open.
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Tip: You can set the preview pane to Full Pane for viewing your data in full pane. Click Change and select
Full Pane.

3. On the Plan Inputs page, click Open, and click Full Pane.

4. Onthe Open Table, Graph, or Tile Set page, search for the table name.
5. Enter the criteria for the data you want to verify and click Search.

6. Review the data in the Search Results table.

Review Data Using the Maintain Supply Network Model Page

Perform the following steps to review the planning data using the Maintain Supply Network Model page.

1. In the Navigator, click Plan Inputs.
2. From the Tasks menu, click Maintain Supply Network Model.
3. Enter the criteria for the data you want to verify and click Search.
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4. Review the data in the Search Results table.

Purge Data

How You Purge Collected Data from the Data Repository for
Supply Chain Planning

Use the Purge Data Repository scheduled process to purge data collected by supply chain planning collections
processes into the database tables that comprise the planning data repository.

Delete data from these tables to free up space and improve performance. Use the Scheduled Processes work area
to run the scheduled process. This topic explains the parameters of the Purge Data Repository scheduled process.
For information on how to run scheduled processes, refer to the Scheduled Processes chapter in the Implementing
Common Features for SCM guide.

The parameters for the Purge Data Repository scheduled process are in one of these categories:
- The Source System and Purge Global Entities parameters
Parameters on the Reference Data tab
Parameters on the Demand Planning Data tab

Parameters on the Supply Planning Data tab

The Source System and Purge Global Entities Parameters

Provide values for these parameters to determine which data records for reference data will be purged from the staging
tables when you run the Purge Data Repository scheduled process.

Parameter Notes

Source System You must select a source system.

- For data collected from the Oracle Fusion source system, select OPS.

- For data collected from an external system, select the applicable source system code.

Purge Global Entities You can select Yes if you want to delete data for the entities for which the planning data repository
stores only one record for each instance of the global entity so there's no reference to a source system.
The default is No.

Parameters on the Reference Data Tab

Provide values for these parameters on the Reference Data tab to determine which data records for reference data will
be purged from the staging tables when you run the Purge Data Repository scheduled process.
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Parameter Notes

The set of entities categorized as reference  You select which reference entities you want data deleted for. The entities you select are included in
entities. The entities you haven't selected = the Selected Entities list on the Reference Data tab.

yet are included in the Reference Entities

list on the Reference Data tab.

Parameters on the Demand Planning Data Tab

Provide values for these parameters on the Demand Planning Data tab to determine which data records for demand
planning data will be purged from the staging tables when you run the Purge Data Repository scheduled process.

Parameter Notes

The set of entities categorized as reference  You select which demand entities you want data deleted for. The entities you select are included in the
entities. The entries you haven't selected = Selected Entities list on the Demand Planning Data tab.

yet are included in the Demand Entities list

on the Demand Planning Data tab.

Limit the Days to Purge You can choose to limit the number of days to purge by selecting one of three choices. For each choice
you must also specify the additional details needed for that choice:
- By date range, followed by a from date and a to date
- By number of days in the future, followed by a number of most recent days to keep

- By number of days in the past, followed by either a number of most recent days to keep or a
number of oldest days to purge

Parameters on the Supply Planning Data Tab

Provide values for these parameters on the Supply Planning Data tab to determine which data records for supply data
will be purged from the staging tables when you run the Purge Data Repository scheduled process.

Parameter Notes

The set of entities categorized as supply You select which supply entities you want data deleted for. The entities you select are included in the
entities. The entities you haven't selected = Selected Entities list on the Supply Planning Data tab.

yet are included in the Supply Entities list

on the Supply Planning Data tab.

How You Purge Staging Tables for Supply Chain Planning

Use the Purge Staging Tables scheduled process to delete data from the staging tables used during collections
processes for supply chain planning.

Delete data from the staging tables to free up space and improve performance. Use the Scheduled Processes work
area to run the scheduled process. This topic explains the parameters of the Purge Staging Tables scheduled process.
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For information on how to run scheduled processes, refer to the Scheduled Processes chapter in the Implementing

Common Features for SCM guide.

Provide values for these parameters to determine which data records will be purged from the staging tables when you
run the Purge Staging Tables scheduled process.

Parameter

Source System

Record Type

Collection Cycle ID

Collected From Date

and

Collected To Date

The set of specific entities for which data is

collected and deletion of the data from the
staging tables is supported.

ORACLE

Notes

You must select a source system.

- For data collected from the Oracle Fusion source system, select OPS.

- For data collected from an external system, select the applicable source system code.

You must select a record type, but you can select All if you want to purge all records that meet the
values of the other parameters, regardless of their record type. The record types other than the All type
are the status of records in the staging tables in regard to the next stage of the collections process. The
next stage of the collections process is the import of the records that are in the staging tables into the
tables that comprise the planning data repository.

- All: All records regardless of status.

- Complete: Records that were successfully imported into the tables that comprise the planning
data repository.

- Error: Records that are in the Error status in the staging tables after import into the planning data
repository was tried, but not successful.

- New: Records that were collected into the staging tables, but import into the planning data
repository hasn't been tried yet.

- Retry: Records in the staging tables for which import into the planning data repository is being
tried again.

- Warning: Records in the staging tables for which a warning occurred when the record was
imported into the planning data repository.

You can enter a request number if you want to do so.

You can provide these dates if you want to purge data within a specific time frame.

Each entity is a parameter for the scheduled process. You can select No for any of the parameters if
you don't want to purge the data for that entity. The default value for each parameter is Yes.
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Aggregate Customer Data

How You Aggregate Customer Data

Use the key customer data options collections template to identify key customers.

The data for these customers will be visible. For each Zone, all non-key customers' data will be aggregated to a member
named All Other. By aggregating the planning data for non-key customers, you can focus your analysis on the key
customers. You use the Supply Chain Planning Key Customer Options (ScpKeyCustomerOptionsimportTemplate.xlsm)
import template to identify the key customers; the rest of the customers' data will be aggregated under an All Other
member.

The data that are not identified in the upload template are aggregated to an all other member for each zone. You can
view the key customers and the All Other member containing the aggregated non-key customer data when you analyze
the forecasts and other data.

Identifying key customers and aggregating non-key customer data helps you to do the following:
- Organize key customer data that are required for planning
- Save time by collecting only the required data from Oracle Fusion Cloud Supply Chain Management

Build a plan specifically for your key customers

Related Topics
« Collection Filters and Collection Templates

How can | reset the key customer aggregated data for a plan?

After you make changes to the aggregation level values in the ScpKeyCustomerOptionsimportTemplate.xIsm file, you
must upload the file and run the plan again.

To reset the key customer aggregated data for a plan, do the following:

1. Review the ScpKeyCustomerOptionsimportTemplate.xlsm file.

2. Update the Aggregation Level values for all of the Level Name values (for example, Customer) and upload the
CSV file.

3. From your Supply Chain Planning work area, open the plan and enable the Aggregate non-key customer data
to All Other level member check box. Run the plan again.

Related Topics
« Considerations for Collecting Key Customer Information
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Considerations for Collecting Key Customer Information

Use the ScpKeyCustomerOptionsimportTemplate.xIsm file to identify the key customers for which nonaggregated data
must be made available.

For non-key customers, the aggregation level that you define in the import template determines whether the data is
retained or aggregated. You can differentiate between key customers and non-key customers and use the aggregated
key customer data to build a plan specifically for your key customers.

Note: For details regarding the ScpKeyCustomerOptionsimportTemplate.xlsm file, refer to the File-Based Data Import
(FBDI) for SCM guide. This guide is one of the guides in the Oracle Help Center for Oracle Fusion Cloud Supply Chain
Management. Use the All Books link for a list of the guides by category, and look for the Development category.

In the ScpKeyCustomerOptionsimportTemplate.xlsm file template:

1. Define your key customers on the KeyCusOptnHeader tab. Enter the name of a valid customer hierarchy in the
Hierarchy Name column.

2. Next, enter the level of that hierarchy in the Level Name column. All customers in this level are identified as key
customers.

3. To have only certain customers identified as key customers, enter the specific customer names on the
KeyCusOptnMembers detail tab.

4. Set the aggregation level values for both key and non-key customers. Use the settings in the template to set the
data to different aggregation levels, such as 1, 2, or 3.

5. Upload the template.

lgnore Aggregate by Zone

There are two Customer hierarchies--Customer and Customer Zone--where the lowest level of each hierarchy is
Customer Site. If you don't have any key customers, leave the Hierarchy Name and Hierarchy Level columns blank on
the KeyCusOptnHeader tab. All customers not named in the template (non-key customers) are aggregated into an All
Other member for the hierarchy.

The upload also creates All Other Zone members for the non-key customers in the Customer Zone hierarchy. If you
don't want to aggregate by zone, enter #ignore_zone in the Hierarchy Name column in the KeyCusOptnHeader.csv and
leave the Level Name column blank.

Aggregation Levels

The aggregation levels are listed in the following table.

Aggregation Level Description

1 Retain all customer sites, and aggregate non-key customer sites. In addition to key customer data
being available, non-key customer data is retained for plans that require data that's not aggregated.
Aggregated customer data is available for plans that require aggregated non-key customer data.

2 Aggregate non-key customer sites. Customers that aren't identified as key customers are aggregated
to an All Other site by zone. However, if the Hierarchy Name and Level Name columns are blank, all
customers are identified as non-key customers and aggregated to an All Other site by zone. This
means that there are no key customers.
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Aggregation Level Description
3 No aggregation of customer sites. All data is available at customer site level.

To remove the key customer designation for previously-loaded customers, use Aggregation Level 3. This enables data
for all customers to be made available at the lowest level. No customers are marked as key customers.

If you select the aggregation level 3, the following happens:

No aggregation is done. All data is at the customer site level only.

If option 2 or 3 was used in previous collection runs, all non-key customer by zone members and data are
deleted.

Plans using the Key Customer feature become invalid and you have to run them again.

The KeyCusOptnMembers detail tab is optional. Use this tab to identify specific customers as key customers.

The Hierarchy Name and Level Name column entries must be the same as the information entered on the
KeyCusOptnHeader tab. Enter valid level member names in the Level Member Name column. These members are the
only customers that will be identified as key customers.

If the KeyCusOptnMembers detail tab is empty, all child members of the hierarchy level chosen in the Header
tab are flagged as key customers.

If the KeyCusOptnMembers detail tab isn't empty, only the listed members are identified as key customers.
The members must be children of the hierarchy level named on the Header tab.
When you create a plan, there is an option in the Plan Options dialog box that determines what level of customer
aggregation is used for the plan:

Key customer data is available and non-key customer data is aggregated to a level member named All Other.

No customer data is aggregated for the plan if the option is deselected.

Related Topics
« How can | reset the key customer aggregated data for a plan?

Load Aggregated Customer Data from Oracle E-Business Suite

This topic explains the procedure you follow to load aggregated customer data from an Oracle E-Business Suite source
system into your Oracle Fusion Cloud Supply Chain Planning destination system.

The procedure is composed of the following steps:

1. Extract data from your Oracle E-Business Suite source system.

2. Prepare the Supply Chain Planning Key Customer Options file if you have defined key customers in your Oracle
E-Business Suite source system.

3. Add the files to your desktop or local hard drive.
4. Import data into your Oracle Supply Chain Planning destination system.
Additional details for each step are provided in this topic.
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Prerequisites

To perform the process that extracts data from your Oracle E-Business Suite source system, you must be assigned a
configured, administrator-level role that’s similar to either the Advanced Planning Administrator role or the Advanced
Supply Chain Planner role.

Your source system must be set up as one of the Trading Community Source Systems for Oracle Supply Chain Planning.

You can perform the steps to import data into your Oracle Supply Chain Planning destination system from one of the
Supply Chain Planning work areas. You don't need an administrator role to perform these steps.

Extract Data

To extract the data from your Oracle E-Business Suite source system, run the Extract Data for Oracle Supply Chain
Planning process.

Consider the following conditions for the MSD_DEM_CUSTOMER attribute when you run the process:

If the MSD_DEM_CUSTOMER_ATTRIBUTE is set to null, then all sites are extracted.

If the MSD_DEM_CUSTOMER_ATTRIBUTE is set to none, then all records are aggregated to Default Customer
Site.

If the MSD_DEM_CUSTOMER_ATTRIBUTE is set to a valid customer attribute, then all sites are extracted.

The extracted data is stored in a file in the zipped file format in the middle tier of your source system.

Prepare the Key Customer Options File

If you have defined key customers in your Oracle E-Business Suite source system, then perform these steps to prepare
the Supply Chain Planning Key Customer Option file:

1. Download the template for file-based data loads for the Supply Chain Planning Key Customer Options object.
2. Add your data to the file.
3. Generate the CSV file.

For details on preparing files for loading planning data, refer to these help topics: Loading Planning Data from Files:
Overview and Creating CSV Files Used to Load Planning Data: Procedure.

Add the Files to Your Desktop or Local Hard Drive

Locate the extracted Zip file on your Oracle E-Business Suite middle tier, and download or transfer the file to your
desktop or local hard drive.

If you have defined key customers in the Oracle E-Business Suites source system, then include the Key Customer
Options file in the Zip file.

Import Data into Your Oracle Supply Chain Planning Destination System
To import the data into your Oracle Supply Chain Planning destination system, perform these steps:

1. From the Navigator, click File Import and Export.
2. On the File Import and Export page, perform the upload action using these values:

o File: The file you created

o Account: scm/planning DataLoader/Import
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3. From one of the Supply Chain Planning work areas, perform the Manage Planning Source Systems task to
check if your source system is already created. If your source system is not already created, then create it with
the following values:

o Version: External.
o Code: Must be the same as the one used for your Oracle E-Business Suite source system.
4. From a Supply Chain Planning work area, perform the Load Planning Data from Files task.

View and Refresh Collected Measure Data

View Collected Data for Measures Before Running a Plan

The Collected Measure Data table enables you to view imported or collected records and their statuses without having
to examine log files or run a plan. The table lists measures that were successfully populated as well as also those that
weren’t for your plan. By using this table, you can quickly resolve problems in the data load process.

Just as you can use the Supplies and Demands table to view the collected or imported supplies and demands, you can
use the Collected Measure Data table to view bookings, shipments, and other entities.

For example, Small Inc. imported its shipments history data using the Supply Chain Planning Shipments History file-
based data import (FBDI) template. To save time and work efficiently, the company wants to ensure that data was
correctly imported before running its plan. The company uses the Collected Measure Data table and selects the option
to view only records with errors. The company notices that several records have an error pertaining to invalid names for
the Customer Site level member. Now that the reason behind the error has been identified, Small Inc. can fix the data

in the FBDI file, import the data again, and run the plan. By using the Collected Measure Data table, Small Inc. quickly
identified data import-related problems and didn’t have to spend time analyzing the log files for the import or analyzing
the plan after running it.

1. In the Plan Inputs work area, click the Open drop-down button.
The Open Table, Graph, or Tile Set dialog box opens.
2. Select the Collected Measure Data table and click OK.
The Collected Measure Data table opens in a new tab.
3. Specify your search criteria, and click Search.
Use the Errors field to limit the records to those with errors or those without errors.

Note: By default, the table displays only the first 10,000 records that meet your search criteria. To change this
limit, you need to create and use a profile option with the MSC_COLLECTED_MEASURE_DATA_MAX_ROWS code.
No indication is provided if the table has records that aren’t displayed because the predefined or user-defined limit
has been exceeded.

4. Analyze the records that are returned according to your search criteria.
The Last Updated Date column displays the date on which the records were created or last updated.

The Refresh Number column displays the refresh numbers of the collection job sets through which the measures
were populated when the FBDI templates or collections feature was used.

5. Optionally, to export the records to a Microsoft Excel file for further analysis, click Actions > Export to Excel.

The records available in the Collected Measure Data table are exported to the file. The predefined or user-defined
limit is applied when the records are exported.
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Tip: When you export the records to an Excel file, you can view more than 15 records at a time. You may find it
helpful during your error analysis to view more than 15 records at a time.

Additional Points About the Collected Measure Data Table

These are some additional points about the Collected Measure Data table:

- The table displays records that are successfully uploaded to the MSC_MEASURE_DATA table.
For records with errors, the table displays records from the MSC_ST_MEASURE_DATA staging table that have
information in the ERROR_TEXT column.

The table doesn't display records from the staging table that weren't moved to the MSC_MEASURE_DATA table
and don't have error information.

- The table filters records by the applicable security privileges of the user. For example, if you have access to only
certain organizations, you can view measure values for only those organizations.

- The table lists both predefined and user-defined measures.

- The table displays measure data that's imported through these file-based data import (FBDI) templates:
o Supply Chain Planning Bookings History

o Supply Chain Planning Causal Factors
o Supply Chain Planning Forecast Measures
o Supply Chain Planning Measures
o Supply Chain Planning Option Bookings History
o Supply Chain Planning Option Shipments History
o Supply Chain Planning Shipments History
- The table doesn't display measure data that’s imported through the Supply Chain Planning External Forecasts
and Supply Chain Planning Price Lists FBDI templates.
To troubleshoot imported data for external forecasts or price lists, examine the log files or run your plan.

- The table also displays any measure for which information is collected from Oracle Fusion Cloud Applications
Suite or imported from Oracle E-Business Suite.

- To view aggregated non-key customer data in the table for demand, demand and supply, and sales and
operations plans, before collecting or importing measure data, select the Aggregate non-key customer data
to an All Other level member check box on the Demand tab on the Plan Options page for the plan. Then, enter
the required aggregation levels in the Supply Chain Planning Key Customer Options FBDI template, and import
customer data with the template. After you collect or import measure data, when you filter your records by the
plan name in the table, you can view the aggregated data for non-key customers. For aggregated records, the
value displayed in the Customer column is “<zone name>:All Other.”

- To avoid reduced performance, don't sort the records if you increase the maximum
number of records displayed in the table by creating and using a profile option with the
MSC_COLLECTED_MEASURE_DATA_MAX_ROWS code.

Related Topics
- How You Aggregate Customer Data
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Refresh Collected Measure Data

The Orchestrate Refresh Measures Processes scheduled process lets you update the plan data for collected planning
measures without running the plan.

You can refresh a subset of predefined or user-defined measures such as shipments and bookings history, sales and
marketing forecasts, and financial measures such as Budget Value and Financial Forecast Value. This process retains
the measure data for statistical and simulation demand forecasts usually purged when running your plan. By defining a
job set, you can automate this scheduled process to refresh measures immediately after loading external measure data
from flat files.

For example, an enterprise has a weekly demand planning cycle. They need to generate a baseline statistical forecast
once a week but continue to get daily updates for recent shipments, bookings, and sales forecast. Instead of running
the plan daily, they modify their planning process to run it at the start of the week and then refresh the key collected

measures daily.

Orchestrate Refresh Measures Processes

Use these steps to configure the Orchestrate Refresh Measures Processes scheduled process using a measure catalog
containing only a subset of plan measures:

1. In the Scheduled Processes work area, click Schedule New Process on the Overview page.

2. Inthe Schedule New Process dialog box, search for and select Orchestrate Refresh Measures Processes, and
then click OK.

3. Inthe Process Details dialog box, Basic Options section, do the following:
o Plan: Select a plan name.

o Measure Catalog: Select a measure catalog.

4. C(lick Advanced and navigate to the Schedule tab. You can set up the process to run as soon as possible or
establish a schedule.

5. When done, click Submit.

The Confirmation dialog box opens and displays the process number. You can use this process number to search for the
process result in the Scheduled Processes work area.

Additional Information about Orchestrate Refresh Measures
Processes

Here's some additional information about the Orchestrate Refresh Measures Processes scheduled process:

- You can schedule the Orchestrate Refresh Measures Processes scheduled process to refresh collected measure
data for one time or on a repetitive schedule from the Scheduled Processes page. You can configure a job set
that contains the Orchestrate Refresh Measures Processes scheduled process after the Load Planning Data
from Flat Files scheduled process to sequence and automate these planning processes.
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- When copying a plan, you get the following options:
o Copy plan options only

o Copy plan with reference to the base plan

o Copy plan with no reference to the base plan

If the copied plan was created using the second option (Copy plan with reference to the base plan), then it does
not support the Refresh Collected Measure Data capability. Such plans do not appear in the Plan field of the
Orchestrate Refresh Measures Processes scheduled process.

- The Orchestrate Refresh Measures Processes scheduled process considers the measure data uploaded using
file-based data import (FBDI) templates, including planning measures and demand history. The process does
not consider transactional data such as sales orders, price changes, or new items and organizations that are
not already included in a plan. For supply plans, measure data loaded using the Supply Chain Planning External
Forecasts (FBDI) template can't be refreshed.

- When introducing a new measure to a plan defined with the Refresh with current data option in Manage
Planning Measures, you must first run the plan to refresh with the current data before you can refresh that
measure's data using this process.

Note: Run your plan after a release upgrade before using this process.

- You need to include both the Shipments History (or Bookings History) measure and the default measure used
to refresh Shipments History in your measure catalog. For example, if the default measure used for the Default
Shipments History Measure profile option is Shipments History: Requested Item by Shipped Date, then include
both this measure and the Shipments History measure in the measure catalog used to refresh your plan.
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4 Segmentation

Segmentation in Oracle Fusion Cloud Sales and
Operations Planning

Segmentation is the process of grouping combinations into segments on the basis of user-defined, static, or dynamic
attributes. Through segmentation, you can better manage the supply for many combinations by grouping them into a
few segments.

In Sales and Operations Planning, these combinations can include items, locations, customers, and demand classes.

You can use segments in sales and operations planning to do any of the following:
- Apply policy assignment sets by segment groups.
- View data and perform drills in tables and graphs by segments.
Define segment groups for use in attribute-based netting sequences.

Filter data in analysis sets by using segments as filters. Then, you can apply forecasting profiles to specific
segments by selecting the associated analysis sets.

For example, you can perform segmentation by defining segment groups that are based on:
o Intermittency and volatility

o Demand volume and cost

o Item attributes for the Customer, Demand Class, Organization, and Product dimensions such as Lifestyle
Phase
o User-defined attributes and organizations, regions, and zones

Segmentation is available and functions the same in the following work areas, except for minor differences, which are
noted in specific segmentation topics.

- Sales and Planning Operations
« Supply Planning
Planning Central
Demand Management
Demand and Supply Planning
Replenishment Planning
Plan Inputs

How You Perform Segmentation

Here's what you do during the segmentation process:

1. Set up a segment group and its segments. The segment group has a specific granularity that's applicable to
the segments. You specify dimension-based or measure-based criteria for each segment on the basis of which
combinations are assigned to the segment.
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2. Run the segmentation job for the segment group from the Manage Segment Groups and Criteria page (Actions

> Execute Segmentation). The combinations are grouped into the segments.

3. View the results of segmentation, and optionally override the assignment of combinations to segments to
better meet your business requirements.

This flow chart summarizes the segmentation process:

Create segment group,
segments,
segment criteria

|

Run segmentation
process

.

| )

Override
No———t segmentation
results

Are segmentation
results OK?

Yes

Use segment group

When the segments are used as members for tables and graphs, for combinations that aren't associated with a segment
in the segment group, the segment information is shown as "Not available."

What You Do After Segmentation
Here's what you do after the segmentation process:
1. Create a policy assignment set and then attach the segment group to the policy assignment set.

2. Attach the segment group to a supply plan.
3. Run the supply plan to calculate the unique plan requirements for the item-org combinations in each segment.
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Work with Segment Groups

Create a Segment Group

A segment group consists of segments into which combinations are grouped. The segment group has a granularity
that's also applicable to the segments. You define the segments on the basis of dimension-based or measure-based
criteria.

In the Replenishment Planning work area, the combinations consist of items and locations that are collected
from Oracle Fusion Cloud Product Lifecycle Management.

In the Supply Planning and Planning Central work areas, the combinations consist of items and locations that
are collected from Oracle Product Lifecycle Management.

In the Sales and Operations Planning work area, the combinations consist of items and locations that are
collected from Oracle Product Lifecycle Management.

In the Demand Management work area, the combinations could include both:

o Items and locations that are collected from Oracle Product Lifecycle Management.

o Customers and demand classes that are collected from Oracle Fusion Cloud Applications and external
sources.

To create a segment group, you must:

1. Create the segment group.
2. Define the segments.
3. Define criteria for the segments.

To restrict segmentation to items for which replenishment planning must be done, you first set the MPS and MRP
Planning Method attribute of items to Replenishment planning in Oracle Product Lifecycle Management. Then, while
setting up criteria for segments of the segment group, you set the Planning Method attribute for the Product dimension
to Replenishment planning. After collection and segmentation, only replenishment planning items are grouped into the
segments of the segment group.

If you're planning replenishments at the item-subinventory level, select the Organization dimension for the segment
group. Then, add the dimension to segments of the group, and use the Location attribute of the dimension to include
subinventories in the segments. The subinventories are listed in the <organization>:<subinventory> format.

Create the Segment Group

Follow these steps to create the segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Segment Groups and Criteria.

The Manage Segment Groups and Criteria page opens.
2. Under Search Results, click Actions > Create.

The Create Segment Group page opens.
3. In Segment Group, enter the segment group name.
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4. In Source System, select the source system for the segment group.
The source system must be the same as that used in the plan to which you attach the segment group. Only the
combinations in the selected source system are available after segmentation in the segment group.
5. In Simulation Set, select a simulation set for the segment group.
If you plan to simulate changes to the same item attributes at the segment group and plan levels, preferably,
use the same simulation set in both cases.
In Description, enter the segment group description.
Under Segment Granularity, in the Dimension column, select the dimension that you want to specify for the
segment group granularity.
The lowest levels for the selected dimensions are displayed in the Level column, and the displayed levels make
up the segment group's granularity.
Note the following:

o For demand, demand and supply, sales and operations, and supply plans, only the predefined Customer,
Demand Class, Organization, and Product dimensions are supported. You must select the Product
dimension. If you select the Customer or Demand Class dimension, you must specify measure-based
criteria for each segment.

o For replenishment plans, you must select only the Organization and Product dimensions.

8. Add more dimensions as required by clicking the Add Row icon.
9. In Catalog, select the Oracle Product Lifecycle Management catalog from which you want to use categories
while specifying the attributes for Product dimension-based criteria of segments in the group.
10. Click Save.

NOo

Define the Segments
Follow these steps to create a segment in the segment group:

1. Under Segments, click the Add Row icon.
. Enter the segment name and description.

3. Under Rank, accept the default number that's a multiple of 10 or enter a whole number that's unique for the
segment group.
During segmentation, if a combination meets the criteria for more than one segment, the combination is
assigned to the segment with the lower rank.

4. Add more segments as required.

5. Click Save.

Define Criteria for the Segments
Follow these steps to define criteria for segments:

1. Under Segments, select the segment for which you want to define criteria.
2. Under Segment Criteria, click the Add Row icon.
A row appears for the segment criterion of the segment.
3. Set the criterion as follows:
a. Inthelist under Dimension, if you want the criterion to be based on the selected dimensions for the
segment group:
i. Select a dimension.
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The list under Attribute is enabled and displays the attributes for the selected dimension.
ii. Inthelist for attributes, select an attribute for the dimension.

If you selected the Product dimension, and you previously specified an Oracle Product Lifecycle
Management catalog, the list includes Category as an attribute.

If you selected the Product dimension, you can select the attribute named Safety Stock Planning
Method.

iii. In the list for operators, select the operator with which you want to evaluate the attribute.

Depending on your selection, fields or lists under From Value and To Value may be enabled, and
dialog boxes may open.

iv. Specify the values for the attribute.

If you selected Category as an attribute, the categories for the selected Oracle Product Lifecycle
Management catalog are displayed in the list under From Value.

If you selected Safety Stock Planning Method as an attribute, you can select Safety stock
quantity, Days of cover, or Not planned in the list under From Value.

b. Inthelist under Dimension, if you want the criterion to be based on measures:
i. Select Measure-based criteria.

The Search and Select: Plans dialog box appears.
ii. Inthe Available Plans pane, in Type, specify the plan type.
iii. Click the Find icon.

The available plans are displayed. For Replenishment Planning, only those plans for which the
Generate forecast check box is selected on the Plan Options page are displayed.

The plans should have been run and contain tables with the required measures. The tables should
have only those dimensions and levels that are in the segment group.

iv. Select and move plans to the Selected Plans pane.
v. Click OK to return to the Create Segment Group page.

vi. In Measure Evaluation Table, select the table from which a measure should be selected for the
segment criterion.

The tables associated with the selected demand or replenishment plans are available in the list.
vii. In Measure Name, select a measure.
viii. In Operator, select the operator with which you want to evaluate the measure value.

Depending on your selection, the From Value field, To Value field, or both are enabled.
ix. Specify the values for the measure.
4. Add more rows for segment criteria as required.

If you're adding rows, enter a whole number in the field under Group for each row. During segmentation,
those rows with the same whole number are processed with the AND operator. Then, the resulting criteria are
processed with the OR operator.

5. Click Save.
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Related Topics
« How You Set Up Replenishment Planning for Subinventories

Edit a Segment Group

You can edit and delete segment groups, segments, and segment criteria.

Edit the Segment Group

You can duplicate, edit, and delete a segment group.
You can delete the segment group only if it's not associated with a policy assignment set or a plan for the work area.

The changes you can make to the segment group are limited. You can't change the name or source system for the
segment group, and you can't change its granularity by adding or deleting dimensions.

Follow these steps to edit the segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Segment Groups and Criteria.

The Manage Segment Groups and Criteria page opens.

Search for the segment group that you want to edit.

3. Select the segment group, and click Actions > Edit.
The Edit Segment Group page opens.

4. Change the description and simulation set as required.
If you plan to simulate changes to the same item attributes at the segment group and plan levels, preferably,
use the same simulation set in both cases.

5. In Catalog, select the catalog from Oracle Fusion Cloud Product Lifecycle Management from which you want to
use categories while specifying the attributes for Product dimension-based criteria of segments in the group.
If you previously selected a catalog and used one of its categories while setting up a Product dimension-based
criterion, the list is grayed out.

6. Click Save.

N

Edit the Segments

You can add, duplicate, and delete segments and change their names, descriptions, and ranks.

In the Replenishment Planning work area, you can delete segments only if the segment group isn't associated with a
policy assignment set or replenishment plan. In the Supply Planning work area, you can delete the segment group only

if it's not associated with a policy assignment set or supply plan. In the Sales and Operations Planning work area, you
can delete the segment group only if it's not associated with a plan.

If you change the rank of a segment, you may change how combinations are assigned to segments after you run
segmentation again. During segmentation, if a combination meets the criteria for more than one segment, the
combination is assigned to the segment with the lower rank.

Edit the Segment Criteria

You can add, edit, and delete criteria for a segment.
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For dimension-based criteria, you can change the attributes, operators, and values. For measure-based criteria, you can
change the plans, measure evaluation tables, measures, operators, and values.

Depending on the operator used for a criterion, you can change the values under From Value, To Value, or both.

If you change the value under Group for the criterion, you may affect the segmentation result. During segmentation,
those criteria with the same whole number are processed with the AND operator. Then, the resulting criteria are
processed with the OR operator.

Run Segmentation

You can run segmentation for a segment group from the Manage Segment Groups and Criteria page.
Follow these steps to run segmentation for the segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Segment Groups and Criteria.

The Manage Segment Groups and Criteria page opens.
2. Search for the segment group for which you want to run segmentation.
3. Select the segment group, and click Actions > Execute Segmentation.

The Execute Segmentation dialog box opens.
4. To retain your segment overrides, select Retain segment overrides.

To save your last segmentation result for display on the Segmentation Summary page, select Save the last
segmentation result. When you select this check box, the results of the last segmentation run are displayed
under the Previous heading on the Segmentation Summary page, and the results of the segmentation run you
are presently submitting are displayed under the Latest heading.

Tip: If you're performing simulations, you may want to repeatedly make changes to your segmentation
criteria and run segmentation so that you can compare the results of your changes with the results of the
last segmentation run, which are displayed under the Latest heading on the Segmentation Summary page.
In such cases, you don't want to select this check box. When you have finished your simulations and are
satisfied with the results of your changes, then select this check box.

5. Click Submit.

The Information dialog box opens and provides you with the request number (process ID) of the segmentation
run. You can use this request number to search for the process status and log on the Scheduled Processes
page. If the segmentation run fails, see the log for more information and troubleshooting.

6. Click OK.

The Information dialog box closes.

7. On the Manage Segment Groups and Criteria page, click View > Refresh to update the status and last run date
of segmentation for the segment group.
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View the Segmentation Summary

You can view segmentation results on the Segmentation Summary page. The results of the latest and previous
segmentation runs are displayed.

A segment group consists of segments into which combinations are grouped.

In the Replenishment Planning work area, the combinations consist of items and locations that are collected
from Oracle Fusion Cloud Product Lifecycle Management.

In the Supply Planning and Planning Central work areas, the combinations also consist of items and locations
that are collected from Oracle Fusion Cloud Product Lifecycle Management.

In the Sales and Operations work area, the combinations consist of items and locations that are collected from
Oracle Fusion Cloud Product Lifecycle Management.

In the Demand Management work area, the combinations could include both:

o ltems and locations that are collected from Oracle Fusion Cloud Product Lifecycle Management.

o Customers and demand classes that are collected from Oracle Fusion Cloud Applications and external
sources.

View the Summary

Follow this procedure to view the segmentation summary for a segment group:

1.

2.

Perform one of these steps:
o Onthe Tasks panel tab, under Plan Inputs, select View Segmentation Summary.

The Segmentation Summary page opens.
o Onthe Manage Segment Groups and Criteria page, select a segment group, and click Actions > View
Segmentation Summary.

The Segmentation Summary page opens.
In Segment Group, select the segment group for which you want to view the segmentation summary.

The page is refreshed with the segmentation summary for the segment group. The results of the latest and
previous segmentation runs are displayed, along with other details of the combinations for each segment.

You can click a number for a segment under a column to open the Manage Segment Members page and view
the combinations that meet the criteria for the number that you clicked. If you perform any overrides on the
Manage Segment Members page, the changes are immediately reflected on the Segmentation Summary page.

If you opened the segmentation summary from the Manage Segment Groups and Criteria page, the field is
grayed out, and you can view segmentation results for only the segment group you selected on the page.

3. Click Done to close the Segmentation Summary page.
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Points to Note About Displayed Information

Note these points about the information displayed on the Segmentation Summary page:

- You can use the latest and previous results to understand how and why combinations have moved from one
segment to another. These movements happen because of changes in demands, sales, and consumption. By
identifying the factors underlying these movements, you can fine-tune the segmentation process and apply
manual overrides as required.

- Every time you run segmentation with the Save the last segmentation result check box selected in the
Execute Segmentation dialog box, the latest results presently displayed on the Segmentation Summary page
are displayed as the previous results, and the results of the job you just submitted are displayed as the latest
results. Your manual overrides remain unaffected so long as you selected the Retain segment overrides check
box in the Execute Segmentation dialog box.

- If you have run segmentation for the first time for the segment group, the previous results aren't displayed.
- No previous results are displayed for a segment that's added during the latest segmentation run.

- The values under the Latest Count, Previous Count, Added in Latest Run, and Removed in Latest Run
columns don't include your manual overrides.

Override Segmentation Results

You can override segmentation results by manually assigning combinations to segments.

- In the Replenishment Planning work area, the combinations consist of items and locations that are collected
from Oracle Fusion Cloud Product Lifecycle Management.

-+ In the Supply Planning and Planning Central work areas, the combinations also consist of items and locations
that are collected from Oracle Fusion Cloud Product Lifecycle Management.

+ In the Supply Planning and Planning Central work areas, the combinations also consist of items and locations
that are collected from Oracle Fusion Cloud Product Lifecycle Management.

+ Inthe Demand Management work area, the combinations could include both:

o Items and locations that are collected from Oracle Fusion Cloud Product Lifecycle Management.

o Customers and demand classes that are collected from Oracle Fusion Cloud Applications and external
sources.

In the case of Replenishment Planning, the combinations consist of items and locations that are collected from Oracle
Fusion Product Lifecycle Management. In the case of Demand Management, the combinations could also include
customers and demand classes that are collected from Oracle Fusion Cloud Applications and external sources.

You can override segmentation results using the:
- Manage Segment Members page
- Edit-in-spreadsheet feature

Changes you make to the segments for combinations are overwritten the next time you run segmentation for the
segment group unless you have selected the Retain segment overrides check box in the Execute Segmentation dialog
box.
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Override Segmentation Results Using the GUI

To override segmentation results through the Manage Segment Members page, follow this procedure:

1.

Perform one of these steps:

o On the Tasks panel tab, under Plan Inputs, select Manage Segment Members.

The Manage Segment Members page opens.

On the Manage Segment Groups and Criteria page, select a segment group, and click Actions > Manage
Segment Members.

The Manage Segment Members page opens and displays the combinations for the segment group.
On the Segmentation Summary page, for the segment of a segment group, click the number under
Latest Count, Previous Count, Added in Latest Run, Removed in Latest Run, Manually Added to
Segment, Manually Removed from Segment, or Final Count.

The Manage Segment Members page opens and displays the combinations corresponding to the
number you clicked.

2. Onthe Manage Segment Members page, under Search, select the segment group for which you want to

3.

override the segmentation results, and click Search. You can further refine your search by the segment,
previous segment, and levels for the dimensions in the segment group.

The page is refreshed with the segmentation results. For each combination, the assigned segment in the latest
segmentation run, assigned segment in the previous segmentation run, and segment override are displayed.
For each combination for which you want to override the segmentation results, under Segment Override,
select the new segment.

4. C(lick Save and Close.

Override Segmentation Results Using a Spreadsheet

To override segmentation results through the edit-in-spreadsheet feature, follow this procedure:

Note: You must first download and install the desktop integration installer that's available under Navigator > Tools.
Otherwise, you can't override segmentation results using a spreadsheet.

1.

Perform one of these steps:

o On the Tasks panel tab, under Plan Inputs, select Manage Segment Members.

The Manage Segment Members page opens.

On the Manage Segment Groups and Criteria page, select a segment group, and click Actions > Manage
Segment Members.

The Manage Segment Members page opens and displays the combinations for the segment group.

On the Segmentation Summary page, for the segment of a segment group, click the number under
Latest Count, Previous Count, Added in Latest Run, Removed in Latest Run, Manually Added to
Segment, Manually Removed from Segment, or Final Count.

The Manage Segment Members page opens and displays the combinations corresponding to the
number you clicked.
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2.

10.
n.

On the Manage Segment Members page, under Search, select the segment group for which you want to
override the segmentation results, and click Search.

The page refreshes with the segmentation results.
Under Search Results, click Edit in Spreadsheet.

A dialog box opens and prompts you to open or save a Microsoft Excel file.
Open the spreadsheet.

The Connect dialog box opens and prompts you to connect to the application URL.
Click Yes.

A dialog box opens and prompts you to enter your credentials.
Sign in with your Oracle Applications Cloud credentials.

The spreadsheet is refreshed with the combinations in the segment group displayed on the Manage Segment
Members page. For each combination, the assigned segment in the latest segmentation run, assigned segment
in the previous segmentation run, and segment override are displayed. Only the first 2,000 rows are displayed.

To narrow your search to a combination in the segment group, enter the details in the first table, and click
Manage Segment Members > Search.

You can use the percent sign as a wildcard character for your search.

For each combination for which you want to override the segmentation results, under the Segment Override
column, select the new segment.

A symbol appears in the cell under the Changed column for each changed row.
To upload your changes, click Manage Segment Members > Upload.

The results of the upload for each row are displayed under the Status column.

The symbol in the cell under the Changed column disappears for each successfully uploaded row.
Save and close the spreadsheet.
To view your changes on the Manage Segment Members page, click View > Refresh.
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5 Supply Network Model

How You Maintain Your Supply Network Model

Use the Maintain Supply Network Model page to view your collected data that includes details of organizations,
customers, suppliers, carriers, and interlocation shipping networks.

To open the Maintain Network Model page, navigate to a Supply Chain Planning work area. Click the Tasks panel tab
and then select the Maintain Supply Network Model link.

You use organizations to represent your business facilities or functions. Typically, if your business has a single physical
facility that performs two different functions, then you model it as two organizations. For example, you have one facility
that's a manufacturing plant and a distribution center. You can model them as two separate organizations. Additionally,
if your business has one function located in two separate physical facilities, you can model those as one organization. If
you modeled your facilities as one organization, you can create separate subinventories to represent inventory for each
facility.

Review the Collected Data

Based on your search results, use the Organization tab to do the following:

Review organizations, including the time zones associated with the organizations, for all source systems.
- Create customer and supplier associations to organizations. This is used when creating the buy-sell transfers.

- Select the drop ship validation organization. For each source system, you can select only one organization as
the drop ship validation organization. You can also assign a calendar to a drop ship validation organization.

- Set past due parameters for each organization, which include:

o Past due forecast days
o Past due sales order days

o Past due supply days

- Set up organizations for subinventory-level replenishment planning by selecting Yes under Plan
Subinventories.

Use the Customers and Supplier tabs to review collected data and assign time zones to customer sites and supplier
sites. If the customer site or supplier site doesn't have an associated time zone, then the customer site or supplier site is
assumed to be in the same time zone as the organization that's associated with the demand or supply.

Use the Carriers and Interlocation Shipping Networks tabs to review collected data on carriers, shipping methods, and
transit times.

Manage Organization Groups

Click the Manage Organization Groups button on the Organizations tab to create and manage organization groups.
Organization groups are managed within the source systems and are used to:

Limit the net change data collection from a source system to specific organizations.
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Load planning data from files for a specific organization group when collection type is Targeted.

Enable Inventory Organization Tracking by Project
This parameter appears on the Maintain Supply Network Model page only when your organization is enabled for
project-specific supply planning.

The Project Enabled parameter governs whether your inventory organization is enabled for inventory tracking by
project. The value for this parameter can be Yes or No for an organization.

When the parameter value is Yes for an organization, the data collection process collects project-and-task-specific
supplies and demands, and the project-specific planning releases planned orders to the organization. The value for this
parameter is No for a supplier-modeled organization or a contract manufacturing organization.

Buy and Sell Transfers

You can conduct material transfers between two organizations in a single Oracle Fusion source system by using the
purchase order and sales order documents. The sales order at the source organization is used to ship the transfer. The
purchase order at the destination organization is used to receive the transfer.

In the supply network model for the purchase order supply at the receiver organization:

Define the supplier to source organization relationship and for the sales order demand at the shipping
organization.

Define the customer to destination organization relationship.
To model an organization as a supplier, update the Supplier and Supplier Site columns of the associated organization.

To model an organization as a customer, update Customer and Customer Site columns of the associated organization.

Forecast and Consume Internal Orders

To forecast and consume internal orders, assign a customer and customer site to the organization that's the destination
of the transfers. Use a customer name that makes sense for the destination organization, such as M1 Transfers. After
you assign a customer and customer site on the Organizations tab, select the Use Customer and Customer Site for
Interorganization Transfers check box for the organization.

Note: To complete the setup to forecast and consume internal orders, you must also do the following:

On the Collect Planning Data page, Parameters tab, Demand Planning Data subtab, select the Organization -
Consumption Inventory Transactions to Include check box.

In the plan options for your plan, select the Include transfer orders check box in the Demand: Advanced
Options dialog box. This check box is only available from a Demand Management, Planning Central, or Demand
and Supply Planning work area.
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Related Topics
» Overview of Data Collections for Supply Chain Planning

» How You Collect Different Data Types for Supply Chain Planning

« How You Load Planning Data from Files

« How You Define the Approved Supplier List for Supply Chain Planning
« Set Up Forecast Consumption for Transfer Orders

How You Define the Approved Supplier List

An approved supplier list (ASL) is a repository of information that links items to the suppliers and supplier sites that
provide them to either a specific ship-to organization or the entire enterprise.

An ASL can be global or specific to an organization; however, supply planning only recognizes global ASLs.

To determine the supplier and supplier sites for items, the planning process collects ASLs from the CSV file upload,
Oracle Fusion Cloud Procurement, or both.

Use the Load Planning Data from Flat Files process to load data directly into the planning ASL by using the
Approved Supplier List CSV template (ScpApprovedSupplierListimportTemplate.xlsm).

- You can also define some ASL attributes in Oracle Procurement and then upload a CSV file that defines
the attributes that you want supply planning to use. For example, define the following item-to-supplier
relationships and order modifiers in Oracle Procurement:

o Supplier
o Supplier site
o Minimum order quantity

o Fixed lot multiple

To upload additional attributes for supply planning to use, you can create and collect the ASL from purchasing. You can
then use the CSV file upload to define additional attributes such as the following:

Item-supplier lead time
- Supplier capacity calendar
Daily supplier capacity

Oracle Fusion Cloud Supply Planning supports the approved supplier list for a base model. However, approved supplier
lists aren't supported for configured items and won't be copied into a supply plan.

Related Topics
» How You Maintain Your Supply Network Model

» Supplier Capacity Options
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Assignment Sets, Sourcing Rules, and Bills of
Distribution

You use assignment sets in a Supply Chain Planning work area to link sourcing rules and bills of distribution to items.

Using sourcing rules, bills of distribution, and assignment sets together, you can specify how material is supplied,
manufactured, and transferred across a supply chain.

Note: This topic is applicable to only the Planning Central, Sales and Operations Planning, Supply Planning, Demand
and Supply Planning, and Replenishment Planning work areas.

When you create sourcing rules and bills of distribution, you create descriptions of the means by which you can
replenish items. However, items aren't specified anywhere on the definition forms, and so a defined sourcing rule or
bill of distribution can later be assigned to any item or group of items. Use assignment sets to associate specific items,
categories, or organizations with the sourcing rules and bills of distribution.

You must use sourcing to describe the supply chain to the planning process. Use the following three structures to do so:
- Sourcing rules

Bills of distribution

- Assignment sets

Sourcing Rules

Sourcing rules and bills of distribution determine the movement of material between organizations. These
organizations include supplier, manufacturing, and distribution facilities. You can navigate to a Supply Chain Planning
work area and click Manage Sourcing Rules from the Tasks drawer to create or search for an existing sourcing rule.

The three types of sources are:

- Transfer From: Interorganization shipping functionality accomplishes the transfer between internal
organizations. Enter the source organization in the Organization column.

Make At: The item is manufactured at this internal organization. Enter the manufacturing organization in the
Organization column.

Oracle Fusion Replenishment Planning doesn't support make at sourcing rules.
Buy From: Purchase the item from an external enterprise. Data entry in the Supplier and Supplier Site columns
is enabled, and the Organization column is disabled.

Allocation Percent and Rank: The total allocation percentage for all sources within a rank must add up to 100 percent.
The sources with the highest rank (lowest numeric value) get the highest priority in allocations. Unconstrained supply
planning and Replenishment Planning only consider sources of rank one. Replenishment Planning also doesn't support
sourcing splits.

Bills of Distribution

When material flows through three or more organizations, bills of distribution describe supply chain links more
efficiently than sourcing rules. However, any relationship that can be described by bills of distribution can also be
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described by a set of sourcing rules. Typically, most users use sourcing rules rather than bills of distribution. You can
navigate to a Supply Chain Planning work area and click Manage Bills of Distribution from the Tasks drawer to create
or search for existing bills of distribution.

Replenishment Planning supports bills of distribution of only rank one and doesn't support split bills of distribution.

Sales and Operations Planning doesn't support bills of distribution.

Note: Despite the name, bills of distribution don't describe an outward bound or push type of sourcing relationship.
Both sourcing rules and bills of distribution are used only to pull material from sources to destinations.

Assignment Sets

You use assignment sets to link sourcing rules and bills of distribution to items. In other words, you use assignment
sets to link sourcing rules, items and supply nodes. The assignment set creates the sourcing and transfer links between
organizations for each item involved in a supply chain plan. Alternative supply chains can be modeled by creating
alternative assignment sets. You can navigate to a Supply Chain Planning work area and click Manage Assignment
Sets from the Tasks drawer to create or search for existing assignment sets.

For more information, see Create an Assignment Set.

Sourcing Assignment Hierarchy

The planning process uses a sourcing assignment hierarchy to determine the actual source of a specific item. You can
assign replenishment sources at the following levels. Specific sourcing assignments override general assignment levels.
If the planning process doesn't find any sourcing assignment, then the make or buy item attribute is used to determine
sourcing.

The following table lists the supply sourcing hierarchy.

Rank Item or Category Applies to

1 Item - Organization 1. Sourcing rule

2 Category - Organization 1. Sourcing rule

3 Item 1. Bill of distribution

2. Global sourcing rule

4 Category 1. Bill of distribution
2. Global sourcing rule

5 Organization 1. Global sourcing rule

6 Global 1. Bill of distribution
2. Global sourcing rule

When entering sourcing assignments at the category level, the catalog associated with the assignment set is used to
determine the list of available categories.
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When you source supplies for sales orders and forecasts (independent demands), then order promising and planning

use a more detailed hierarchy. This hierarchy includes the demand class, customer, and customer site which are

dimensions of independent demand.

The following table lists the demand sourcing hierarchy.

Rank

10

n

12

13

14

15

Item or Category

Item - Customer / customer site

Iltem - Customer

ltem - Demand Class

Item - Region

Category - Customer / customer site

Category - Customer

Category - Demand Class

ltem

Category - Region

Category

Customer / customer site

Customer

Demand Class

Region

Global

Using the demand sourcing hierarchy, if a demand line includes a value for demand class, then if no sourcing rule exists
for Item - Customer / customer site or Item - Customer, but a rule exists for tem-Demand Class, then that rule is used
to determine supply sources for the demand line.
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When using the sourcing hierarchy, if two rules conflict, the more granular rule is used. To verify which source is
used for an assignment set, from within the set, click the View Sourcing button after entering the following required
parameters:
- Assignment set
- Organization
Item
Date

The dialog box displays which assignments apply to the item-organization-date that you selected. If multiple rules
apply, then the Active Rule is marked in the form.

Related Topics
« Item Attributes and Order Modifiers for Supply Planning

« Support for Sourcing Rules and Bills of Distribution in Oracle Replenishment Planning

Specify Catalogs for Assignment Sets

A catalog is a group of categories that you can use to classify an item. Use it to organize your item into a hierarchy.
A catalog can have a flat or a one level structure of categories. You can also have a hierarchical structure of categories.
You must specify a catalog for each assignment set when you create the set. You associate the set with a catalog to:
Use categories associated to that catalog in your assignment set.
Link the sourcing assignments to the categories.

Use the Manage Assignment Sets task in the Global Order Promising work areas to create an assignment set and specify
the catalog. Don't use assignment sets in the Demand Management work area.

If you don't specify a catalog, then the assignment set uses the Catalog for Sourcing Assignments
(MSC_SRC_ASSIGNMENT_CATALOG) profile option as the catalog. To modify it, see Manage Promising Profiles.

A catalog is a collection of categories that you can use to classify your item. For example, you can assign the Floral Dress
item to the Summer category in the Ladies Wear catalog. For details about catalogs and categories, including how to
create a catalog and add categories and items to it, see Assign Catalogs and Categories Using Item Rules.

Create a Sourcing Rule

Learn how to create a sourcing rule.

1. Collect the reference data that you need to create your sourcing rule, such as organizations, items, and so on.
Make sure the collected data is up to date on the server.

For details, see Collect Data for Global Order Promising.
2. Go to the Global Order Promising work area, then click Tasks > Manage Sourcing Rules.
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3. Onthe Manage Sourcing Rules page, click Actions > Create.
4. On the Create Sourcing Rule page, enter a name and description.
5. Set the Organization Assignment Type attribute to Global or Local.

If you set it to Local, then set a value in the Organization attribute. Select the one organization that you will
apply this sourcing rule to.

6. Inthe Sourcing Rule Effective Dates section, click Actions > Add Row, then set the dates when you want the
sourcing rule to be in effect.

7. In the Sources section, click Actions > Add Row, then set the values.

Attribute Value

Type Choose one:

o Transfer From
o Make At

o BuyFrom

8. Set other attribute values depending on the type that you selected. The page will help you. It will make some
attributes available depending on the type.

9. C(lick Save and Close.

Related Topics
» How You Collect Different Data Types for Supply Chain Planning

» Support for Sourcing Rules and Bills of Distribution in Oracle Replenishment Planning

Export Planning Data to CSV Files

You can replicate sourcing rules and assignment set data from your Oracle Fusion Cloud Supply Planning instance to
another instance. When exporting data to CSV files, you can export a subset of the measures that are listed in a plan's
measure catalog.

Replicate Sourcing Rules and Assignment Set Data

You can replicate sourcing rules and assignment set data from your Oracle Fusion Cloud Supply Planning instance to
another instance or application without manually reentering data. For example, you can replicate the sourcing rules in
your Oracle Supply Chain Planning production instance into a reporting system or a test instance.

Use the Export Supply Chain Planning Data scheduled process job to extract sourcing rules and assignment set data
into a comma-delimited values (CSV) file format. The generated file is in the standard file-based import (FBDI) file
format that you can then use to do the following:

- Check for missing or incorrect sourcing rules or sourcing assignments. For example, does a particular item-
organization have a valid sourcing assignment?

Replicate and then modify existing sourcing rules and assignment sets in a spreadsheet. You can then upload
the new setups into another instance or application to create new sourcing rule and assignment set setups.
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- Copy the sourcing rule and assignment set setups from one instance to another instance or application, such as
from a test instance to a production instance.

The format of the CSV files, including the header content, is the same as the format of the corresponding files in the
source instance. This enables you to import the same data directly into another production or test instance. Use the
Load Planning Data from Files process to upload your imported files to staging tables.

The following steps show you how to export sourcing rules and assignment set data to a CSV file:

1. Inthe Scheduled Processes work area, click the Schedule New Process button on the Overview page.

2. In the Schedule New Process dialog box, search for and select Export Supply Chain Planning Data and then
click OK.

3. In the Process Details dialog box, Basic Options section, select Sourcing Rules and Assignment Sets from the
Entities to Export drop down list.

4. Optionally, click the Filter button to filter your export with specific assignment sets. If you don't select any
filters, then the process exports all sourcing rules and assignment sets.

5. Inthe Process Details dialog box, click the Submit button to submit the scheduled process job.

After you submit your job, you will receive a confirmation with a confirmation number. The planning process
appends the confirmation number to the extracted CSV file names, such as AssignmentSets_65960.csv and
SourcingRules_65960.csv, where 65960 is the confirmation number.

Export Measures Along With Planning Data

While exporting planning data, you can include a subset of measures that are part of a plan's measure catalog.

You can assign a measure catalog other than a plan’s extract measure catalog defined in Plan options, in the Manage
Plans Ul. This improves the versatility and quality of data extracts required for planning.

Depending on your planning cycle and data needs, extract only those measures that are most relevant for the planning
activity. For example, for a given plan you can export demand related measures early in a planning cycle and supply
related measures later in the cycle.

You can also assign a measure catalog when running the Prepare Planning Data for Export scheduled process.

ltem Attributes and Order Modifiers for Supply Planning

Items represent the material that you use in manufacturing and distribution processes and store in inventory. ltem
attributes specify properties of each item. You set the item attributes for supply planning through the Product
Information Management work area.

Use these steps to set item organization attributes for supply planning:

1. Navigate to the Product Information Management work area and open the Manage Items task from the Tasks
drawer.
2. Search for your items.
3. Select an item and edit attributes on the specification tab. You can locate the Planning attributes under the
planning section.
This table lists the attributes related to supply planning.
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Item Attribute

Item Overview

Manufacturing

Manufacturing

Manufacturing

Manufacturing

Manufacturing

Manufacturing

Inventory

Inventory

Inventory

Order Management

Order Management

Planning

Planning

Planning

Planning

Planning

Planning

Planning

Planning

Planning

ORACLE

Item Structure

Unit of Measure

Structure Item Type

Base Model

Autocreated Configuration

Assemble to Order

Build in WIP

Supply Type

Inventory ltem

Stockable

Transactable

Customer Orders Enabled

Transfer Orders Enabled

Make or Buy

Safety Stock Method

Planner Code

Planning Method

Forecast Control

Time Fences: Demand

Time Fences: Release

Time Fences: Planning

Cost
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Item Attribute Item Structure
Planning Carrying Percentage

Planning Shrinkage Rate
Planning Acceptable Early Days
Planning Lead Times: Processing
Planning Lead Times: Preprocessing
Planning Lead Times: Postprocessing
Planning Lead Times: Fixed
Planning Lead Times: Variable
Planning Minimum Order Quantity
Planning Maximum Order Quantity
Planning Fixed Order Quantity
Planning Fixed Lot Multiplier
Planning Fixed Days Supply
Planning Rounding
Purchasing Purchasable
Purchasing Approved Supplier List
You can use these attributes for specific purposes:

Make or Buy: This attribute is used by default if no sourcing rule is present.

Planning Method: Use either MRP planned or MPS planned as the planning method.

Time Fences: All are used by planning.

Buy items use the processing lead times. Make items use fixed and variable.

Make, buy, transfer all use preprocessing lead time. Buy and transfer use post processing lead time.

Acceptable Early Days is used if you need to reschedule existing supplies. If the supply due date is within the
acceptable early days, then no reschedule out recommendation is issued.
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Order Modifiers

You use order modifiers to obtain planned orders that you're more likely to use in your environment. For example, you
may purchase an item from a supplier who only provides it on pallets of quantity 100. If you're short in some quantity,
say 72, you can set the planned order quantity to 100 instead of 72 to support your requirement. You can't apply order
modifiers to phantoms and back-to-back items.

These are the order modifiers that you can use:

Minimum Order Quantity
Maximum Order Quantity
Fixed Order Quantity
Fixed Lot Multiplier

Fixed Days Supply
Rounding

Material planning uses a priority sequence (precedence) of order modifiers. It applies certain order modifiers before
others and rules out certain order modifiers based on it using certain other order modifiers. The order modifier
precedence is:

1.

Fixed Days Supply: One planned order for this item must cover all the shortages for the number of days
specified in the value. For example, if the net requirements are 50 on Monday, 100 on Wednesday, 70 on
Thursday, and you've set Fixed Days Supply to 5, the planning process creates one planned order, with a
quantity of 220 (50 + 100 + 70) and due on Monday. The period start dates aren't fixed. In the example, the
next period of 5 days would not always start on the following Monday but would start on the next day after
Friday that has net requirements. You can adjust the Fixed Days Supply value using the other order modifiers.
Therefore, the next period of 5 days could be the following Wednesday through the second Tuesday.

Note: In Supply Planning, if there's a Fixed Days Supply, then the application doesn't split supplies based on
sourcing rule percentages.

Fixed Order Quantity: You must always set the planned order quantity with this value. For example, if the net
requirements are 1and you've set Fixed Order Quantity to 200, the planning process creates one planned order
with a quantity of 200. If set, the planning process skips to the Rounding order modifier.

Fixed Lot Multiplier: You must always have the planned order quantity with this value. For example, if the net
requirements are 400 and you've set Fixed Lot Multiplier to 150, the planning process creates one planned
order with a quantity of 450.

Minimum Order Quantity: The planned order quantity may never be less than this value. For example, if the net
requirements are 100 and you've set Minimum Order Quantity to 150, the planning process creates one planned
order with a quantity of 150. If set, the planning process skips to the Rounding order modifier.

Maximum Order Quantity: One planned order for this item may not have a quantity more than this value. For
example, if the net requirements are 200 and you've set Maximum Order Quantity to 150, the planning process
creates two planned orders, one with a quantity of 150 and the other with a quantity of 50.

Rounding: The planned order quantity must always be a whole number; the planning process always rounds
fractional quantities up to the next highest whole number. For example, if the net requirements are 99.2 and
you've selected Rounding, the planning process creates one planned order with a quantity of 100.
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6 Bills of Resources

Automatically Generate Bills of Resources

You can generate bills of resources through an automated scheduled process that uses collected discrete work
definitions and item and resource attributes.

Use the Create Bills of Resources scheduled process to create bills of resources for planning assembly items in a sales
and operations plan.

Aggregate supply planning in sales and operations planning doesn't consider detailed bills of materials and routings.

It uses bills of resources that collapse routing operations to focus on critical components and resources so that you
can perform rough cut capacity planning at a strategic level. This process enables you to plan at an aggregate level and
make strategic decisions in your sales and operations planning process.

The Create Bills of Resources scheduled process:

- Uses collected discrete work definition data in the form of routings and item structures as the primary source of
input data.

Routings are required input data. You can't run the Create Bills of Resources process with only bills of materials.

- Uses assighment set with Make at and Transfer from sourcing as input data. For example, the Create Bills of
Resources scheduled process uses a sourcing assignment at an item or product category level with a Make at
sourcing rule.

Define sourcing assignments in an assignment set. An assignment set is required for aggregate supply
planning in a sales and operations plan. To simplify data setup, Oracle recommends that you specify sourcing
assignments at an aggregate level such as Category and Organization rather than at an item level. The planning
process considers the Transfer from sourcing rule for subassemblies manufactured in upstream organizations.

- Considers critical components and bottleneck resources to narrow down the scope of the work definitions and
ensure that constrained supply can meet strategic needs.

- Sends bills of resources data to the Aggregate Bill of Resources table in the output simulation set (not Plan
Inputs) that you can associate with a sales and operations plan.

Note: You can also upload the bills of resources entity by using the file-based data import (FBDI) template,
ScpBillOfResourcesimportTemplate.xIsm. To create bills of resources at the category level, you must use the FBDI
import template.

You can schedule and automate the Create Bills of Resources process. For example, define a job set that automates a
scheduled process in which the Create Bills of Resources scheduled process is followed immediately by a batch run plan.

After you submit the scheduled process, refer to the log file associated with the Create Bills of Resources Process ID in
Search Results on the Scheduled Processes page.

When the scheduled process completes, you can open the Aggregate Bill of Resources table in the output simulation set
to review and modify the process output.
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How You Create Bills of Resources

This topic provides information to run the Create Bills of Resources scheduled process. The Create Bills of Resources
scheduled process creates bills of resources for planning manufactured items in a sales and operations plan.

Create Bills of Resources Scheduled Process Prerequisites

Before you can run the Create Bills of Resources scheduled process, you must do the following:

1.

Identify assembly and subassembly items.

You must first identify which assembly items to consider in the Create Bills of Resources process. Mark critical
assembly and subassembly items in manufacturing organizations using the Critical Component attribute

in the Items table in an input simulation set, unless already set in plan inputs. You can use the Make or Buy
attribute to filter for make items in the ltems table.

Your selections must also include manufactured subassembly items that must be modeled with separate bills of
resources for aggregate planning. For example, a subassembly consumed in an assembly item can have its own
bill of resources if it has a long manufacturing lead time or it's produced in a different organization.

Identify which component items to include in the bills of resources for your assembly items.

In an input simulation set, use the Critical Component attribute in the Items table to mark critical component
items consumed in manufacturing organizations, unless already set in plan inputs. The Critical Component
item attribute can be marked and collected from a Fusion source. You can use the Make or Buy attribute to
filter for buy items in the Items table.

A subassembly consumed in an assembly item should be modeled as a component in the assembly item's bill
of resources.
Identify resources to include in the bills of resources in your assembly items.

Mark resources as critical in manufacturing organizations using the Bottleneck attribute in the Resources table
in the input simulation set, unless already set in plan inputs.

Configure the Create Bills of Resources Scheduled Process

Use these steps to configure the Create Bills of Resources Scheduled Process.

1.

Open the Process Details dialog box for the Create Bills of Resources scheduled process.

From the Bills of Resources drop-down list, select the Item Level for Aggregate Planning predefined template
to generate bills of resources.

Optionally, if you have already created a sales and operations plan, select the plan to automatically populate
fields for the scheduled process.

In the Organizations section, select the source system and level members to use. You must select at least one
level member.

In the ltems section, select the catalog, level, and level members to use.

o Oracle recommends that you select the level that's the category parent of the item.
o You must select at least one level member.
In the Input Parameters section, select parameters for the following:
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o

Assignment Set: Select the assignment set for the scheduled process to use.

Oracle recommends that the catalog selected in the Items section is also used for sourcing assignments
configured in the assignment set.

Input Simulation Set: Select the name of the input simulation set for the Create Bills of Resources
scheduled process to use. An input simulation set is a set of adjustments to plan inputs read by the
scheduled process, such as defining a resource as Bottleneck or a component as Critical.

Attribute Used to Include Components: Select Critical Components to use in the scheduled process. If
the planning bills of resources don't include components, select Do no include components.

Attribute Used to Include Resources: Select Bottleneck to use in the scheduled process. If only
components are constrained, select Do not include resources.

7. Inthe Output Parameters section, select parameters for the following:

o

o

Bill of Resources Structure: For Sales and Operations Planning, the resource structure is only within a
single organization.

The item assembly can only be defined within a single organization. For example, an assembly item is
made in Location1 and a subassembly item used by the assembly item is made in Location2. You need
separate bills of resources for each item-organization, one for the assembly item made in Location1 and
another for the subassembly item in Location2. The subassembly made in Location2 is modeled as a
component used in the assembly item's bill of resources in Location?.

Planning Product Level: If using the Item Level for Aggregate Planning template, the planning product
level is set to Item.

Bills of resources at a category level must be collected through the file-based data import process.

Output Simulation Set: You must select an output simulation set to contain the bills of resources created
during the scheduled process. The output simulation set can be the same as the input simulation set.

8. Submit the scheduled process.
Refer to the log file associated with the Create Bills of Resources Process ID in Search Results on the Scheduled
Processes page.
When the scheduled process completes, you can open the Aggregate Bill of Resources table in the output
simulation set to review and modify the process output

How Bills of Resources are Generated

This topic provides some examples of how bills of resources are generated by the Create Bills of Resources scheduled

process.

The following table displays the full supply chain bill and the critical status that we'll use in Example 1and Example 2:

ORG

M1

M1

Assembly Component Resource Critical Usage Quantity Resource

Quantity
AS301 CM153 n/a Y 1 n/a
AS301 n/a R1 N n/a 01
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ORG Assembly Component Resource Critical Usage Quantity Resource
Quantity

M1 AS301 n/a R2 N n/a 0.2

M1 AS301 SB1M n/a Y 2 n/a

M1 AS301 SB112 n/a N 1 n/a

M1 SB112 CM201 n/a N 1 n/a

M1 SB112 CM202 n/a N 1 n/a

M1 SB11 CM364 n/a N 1 n/a

M1 SB111 CM365 n/a N 1 n/a

M1 SB1M n/a R3 N n/a 015

M1 SB1M n/a R4 Y n/a 0.25

Example 1: Single Bill of Resources in a Manufacturing Organization

In this example, a bill of resources is created from a multiple-level bill in a single manufacturing organization where:

ORG

M1

M1

M1is the manufacturing organization

AS301is an assembly item and marked as a Critical Component in the Items table

CM153 is a component used in AS301 and marked as a Critical Component in the ltems table
SB111is a subassembly with 2 units used in AS301

R4 is a resource with 0.25 hour used per unit in SB111 and marked as a Bottleneck in the Resources table

Assembly Components Resource Usage Quantity Resource Quantity
AS301 CM153 n/a 1 n/a
AS301 n/a R4 n/a 0.5

Note that the Resource Quantity for resource R4 is 0.5 hour. Two units of subassembly SB111 are required, even though
the subassembly isn't included in the bill of resources.
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Example 2: Multiple Bills of Resources in a Manufacturing Organization

In this example, bills of resources are created from a multiple-level bill in a single manufacturing organization where:

M1is the manufacturing organization

- AS301is an assembly item and marked as a Critical Component in the Items table

- CM153is a component used in AS301 and marked as a Critical Component in the Items table

- SB111is a subassembly with 2 units used in AS301 and is marked as a Critical Component in the Items table
R4 is a resource with 0.25 hour used per unit in SB111 and marked as a Bottleneck in the Resources table

ORG Assembly Components Resource Usage Quantity Resource Quantity
M1 AS301 CM153 n/a 1 n/a
M1 AS301 SB1M n/a 2 n/a
M1 SB111 n/a R4 n/a 25

Note that the Resource Quantity for resource R4 is .25 hour in the bill of resources for subassembly SB111.

Example 3: Multiple Bills of Resources in Multiple Manufacturing
Organizations

In this example, multiple bills of resources are created for multiple manufacturing organizations where:

- AS301is an assembly item and marked as a Critical Component in the Items table
- CM153is a component used in AS301 and marked as a Critical Component in the Items table

- SB111is a subassembly with 2 units used in AS301 and is marked as a Critical Component in M1and S1in the
Items table

R4 is a resource with 0.25 hour used per unit in SB111 and marked as a Bottleneck in the Resources table

The following table displays the full supply chain bill and the critical status that we'll use in this example:

ORG Assembly Component Resource Critical Usage Quantity Resource
Quantity

M1 AS301 CM153 n/a Y 1 n/a

M1 AS301 n/a R1 N n/a 01

M1 AS301 n/a R2 N n/a 0.2

M1 AS301 SB111 n/a Y 2 n/a

M1 AS301 SB112 n/a N 1 n/a
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ORG Assembly Component
M1 SB112 CM201

M1 SB112 CM202

S1 SB1M CM364

S1 SB111 CM365

S1 SB1M n/a

S1 SB1M1 n/a

Resource

n/a

n/a

n/a

n/a

R3

R4

Critical

Usage Quantity

n/a

n/a
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Resource
Quantity

n/a

n/a

n/a

n/a

015

0.25

Subassembly SB111is produced in organization S1and transferred to M1 where it's a component in assembly AS301. In
this case, the bill or resources for subassembly SB111is created in organization S1instead of M1:

ORG Assembly

M1 AS301 CM153
M1 AS301 SB1M
S1 SB1M n/a

Setups to Generate a Production Plan

Components

Usage Quantity

Resource Quantity

n/a

n/a

25

This topic explains required setups to generate a production plan in your sales and operations plan. Note the following

points:

- Create bills of resources for assembly items using the Create Bills of Resources scheduled process. If an
assembly item consumes a manufactured subassembly as a component item, then that subassembly must also
have its own bill of resource. Verify bill of resource data in the Aggregate Bill of Resource table in the simulation

set that contains the process output.

Alternatively, you can load bill of resource data by using the file-based data import (FBDI) template for Supply
Chain Planning Bill of Resources (ScpBillOfResourcesimportTemplate.xlsm). Verify collected bill of resource

ORACLE

134



Oracle Fusion Cloud SCM Chapter 6
Using Sales and Operations Planning Bills of Resources

data in the Aggregate Bill of Resource table in Plan Inputs. If you plan some assemblies at the category level,
then you must load bill of resource data from flat files.

After you run a plan to refresh with current data, open the Aggregate Bill of Resource table to verify the bill of
resource data.

« Resources are modeled in the bill of resources. If a resource isn't used in any bill of resources, then it's not
included in the plan.

Consider modeling only critical resources to simplify your bill of resources.

- Oracle recommends that you start with an unconstrained plan before turning on resource and supplier capacity
constraints in the Supply tab of plan options. If resources are heavily overloaded, then you should review the
loaded resource availability.

In a constrained plan, resource available capacity is constrained at the work center level. Resource availability
for a work center is the sum of the resource availability for its individual resources modeled in the bill of
resources.

Constrained supplier items must be defined in the Approved Supplier List (ASL). Verify these supplier items in
the Suppliers table in Plan Inputs and in your sales and operations plan.

- Make at sourcing rules are required for assembly and manufactured subassembly items.

Review the effective dates for sourcing rules. No production can occur prior to the effective start date. If a
sourcing rule has an effective end date that doesn't span a plan horizon, then it's possible for early production
and inventory prebuilding.

- Transfer from sourcing rules must be assigned in the plan's assignment set to create shipping lanes between
organizations.

- If you plan some assemblies at the category level, Make at and Transfer from sourcing rules must be assigned
at the category level in the plan's assignment set.

To transfer aggregate items, you must define at least one bill of resource record for a category level bill of
resource per inventory organization. This requirement also applies to purchased items that are planned at the
category level.

- Aggregate supply planning uses the End Item Demand measure specified in the demand schedule.

Review the End Item Demand field in Supply Plan Input in the Supply tab of plan options. By default, the
Consensus Forecast measure is used as the demand schedule. If you created a new demand forecast measure
and must use it for the demand schedule, then ensure that it's added to the End Item Demand measure group
on the Manage Planning Measures page.

Review the Net Demand measure in a plan table. This measure displays the higher quantity between sales
orders and demand schedule measure.

- Check for warning messages related to possible data set up issues in the Review Plan Messages table or on the
Manage Plans page.
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7 Planning Analytics

Overview of Planning Analytics

Configuring planning dimensions and hierarchies on the Configure Planning Analytics page is a key setup to use the
analytics in Supply Chain Planning work areas.

It has a unified dimensional hierarchy for various uses. Depending on your security privilege, you can also open the
Configure Planning Analytics page from the Setup and Maintenance work area by selecting the following:

- Offering: Supply Chain Planning
Functional Area: Supply Chain Planning Configuration
- Task: Configure Planning Analytics

To run plans successfully, you must complete the following Configure Planning Analytics tasks:

- Set Up Dimension Catalogs
- Set Up Measure Catalogs
- Set Up Levels and Attributes

You can use the default hierarchies for most of the dimensions.

If the default product catalog named Product is not collected, then you must select at least one product hierarchy. If a
default product catalog is collected, then the predefined Product hierarchy is selected as a product hierarchy by default.
You can optionally add or change the product hierarchy. You must include at least one product hierarchy when creating
a dimension catalog.

On the Configure Planning Analytics page, Levels and Attributes tab, you can configure your planning table and graphs
to display descriptions instead of codes for the following entities: Items, Organizations, Resource, Work Center, and
Work Area.

Related Topics
- Considerations for Setting Up Dimension Catalogs

- Configure Planning Analytics

» How You Use Dimensions and Dimension Catalogs in Supply Chain Planning
« How You Use Levels and Attributes in Supply Chain Planning

« Can | modify the default dimension catalog?

How You Create Bills of Resources

This topic provides information to run the Create Bills of Resources scheduled process. The Create Bills of Resources
scheduled process creates bills of resources for planning manufactured items in a sales and operations plan.
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Create Bills of Resources Scheduled Process Prerequisites

Before you can run the Create Bills of Resources scheduled process, you must do the following:

1.

Identify assembly and subassembly items.

You must first identify which assembly items to consider in the Create Bills of Resources process. Mark critical
assembly and subassembly items in manufacturing organizations using the Critical Component attribute

in the Items table in an input simulation set, unless already set in plan inputs. You can use the Make or Buy
attribute to filter for make items in the ltems table.

Your selections must also include manufactured subassembly items that must be modeled with separate bills of
resources for aggregate planning. For example, a subassembly consumed in an assembly item can have its own
bill of resources if it has a long manufacturing lead time or it's produced in a different organization.

Identify which component items to include in the bills of resources for your assembly items.

In an input simulation set, use the Critical Component attribute in the Items table to mark critical component
items consumed in manufacturing organizations, unless already set in plan inputs. The Critical Component
item attribute can be marked and collected from a Fusion source. You can use the Make or Buy attribute to
filter for buy items in the Items table.

A subassembly consumed in an assembly item should be modeled as a component in the assembly item's bill
of resources.

Identify resources to include in the bills of resources in your assembly items.

Mark resources as critical in manufacturing organizations using the Bottleneck attribute in the Resources table
in the input simulation set, unless already set in plan inputs.

Configure the Create Bills of Resources Scheduled Process

Use these steps to configure the Create Bills of Resources Scheduled Process.

1.
2.

Open the Process Details dialog box for the Create Bills of Resources scheduled process.

From the Bills of Resources drop-down list, select the Item Level for Aggregate Planning predefined template
to generate bills of resources.

Optionally, if you have already created a sales and operations plan, select the plan to automatically populate
fields for the scheduled process.

In the Organizations section, select the source system and level members to use. You must select at least one
level member.

In the ltems section, select the catalog, level, and level members to use.

o Oracle recommends that you select the level that's the category parent of the item.

o You must select at least one level member.
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6. Inthe Input Parameters section, select parameters for the following:
o Assignment Set: Select the assignment set for the scheduled process to use.

Oracle recommends that the catalog selected in the Items section is also used for sourcing assignments
configured in the assignment set.

o Input Simulation Set: Select the name of the input simulation set for the Create Bills of Resources
scheduled process to use. An input simulation set is a set of adjustments to plan inputs read by the
scheduled process, such as defining a resource as Bottleneck or a component as Critical.

o Attribute Used to Include Components: Select Critical Components to use in the scheduled process. If
the planning bills of resources don't include components, select Do no include components.

o Attribute Used to Include Resources: Select Bottleneck to use in the scheduled process. If only
components are constrained, select Do not include resources.

7. Inthe Output Parameters section, select parameters for the following:

o Bill of Resources Structure: For Sales and Operations Planning, the resource structure is only within a
single organization.

The item assembly can only be defined within a single organization. For example, an assembly item is
made in Location1 and a subassembly item used by the assembly item is made in Location2. You need
separate bills of resources for each item-organization, one for the assembly item made in Location1 and
another for the subassembly item in Location2. The subassembly made in Location2 is modeled as a
component used in the assembly item's bill of resources in Location?.

o Planning Product Level: If using the Item Level for Aggregate Planning template, the planning product
level is set to Item.

Bills of resources at a category level must be collected through the file-based data import process.
o Output Simulation Set: You must select an output simulation set to contain the bills of resources created
during the scheduled process. The output simulation set can be the same as the input simulation set.
8. Submit the scheduled process.

Refer to the log file associated with the Create Bills of Resources Process ID in Search Results on the Scheduled
Processes page.

When the scheduled process completes, you can open the Aggregate Bill of Resources table in the output
simulation set to review and modify the process output

Configure Planning Analytics

To run plans successfully, you must set up dimensions and dimension catalogs, measure catalogs, and levels and
attributes.

You can open the Configure Planning Analytics task from one of the Supply Chain Planning work areas. Depending on
your security privilege, you can also open the Configure Planning Analytics page from the Setup and Maintenance work
area.

Note: Default Catalog is the name of the predefined dimension catalog. It contains predefined hierarchies. Oracle
recommends that you make a copy of the Default Catalog if changes are required, instead of editing the default
catalog.
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To configure planning analytics:

1. In the Navigator, click one of the Supply Chain Planning work areas or click the Setup and Maintenance work
area.

o If you clicked one of the Supply Chain Planning work areas, do the following:

i. Click the Tasks panel tab.
ii. Inthe Tasks panel drawer, click the Configure Planning Analytics link.
o If you clicked the Setup and Maintenance work area, select the following:

- Offering: Supply Chain Planning
- Functional Area: Supply Chain Planning Configuration
- Task: Configure Planning Analytics
2. On the Configure Planning Analytics page, Dimension Catalogs tab, do the following:

a. Create a dimension catalog using the Add Row button, or duplicate the default dimension catalog using
the Duplicate button.

b. Specify what hierarchies to use in the dimension catalog by moving hierarchies from the Available pane
to the Selected pane.

c. Assign the dimension catalog to a plan that will use the set of hierarchies for analysis during the plan
creation from Manage Plans.

3. Each Supply Chain Planning work area has a default measure catalog. Create a new measure catalog to add or
remove measures.

a. Use the Add Row button to create a new catalog or use the Duplicate button to duplicate an existing
catalog.

b. Specify the measures for the catalog by moving the measures from the Available pane to the Selected
pane.

c. Assign the measure catalog to a plan that will use the set of measures during the plan creation from
Manage Plans.

After you create and define a measure catalog, you can select the measure catalog for a plan from the Edit Plan
Options page.
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4. C(lick the Levels and Attributes tab and select the desired dimension and hierarchy.

e ngoo

In the Dimension list, select a dimension.
Optionally, in the Hierarchy list, select a hierarchy.

Click the Search icon button.

To change how the level name appears in pivot tables and graphs, select the row and enter the level

name in the Level Name to Display field.

Note: You can't edit the Level Name to Display field for the lowest level of the hierarchy.

e. Todisplay a particular member identifier in your tables and graphs, select a dimension (Product,
Organization, or Resource) and level, and then select a value in the Member Identifier to Display

column:

Dimension

Product

Organization

Resource

Resource

Resource

Resource

Time

Time

ORACLE

Level

Item

Organization

Resource

Work Center

Work Area

Organization

Quarter

Month

Member Identifier to Display Options

Item Name, Item Description, ltem Name
and Description, or Item Description and
Name

Organization Name or Organization Code

Resource Code, Resource Name, or
Resource Description

Work Center Code, Work Center Name, or
Work Center Description

Work Area Code, Work Area Name, or
Work Area Description

Organization Name or Organization Code

Quarter Name or Start Date

The display name you configured on
this page appears for quarter name on
the Fiscal, Manufacturing, and Hybrid
calendars.

Month Name or Start Date

The display name you configured on
this page appears for month name on
the Fiscal, Manufacturing, and Hybrid
calendars.
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Dimension Level Member Identifier to Display Options

Tip: The organization level in the Organization dimension and the organization level in the Resource
dimension are separate settings. Oracle recommends that you set them to use the same identifier.

f. To add an attribute for the lowest level of the hierarchy, click the Edit Page button in the Attributes
column.

i. Inthe Manage Attribute List dialog box, click the Add Row button.
ii. Inthe Attribute list, select an attribute.
iii. Inthe Attribute Label text box, enter a label name and click OK.
5. Onthe Configure Analytics page, click the Save and Close button.

Related Topics
» How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

- Considerations for Setting Up Dimension Catalogs

« How You Use Levels and Attributes in Supply Chain Planning
« Overview of Planning Analytics

» How You Use Measure Catalogs in Supply Chain Planning

Dimensions and Dimension Catalogs

How You Use Dimensions and Dimension Catalogs in Supply
Chain Planning

Oracle Fusion Cloud Supply Chain Planning has hierarchy levels by which you can view, compare, and analyze demands
and supplies of your products over various dimensions, such as geography and organizations.

Oracle Supply Chain Planning uses a single set of dimensions and hierarchies to drive aggregation context for demand
planning, supply planning, embedded analytics, and management analytics.

Oracle Supply Chain Planning provides predefined planning dimensions. Each of those dimensions has a predefined
hierarchy. When you implement the Oracle Supply Chain Planning offering, you must decide which dimensions and
hierarchies to use for demand and supply analysis.

Each dimension catalog has a collection of hierarchies in different dimensions that is enabled for use in the plan
options. By default, all predefined hierarchies are available in Planning Analytics. You can disable certain dimensions
that are not relevant for your plans. For example:

If you are only using demand plans, then supplier, resource, and order type dimensions may not be relevant
If you are using sales and operations plans, then the order type dimension is not relevant
The following hierarchies are predefined in Oracle Supply Chain Planning:

- Customer
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Demand Class
Exception Type

- Order Type

- Organization

Plan
Product
Resource

- Supplier

- Source

.« Time

Access the Configure Planning Analytics page from a Supply Chain Planning work area. Depending on your security
privilege, you can also open the Configure Planning Analytics page from the Setup and Maintenance work area.

- To access the Configure Planning Analytics page from a Supply Chain Planning work area:

a. Click the Tasks panel tab.
b. Inthe Tasks panel drawer, click the Configure Planning Analytics link

- To access the Configure Planning Analytics page from the Setup and Maintenance work area, select the

following:
o Offering: Oracle Supply Chain Planning

o Functional Area: Supply Chain Planning Configuration
o Task: Configure Planning Analytics

In the Dimension Catalogs tab, several hierarchies are available in various dimensions. You can specify which hierarchy
to use in a particular dimension catalog. For example, you can select an organization type hierarchy, a product type
hierarchy, or a customer hierarchy to use in plans for analysis. After you define a dimension catalog, you can assign it to
a plan that will use the set of hierarchies for analysis.

You can select one of your dimension catalogs to be used as the default dimension catalog in plans. If you do not select
a default catalog, the predefined catalog named Default Catalog is used.

Related Topics

Considerations for Setting Up Dimension Catalogs

How can | use dimensions in Supply Chain Planning?

Overview of Planning Analytics

What's a dimension in Supply Chain Planning?

Why You Disable or Enable Dimensions for Supply Plan Measures

Considerations for Setting Up Dimension Catalogs

Oracle Fusion Cloud Supply Chain Planning provides predefined planning dimensions and each of those dimensions
have predefined hierarchies. The predefined hierarchies are included in the default dimension catalog and are available
in all plans.
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Hierarchy Selections for the Product Dimension

A predefined product hierarchy is included in the default dimension. The default product hierarchy has three fixed
levels: Item, Category 1, and Category 2. Other product hierarchies (other item catalogs in Oracle Product Model that are
collected into Supply Chain Planning work areas) can be optionally enabled as user-defined product hierarchies.

For Oracle Sales and Operations Planning, the Lifecycle Phase attribute is also included in the default dimension.

By default, Product Model's planning functional area catalog is collected into the product hierarchy. For the collection to
run successfully, you must create the planning functional area catalog in Product Model with the following attributes:
- Controlled at = Master-Level (not Org-Level)
- Allow hierarchy of categories = No
Default category must be selected
- Allow multiple item category assignments = Not selected

- Catalog Content = Items at Leaf Level

If this catalog is not set up with these attributes, the planning functional area catalog is not collected and the Product
hierarchy will not be populated. This will result in the forecasting engine not being able to use the product aggregation
and some of the predefined tables and graphs will not work correctly.

Hierarchy Selections for the Organization Dimension

Enterprise is the default organization hierarchy and has three fixed levels: Organization, Business Unit, and Legal Entity.
This default organization is defined in Oracle Fusion Cloud HCM and you can only modify it there. Optionally, you can
enable other Organization hierarchies (based on regions, one per country).

Hierarchy Selections for the Customer Dimension

The default Customer hierarchy has three fixed levels: Customer site, Customer, and Customer Class. This default
customer hierarchy is defined in the trading community model and you can only modify it there.

Hierarchy Selections for the Resource Dimension

The default Resource hierarchy has four fixed levels: Resource, Work Center, Work Area, and Organization. This default
resource hierarchy is defined in Oracle Manufacturing and you can't modify it.

Hierarchy Selections for the Supplier Dimension
The default Supplier hierarchy has two fixed levels: Supplier Site and Supplier.

Hierarchy Selections for the Exception Type, Order Type, and Source Dimensions

Predefined Exception Type, Order Type, and Source dimensions are included in the Default dimension catalog. Each has
only a single hierarchy with a single level.

Hierarchy Selections for the Time Dimension

In the Time dimension, Gregorian calendar is the only predefined hierarchy. All other hierarchies can be optionally
included as user-defined hierarchies. These include workday calendars of inventory organizations collected from Oracle
Fusion Cloud Supply Chain & Manufacturing and fiscal calendars from Oracle Fusion Cloud Financial Management.
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Related Topics
» How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

» How can | use dimensions in Supply Chain Planning?

« Can | modify the default dimension catalog?

« Overview of Planning Analytics

« Why You Disable or Enable Dimensions for Supply Plan Measures

What's a dimension in Supply Chain Planning?

A dimension is a structure that organizes data. It categorizes data to enable you to answer business questions.
Commonly used dimensions are customers, products, and time.

Related Topics
- Configure Planning Analytics

» How can | use dimensions in Supply Chain Planning?
- How You Use Dimensions and Dimension Catalogs in Supply Chain Planning
« Considerations for Setting Up Dimension Catalogs

How can | use dimensions in Supply Chain Planning?

Oracle Fusion Cloud Supply Chain Planning applications come with predefined hierarchies in the Product dimension.

These predefined hierarchies are part of the Dimension catalog structure in Oracle Product Model. Integrations with
Oracle E-Business Suite and third-party systems where the product dimensions can still be maintained and uploaded
for use by the Oracle Supply Chain Planning applications is supported.

Related Topics
» How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

- Considerations for Setting Up Dimension Catalogs
« What's a dimension in Supply Chain Planning?

What's a dimension catalog in Supply Chain Planning?

In Oracle Fusion Cloud Supply Chain Planning, a dimension catalog is a selected list of dimensions enabled for use in
plans.

In Oracle Supply Chain Planning, a dimension catalog is a selected list of hierarchies in different dimensions that is
enabled for use in plans. The Default dimension catalog appears by default, but can be changed to another dimension
catalog that has been defined.
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Related Topics
« Can | modify the default dimension catalog?

« What's a dimension in Supply Chain Planning?
« Considerations for Setting Up Dimension Catalogs
- How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

Can | modify the default dimension catalog?

Yes, you can modify the Oracle Fusion Cloud Supply Chain Planning default dimension catalog. However, if you want to
make any changes, Oracle recommends that you create a duplicate of the default dimension catalog.

Related Topics
» How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

« Considerations for Setting Up Dimension Catalogs
- What's a dimension catalog in Supply Chain Planning?

Measure Catalogs

How You Use Measure Catalogs

The measure catalog is similar to the dimension catalog.

Each measure catalog has a collection of measures that you can enable for use in plans in one of the Supply Chain
Planning work areas. While Oracle provides predefined measures, you can also create measures in some work areas and
add them to a measure catalog.

On the Configure Planning Analytics page, Measure Catalogs tab, you can create a measure catalog and add or remove
measures from a measure catalog.

The predefined measure catalog is the default. When you create a new plan, the measure catalog that is used is based
on the catalog check box located on the Measure Catalogs tab. For example, the catalog check box in the:

Planning Central work area is Planning Central Catalog

- Sales and Operations Planning work area is Sales and Operations Planning Catalog
Demand Management work area is Demand Management Catalog

- Supply Planning work area is Supply Planning Catalog

If you change the default catalog later, the plan continues to use the same measure catalog that it was created with.

Related Topics
« Can | modify the default measure catalog?
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Can | modify the default measure catalog?

No. Although you cannot modify the default measure catalog, you can create a measure catalog, modify the list of
measures, and assign it to plans on the Plan Options page.

Related Topics
» How You Use Measure Catalogs in Supply Chain Planning

Levels and Attributes

How You Use Levels and Attributes

On the Levels and Attributes tab, you can enable certain item attributes (standard fields or flexfields) and organization
attributes (standard fields) to be available in Planning Analytics as filters.

For example, you can enable PLANNER_CODE to use in an analysis to group metrics and measures by that particular
attribute.

You can create a display name to use in the various pivot tables and graph configurations. For example, if the
predefined level name is Product Category 2, you can enter a display name of Laptops. You can also configure which
identifier to display in tables and graphs for selected hierarchies. For example, you can choose to display item name or
item description in your tables and graphs.

Displaying Descriptions in Tables and Graphs

You can analyze planning data in planning tables and graphs by using the description fields of selected entities in
hierarchies, such as items and organizations. You can use the description fields when their primary identifier is a difficult
to understand alphanumeric code.

For each dimension level (Item, Organization, Resource, Work Center, or Work Area) you can select only one member
identifier option to display in a planning table or graph. To see a list of the Member Identifier to Display options, refer to
the Configure Planning Analytics topic in this guide.

Tip: The organization level in the Organization dimension and the organization level in the Resource dimension are
separate settings. Oracle recommends that you set them to use the same identifier.

Changing a member identifier can impact the advanced criteria in tables and graphs. If you use an advanced filter
criteria in a table or graph, then the criteria will be compared to the new member identifier, which can affect the search
results. The change to the member identifier can result in different or no members meeting the filter criteria. For
example, many names might start with AB, but no descriptions start with AB. After you make this change, you should
verify that any advanced filter criteria used are still valid.
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Note: In the Selector Tool, the member values displayed are based on what's configured in the Member Identifier to
Display column on the Configure Planning Analytics page, Levels and Attributes tab. For example, for item, you can
configure your tables and graphs to show item description instead of item name, which is what also appears when
you're in the Selector Tool.

Related Topics
» Overview of Planning Analytics

 Configure Planning Analytics

User-Defined Hierarchies

Overview of User-Defined Hierarchies

You can create and update user-defined hierarchies for your demand, demand and supply, sales and operations, or
supply plan using the file-based data import (FBDI) template named Supply Chain Planning User-Defined Hierarchy
(ScpUser-DefinedHierarchylmportTemplate.xlsm).

You can do the following using the import template:
- Create a user-defined hierarchy for these dimensions:
o Customer
o Demand Class
o End Demand Organization
o End Demand Product
o Organization
o Product
o Resource
o Sales Organization
o Supplier

- Add members to or remove members from an existing level in the user-defined hierarchy.

Modify the user-defined hierarchy by adding or deleting levels.
Delete the user-defined hierarchy.

Note: After creating your user-defined hierarchy, you can’t rename its levels and level members.

Related Topics
« Create a User-Defined Hierarchy

« Add or Remove Members
« Add or Delete Levels
» Delete a User-Defined Hierarchy
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Create a User-Defined Hierarchy
You can’t create a user-defined hierarchy with only the lowest level.
To create the user-defined hierarchy, do these steps:

1. In the Supply Chain Planning User-Defined Hierarchy import template (ScpUser-
DefinedHierarchylmportTemplate.xlsm), enter the structure of the user-defined hierarchy on the User-
DefinedHierarchyMaster_ worksheet.

The lowest level for each supported dimension is LEVEL_O, and the name for this level is predefined and can’t be
changed. The highest-possible level is LEVEL_10.

If the hierarchy is for the Product dimension, you can enter Yes in the Default Indicator column to enable the
hierarchy by default in the Selector Tool.

Enter the details of the level members on the User-DefinedHierarchyDetail_ worksheet.

Generate the .csv files for the import template, and compress them into a single file.

. Click Navigator > Tools > File Import and Export, and import the compressed file.

In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.
a. Inthe Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.

c. In Data File, select the compressed file.

d.

Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined
hierarchies.

6. Click Submit.

The user-defined hierarchy is created.

M oA BN

7. Add the user-defined hierarchy to the dimension catalog that’s used by your plan.

Note: If you've created your demand, demand and supply, or supply plan in the Planning Central work area, add
the hierarchy to the Default Catalog, which is the only dimension catalog that can be used in plans that are created
in this work area.

8. Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog box.

Select other options as required.

9. Modify your selections on the Hierarchies and Members tabs in the Selector Tool for the affected tables and graphs.

Related Topics
« Overview of User-Defined Hierarchies

« Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Add or Remove Members

You can add members to or remove members from any level of your user-defined hierarchy.
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Note these points about adding members to or deleting members from your user-defined hierarchy:

- At the lowest level (LEVEL_0), you can add only those members that have already been collected from your
Oracle Fusion Cloud Application or third-party source system. When you delete members at the lowest level of
your user-defined hierarchy, the deletion is restricted to the user-defined hierarchy, and the members continue
to exist in your source system.

If you're only adding or deleting members at Level_0, you must run the Load Planning Data from Flat Files
scheduled process in the Net change mode.

In the Supply Chain Planning User-Defined Hierarchy import template (ScpUser-
DefinedHierarchylmportTemplate.xlsm), you don't need to enter anything on the User-
DefinedHierarchyMaster_ worksheet or generate the .csv file for this worksheet. On the User-
DefinedHierarchyDetail_ worksheet, you can enter Yes in the Delete Indicator column for the members you're
going to delete.

If you're only adding members to an intermediate level or the top level of your user-defined hierarchy, you must
run the Load Planning Data from Flat Files scheduled process in the Net change mode.

In the Supply Chain Planning User-Defined Hierarchy import template, you don't need to enter anything

on the User-DefinedHierarchyMaster_ worksheet or generate the .csv file for this worksheet. On the User-
DefinedHierarchyDetail_ worksheet, you need to enter only the details for the new members. If required, for the
new members at intermediate levels, you can also enter child members at lower levels.

If you're only deleting members from an intermediate level or the top level of your user-defined hierarchy, you
must run the Load Planning Data from Flat Files scheduled process in the Targeted mode. Effectively, you're
going to delete and recreate the user-defined hierarchy.

In the Supply Chain Planning User-Defined Hierarchy import template, you must enter all the levels on the
User-DefinedHierarchyMaster_ worksheet and all the level members on the User-DefinedHierarchyDetail _
worksheet and generate the .csv files for both worksheets.

You must also delete all members for which you're deleting the parent member. Otherwise, you'll have
orphaned members in your user-defined hierarchy. You can delete the members by not including the applicable
rows on the User-DefinedHierarchyDetail_ worksheet instead of entering Yes in the Delete Indicator column.

To add members to or remove members from levels of the user-defined hierarchy, do these steps:

1.

W

If you previously imported measure values using the Supply Chain Planning Measures import template
(ScpMeasuresimportTemplate.xlsm) for existing members that you're going to delete, delete the measure data for
these members using the same import template.

On the Measures_ worksheet, for the values that you want to delete, enter Yes in the Delete Indicator column.

Generate the .csv file for the import template, and compress it.
Click Navigator > Tools > File Import and Export, and import the compressed file.

. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.

a. Inthe Process Details dialog box, in Source System, select the source system.

b. In Collection Type, select Net change.

c. In Data File, select the compressed file.

d. Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined
hierarchies.

e. Click Submit.

Data is removed for the level members that you're going to delete.
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5. In the Supply Chain Planning User-Defined Hierarchy import template, enter information as required on the User-
DefinedHierarchyMaster_ and User-DefinedHierarchyDetail_ worksheets.

6. Generate the .csv files for the import template, and compress them into a single file.
Click Navigator > Tools > File Import and Export, and import the compressed file.
8. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.
a. Inthe Process Details dialog box, in Source System, select the source system.
b. In Collection Type, make the required selection.
c. In Data File, select the compressed file.
d

Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined
hierarchies.

e. Click Submit.
The members are created or deleted.

~

9. Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog box.

Select other options as required.

10. Add members to or remove members from the Selected Members pane on the Members tab in the Selector Tool for
the affected tables and graphs.

Related Topics
« Overview of User-Defined Hierarchies

« Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Add or Delete Levels

If you want to make changes to the levels of an existing user-defined hierarchy, then you must delete and recreate the
entire hierarchy using the Targeted collection type for the Load Planning Data from Flat Files scheduled process.

You can’t delete the lowest level (LEVEL_O) of the user-defined hierarchy.

Note: Oracle doesn’t recommend deleting a level from the user-defined hierarchy if you've loaded or stored data at
that level because level deletion also requires data removal.

To modify the user-defined hierarchy by adding or deleting levels, do these steps:

1. If your measures are storing data for a level that you’re going to delete, delete the level data in these measures using
the Supply Chain Planning Measures import template (ScpMeasuresimportTemplate.xlsm).

On the Measures_ worksheet, for the values that you want to delete, enter Yes in the Delete Indicator column.

If you previously imported measure values for an existing level that’s going to move up or down in your user-defined
hierarchy, you don’t have to reimport measure values for that level because the IDs for the level and level members
remain unchanged.

2. Generate the .csv file for the import template, and compress it.
3. Click Navigator > Tools > File Import and Export, and import the compressed file.
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4. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.
a. Inthe Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.
c. In Data File, select the compressed file.
d.

Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined
hierarchies.

5. Click Submit.
Measure values are deleted.

6. In the Supply Chain Planning User-Defined Hierarchy import template (ScpUser-
DefinedHierarchylmportTemplate.xIsm), enter the levels that must be added or deleted on the User-
DefinedHierarchyMaster_ worksheet.

Consider an example in which your user-defined hierarchy structure for the Organization dimension is Organization
(LEVEL_O), District (LEVEL_1), and Region (LEVEL_2):

o If you want to add a level called State that’s at the highest level, you should enter Organization (LEVEL_O),
District (LEVEL_1), Region (LEVEL_2), and State (LEVEL_3).

o If you want to add a level called Borough that'’s in between Organization and District, you should enter
Organization (LEVEL_0), Borough (LEVEL_1), District (LEVEL_2), and Region (LEVEL_3).

o If you want to delete the District level, you should enter Organization (LEVEL_O) and Region (LEVEL_1).

If the hierarchy is for the Product dimension, you can enter Yes in the Default Indicator column to enable the
hierarchy by default in the Selector Tool.

You don'’t need to enter anything on the User-DefinedHierarchyDetail_ worksheet for the deleted levels. For the
new and modified (existing) levels, you must enter the all the level members on the User-DefinedHierarchyDetail
worksheet.

7. Generate the .csv files for the import template, and compress them into a single file.
Click Navigator > Tools > File Import and Export, and import the compressed file.
9. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.
a. Inthe Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Targeted.
c. In Data File, select the compressed file.
d

Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined
hierarchies.

10.Click Submit.

The user-defined hierarchy is deleted and recreated.

o

11. Using the Supply Chain Planning Measures import template, import measure values for newly added levels if you
need to.

12. Generate the .csv file for the import template, and compress it.
13. Click Navigator > Tools > File Import and Export, and import the compressed file.
14.1n the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.
a. Inthe Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.
c. In Data File, select the compressed file.
d.

Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined
hierarchies.
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15. Click Submit.

Measure values are populated.

16.Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog box.

Select other options as required.

17. Modify your selections on the Hierarchies and Members tabs in the Selector Tool for the affected tables and graphs.

Related Topics
« Overview of User-Defined Hierarchies

» Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Delete a User-Defined Hierarchy

This topic explains how you can delete a user-defined hierarchy.

Across your user-defined hierarchies, the IDs of the lowest levels and their members are the same. You can't delete the
lowest levels, their members, and the measure data that's associated with these members. These members are shared
across your user-defined hierarchies.

The intermediate levels and top level of your user-defined hierarchy are specific to it. These levels and their members
have unique IDs and aren't shared. When you delete the user-defined hierarchy, the intermediate levels and top level
and their members are deleted.

To delete a user-defined hierarchy, do these steps:

1. If your measures are storing data for an intermediate level or the top level that you're going to delete, delete the data
in these measures, and reload them at an existing level of a different user-defined hierarchy using the Supply Chain
Planning Measures import template (ScpMeasuresimportTemplate.xlsm).

On the Measures_ worksheet, make the changes that you require.

2. Generate the .csv file for the import template, and compress it.
Click Navigator > Tools > File Import and Export, and import the compressed file.
4. In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.
a. Inthe Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.
c. In Data File, select the compressed file.
d.

Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined
hierarchies.

5. Click Submit.

Measure values are deleted or populated.

W
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6.

o

In the Supply Chain Planning User-Defined Hierarchy import template (ScpUser-
DefinedHierarchylmportTemplate.xlsm), on the User-DefinedHierarchyMaster_ worksheet, enter the name and level
names of the user-defined hierarchy that you want to delete.

Enter Yes in the Delete Indicator column.

You don’t need to enter anything on the User-DefinedHierarchyDetail_ worksheet or generate the .csv file for this
worksheet.

Generate the .csv file for the import template, and compress it.
Click Navigator > Tools > File Import and Export, and import the compressed file.
In the Scheduled Processes work area, run the Load Planning Data from Flat Files scheduled process.
a. Inthe Process Details dialog box, in Source System, select the source system.
b. In Collection Type, select Net change.
c. In Data File, select the compressed file.
d.

Ignore the fields for organization group collection because this functionality isn’t relevant to user-defined
hierarchies.

10.Click Submit.

n.

12.

The user-defined hierarchy is deleted from dimension catalogs that it exists in.

Note: The user-defined hierarchy is still available in tables and graphs that are using it.

Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog box.
Select other options as required.

The user-defined hierarchy is removed from the tables and graphs of the plan.

Modify your selections on the Hierarchies and Members tabs in the Selector Tool for the affected tables and graphs.

Related Topics

« Overview of User-Defined Hierarchies
» Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets
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8 Planning Measures

Predefined Measures in Supply Chain Planning

When you use one of the Supply Chain Planning work areas, you have access to many predefined measures.

To review the details of each predefined measure, use the following:

- The Manage Planning Measures task
- A spreadsheet available at My Oracle Support

The Manage Planning Measures Task

On the Manage Planning Measures page, select a measure, and then select edit. You can review the details of the
measure on the Edit Measure page even if you can't make changes to the measure.

A Spreadsheet Available at My Oracle Support

Use Doc ID 2374816.1, Oracle Supply Chain Planning Cloud: List of Predefined Measures.

The List of Predefined Measures spreadsheet contains only the core measure attributes. You can use the Edit Measures
page to view all the attributes associated with a particular measure.

How You Manage Planning Measures

Use the Manage Planning Measures task to review Supply Chain Planning measures.

You can edit several measures, but some measures you can only view. You use the pivot table to view the data you
edited at different aggregations. The results of the edits are stored based on definitions of a measure.

This topic discusses how you can perform these tasks:

- Update the definition of a measure

- Update aggregation parameters

- Update disaggregation parameters
Edit data of a measure

Update the Definition of a Measure

To update the definition of a measure:

1. In a Supply Chain Planning work area, click the Tasks panel tab.

2. Inthe Tasks panel, click the Manage Planning Measures link.

3. Expand a measure group and scroll manually or use the search option to find all measures that match the
search criteria.

4. Select the measure that you want to modify and then click the Edit icon.
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Note: Look for a check mark next to Allow editing at the top of the measure definition controls to confirm
that the measure is editable.

5. Click the Aggregation and Disaggregation tab to view measure definitions.

The dimensions, hierarchies, and levels at which data persists vary from measure to measure. For the
dimensions with a check mark, the measure is defined on the current dimension. For these dimensions, each
measure is defined on a single hierarchy as listed on the dialog box.

6. Click Save and Close.

Update Aggregation Parameters

Aggregation parameters control the way in which data of a measure is aggregated from the storage level to a table,
graph, or infotile. Calculation Order enables you to chose between the following options:

- Calculate and Aggregate: Calculates the measure's expression at the lowest data level and then aggregate up.

- Aggregate and Calculate: Aggregates all measures referenced in the measure's expression and then calculate
the expression.

Update Disaggregation Parameters

The disaggregation methodology is driven by the definitions of the disaggregation parameters. Disaggregation for
definitions that include time can be different from disaggregation for definitions that don't include time. For noneditable
measures there are no configuration in the disaggregation parameters.

Here are the four different allocation methods:

- Same: Indicates that all lower-level entries into which the data is being saved will receive the same value.
Service level would be a good measure to use Same Value settings as the percentage being entered should not
be allocated between different items and organizations.

Equal: Spreads the edited value among the lower level entries into which data is being saved. Each entry
receives an equal share of the update. This could commonly be seen on the time dimension, where data may
be updated for a week or month, but there is no guidance on how it should be allocated to the common storage
level of days. It is typically set to the time dimension to equal value to support equal allocation between the
days.

- Self: Uses a measure's own pre-calculated values to allocate the data to the dimension member combinations.
For example, item-organization. The weights for each combination are calculated and stored for the measure
during plan run. These weights are used to allocate the data. For example, the forecasts for P1-Org1 and P2-

Org1lare 40 and 60 respectively. Therefore, the weights used for allocation would be 40% for P1-Orgl and 60%
for P2-Orgl.

Measure: Uses values of a different measure to allocate.

Edit Data of a Measure

To edit the data of a measure, open a table containing the measure, double-click the cell where the data is to be entered
and then enter the data. In a table, editable and noneditable cells look similar. However, when you double-click a cell of
an editable measure, the cell enables you to enter values.
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Copy Data from One Measure to Another

In a Supply Chain Planning table, you can update the value of one measure by using values from another measure. In
several cases, a measure can have other related measures that enable you to override the value of a base measure. For
example, Sales Forecast is one of those measures:

- Sales Forecast: Base measure.
- Adjusted Sales Forecast: You can override what's in Sales Forecast.

- Final Sales Forecast: The planning process takes the Adjusted Sales Forecast, if there is one, or uses the Sales
Forecast. The planning process uses the Final Sales Forecast, which takes into account any manual adjustments
that you made.

You can specify the data source whose values you want to copy to the selected range of cells in the target measure.
Using a table containing the three measures listed in our previous example, select a range of cells associated with the
Adjusted Sales Forecast measure, click Actions and then select Edit. In the Edit Measures dialog box, use the Sales
Forecast measure as the source measure for Adjusted Sales Forecast and increase it by 10 percent. If your Sales Forecast
is 200, then Adjusted Sales Forecast now reflects 220.

For a measure to appear in the list of values for Source Measure in the Edit Measures dialog box, the measure must be
included in the table. The measure must also conform to the same dimensions as the measure you're editing.

When editing a measure's value at an aggregate level, the value is allocated down to the lowest level. For example, when
editing weekly data, the value will be allocated down to the day.

You can also edit multiple measures at a time; however, you can't have circular references. In the following example,
Measure3 is used as a source measure for Measurel. But, Measure3 is also being edited at the same time to increase the
measure by 10 percent.

Measure Source Measure Action Value
Measurel Measure3 Increase by percentage 10
Measure2 Measure2 Increase by percentage 10
Measure3 Measure3 Increase by percentage 10

In this scenario, the planning engine won't know which value of the source measure to use: the original Measure3 value,
or the value of Measure3 after increasing it by 10 percent. To avoid circular references, you must handle these edits
separately.

Related Topics
« Configure Units for a Measure

« Configure Currencies for a Measure
« Configure Conditional Formatting for a Measure
« Configure Color by Measure to Display in Graphs
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Import Measure Data Into a Planning Table

When working with large volumes of data, you can export data from a planning pivot table to Microsoft Excel.

After you export the data, you can edit and make adjustments to any planning measure in the spreadsheet. When
you're done making changes offline in the spreadsheet, you can then import the updated planning data back into the
same table. To initiate the Upload Planning Table Data scheduled process, click the Import icon on the toolbar in the
opened table and then select the spreadsheet.

The spreadsheet that you import must have the same structure and format as the planning table. The imported
spreadsheet can be at any level of aggregation, as long as the levels match all of the levels displayed in the table. After
you select the file to import, the Upload Planning Table Data scheduled process updates the table in the background in
batch mode. While the import process uploads data in the background, you can work on other supply chain planning
tasks. When the upload process completes, the Import icon in the table displays a green check mark for the planner
who uploaded the data.

Note: To see the uploaded data in your planning table, refresh the table after the Upload Planning Table Data
scheduled process completes.

Importing data into planning tables is available for all pivot tables in Supply Planning, Sales and Operations Planning,
Demand Management, Replenishment Planning, and Planning Central. Importing data isn't available for non-pivot
views like standard grids or other views such as the Build Plan table.

Tips for Importing Measure Data

Here are some tips to successfully import data from a spreadsheet into a planning table:

- The imported file must be a Microsoft Excel file with the .xIsx file extension.
- The import process only updates editable measures.

- The imported file must have the exact same format at the planning table. This includes the following:

o The uploaded file and the target table must contain the same number of rows and columns.
o Thelevels specified in the spreadsheet must match. The level names, such as Item or Organization, don't
have to appear as the header columns, but the columns and rows that represent the level must match.

o The members in each of the level rows and columns must be identical and in the same order. No member
can be omitted and new members can't be added.

o The measures column must have the same measures as the planning table for all combinations.

- The imported file must have the exact member combinations and their order listed in the column and row
headers of the table. All member names, such as item names and time periods, must be present in the same
order in the file being imported even if there are no updates for those combinations. Typically, you can achieve
the required order by exporting the table, making the edits offline, and then using the same file for import.

- All date values must be in the correct date format.

If you update data directly in a table when the update process is still in progress, your updates can be
overwritten if they're for the same combination and measure.
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- If multiple users import files into the same table, the import process that finishes last overrides the others. For
planning tables that need frequent updates by multiple users, Oracle recommends that you create different
tables with appropriate filters.

Additional Information about the Import Process

Here's some additional information about importing data into planning tables:

- Tables with page filters aren't enabled for import. To use the table for import, remove the page filter or use
member filters in the table configuration. Filters specified as member filters in the table configuration are
respected.

- The import process evaluates and imports only the first worksheet in the workbook. If the workbook contains
other worksheets, the import process ignores them.

- The worksheet can contain native Excel comments and conditional formatting. The import process ignores
these comments and conditional formatting.

- If a cell has a formula based on another cell, the import process evaluates the formula and uses the result. The
other cell can be in the same worksheet or a different worksheet in the same workbook.

- The import process uses the data security rules assigned to the planner doing the import.

Configure Units for a Measure

You can view a measure in several units of measure (UOM) and currencies side by side without needing separate
measures. By converting a single measure into various values and currencies, you get superior data consistency and
don't require recalculation and data synchronization.

In addition, sometimes different products and organizations have data that's loaded externally using different units of
measure. For example, vitamins sold in Europe may be shipped in bottles, while in Asia the quantities are by pill count.
By defining units, you enable these values to be converted into a cohesive value, which can be aggregated in a seamless
manner.

To configure units for a measure:

In a Supply Chain Planning work area, click the Tasks panel tab.

In the Tasks panel, click Manage Planning Measures.

Locate the measure for which you want to configure units and click Edit.

On the Advanced tab, select the Properties tab.

Select UOM from the list as the default value for the Base Units of Measure.

The base units of measure define the default unit of measure to which displayed data is converted. It is editable
only for numeric measures, which don't have product and organization-based levels. For measures that have
product and organization, the definition comes from the data source. When using the measure, you must
attempt to select only the relevant UOM entries for the measure to streamline the user process.

6. Select the relevant units of measure from the Display Unit of Measure.

You completed defining the unit of measure. You can view the measure using a specific table or graph.

VEWNA

Note: To show the same measure with different unit of measures, you can create a copy from the original measure.
Rename the duplicated measure to use another unit of measure of your choice. You can show the same measure as
both numbers and currencies.
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To override the default unit of measure:

1. Open a table and select View, Format Measures to find the measure.
2. C(lick the measure you want to modify and select the value from the Unit of Measure list.
3. Click Save and Close.

Related Topics
« How You Manage Planning Measures

Configure Currencies for a Measure

You can view a measure in several units of measure and currencies side by side without having separate measures. By
converting a single measure into various values and currencies, you get superior data consistency and don't require
recalculation and data synchronization.

To configure currencies for a measure:

In a Supply Chain Planning work area, click the Tasks panel tab.

In the Tasks panel, click the Manage Planning Measures link.

Locate the measure for which you want to configure currencies and click Edit.
On the Advanced tab, select the Properties tab.

Select Currency from the list as the default value for the Base Currency.

A WN

The base currency defines the default currency to which displayed data is converted and is editable only for
currency type measures.
6. Select the relevant currencies from the Display Currency.

You completed defining the currencies for a measure. You can view the measure using a specific table or graph.

The currency value is editable only if the measure type is Currency. For numeric measures, you can change the type
from Number to Currency. Select the currency that you want to use in this instance of the measure.

Note: To show the same measure with different currencies, you can create a copy from the original measure. Rename
the duplicated measure to use another unit of measure of your choice. You can show the same measure as both
numbers and currencies.

To override the default currency:

1. Open a table and select View, Format Measures to find the measure.
2. Click the measure you want to modify and select the value from the Currency list.
3. Click Save and Close.

Related Topics
» How You Manage Planning Measures
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Configure Conditional Formatting for a Measure

Use conditional formatting to change the background color of a cell when a specific condition occurs.

Conditional formatting is useful to draw the attention of the user for information that requires action. You define
conditions for an individual measure. A measure can have one or more formats applied. The condition is evaluated
at the table level using the configured units and currencies. Two tables with different units of measure or currencies
defined can have different cells trigger the conditional formats.

To configure global conditions:

1. In a Supply Chain Planning work area, click the Tasks panel tab.

2. Inthe Tasks panel, click the Manage Planning Measures link.

3. Locate the measure for which you want to apply conditions and click Edit.
4. Onthe Advanced tab, select the Conditional Formatting tab.

5. Click the + icon to add a row and complete the information.

Field Name Description

Measure Locate the measure you want to use to evaluate. Conditional format for a measure can be based
on another measure.

Condition Compares the selected measure to a value or another measure

Compare to Measure Measure to which the selected measure is compared

Value When the Compare to Measure is empty, this value is used to compare the selected measure
Color Defines the color for the cell background when the condition is met

6. Click Save and Close.
To configure local overrides to conditions:

1. Open a table and select View, Format Measures.

2. Locate the measure that you want to modify and then select the Use Override Conditional Formatting check
box.

3. The Conditional Formatting section appears. Select a new conditional format to use in your table.

4. For only the Build Plan table accessed through a Supply Planning work area, the Conditional Formatting section
also includes the Apply and Name columns.
In the Apply column, select whether you want the conditional formatting to be highlighted in your Build Plan
table all the time or only when you select it from the Highlight Exceptions drop-down list.
For example, if you set up a conditional format named Resource Overload and select When selected, Resource
Overload appears in the Highlight Exceptions drop-down list in your Build Plan.

5. Click Save and Close.
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Related Topics
- How You Manage Planning Measures

Load Measures from Other Plans

Overview of Loading Measures from Other Plans

You can copy data from a plan in one Oracle application to another plan in a different Oracle application. You can also
copy data between measures in the same plan in an Oracle application. When you load measures, you can:

- Copy a stored measure into another stored measure across plans or within the same plan.

- Copy a calculated measure into a stored measure across plans or within the same plan.

By doing so, you can reduce the time taken for calculating and displaying the table or graph that displays the
stored measure.

- Copy a calculated measure into another calculated measure across plans.
- Take snapshots of measure values for comparison at a later time.

You have two options to load measures between plans or within a plan:

- Use the Load Measures from Other Plans task in a Sales and Operations Planning, Demand Management, or
Demand and Supply Planning work area.

This task in turn submits the parent process named Orchestrate Load Measures Processes in the Scheduled
Processes work area.

« Use the process named Orchestrate Load Measures Processes in the Scheduled Processes work area.

The target measure is refreshed only when you run the task or process. Therefore, you should use the task or process
whenever the value of the source measure changes. Usually, you must run the task or process after a plan run with a
data refresh.

The load measures from other plans functionality provides you with visibility of data from a measure across different
planning applications. For example, you can make the constrained forecast from Sales and Operations Planning Cloud
visible to demand planners in Oracle Demand Management Cloud for reference. You can also enable further refinement
of the operations forecast. After you copy a calculated measure into a stored measure, you can perform aggregate or
disaggregate analysis of the tactical planning data.

You can load a source measure to a different target measure. For example, you can load the Constrained Forecast
source measure from a demand and supply plan to a target measure called Tactical Constrained Forecast in an
aggregate sales and operations plan. Then you can compare the aggregate constrained forecast with the tactical
constrained forecast to drive effective decision-making.

Additionally, you can create measure mappings and save them to a measure copy set to reuse in subsequent scheduled
process runs. You can modify measure mappings in an existing measure copy set. By using measure copy sets, you can
quickly submit the scheduled process.
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Specify Time Range When Loading Measures From Other Plans

You can specify the time range when copying the measure data between plans. You can include either the entire or a
specific time range. You can copy the measure data for the past and future periods to support period-to-date reporting
and analysis.

The context of the copy is based on the target plan. If you copy the data between different plans, the Copy Time Level

is the higher time level of the two plans. For example, you want to copy the measure data from a Demand Management
plan at a hybrid time level to a Sales and Operations plan at a monthly time level. Here, the data is copied at the higher
time level, that is, the monthly level. However, if you copy the measure data from a Sales and Operations plan at a
monthly time level into a Demand Management plan at a daily or hybrid time level, the data is copied at the month level.
Once this data gets copied, it gets disaggregated to the daily or hybrid time level.

If you copy the data in the same plan, the Copy Time Level is the planning time level of the plan.

For example, you have the following sales and operations plan with a monthly time level and need to copy the measure
data from a calculated measure to a stored measure within the same plan. The plan start date is November 2, 2022, and
the current date is November 14,2022.

Current Date
Plan Start

Past Future

From Plan Aug- Sep- Dec-
2022 2022 2022
Enterp rise Forecast

Month Month Month Month Month Month

To Plan (same) Aug
2022

Enterprise Forecast

Stored

- Suppose the source forecast measure spans both forecast and history. You must use a negative value when you
select the past time period. Specify -1to identify the month prior to the current, that is, October 2022. Set the
Time Level Range End as 24 to include the entire future in the monthly range.

- Suppose the source forecast measure spans the forecast, specify Time Level Range Start as 1. The measure
values in the November 2022 period are copied from the plan start rather than from the current date forward.

I Note: Enter the time range start and end values that are nonzero integers.

Source and Target Measure Mapping
Here's some additional information about source and target measure mapping:

- When you're copying measure data between plans, if the target plan's measure catalog contains a measure
with the same name as the source measure, it's automatically selected as the target measure. If a measure
with the same name as the source measure isn't available in the target plan's measure catalog, then you must
manually select the target measure.
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- If none of the target measures is shared, only forecast data is copied. If at least one target measure is shared,
both forecast and historical data are copied.

- When you copy data from a calculated measure to a stored measure, select a calculated measure for which the
resulting value doesn't change often.

Calculated measures that use collected, historical data are good choices as source measures. Calculated
measures that change when you generate a forecast or do a manual override aren't good choices as source

measures.

- When you want to copy data from a calculated measure to a stored measure, you can duplicate the calculated
measure to create the stored measure. Remove the calculations from the copy, and retain the other settings.

- You can't use a source measure in more than one mapping row of a measure copy set. Also, you can't use a
target measure in more than one mapping row of a measure copy set.

- Source and target measures can be predefined or user-defined.

This table summarizes how the list of available target measures is determined and displayed:

When

The source and target plans are the same

- The source and target plans are the
same

- The source and target plan types are
different

ORACLE

Then

The source measure isn't available for selection because the source measure and target measure
must be different.

No calculated measures are available for selection.

The available target measures are of the same type as the source measure.
The available target measures are in the measure catalog of the target plan.

The available target measures have the same calculation order for aggregation as the source
measure.

If the source measure is stored, then only stored or editable measures are available as the target
measures.

If the source measure is calculated, then the available target measures are:

Stored or editable

Calculated and with the same dependent measures as the source measure when the source plan
and target plan types are different

In this case, the dependent measures are in the measure catalog of the target plan, and one of the
dependent measures must be stored or editable.

The available target measures have at least one hierarchy level in common with the source
measure.

If the source measure contains the Day level of the Time dimension, then the available target
measures must also contain the Day level of the Time dimension.

The available target measures can be shared.

If the planning time level of the target plan is higher than a day, then the available target
measures can be shared.

If the planning time level of the target plan is a day, then the available target measures can't be
shared.

The available target measures aren't archived.
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Source and Target Plan Type Mapping

When the planning time level of the source plan is Day, the target plan can have any planning calendar and planning
time level.

When the planning time level of the source plan isn't Day, the target plan is selected as follows:
- If the planning time level of the target plan is Day, the planning calendar can be anything.

- If the planning time level of the target plan isn't Day, the planning calendar of the target plan and source plan
must be the same.

You can copy measure data between a demand plan with a hybrid time hierarchy and a sales and operations plan with
an aggregate time level. The planning calendar for each available sales and operations plan is one of the calendars on
the basis of which the hybrid time hierarchy for the demand plan is created. The planning calendar and planning time
level of the sales and operations plan determine the level at which measure data is copied.

For example, if you copy measure data from a demand plan for which the planning calendar is a Gregorian hybrid
hierarchy to a sales and operations plan that's defined at the Gregorian month, measure data gets copied at the
Gregorian month level. If you copy measure data from a sales and operations plan defined at the fiscal Quarter level to a
demand plan with a fiscal hybrid hierarchy, measure data gets copied at the fiscal Quarter level and disaggregated to the
Hybrid time level.

This table summarizes how you can copy measure data from work areas and between plan types:

From Work Area Source Plan Type Target Plan Type

Demand Management Demand plan Demand plan

Demand and Supply Planning The source and target plans are the same.
Demand and Supply Planning Demand and supply plan Sales and operations plan

Sales and Operations Planning

Demand and Supply Planning Demand and supply plan Demand and supply plan

The source and target plans are the same.

Demand Management Sales and operations plan Demand plan

Demand and Supply Planning

Demand and Supply Planning Sales and operations plan Demand and supply plan

Sales and Operations Planning

Sales and Operations Planning Sales and operations plan Sales and operations plan

The source and target plans are the same.

Sales and Operations Planning Demand plan Sales and operations plan
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From Work Area Source Plan Type Target Plan Type
Sales and Operations Planning Supply plan Sales and operations plan

Related Topics
« Load Measures from Other Plans

» Orchestrate Load Measures Processes

Load Measures from Other Plans

This topic provides steps to load measures from one plan to another or within a plan.

Note: Before you copy the measure data, ensure that the source and target plans have run without any errors.

1. Navigate to the Load Measures from Other Plans page:
a. Inthe Navigator, click one of the following work area links, and then open a plan:

- Sales and Operations Planning
- Demand Management
- Demand and Supply Planning
b. On the Tasks panel tab, click the Load Measures from Other Plans link.
2. On the Load Measures from Other Plans page, select a source plan and a target plan.

The target plan is automatically selected as the source plan and can't be changed in these cases:

Chapter 8
easures

o Inthe Demand Management or Demand and Supply Planning work area, you selected a demand plan as

the source plan.

o Inthe Demand and Supply Planning work area, you selected a demand and supply plan as the source

plan.

o Inthe Sales and Operations Planning work area, you selected a sales and operations plan as the source

plan.

3. (Optional) To insert new combinations in the target plan, select the Create new combinations check box.

Selecting the Create new combinations check box doesn't insert new item and organization combinations
from the source plan into the target plan. Instead, the planning process inserts new demand combinations

from the source plan that don't already exist in the target plan. If you don't select this check box, source

plan

combinations aren't created in the target plan if they don't already exist there, and measure data isn't copied for

these combinations.
4. Inthe Copy Range Relative to Start Date section, do the following:

a. Copy Time Level: Copy Time Level conveys the time level at which measure data is copied. It is read-only

and informational.

b. Time Level Range Start: Enter the range start value to copy the measure data for either the history or

future time period.

c. Time Level Range End: Enter the range end value to copy the measure data for either the history or

future time period.
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Note: For history, enter negative values for both Time Level Range Start and Time Level Range End.

5. Inthe Measure Mapping section, click the Add Row icon to add a source and target measure mapping row.

a. Inthe Source Measure field, select the name of source measure. Don't select a measure that's already
used as a source measure in another mapping row.

b. Inthe Target Measure field, select the name of the target measure. Don't select a measure that's already
used as a target measure in another mapping row.

If you're copying measure data between plans, by default, the source measure is automatically selected
as the target measure if it's in the measure catalog of the target plan.

If you're copying measure data within the plan, the source measure isn't available for selection as the
target measure.

6. (Optional) To save the mapping to reuse later to quickly load data into your plan, click Save as Measure Copy
Set.

a. Inthe Save as Measure Copy Set dialog box, enter a name and description for your measure copy set.
b. To replace an existing measure copy set, select the Overwrite existing check box.
c. Click Save and Close to return to the Load Measures from Other Plans page.

7. Click Submit to run the Load Measures from Other Plans scheduled process.

The Status dialog box opens and displays the request number. You can use this request number to search for
the result of the parent process (Orchestrate Load Measures Processes) in the Scheduled Processes work area.

Related Topics
« Overview of Loading Measures from Other Plans

Orchestrate Load Measures Processes

This topic provides steps to load measures between plans or within a plan using the Orchestrate Load Measures
Processes scheduled process.

Note: Before you copy the measure data, ensure that the source and target plans have run without any errors. Also
ensure that the measure copy set has been created on the Load Measures from Other Plans page.

1. Inthe Scheduled Processes work area, click the Schedule New Process button on the Overview page.

. Inthe Schedule New Process dialog box, search for and select Orchestrate Load Measures Processes, and
then click OK.

3. Inthe Process Details dialog box, Basic Options section, do the following:

a. From Plan: Select a source plan name.
b. To Plan: Select a target plan name.

You can select the source plan as the target plan if you want to copy measure data within the plan.
c. Measure Copy Set: Select a measure copy set.

If you're copying measure data within the plan, the source measure and target measure in a row of the
measure copy set can't be the same.
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d. Create new combinations: Optionally, select the check box to insert new combinations in the target plan.

When you're copying measure data between plan types, if you select this check box, source plan
combinations are created in the target plan if they don't already exist there before the measure data is
copied. If you don't select this check box, source plan combinations aren't created in the target plan if
they don't already exist there, and measure data isn't copied for these combinations.
4. Click the Advanced button and navigate to the Schedule tab. You can set up the process to run as soon as
possible or establish a schedule.
5. When done, click Submit.

The Confirmation dialog box opens and displays the process number. You can use this process number to
search for the process result in the Scheduled Processes work area.

Related Topics
« Overview of Loading Measures from Other Plans

+ Load Measures from Other Plans

View the Audit Trail for a Measure

Use the Audit Trail of Measure Updates table to view the audit trail for a measure.

The table displays details of changes made to measure values for auditing purposes. You can view the audit trail for all
measure types, such as numeric, date, and string.

The Audit Trail of Measure Updates table is available for Demand Plan, Supply Plan, Demand and Supply Plan, and Sales
and Operations Plan types. You can access the audit trail from your respective Supply Chain Planning work area.

Only editable measures that are part of the plan's measure catalog appear in the Audit Trail of Measure Updates table.

Note: Only the user who updated the measure can view the previous value and new value in the audit row. Other
users, who have permissions to view the audit trail, must open the Audit Trail Details page to view the details.

The security permissions are set according to the job roles on a measure group or on a specific hierarchies, such as
Item, Organization, Customer or Supplier. For additional details, open the Administer Planning Security page from the
task drawer of the Plan Inputs work area.

Use the following steps to view the audit trail for a measure:

1. From a Supply Chain Planning work area, click the Open button and then select a pane.
. Inthe Open Table, Graph, or Tile Set dialog box, search for the Audit Trail of Measure Updates table. Select the
table and then click OK.
3. On the Audit Trail of Measure Updates tab, type a specific measure name and click Search.

You can click the Search button without typing any search criteria to display all the measures that have the audit
trails.
4. Inthe Search Results region, you can view the audit trails for a measure, which includes the following
information:
o Measure Name: Name of the measure on which the updates were made.

o Last Updated Date: Date and time when updates were made to the measure.
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o Updated By: Name of the user who made the updates.
o Previous Value: Previous value for the measure.
o New Value: New value for the measure.

o Details: When you click Details, the Audit Trail Details page opens. You can review additional details, such
as levels, members, filtered levels, and filtered members.

Guidelines for Setting the Calculation Order

How you set the calculation order for a measure affects its computation of data.

On the Aggregation and Disaggregation tab on the Create Measure page, in Aggregation Parameters, you can select
Calculate then aggregate or Aggregate then calculate in the Calculation Order field. If you make an incorrect
selection in this field, the measure value won't be correct.

Note these guidelines for setting the calculation order of the measure:

- When the measure's calculation order is Calculate then aggregate, all dependent measures must also use the
same order.

Dependent measures are all the measures (and their dependent measures, in turn) that are used in the main
measure's expression.

- On the Expression tab, your selection of the calculation order along with your use of the Lag and Lead
functions can affect the calculation of data.

The Lag and Lead functions have two parameters. The first parameter contains the measure the function is
applied to. The second parameter contains the number of time buckets.

When you use the Calculate then aggregate order, the second parameter is interpreted as being in days. For
example, Lag(Bookings History Average, 10) returns the value of the Bookings History Average measure from
10 days prior to the time period of the table cell.

When you use the Aggregate then calculate order, the second parameter is interpreted as being in the time
level that the measure data is displayed at in the table. For example, in a table that displays monthly time
buckets, Lead(Consensus Forecast MAD, 6) returns the value of the Consensus Forecast MAD measure 6
months after the month of the table cell.

If you've configured the table so that time buckets can be expanded or collapsed, then the time buckets can be
interpreted at different levels. For example, if you've configured the table to display both quarterly and monthly
time buckets and can expand a quarter to see the underlying months, Lag(Shipments History, 2) returns the
value of the Shipments History measure from 2 quarters prior to the cell being reviewed if the quarters are
collapsed or 2 months prior to the cell being reviewed if the quarters are expanded.

169
ORACLE



Oracle Fusion Cloud SCM Chapter 8
Using Sales and Operations Planning Planning Measures

Manage User-Defined Measures

Create Measures and Assign to a Measure Catalog

In addition to reviewing measures, you use the Manage Planning Measure task to create, edit, duplicate, and delete
measures. You can also create measure groups and add predefined and user-defined measures in them.

This topic discusses the following:

- Creating measures

- Assigning measures to a measure catalog

Create Measures

If you have the required privileges, you can create measures if the predefined ones don't meet your requirements. The
measures that you create have the same features and functionality as predefined measures.

To create a measure:

1. In a Supply Chain Planning work area link, click the Tasks panel tab.

You can create measures from one of the following work areas: Demand Management, Replenishment
Planning, Supply Planning, Sales and Operations Planning, Demand and Supply Planning, or Plan Inputs.

2. Inthe Tasks panel, click the Manage Planning Measures link.
3. Click Create from the Actions menu.

On the Create Measure page, enter a measure name and description.

Select a measure group.

Select a data type.

Select the Allow editing check box if you want the measure to be editable in a pivot table.
Select Edit Range to enable the Edit Lock tab, which controls the editable status of the measure

P an oo

The Edit Range value determines the time range over which the measure is editable. The available values
are: History, Future, History and Future.

f. Onthe Aggregation and Disaggregation tab, define the dimension parameters. Select the dimensions,
hierarchy, and hierarchy level within the dimension to store the measure data. When a dimension and
hierarchy are selected, the default setting for the Stored Level is the lowest level of the dimension's
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hierarchy. You can modify the level to store by selecting the hierarchy from the list and setting the stored
level parameter within that hierarchy.

- Aggregation Parameters: The Aggregation parameters control the way a measure's data is
aggregated. You have two options:

o Calculate and aggregate: Calculate and Aggregate calculates the measure's expression at the
lowest data level and then aggregate up.

o Aggregate then calculate: Aggregate and Calculate aggregates all measures referenced in
this measure's expression and then calculate the expression.

In the Time Dimension field, select the aggregation function that controls how data is aggregated
for the time dimension. The Other Dimensions fields are the same as the Time dimension fields.
These options control how the data is aggregated across all the dimensions except for time. The
Weighted By field is enabled only if you select Weighted Average as the aggregation parameter
for either Time or Other Dimensions. It enables you to select the measure to drive the weighted
average calculation.

The aggregation types include: Sum, Average, Weighted Average, Minimum, Maximum, Count,
Latest, Median, Variance, and Standard Deviation.

- Disaggregation Parameters: The Disaggregation Parameters control how changes to the data at
an aggregated level are allocated down for storage. This is used when data changes are made in a
pivot table, but also when made by the demand forecast. The weights for each combination, such
as item-organization, are calculated and stored for the measure during plan run. These weights
are used to allocate the data. For example, the forecasts for P1-Org1 and P2-Org1 are 40 and 60
respectively. Therefore, the weights used for allocation would be 40% for P1-Org1 and 60% for P2-
Orgl.

The parameters for the Disaggregation Type field are: By Measure, By Self, Equal, and Same Value.
The default parameter is Equal.

The Disaggregation Basis field is enabled only if you select the Disaggregation Type as By Measure.
Select the measure to use as the disaggregation basis from the list of measures.

The Secondary Basis field is enabled only if you have selected the Disaggregation Type field as
By Measure or By Self. The values for Secondary Basis are Booking History Average or Shipment
History Average.

The Secondary Basis measure is selected in case the basis measure has no value. You can select
only measures that contain pre-calculated proportions as a secondary basis. That is, they're
calculated during plan run.
g. On the Expression tab, define any new expressions for a measure. You create an expression when you
have to show any value other than its stored information. The expression provides a flexible framework
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for an extensive variety of calculations and information. An expression for a measure references other
measures, operators, and numbers.

For example, to create a user defined measure that shows archived time periods, you need to use an
archive expression. See the View Planning Measures from Archived Time Periods topic to learn more.

In the Expressions subtabs:

- The Functions tab lists the available functions, a description, an example of the function's use.

- The Measures tab lists the available measures, their descriptions, and data type. The Insert button
inserts the highlighted measure into the expression building area where functions or arithmetic
operations can be specified.

- The Attribute tab lists the attributes available for the Product dimension at Item level. The
description and data type of the attribute is shown in the description pane.

After you complete the expression, use the Validate button to ensure the syntax is correct. An error or
succeeded messaged is displayed.

On the Edit Lock tab, you can define a new expression similar to the measure expression. The difference
is rather than evaluating and displaying the expression result, the expression result is used to control or
refine the editable status of the measure. If the expression evaluates as true, the measure is locked from
editing. The expression is evaluated every time the table is run, and may change as relevant measures or
attributes are modified.

On the Advanced tab, click the Properties tab and review the following parameters:

- If you select the Shared measure check box, then the measure is shared across plans. By default,
the parameter isn't selected, and the measure is plan-specific.

Note: You can share measures across only demand plans with the day planning time level or
across demand and supply plans. In such plans, shared measures are common, and the entries
you make in one plan apply to other plans. For plans of other types, even if you select the check
box, the measures are plan-specific.

- If you select the Refresh with current data check box, then the current measure value needs a
placeholder to store the result in the application. For example, a noneditable measure where the
data is imported from a legacy or other application. Selecting this check box allocates a space to
store the measure by the defined dimensions.

- Conversion Type enables you to define the valid Unit of Measure (UOM) and Currency conversions
that are available for a measure in a table.

Base Units of Measure defines the default unit of measure used to convert displayed data. The field
is editable only for Numeric measures, which don't have Product and Organization-based levels
(for measures that have product and organization, the definition comes from the data source).
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Select any relevant units of measure, which may be useful in a table, graph, or tile. Only the UOMs
that you select are available for selection in a table or graph.

Base currency defines the default currency to which displayed data are converted. The field is
editable for only Currency type measures.

You use Price lists to convert quantities into values, which are then converted to a currency.

- Data Lookup value enables you to identify a data lookup source that displays the measure as a list
of value. The source attributes have 3 options: None (Default), Level, and List.

o If Source=Level, you must identify the level and the attribute to display in the measure list.
o If Source=List, then you can create and maintain the list of values. You can either add or
remove members in this list.
j- On the Advanced tab, click the Goals tab to define if low or high values are better for measure goals.

k. On the Advanced tab, click the Conditional Formatting tab to define conditional formatting settings for
the measure.

4. Click Save and Close.

Assign Measures to a Measure Catalog

To use the user-defined measure in your plan, add the new measure to the plan's measure catalog. Navigate to
Configure Planning Analytics, find the plan's measure catalog on the Measures Catalog tab. In the Available Measures
pane, search for the new user-defined measure, and add it to the Selected Measures. After you perform a plan run you
can create a table or use an existing table, and add your new measure to the table.

Related Topics
» Configure Global Goals for Measures

« Duplicate, Edit, and Delete Measures
« Create Measure Groups

Duplicate, Edit, and Delete Measures

You can duplicate, edit, or delete user-defined measures using the Manage Planning Measures task, which is available in
the Tasks drawer.

To duplicate the measure: Select a measure from the list of measures, select the Action menu on the toolbar, and then
click Duplicate. Duplicating the existing measure gives you a starting point for creating a new measure definition. When
you duplicate a measure the default name is Copy of <original measure name>. Other definitions of the duplicated
measure remain the same as the original measure.

To edit the measure: Select a measure from the list of measures, select Actions menu, and then click Edit. Editing a
measure enables you to select an existing measure and edit its attributes.

To delete the measure: Select a measure from the list of measures, select Actions menu, and then Delete. A complete
list of all objects including tables and measure groups are be displayed to ensure you are aware of impacts of deleting a
measure.
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Related Topics
« Create Measure Groups

« Configure Global Goals for Measures

Create Measure Groups

Use Manage Planning Measures task to create a measure group. Measure groups are created to group measures
together that you need frequently. Depending on your business need you can create measure groups and associate
measures with appropriate groups.

To create a measure group:

1. In the Navigator, click a Supply Chain Planning work area link.

2. Click the Tasks panel tab.

3. Inthe Tasks panel drawer, select the Manage Planning Measures link.
4. Select Create Group from the Actions menu.

o Enter a name and description.

o From the Available Measures pane you can select measures and move them to the Selected Measures
pane.
5. Click Save and Close.

Related Topics
« Create Measures and Assign to a Measure Catalog

- Duplicate, Edit, and Delete Measures

Configure Global Goals for Measures

You can define global goals for a measure using the Goals tab when you create or edit a measure. On the Create
Measure page, click the Advanced tab and then select the Goals tab to configure global goals.

Define if low or high values are better. For example, a high value is good for revenue; a low value is good for expenses.
For global goals, you can provide a low range or a high range.

Goals option is available only for measures of type Currency, Number, and Percent. Using Global Goals, you can first
define if low or high values are better for a measure. The ranges are displayed on the page when you are viewing a
measure in comparison with its goal, for example, in an infotile. Global goals are measure level parameters and are
not defined specifically for a subset of the data. For example, you cannot have a goal of 1000 for one organization and
50000 for another.

Related Topics
- Create Measures and Assign to a Measure Catalog

 Duplicate, Edit, and Delete Measures
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9 Planning Exceptions

Exceptions in Plans

Overview of Plan Exceptions

Exceptions are a key element to evaluate and improve your plan in Oracle Fusion Cloud Supply Chain Planning.

After you run a plan, view the exceptions to understand the quality of the plan and to get visibility of key problem areas.
You can focus on key exceptions to understand their root causes. From the exceptions tables, you can drill down to
other plan views for more details into the problem areas. After taking actions to resolve exceptions, run the plan again
to evaluate whether the plan is now acceptable.

Oracle provides several predefined exceptions that the Oracle Supply Chain Planning processes compute after you run
a plan. View these exceptions to identify problem areas in the plan that might need your attention. To view a list of the
exceptions, open your plan and then open the Exceptions table.

The exception types and their calculation logic are predefined. However, to ensure that only significant deviations
are highlighted, you can edit the conditions under which the exceptions are generated. You control which exceptions
to calculate for a plan by specifying an exception set on the Plan Options page. View the metrics associated with
exceptions, such as by count or by quantity, in tables or graphs at different hierarchical levels.

You can also create user-defined exceptions based on specific conditions in the supply chain that you want to identify.
Base these user-defined exceptions on your business requirements and focus on specific areas to improve your supply
chain planning capabilities. Use the Configure Exception task to create a user-defined exception.

Note: You can't create user-defined exceptions in the Planning Central work area. Also, there are no predefined
exceptions for Replenishment Planning.

Plan Exception Types

From within your plan, you can open the Exceptions table to view the exceptions grouped within the following folders:

Exception Folder Accessible from these work areas:

Demand Planning Exceptions Demand Management
Planning Central

Sales and Operations Planning
Replenishment Planning Exceptions Replenishment Planning (user-defined exceptions only)
Sales and Operations Planning Exceptions = Sales and Operations Planning

Supply Planning Exceptions Supply Planning
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Exception Folder Accessible from these work areas:

Planning Central

Views for Multiple Exceptions Supply Planning

Planning Central

Exception Categories
There are two categories of exceptions:

- Measure-based exceptions

- Order-based exceptions

Chapter 9
Planning Exceptions

Oracle provides several predefined exceptions for most Supply Chain Planning modules. You can also create user-
defined exceptions from most Supply Chain Planning work areas. The following table lists the Supply Chain Planning
modules, the type of exception, whether the product has predefined exceptions, and whether you can create user-

defined exceptions.

Module Type of Exception

Oracle Demand Management Measure-based exceptions
Oracle Planning Central Measure-based exceptions
Oracle Replenishment Planning Measure-based exceptions
Oracle Sales and Operations Measure-based exceptions
Planning

Oracle Supply Planning Order-based exceptions

(constrained and unconstrained)
Measure-based exceptions

View Exceptions for Your Plan

Predefined Exceptions

Yes

Yes

No

Yes

Yes

User-Defined Exceptions

Yes

No

Yes

Yes

Yes

When you open the exceptions table, the number of exception records generated are shown after the exception name,
in parentheses. Clicking the exception name displays a table with details of the exception. From the Exceptions tab, you

can:

- Search for exceptions for a specific item and organization within a specified date range

- Search for measure-based exceptions based on various attributes such as Planner, Planner Description,
Catalog, and Category. If a measure-based exception is created at the category level, categories specific to the
catalog selected in the hierarchy parameter appear in search results. If a measure-based exception is created
at the Item level, then you can filter the records based on Item, Catalog, and Category Level attributes. If a
measure-based exception is created with no product dimension, then you can filter the records based on other

attributes except Item and Category level
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- Save the search criteria for future searches
Export the table to a spreadsheet, rearrange columns, and perform other standard table actions on the table

Predefined views within the Views for Multiple Exceptions folder enable you to view all exceptions for an item, resource,
or supplier within the same table. The folder is available only in the Supply Planning and Planning Central work areas.

From tables that show exception data, you can navigate in context to other plan data. This navigation capability is useful
when, for example, you view exceptions for an item and you also want to see its supply or resource availability.

Related Topics
- How You Edit Exceptions

« Configure Exception Thresholds

« Overview of Exceptions and Exception Sets
« Overview of Predefined Planning Exceptions
» Overview of User-Defined Exceptions

Configure Exception Thresholds

You can control the number of exceptions that your plan generates by changing the levels at which an exception is
computed and its threshold value. A higher threshold value typically results in fewer exceptions.

To configure exception thresholds, do the following:

1. From a Supply Chain Planning work area, select the Configure Exceptions task.
2. On the Configure Exceptions page, select an exception.
3. Click Actions and then select Edit.

Demand planning, replenishment planning, and sales and operations planning exceptions are measure-based
exceptions. A base measure forms the foundation for these exceptions.

In the Planning Central work area, you can't change the base measure, but you can edit the level at which the exception
is computed and its threshold value.

Most supply planning exception calculations are for a specific order and aren't associated with a base measure. For
these types of exceptions, select the fact associated with the exception and modify the condition that specifies when to
generate the exception. Think of a fact as an attribute of the exception. Typical facts are quantity and value.

Related Topics
- How You Edit Exceptions

» Overview of Plan Exceptions
« Overview of User-Defined Exceptions

Create Tables and Graphs for Exceptions

Create a table or graph for plan exceptions based on their measures, such as number of exceptions generated and the
quantity associated with the exception.
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Create a Table for Exceptions

PUWUNa

In a Supply Chain Planning work area, open a plan.
Click the Actions button and select Manage Tables, Graphs, and Analysis Sets from the list.
In the Manage Tables, Graphs, Analysis Sets dialog box, click Actions. Next, select Create and then select Table.
On the Create Table page, do the following:
o Enter a name for your table.

o Select a group.
o Enter a description.
o Select the type of access (public or private).

On the Measures tab, do the following:
a. Inthe Available Measures section, expand the Overall Plan Health folder.
The Overall Plan Health folder contains the measures associated with exceptions.
b. Select the exception facts that you want to view in the table.

6. On the Hierarchies tab, include the Exception Type hierarchy.
7.
8. C(lick Save and Close.

On the Members tab, select the exception types to display in the table.

Create a Graph for Exceptions

1

In a Supply Chain Planning work area, open a plan.

2. (Click the Actions button and select Manage Tables, Graphs, and Analysis Sets from the list.

3.

oo

In the Manage Tables, Graphs, Analysis Sets dialog box, click Actions. Next, select Create and then select
Graph.
On the Create Graph page, do the following:

o Enter a name for your graph.

o Select a group.
o Enter a description.
o Select the type of access (public or private).

On the Measures tab, do the following:
a. Inthe Available Measures section, expand the Overall Plan Health folder.
The Overall Plan Health folder contains the measures associated with exceptions.
b. Select the exception facts that you want to view in the graph.
On the Hierarchies tab, include the Exception Type hierarchy.
On the Members tab, select the exception types to display in the graph.
On the Layout tab, do the following:
a. Inthe Graph Layout Options section, select a type of graph.
b. Configure your graph in the horizontal panels below the Graph Layout Options.
The horizontal panels below the Graph Layout Options section vary, depending on the type of graph that
you select. For example, if you select Pie Graph for your graph type, the horizontal panels include General
Options, Pie Slice, and Formatting.
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9. Click Save and Close.

Related Topics
» How You Edit Exceptions

« Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets
» Overview of Plan Exceptions

Exceptions and Exception Sets

Overview of Exceptions and Exception Sets

On the Configure Exceptions page, you can select an exception and edit the thresholds for reporting. You can configure
only those exceptions that are relevant to your Supply Chain Planning work area.

On the Configure Exception Sets page, you can restrict the exceptions that are computed as part of the plan run. You
can also control the organizations, item categories, time period, and so on for which to compute exceptions.

A defined exception set is associated with a plan. The plan evaluates the exceptions using the filters associated with the
exception set. Select the exception set to use during the plan run on the Plan Options page, Scope tab.

Related Topics
- How You Edit Exceptions

» Configure Exception Sets

- Set Filters on Planning Dimensions for Exceptions
« Overview of User-Defined Exceptions

» Define Scope Plan Options

How You Edit Exceptions

To edit exception parameters, select an exception on the Configure Exceptions page. You can configure only those
exceptions that are relevant to your Supply Chain Planning work area.

In the Edit Exception dialog box, there is an area for General Properties and Exception Detail. Depending on the Supply
Chain Planning work area that you're in, you can see the following tabs in the Exception Detail section:

Demand Management work area: Level, Threshold, and Notification

Planning Central work area: Level and Threshold

Replenishment Planning work area: Level, Threshold, and Notification
- Sales and Operations work area: Level, Threshold, and Notification

- Supply Planning work area: Level, Threshold, and Notification
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You can edit Level and Threshold only for those exceptions whose basis is Measure. For exceptions whose basis is
Order, you can edit only the Threshold.

Level Tab

On the Level tab, the dimensions for the exception are derived from the base measure. You can edit the default values
for hierarchy and level. You can also enable and disable each of the available dimensions to control the level that the
exception is evaluated at.

Note: Ensure that the selected hierarchy is in the dimension catalog for the plan. The Configure Exceptions task is
outside of the plan context. It's possible to select a product hierarchy that's not used in the plan's dimension catalog,
in which case the plan exceptions output won't display data for items.

Threshold Tab

On the Threshold tab, the base measure used in the exception is compared to either a value or another measure. If
the threshold is specified in terms of a value, the value is interpreted in terms of the data type of the base measure. To
ensure that exceptions return meaningful values, set the threshold to an appropriately high or low value.

Notifications Tab

On the Notification tab, set up notification rules for exceptions. Configure exceptions to trigger notifications to specific
users or roles. In the Details section specify the entity and condition for notifications. Notifications are automatically
sent at the end of the plan run.

Related Topics
« Configure Exception Sets

- Set Filters on Planning Dimensions for Exceptions
« Overview of Predefined Planning Exceptions

« Overview of User-Defined Exceptions

« Overview of Plan Exceptions

Configure Exception Sets

Use the Configure Exception Sets page to create, modify, or copy an exception set.

The set of exceptions and their scope that's calculated by the plan is configured on the Create or Edit Exception Set
page. When creating an exception set, you must first specify the exceptions to include in the set, which can include
user-defined exceptions. User-defined exceptions aren't available in Planning Central.

The exception set also enables you to restrict the generation of exceptions for specific organizations, categories,
suppliers, and customers. You can then point to the exception set on the Plan Options page for a plan.

When you create a constrained supply plan in Supply Planning, the Exception Set plan option defaults to the
Constrained Supply Planning Default exception set.

Use the following steps to configure exception sets:

1. In a Supply Chain Planning work area, click the Tasks panel drawer and click Configure Exception Sets.
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2. Onthe Configure Exception Sets page, select an existing exception set. Next, click Actions and select
Duplicate.
3. Inthe Create Exception Sets dialog box:

a. Expand the group of exceptions in the Available Exceptions section. For example, expand Supply
Planning Exceptions.

b. Select the exception from the Available Exceptions section and move it to the Selected Exceptions
section.

4. C(lick Save and Close to return to your plan.

Note: To generate exceptions, you must include the exception set in the plan options for your plan.

Related Topics
« How You Edit Exceptions

- Set Filters on Planning Dimensions for Exceptions
« Overview of Plan Exceptions

« Overview of Predefined Planning Exceptions

» Overview of User-Defined Exceptions

Set Filters on Planning Dimensions for Exceptions

After selecting available exceptions for an exception set to use in a plan, you can add filters on some of the key planning
dimensions. The levels on which you can define filters are organizations, categories, suppliers, and customers.

On the Configure Exception Sets page, Filters tab, select one or more organizations, suppliers, categories, and
customers in each of the tables for which to generate exceptions. If you don't specify a filter for a level, you will generate
exceptions for all records in that level. For example, if you don't specify an organization, exceptions will be generated for
all planning organizations when you run the plan. If any of the organizations, categories, suppliers, or customers in the
exception set aren't available in the plan, they will be ignored.

In the Exception Cutoff Days field, specify the number of calendar days, starting from the plan start date, from which
to generate the exceptions. If this field is blank, exceptions will be generated for the full planning horizon.

Related Topics
« Configure Exception Sets

- How You Edit Exceptions
« Overview of Plan Exceptions
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Predefined Planning Exceptions

Overview of Predefined Planning Exceptions

The planning process computes several predefined exceptions after you run a plan.

View these exceptions to obtain quick visibility of problem areas in the plan that might need your attention. To view a
list of the exceptions, from a Supply Chain Planning work area, open a plan and then open the Exceptions table.

The Exceptions table is grouped into different folders, depending on the plan type:

Demand Planning Exceptions
- Sales and Operations Planning Exceptions
- Supply Planning Exceptions

- Views for Multiple Exceptions: View exceptions for an item, resource, or supplier within the same table. (This
folder is available only in the Supply Planning and Planning Central work areas.)

Note: There are no predefined exceptions for Replenishment Planning, only user-defined exceptions that reside in
the Replenishment Planning Exceptions folder.

Related Topics
« Overview of Plan Exceptions

- How You Edit Exceptions

 Predefined Sales and Operations Planning Exceptions
» Predefined Demand Planning Exceptions

« Predefined Supply Planning Exceptions

Predefined Sales and Operations Planning Exceptions

The basis for all predefined sales and operations planning exceptions is Measure. The following table lists the
predefined sales and operations planning exception reports, their descriptions, the base measure used for the
exception, and the levels.

Sales and Operations Planning Description Base Measure Levels
Exception Name

Demand Quantity Not Satisfied The satisfied demand (Constrained  Unmet Demand Month
Forecast measure) is less than the
required demand (Net Demand Organization
measure) for a planning time
bucket. This exception can occur if ltem

lead times are enforced or capacity
constraints are considered. When
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Exception Name

Items Below Safety Stock

Items with a Shortage

Resource Overloaded

Work Center Overloaded

ORACLE

Description Base Measure

this occurs, demand is backordered
(Backorder measure).

The projected available balance
(Projected Available Balance
measure) is below the specified
safety stock (Safety Stock measure)
level for a planning time bucket.

If the exception extends beyond
one time bucket then the planning
process reports one exception with
the start and end dates to reflect
the duration.

Projected Available Balance

The projected available balance
(Projected Available Balance
measure) has a negative value for
a planning time bucket. It's unlikely
for this exception to occur in a
sales and operations plan.

Projected Available Balance

The resource utilization (Resource
Utilization Percentage measure)
exceeds 100 percent for a planning
time bucket. If the exception
extends beyond one time bucket
then the planning process reports
one exception with the start and
end dates to reflect the duration.
In a sales and operations plan that
considers work center capacity
constraints, it's still possible for
resources in a work center to be
overloaded.

Resource Utilization Percentage

The work center utilization
(Resource Utilization Percentage
measure) is greater than or equal
to 100 percent for a planning time
bucket. If the exception extends
beyond one time bucket then

the planning process reports one
exception with the start and end
dates to reflect the duration. In

a sales and operations plan that
considers work center capacity
constraints, it's still possible

for resources in a constrained
work center to be overloaded.
Additionally, only the capacity

for Constrained Work Center
Level Members are considered,
whereas other work centers are
unconstrained and can exceed 100
percent.

Resource Utilization Percentage

Chapter 9
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Levels

Month
Organization

Iltem

Month
Organization

Item

Month
Organization

Resource

Month
Organization

Work Center
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Exception Name

Supplier Capacity Overloaded

Supplier Category Capacity
Overloaded

Lead Time Compression

Consensus MAPE Exceeds
Threshold

Significant Deviation between Final
Sales Forecast and Consensus
Forecast

ORACLE

Description

The supplier item capacity
utilization (Supplier Capacity
Utilization Percentage measure)

exceeds 100 percent for a planning

time bucket. If the exception
extends beyond one time bucket
then the planning process reports
one exception with the start and
end dates to reflect the duration.
In a sales and operations plan
that considers supplier capacity
constraints, it's still possible for
supplier items in a category to be
overloaded.

The supplier category capacity
utilization (Supplier Capacity
Utilization Percentage measure)
is greater than or equal to 100

percent for a planning time bucket.

If the exception extends beyond

one time bucket then the planning

process reports one exception
with the start and end dates to
reflect the duration. In a sales and
operations plan that considers
supplier capacity constraints, it's
still possible for supplier items in a
category to be overloaded.

This exception can occur for

a planning time bucket when
purchasing and transfer lead
time compression is allowed.
The exception quantity is the
number of time buckets that
have been compressed. For
example, if a supplier item has a
3-month lead time and the item
is required in 2 months, then the

exception quantity is 1. If the Allow

purchasing and transfer lead time
compression plan option isn't

selected, then a Demand Quantity
not Satisfied exception can occur.

The mean absolute percentage
error (MAPE) value for the
consensus forecast exceeds

20 percent for an item in an
organization.

The deviation between the Final
Sales Forecast quantity and the
Consensus Forecast quantity
exceeds 20 percent for a planning
time bucket.

Base Measure

Supplier Capacity Utilization
Percentage

Supplier Capacity Utilization
Percentage

Lead Time Compression

Consensus Forecast MAPE

Deviation Between Final Sales
Forecast and Consensus Forecast

Chapter 9
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Levels

Month
Supplier Site

Item

Month
Supplier Site

Category 1

Month
Supplier Site
Organization

Item

Organization

Item

Month
Zone

Organization
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Exception Name

Significant Deviation between Final
Marketing Forecast and Consensus
Forecast

Significant Deviation between
Shipments History and Consensus
Forecast

Significant Deviation between
Financial Forecast and Operating
Plan Value

Significant Deviation between
Financial Forecast and
Unconstrained Operating Plan
Value

Significant Deviation between Last
Year Shipments and Operating
Plan Value

Significant Deviation between
Current and Prior Consensus
Forecast Value

Significant Deviation between
Current and Prior Operating Plan
Value

ORACLE

Description

The deviation between the Final
Marketing Forecast quantity and
the Consensus Forecast quantity
exceeds 20 percent for a planning
time bucket.

The deviation between the
Shipments History quantity and
the Consensus Forecast quantity
exceeds 20 percent for a planning
time bucket.

The deviation between the
Financial Forecast Value and the
Operating Plan Value exceeds 20
percent for a planning time bucket.

The deviation between the
Financial Forecast Value and the
Unconstrained Operating Plan
Value exceeds 20 percent for a
planning time bucket.

The deviation between the
Shipments History Value 1 Year
Ago and the Operating Plan Value
exceeds 20 percent for a planning
time bucket.

The deviation between the
Consensus Forecast Value and the
archived Consensus Forecast Value
exceeds 20 percent for a planning
time bucket.

The deviation between the
Operating Plan Value and the
archived Operating Plan Value
exceeds 20 percent for a planning
time bucket.

Base Measure

Deviation Between Final Marketing
Forecast and Consensus Forecast

Deviation Between Shipment
History Shipped Items by
Requested Date and Consensus
Forecast

Deviation Between Financial
Forecast and Operating Plan Value

Deviation Between Financial
Forecast and Unconstrained
Operating Plan Value

Deviation Between Last Year
Shipments and Operating Plan
Value

Deviation Between Current and
Prior Consensus Forecast Value

Deviation Between Current and
Prior Operating Plan Value

Chapter 9
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Levels
Item

Month

Item

Month
Zone
Organization

Item

Month
Organization

Item

Month
Organization

Iltem

Month
Zone
Organization

Item

Month
Zone
Organization

Item

Month
Zone
Organization

Item

185



Oracle Fusion Cloud SCM Chapter 9
Using Sales and Operations Planning Planning Exceptions

User-Defined Exceptions

Overview of User-Defined Exceptions

You can create your own exceptions to improve supply planning capabilities using specific conditions in the supply
chain.

Use the Configure Exception task to create a user-defined exception.

You can create and use exceptions for these modules:

Module Exception Type

Oracle Demand Management Measure-based exceptions
Oracle Replenishment Planning Measure-based exceptions
Oracle Sales and Operations Planning Measure-based exceptions
Supply Planning (constrained and Order-based exceptions

unconstrained)
Measure-based exceptions

Note: User-defined exceptions aren't available for Oracle Planning Central.

For user-defined exceptions that are measure based, the measure forms the foundation for that exception. After you
select a measure, you can specify the dimension hierarchy and level for that measure, and the threshold value or
measure to generate the exception. You can create an exception based on the following thresholds:

- Value: Set the value and the specific operation, such as less than, equal, and larger than, against the base
measure.

- Measure: Select the measure based on your business requirement and select the specific operation that meets
the condition against the base measure.

For example, you can create a date-type, measure-based exception such as launch date or discontinuation date. You
then can set the threshold value with date and select a date-type measure from the Measure parameter.

Consider the Forecast Start Date before Launch Date date-type exception. You can define the parameters as:
- Base Measure = Forecast Start Date

- Operation = Before (Available values for date type exceptions are: After, Before, Equals, On or after, and On or
before)

- Threshold Measure = Product Launch Date
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Related Topics
- Configure Measure-Based Exceptions

Configure Measure-Based Exceptions

This topic covers how to configure measure-based exceptions in Supply Planning, Sales and Operations Planning,
Demand Management, and Replenishment Planning.

You can create measure-based exceptions where the measure forms the foundation for that exception. After you select
a measure, you can specify the dimension hierarchy and level for that measure, and the threshold value or measure

to generate the exception. For example, you can create an exception to identify resource overloads when the resource
utilization percentage is greater than 110%.

Configure Exceptions That Are Measure Based
Use the following general steps to configure a user-defined exception that's measure based.

1. In a Supply Chain Planning work area, click the Tasks panel drawer and click Configure Exceptions.
2. Onthe Configure Exceptions page, click Actions and then select Create.

3. Inthe Create Exception dialog box, General Properties section, specify or enter information for the following
fields:

a. Exception

b. Display Name
c. Exception Group
d. Base Measure

4. Inthe Exception Detail section, on the Level tab, select the dimension and its corresponding hierarchy and level
to use for your exception

What you select for levels determines the combination at which the exception condition is evaluated. For
example, if you select levels Item and Organization, then the exception criteria is evaluated for each unique
combination of Item and Organization.

Note: Configure Exceptions is a task defined outside of plan context. When configuring exceptions for
measure-based plans, ensure the selected hierarchy is in the plan's dimension catalog in plan options.
Otherwise item level exceptions might be blank after running a plan.

5. Onthe Threshold tab:

a. Select an operation.

b. Define a threshold for the base measure, which can be defined based on a value or another measure.
6. On the Notification tab, define the notification attributes.
7. When done, click Save and Close.

Exception Detail Section

In the Create Exception dialog box, the Level tab in the Exception Detail section is populated based on the base
measure. The Level tab consists of dimension, hierarchy, and level.
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For example, for the user-defined exception Fill Rate Shortfall Percentage, the details are populated based on the base
measure Fill Rate Shortfall Percentage. As defined on the Threshold tab, the planning process generates this exception
when the Fill Rate Shortfall percentage is greater than 10%.

For this exception, the populated dimensions are Organization and Product. You can select dimensions and their
corresponding hierarchy and levels. In this example for the Product dimension, you can select either ltem or Category as
the level.

If you select the Item level, the planning process generates this exception for any item with the Fill Rate Shortfall
Percentage of greater than 10% as defined in the Threshold tab. This case enables you to analyze the plan output in
more detail. At the same time, the number of exceptions could be large enough that analyzing each exception might not
be possible.

On the other hand, if you select the Category level, the planning process generates this exception for any category with
the Fill Rate Shortfall Percentage of greater than 10%. In this case, the number of exceptions is lower than the item level
scenario. But, potentially some issues that exists at the item level aren't visible since the planning process generates an
exception only when the specified criterion holds at the category level.

Related Topics
» Overview of User-Defined Exceptions

« Overview of Plan Exceptions

Configure Exceptions Based on User-Defined Measures

You might have a scenario where you need to define a user-defined measure and then configure an exception based on
that measure.

For example, you want to identify the items that have demands with a risk of not being satisfied, and the value of these
demands are 10 percent more than their quarterly revenue.

Step 1: Configure a User-Defined Measure

In our example, the first step is to define a user-defined measure that represents the percentage value of demands at
risk. This percentage can be calculated as follows:

Demand at Risk Value Percentage = (Demand at Risk Value / Revenue) x 100
Use the following steps to configure a user-defined measure.
1. Navigate to the Tasks panel. In the Configuration section, click the Manage Planning Measures link.

2. Onthe Manage Planning Measures page, click Actions and then select Create.
3. Inthe Create Measure dialog box, enter or select the following:

Parameter Value
Measure Demand at Risk Value Percentage
Description Enter a description
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Parameter Value
Data Type Percent
Enable in Work Area Supply Planning
Measure Groups Overall Plan Health

4. Onthe Aggregation and Disaggregation tab in the Dimension Parameters section, select the Customer and
Demand Class dimensions.

5. Onthe Expression tab, Functions subtab, define the Demand at Risk Value Percentage equation:
Safe_Division (Demand at Risk Value, Revenue, null) * 100.
6. Click Save and Close.

Step 2: Configure a User-Defined Exception

The next step is to configure a user-defined exception using Demand at Risk Value Percentage as the base measure.

1. Navigate to the Tasks panel. In the Configuration section, click the Configure Exceptions link.
2. Onthe Manage Planning Measures page, click Actions and then select Create.
3. Inthe Create Exceptions dialog box, in the General Properties section, enter or select the following:

Parameter Value

Exception Demand at Risk Value over 10 Percent of Revenue
Display Name Demand at Risk Value over 10 Percent of Revenue
Exception Group Supply Planning Exceptions

Base Measure Demand at Risk Value Percentage

4. Inthe Exception Detail section, on the Level tab, specify the dimension and its corresponding hierarchy and

level.
5. Onthe Threshold tab, define the threshold for the base measure as Demand at Risk Value Percentage Greater
than 10%:
Parameter Value
Base Measure Demand at Risk Value Percentage
Description Demand at Risk Value Percentage
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Parameter Value
Operation Greater than
Threshold Value 10%

6. Click Save and Close.

Calculate User-Defined, Measure-Based Exceptions

After you modify, add, or delete one or more user-defined, measure-based exceptions in your plan’s exception set,
you can recalculate these exceptions independent of running the plan. These calculations are based on the current
definitions of the exceptions and include any changes since the plan was last run.

This calculation is based on the current definition of exceptions that includes any changes since the plan was last run.
By default, the process calculates all exceptions in the plan exception set. You can change the exception set parameters
of the process to calculate a subset of those exceptions.

Note: The Calculate Measure-Based Exception process doesn't recalculate predefined order-based exceptions.

The Calculate Measure-Based Exception process is available from the Supply Planning, Demand Planning,
Replenishment Planning, and Sales & Operations Planning work areas.

You can recalculate user-defined, measure-based exceptions from these pages:

- Scheduled processes: By default, scheduled process recalculates all exceptions in the exception set. However,
you can also recalculate exceptions of a subset by changing the exception set parameters.

- Actions menu on the header of the open plan

- Actions menu on Manage Plans page

Note: The Calculate Measure Based Exception process and Plan Run process cannot run simultaneously for the same
plan.
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10 Planning Cycles

Overview of Planning Cycles

Sales and Operations Planning is a process of recurring planning cycles consisting of activities, tasks, and participants.

Manage your Sales and Operations Planning process by using the predefined, but configurable, process activities and
dashboards. The planning cycle combines reviews of product development, demand, and supply with a focus on future
actions, and aligns operating plan performance with financial goals.

The planning cycle combines reviews of product development, demand, and supply with a focus on future actions, and
aligns operating plan performance with financial goals.

Create a sales and operations planning cycle on the Manage Planning Cycle page in the Sales and Operations Planning
work area. Define your template on the Manage Planning Cycles page: What are your activities, what are the tasks,
and who are the participants for each stage. You can edit the planning cycle later, as needed. Create templates from
templates used in prior planning cycles, which you can configure to align with your Sales and Operations Planning
process as it evolves.

The following table describes the five preconfigured review stages of a Sales and Operations Planning process that is
managed by the planning cycle.

Review Stage Description
Product Review Perform a cross-functional review of new products and the life cycle of maturing products.
Demand Review Analyze forecasts for new and existing products based on the inputs from sales and marketing to reach

consensus on the future unconstrained demand plan.

Supply Review Use the latest consolidated, unconstrained demand plan and analyze the feasibility of internal and
external supply capacity to fulfill demands. For example, you analyze whether there is sufficient
supplier and resource capacity and inventory to balance supply with demand.

Financial Review Compare the profitability of operational plans for the current fiscal year relative to the financial forecast
target.
Executive Review Make decisions and approve operational plans.

The Sales and Operations Planning process does not require you to have all of the review stages. If you do not have a
product review or a formal executive review, then do not add any participants or tasks for those review stages.

You can use the Configure Planning Cycle Stages dialog box to rename or hide a review stage. For example, you can
rename Demand Review to Demand and Supply Balancing. To rename or hide a review stage, navigate to the Manage
Planning Cycles page, open the planning cycle, and then click Actions > Configure Stages.
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Related Topics
« Create a Planning Cycle

« Demand Reviews

» Supply Reviews

« Executive Reviews

« Configure Planning Cycle Stages

Create a Planning Cycle

Use the predefined planning cycle template called Default_PlanCycle to initially create a planning cycle. You can modify
the planning cycle to model the activities, tasks, and participants that you want to use in your Sales and Operations
Planning process.

Use links to associate a task with a relevant dashboard or report to carry out each task. You can link to graphs, tables,
tile sets, and layouts. Use your user-defined planning cycle as a template for future planning cycles to copy over all
activities, tasks, and participants.

Note: When you copy a planning cycle, changes that you made to that planning cycle's stage names and your choices
to display stage names or not are copied over to the new planning cycle. Use the Configure Planning Cycle Stages
dialog box to rename or display a review stage in your new planning cycle.

Follow these steps to create a planning cycle using the predefined Default_PlanCycle template:

1. Navigate to the Manage Planning Cycles page:

a. Inthe Navigator, under Supply Chain Planning, click the Sales and Operations Planning work area link.
b. Inthe Sales and Operations Planning work area, click the Tasks panel tab.
c. Inthe Tasks panel drawer, under Planning Cycles, click the Manage Planning Cycles link.

2. Onthe Manage Planning Cycles page, in the Actions menu, select Create.

3. In the Create Planning Cycle dialog box, enter or select the following values:

Field Definition

Planning Cycle to Copy Select the planning cycle template from which to copy. Use the predefined planning cycle
template called Default_PlanCycle to initially create a planning cycle.

Planning Cycle Enter a name for your planning cycle, such as: SOP FY2019 January.
Description Enter a description for the planning cycle that you are creating.

Start Date Enter a start date for your planning cycle in the following format: mm/dd/yy.
End Date Enter an end date for your planning cycle in the following format: mm/dd/yy.
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Field Definition
Plan Select a sales and operations plan to associate with the current planning cycle. The link that you

set up for an activity or task ties that report to the plan.

You can select multiple plans. For example, you can select the current baseline plan and
alternative plans under consideration for the current planning cycle.

4. When done entering or selecting values, click Save and Continue.

The Manage Planning Cycles page, Product Review tab appears where you can configure your planning
activities, tasks, and participants.

5. To create an activity, do the following:

a. Click the Create icon and select Activity.
b. Inthe Create Activity dialog box, enter or select the following values:

Field Description
Title Enter a title for your activity.
Category Displays the name of the planning cycle category, such as Product Review, Demand

Review, Supply Review, and so on.

Owner Select the owner of the activity.

Assignee Select the assignee for the activity.

Type Select General or Meeting.

Link Select a table, graph, tile set, layout, or URL to which to link. The link that you set up for

the activity ties that report to the plan.

c. When done, click Save and Close to return to the Manage Planning Cycles page, Product Review tab.
6. To create a task, do the following:

a. Click the Create icon and select Task.
b. Inthe Create Task dialog box, enter or select the following values:

Field Description

Activity Title Select an activity to which to associate the task.
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Field Description
Title Enter a title for your task.
Owner Select the owner for the task.
Assignee Select the assignee for the task.
Due Date Select one of the following for a date by which the task must be completed:

- Offset days from cycle start: Enter the number of days from the start of the cycle.

- Fixed: Enter a specific date.

Type Select General or Meeting.

Link Select a table, graph, tile set, layout, or URL to which to link. The link that you set up for
the task ties that report to the plan.

c. When done, click Save and Close to return to the Manage Planning Cycles page, Product Review tab.
7. To configure the participants for your plan:

a. Click the Edit icon to access the Participants: Product Review dialog box.
b. Select participants and either add them to or delete them from the Participants list.
c. When done, click Save and Close to return to the Manage Planning Cycles page, Product Review tab.

8. When you are done configuring the planning cycle for the Product Review stage, click the other tabs to
configure the other stages: Demand Review, Supply Review, Financial Review, and Executive Review.

Note: The Sales and Operations Planning process does not require you to have all of the review stages. If you
do not have a product review or a formal executive review, then do not add any participants or tasks for those
review stages.

9. When you have completed configuring the planning cycle for all stages, click Done.

Related Topics
« Overview of Planning Cycles in Sales and Operations Planning

« Configure Planning Cycle Stages
» How You Work in a Planning Cycle
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Link Planning Cycle Tasks to Demand and Supply Plans

You can link the planning cycle tasks to demand and supply plans using the following steps:

1. On the Manage Planning Cycles page, select the Name of the planning cycle.
2. Inthe Actions menu, select Edit.
3. Inthe Edit Planning Cycle dialog box, select Plans.

Select the demand and supply plans to associate with the current planning cycle. You can link the planning cycle
activities and tasks with demand and supply plans used in your Sales and Operations Planning process.

You can select multiple plans. For example, you implement the Demand Management, Supply Planning or
Replenishment Planning plans. You can use these detailed plans together with, or without, the sales and operations
plans.

Link Planning Cycle Tasks to External Systems

You can link planning cycle activities, tasks, action items, and decision items in Sales and Operations Planning to
external systems outside of Oracle Cloud Supply Chain Planning. You can select a configured link from an open
planning cycle task to open the link in a new tab.

For example, if you have a task to review and adjust the financial forecast in Oracle Cloud Enterprise Performance
Management (EPM), you can configure a task link from Sales and Operations Planning to your EPM application.

When you create a planning cycle link to an external system in Sales and Operations Planning, follow these steps:

1. In Name, enter the link to view when you navigate from a planning cycle task.

2. In Application Name, select the name that you create in Manage Integration of Additional Applications. The
name must start with SCP_EXT_LINK_. Refer to the Set Up the Application Integration for an External System
topic for further instructions.

In Base URL, the base URL that was configured for the Application Name is displayed.
4. In Page Path, enter the remaining path with a plan token (#PlanName# or #Planld#) or without plan context.
o #PlanName#: Use this token to pass the plan member name.

W

o #Planld#: Use this token to pass the internal ID of the plan member.

The Page Path in a planning cycle link to an external system either can have a plan context or no plan context. For
example, a URL link to a web page doesn’t require plan context. When specifying plan context in the Page Path, use a
plan token. The system will replace the token with a selected plan when navigating to an external system with a plan
context. The potential targets of navigation are displayed if you specify the plan context. If you go to a link with no plan
context, you can't see any of the plans associated with the planning cycle as there’s no plan context in the configured
page path.

Related Topics
« Set Up the Application Integration for an External System
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Configure Planning Cycle Stages

Sales and Operations Planning provides five preconfigured review stages in a planning cycle: Product Review, Demand
Review, Supply Review, Financial Review, and Executive Review.

You can change the review stage names to better align with your organization's planning processes. For example, you
can rename Demand Review to Demand and Supply Balancing. You can also choose to not display a review stage tab in
your planning cycle. Use the Configure Planning Cycle Stages dialog box to rename or hide a review stage, which you
navigate to from the Manage Planning Cycles page.

In Manage Planning Cycles, you create a planning cycle by using an existing planning cycle as a template. When you
copy a planning cycle, changes that you made to the planning cycle stage names and your choices to display stage
names or not are copied over to the new planning cycle.

Note: You can only have up to five review stages in a planning cycle, and you must display at least one stage. Also,
the planning cycle stage name must be unique; the name can't already exist in the planning cycle.

Use the following steps to rename your review stages or to hide a stage for the planning cycle:

1. Open the Configure Planning Cycle Stages dialog box:

a. From the Sales and Operations Planning work area, click the Tasks drawer and then click Manage
Planning Cycles.

b. On the Manage Planning Cycles page, search for and select your planning cycle.

c. When the planning cycle opens, click Actions and then select Configure Stages.

The Configure Planning Cycles Stages dialog box opens.
2. Inthe Stage Name Override column, enter a new name to use instead of the predefined review stage name.

The planning cycle stage name that you enter must be unique. The name cannot already exist in the planning
cycle.
3. Inthe Enabled column, select Yes to display the tab or No to hide the tab for that stage on the user interface.

You must have at least one planning cycle review stage set to Yes.
4. When done, click Save and Close.

Your changes appear on the Manage Planning Cycles page. If you use this planning cycle as a template for a
new planning cycle, your changes carry over to the new planning cycle.

Note: If you're working in an open planning cycle, you must close the planning cycle and then reopen it to
see your changes.

Related Topics
» Overview of Planning Cycles in Sales and Operations Planning

» Create a Planning Cycle
» How You Work in a Planning Cycle

196
ORACLE



Oracle Fusion Cloud SCM Chapter 10
Using Sales and Operations Planning Planning Cycles

How You Work in a Planning Cycle

After you create and configure your planning cycle in Sales and Operations Planning, open it to monitor the progress of
your activities and tasks. You can see where you are in the planning process and create action items, if needed.

You can see how many steps have completed, as well as the time to get work done to close a task.

When you open a planning cycle from the Sales and Operations work area, you will see only the review tabs for which
you have participants and tasks assigned. For example, you have no participants assigned for the Executive Review, so
the Executive Review tab does not appear when you open the planning cycle. If needed, you can modify the planning
cycle and add participants and tasks for the Executive Review.

The tabs for a planning cycle are:

- Overview

« Product Review
- Demand Review
- Supply Review

- Financial Review
- Executive Review
- Notes

You can access the Overview and Notes tabs and the tabs for the stages in which you are a participant. For example,
a demand planner might be a participant in the product, demand, and supply reviews but not for the financial or
executive reviews.

The Overview tab displays an overview of the overall Sales and Operations process where you can monitor progress to
date. The Overview tab also provides a timeline, list of assigned tasks, and participants. You can filter the Worklist and
Timeline sections by review phase, such as Supply Review.

The Product Review, Demand Review, Supply Review, Financial Review, and Executive Review tabs all have the same
user interface. Each tab contains editable lists of planning activities, tasks, and action items. Each task is associated with
an owner, due date, and status.

Each review type displays the following panes:

- Planning Activities: Displays the list of activities and tasks for the review process. This list is editable, so you
can insert additional tasks when needed.

- Action Items: Lists action items assigned during the review process and their status. Each task has an owner,
assignee, due date, and status. Action items can have a link to a relevant dashboard or report to carry out each
task.

- Decision Items: Displays a list of recommendations and alternatives to consider for discussion in an upcoming
review meeting. You can escalate the decision items from the review stage. If you cannot make a decision about
the item, you can defer the decision and push the decision item out to a later stage.

The Notes tab is where you can document and communicate important information. For example, use Notes to
document why there was a change to the plan or record decisions and assumptions that led to those changes. In Sales
and Operations Planning, you can associate notes with objects, such as product categories. With such documentation,
you can understand why decisions were made and who made them.
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To open a planning cycle:

1. In the Navigator, click the Sales and Operations Planning work area link.
2. Inthe Tasks panel drawer, click the Open Planning Cycle link.

3. Inthe Open Planning Cycle dialog box, select a planning cycle.

4. Click OK. Your planning cycle opens on the Edit Plan page.

Related Topics
« Product Reviews

« Demand Reviews
» Supply Reviews
« Financial Reviews

« Executive Reviews

Planning Cycle Phases

Product Reviews

The Sales and Operations Planning product review process helps channel new product development by providing
decision makers with visibility into the key revenue and profitability metrics associated with the new product
introduction.

You can measure the profitability of a new product through an analytic that shows the revenue for new product items.

The predefined Product Review dashboard in the Sales and Operations Planning work area enables you to perform a
cross-functional review of new products and the life cycle of maturing products. The dashboard has four predefined
infotiles that enable you to monitor the health across the product life cycle from prelaunch planning to postlaunch
performance. You can also view metrics associated with end-of-life items.

The four infotiles on the Product Review Summary dashboard are:

- New Product Vitality: Displays the percentage of revenue contributed by a new product. New product revenue
is the revenue from expected sales for products that have their Lifecycle Phase item attribute set to Prelaunch,
Postlaunch, or Growth.

- Shipments Forecast Value Change: Displays the difference in Shipments Forecast Value between the current
estimate and its value in the last MAPE archive across all prelaunch items.

- Bottom MAPE for Postlaunch Items: Displays Bottom Shipments Forecast MAPE for postlaunch items
associated with shipments forecast.

- Periods of Cover for Declining Items: Displays the Projected Available Balance Periods of Cover for Decline Item
measure. This measure is calculated as the ratio of the projected available balance to the total demand.
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Related Topics
» Overview of Planning Cycles in Sales and Operations Planning

« Create a Planning Cycle

» How You Work in a Planning Cycle

« Overview of Plan Archival in Supply Chain Planning
« Use the Manage Product Launch Page

Demand Reviews

The Sales and Operations Planning demand review process enables the collaboration within an enterprise required
to develop an unconstrained consensus forecast. The consensus forecast is a single set of forecast numbers that the
enterprise determines.

Use the Demand Review Summary dashboard in the Sales and Operations Planning work area to identify significant
gaps between lagged consensus forecast and actual sales. From the dashboard, you can drill down to various tables to
make forecast adjustments.

The four infotiles on the Demand Review Summary dashboard are:

Unconstrained versus Forecast: Displays the comparison between the Unconstrained Operating Plan Value and
the Financial Forecast Value. The Unconstrained Operating Plan Value is the value of all of the demand planned
for. The Financial Forecast value is the forecast estimate (in currency).

Consensus Forecast Value Change: Displays the change between the Consensus Forecast Value, the current
consensus forecast, and the previous value in the last MAPE archive.

- Forecast Value Comparison: Displays the comparison between the Consensus Forecast Value and the Final
Sales Forecast Value.

- Stakeholder Forecast MAPE: Displays the comparison between the forecast accuracy performance and
stakeholders. This infotile compares the sales, marketing, and consensus forecasts.

Related Topics
» Overview of Planning Cycles in Sales and Operations Planning

« Create a Planning Cycle
« How You Work in a Planning Cycle

Supply Reviews

The Sales and Operations Planning supply review process helps you to measure and improve key metrics to produce
according to your plan. Use the latest consolidated, unconstrained demand plan and analyze the feasibility of internal
and external supply capacity to fulfill demands.

For example, you can analyze whether there is sufficient supplier and resource capacity and inventory to balance supply
with demand.

The supply review process uses the demand plan from the Demand Review and the available supplier and resource
capacity and other supply information for supply planning. The process also determines the ability to meet the

199
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20056882

Oracle Fusion Cloud SCM Chapter 10
Using Sales and Operations Planning Planning Cycles

consensus-based demand plan, compares future supply planning performance with archived, historical measures. After
you make the consensus forecast adjustments in the demand review process, you can rerun the supply plan. Running
the supply plan enables you to evaluate where you can create sufficient additional supply to meet increased demand.

Use the Supply Review Summary dashboard in the Sales and Operations Planning work area to view the following

graphs:

Demand and Supply: View the total demand compared to the total supply to determine if there are any gaps.

Resource Overloading: Drill down into detailed graphs that show you organizations with overloaded resources.
For example, you can drill down to the Resource Plan by Month table. In the Resource Plan by Month table, you
can identify the resources and the time buckets in which resources are constrained.

Supply Overloading: View the key time periods and supplier items that have a large number of exceptions. You
can drill from individual items in the Exceptions Top Utilized Items graph to view the plan for the associated
suppliers of that item.

Inventory Turnover: View this graph to monitor inventory cover.

Cost Comparison: View the manufacturing, purchase, carrying, and shipping costs.

Related Topics

Overview of Planning Cycles in Sales and Operations Planning
Create a Planning Cycle
How You Work in a Planning Cycle

Financial Reviews

The Sales and Operations Planning financial review process provides visibility into financial metrics. You can compare
operational plans with the business plan and financial budget. You can review revenue, costs, margins, inventory value,
and other performance measures.

You can identify whether overall revenue and profits are tracking to plan, and identify key areas of improvement.

The Financial Review dashboard in the Sales and Operations Planning work area has five predefined infotiles that
provide you with visibility into revenue and profit details:

Plan versus Forecast: Compares the Operating Plan Value and Financial Forecast Value. The Operating Plan
Value is the sum of the values of Shipment History and the Constrained Forecast value.

Unmet Revenue: Displays unmet revenue, which is calculated based on the value of demand that cannot be
met on time.

Cost Comparison: View the manufacturing, purchase, carrying, and shipping costs.
Gross Margin: Displays the overall gross margin between revenue and cost.

Revenue and Gross Margin Percentage: Displays the revenue and gross margin percentage.

Related Topics
« Overview of Planning Cycles in Sales and Operations Planning

- Create a Planning Cycle

- How You Work in a Planning Cycle
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Executive Reviews

The Executive Review dashboard supports the Sales and Operations Planning meeting. This meeting occurs every
planning cycle in which senior stakeholders meet. The dashboard, which you access from the Sales and Operations
work area, provides executive visibility to performance indicators, forecast issues, and operational issues.

The Executive Review dashboard provides visibility into key performance indicators, business trends, new product
development metrics, and supply and demand mismatches across the process stages. The Executive Review dashboard
contains seven predefined infotiles:

- Plan versus Forecast: Compares the Operating Plan Value and Financial Forecast Value. The Operating Plan
Value is the sum of the values of Shipment History and the Constrained Forecast value.

- New Product Vitality: Displays the percentage of revenue contributed by a new product. New product revenue
is the revenue from expected sales for products that have their Lifecycle Phase item attribute set to Prelaunch,
Postlaunch, or Growth.

- Forecast Value Comparison: Displays the comparison between the Consensus Forecast Value and the Final
Sales Forecast Value.

- Cost Comparison: View the manufacturing, purchase, carrying, and shipping costs.
- Gross Margin: Displays the overall gross margin between revenue and cost.
- Revenue and Gross Margin Percentage: Displays the revenue and gross margin percentage.

- Inventory Turnover: View this graph to monitor inventory cover.

Related Topics
» Overview of Planning Cycles in Sales and Operations Planning

» Create a Planning Cycle
» How You Work in a Planning Cycle
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11 Sales and Operations Plans

Overview of Sales and Operations Plans

Before you can run a sales and operations plan, you must create the plan and define its options. Plan options determine
the actions of the planning services by specifying the type of plan to run.

These options specify the scope of the plan in terms of organizations, items, resources, time horizon, planning
measures, and more. Plan options also configure whether to plan demand and supply separately or sequentially within a
plan. Use the Create Plan page in the Sales and Operations Planning work area to create the plan and define its options.

Navigate through the following tabs on the Create Plan page to set up plan options for your sales and operations plan:

- Scope: Specify plan organizations, items, time horizon, and measures used in the plan.
Demand: Specify forecasting profiles to include when planning demand.
- Supply: Specify general and organization-specific options for planning supply.

The Manage Plans page in the Sales and Operations Planning work area is for integrated plan management. The
following are some of the tasks that you can perform from the Manage Plans page:

- Create and define plans
- Create a copy of existing plans
- Open an existing plan
Run plans in batch mode
Perform data refresh on your plans
- Approve plans

For existing sales and operations plans, use the Manage Plans task to search for and open a plan. To access the Manage
Plans page and open an existing sales and operations plan, do the following:

From the Navigator click the Sales and Operations Planning work area link.

Click Manage Plans from the Tasks drawer.

On the Manage Plans page, provide the appropriate search criteria and click Search.
In the search results area, select your plan and click the Actions button.

PUNa

Related Topics
- Actions to Manage Your Plans

Manage Plans

Actions to Manage Your Plans

The Actions menu on the Manage Plans and the Edit Plan pages are integrated plan management pages for all plan
types. When you open the Edit Plan page, note that only the plan name displays in the heading.
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Note: Not all action options are available on both the Manage Plans page and the Edit Plan page. For example,
the Compare action is only available when you're in an open plan on the Edit Plan page. Also, not all action options
are available for all plan types or work areas. For example, the Planning Central work area doesn't include Archive,
Compare, or Copy to Simulation Set in the Actions menu.

The following table lists the available options in the Actions menu and the description of each option.

Action

Approve

Archive

Cancel Compare

Close

Compare

Copy to Simulation Set

Create

Delete

Duplicate

Edit Plan Options

Export

Export Plan Data

Load

Manage Tables, Graphs, and Analysis Sets

ORACLE

Description

Initiate and complete the approval process for a plan.

When you rerun the plan, the Approved status is removed from the Approval Status column.

Archive a plan.

Cancel the comparison of plan data.

Close a loaded plan from memory. This option isn't available for Demand Plan types.

Compare plan data with another plan.

Open the Copy to Simulation Set dialog box to copy plan data to an existing simulation set. Plan data
includes items, resource availability, bill of resources, and so on. This option is available only for Supply
Plan and Demand and Supply Plan types.

Open the Create Plan dialog box where you can define the plan options for your new plan. Depending
on your plan type, define the scope, demand, safety stock, and supply options. The Safety Stock tab
isn't available for Sales and Operations Plan types.

Delete a plan and its archive versions. This irrevocable action purges the plan from memory and the
database.

Create a copy of an existing plan to leverage previously defined plans or to perform what-if simulation
analysis. You can decide whether you want to copy only the plan options or copy the plan options
including plan data.

Open the Plan Options dialog box where you can edit your plan options. Depending on your plan type,
you can change the scope, demand, safety stock, and supply options.

Export the data from the Search Results table on the Manage Plans page to a spreadsheet.

Extract all multidimensional plan data from a plan into a set of files for offline reporting and analysis.

Load the plan into memory. This option is available only for Supply Plan, Sales and Operations Plan,
and Demand and Supply Plan types.

Open the Manage Tables, Graphs, and Analysis Sets dialog box. You can search for tables, graphs, tiles,
tile sets, and analysis sets and manage them.
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Action Description
Open Open the Edit Plan page for an existing plan. Note that only the plan name displays in the page
heading.
Publish Order Forecast Starts the Publish Order Forecast job. You can publish the order forecast without saving the plan to

the database. This option is available in the Actions menu on the Items, Supplies and Demands, and
Manage Plans page. This option is available only for Supply Plan, and Demand and Supply Plan types.

Publish Data Export measure data from a plan based on a pivot table. You can export the data available in planning
data measures at any aggregation level based on an existing pivot table to a file in a comma delimited
(CSV) file format.

Release Release the plan from the Supply Chain Planning work area to another plan execution system. This
option is available only for Supply Plan, and Demand and Supply Plan types.

The Release action integrates Supply Chain Planning with other plan execution systems by publishing
approved planning recommendations to execution systems. These plan recommendations can be in
the form of new planned orders, rescheduled existing supplies, and canceled existing supplies.

Request Approval Request approval of a plan. This option is available only for Sales and Operations Plan types.
Reset Approval Status Reset the approval status. This option isn't available for Supply Plan types.
Review Plan Messages Open the Review Plan Messages tab to review the warning and error messages generated by the

planning processes, such as forecast generation and supply plan generation. You can also review the
recommendations to address the warning and error conditions.
Run Run the plan and generate data.
When you click Run, the Run Plan dialog box opens. In the Run Plan dialog box, you can select data
refresh options, scope options, and demand and supply plan run options to generate planning data.
Save Plan to Database Save the plan from the memory to the database.
The benefit of saving a plan to the database is that you can perform plan analysis without first loading

the plan. This option is available only for Supply Plan and Demand and Supply Plan types.

View Status Details Open the Plan Status Details dialog box to view all of the actions performed by any user for the
selected plan. You can also export status details to a spreadsheet.

Related Topics
« Overview of Supply Chain Planning Plan Types
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Create a Plan

You can create plans and then duplicate them to save time and perform planning activities incrementally. For example,
you have defined the line of business associated with an existing plan, such as organizations and items.

You can create a copy from that existing plan rather than define a new plan.

Use this generic procedure to create a plan.

PUWNA

In a Supply Chain Planning work area, click the Tasks panel tab.

In the Tasks panel drawer, click the Manage Plans link.

In the Search Results region, from the Actions menu, select Create.
On the Create Plan page, complete the general information for the plan:

e ngoo

Enter a name.

(Optional) Provide a description for the plan.
Select the plan type.

Select a supply planning mode.

Note: The Supply Planning Mode attribute is only available for a supply plan, demand and supply plan,
or a sales and operations plan type.

- Supply plan and demand and supply plan types: Options are Constrained and Unconstrained.
Constrained is only available if you have opted in for Constraint-Based Supply Planning. Otherwise,
the supply planning mode defaults to Unconstrained.

- Sales and operations plan type: The supply planning mode defaults to Aggregate.

(Optional) Select the Enable for OTBI reporting check box to make measures from a plan available in
Oracle Transactional Business Intelligence (OTBI) for reporting.

Select the owner.
Define the access level:

i. Select Public to make the plan accessible for all users.

ii. Select Private to restrict the plan accessible to you and to a list of users that you want to provide
access.

5. Based on the type of plan that you selected, complete the required information in one or more tabs (Scope,
Demand, Safety Stock, and Supply).

Related Topics
» Copy a Plan

If you're planning to show archived measures in your plan, you need to set the duration in days for the archived
time periods and enable viewing the past days on the plan table. See the View Planning Measures from Archived
Time Periods topic to learn more.

6. Click Save and Close.

« View a Plan
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Copy a Plan

You can create plans and then duplicate them to save time and perform planning activities incrementally.

For example, you have defined the line of business associated with an existing plan, such as organizations and items.
You can create a copy from that existing plan rather than define a new plan.

Use the Duplicate procedure to:

- Create a copy of an existing plan that includes the plan data.
- Create only a copy of plan options.

Use these steps to copy a plan.

1. Navigate to the Duplicate Plan dialog box:

In a Supply Chain Planning work area link, click the Tasks panel tab.
In the Tasks panel drawer, click the Manage Plans link.
Enter the search parameters and click the Search button.

In the Search Results region, select the plan that you want to copy, click Actions, and then select
Duplicate.

2. Inthe Duplicate Plan dialog box, complete the following information for the plan:

e ngoo

a. Select a copy type:

- Copy plan options only: The planning process copies plan options to the duplicate plan, but not
the plan data.

Typically, when you duplicate the plan with the Copy plan options only option, the next step is to
edit the plan options before running the plan.

- Copy plan with reference to base plan: When you duplicate the plan with reference to the base
plan, the next step is to open the copied plan as you're likely to make edits before running the plan.
On the Manage Plans page, the Copied From column displays the name of the plan that you copied
from.

CAUTION: If you delete the base plan or rerun the base plan with the Refresh with current data
option, plans copied from the base plan become invalid.

- Copy all plan data with no reference to base plan: The planning process makes a full, standalone
copy of the plan, which can include archived measures. For approved sales and operations plans,
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this option enables you to create a full backup copy of your plans at the end of every planning
cycle.

On the Manage Plans page, the Copied From column is empty for the new plan because it's a
standalone copy of the base plan. Therefore, there's no reference to the base plan.

The Copy all plan data with no reference to base plan option isn't available for demand plan types.
Enter a name and a description.
c. Define the access level:

- Select Public to make the plan accessible for all users.

- Select Private to restrict the plan accessible to you and to a list of users that you want to provide
access.

d. (Optional) Select the Load plan after copy check box to load the copied plan to memory. This check box
isn't available for demand plan or sales and operations plan types.

e. Select the owner.

f. (Optional) Select the Include archives check box to make a standalone copy of your plan that includes
archived measures. The copies of the archived versions are relabeled to remain consistent with the new
plan name. This relabeling applies to both scheduled and ad hoc archive versions.

The transaction history of when archived versions were created in the original plan isn't copied to the
new plan. However, the new archived version names retain the date stamp and sequence number of
when the archives were originally run.

The Include archives check box is available only when:

- The Enable for archiving check box is selected in the Scope: Advanced Options dialog box in the
plan options.

- The Copy all plan data with no reference to base plan is selected as the copy type in the
Duplicate Plan dialog box.

3. Click Save and Close

Related Topics
- CreateaPlan

« View a Plan

View a Plan

If you already have an existing plan, you can open the plan from the Plans drawer or by using the Manage Plans task.
You must always run a plan before you can view it.
To open an existing plan from the Plans drawer to view it, do the following:

1. In a Supply Chain Planning work area link, click the Plans drawer.
2. Expand Plans, and select the plan of your choice.
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3. Click the Actions button and select Open.

Tip: If you have many plans, you have an option to search a plan by using the Manage Plans task. In this
case, provide appropriate search criteria and click Search. In the search results area, select your plan and click
the Action button and select Open. Oracle recommends this method to view sales and operations plans.

Note: If you're planning to show archived measures in your plan, you need to set the duration in days for the archived
time periods and enable viewing the past days on the plan table. See the View Planning Measures from Archived Time
Periods topic to learn more.

Related Topics
+ Create a Plan

Enable Plans for OTBI Reporting

Oracle Transactional Business Intelligence (OTBI) is a real-time, self-service reporting solution that helps you create
user-defined and interactive reports.

You can enable OTBI reporting for plans created in your Supply Chain Planning work area to:

Run reports in real-time to analyze supply, demand, and sales and operations planning plans
- Generate user-configurable and easy-to-use reports by using business intelligence tools and charts
- Analyze key metrics, such as exception metrics, inventory balances, pegged quantity, and orders to be released
- Compare two or more plans that are enabled for OTBI reporting

To improve your supply chain performance, you can monitor and identify problem areas by using strategic insights into
live and operational data. Compare different scenarios in real-time by using key measures to decide the best course of
action. You can respond to changes by modeling complex strategies and plans to analyze and compare them. You can
also define native OTBI capabilities like alerts based on exception conditions, user-defined measures, and conditional
formatting to monitor or track problem areas.

To create OTBI reports, navigate to the Reports and Analytics work area. You can build reports by using the base
measures available in your Supply Chain Planning work area. You can also create user-defined measures based on the
base measures by using the standard business intelligence tools.

To open OTBI reports in a Supply Chain Planning work area, save the OTBI reports into the Report Components
subfolder within the Transactional Analysis Samples folder. The Report Components folder is located in the shared
Supply Chain Planning folder in the Reports and Analytics work area.

To enable OTBI reporting for plans, you must do the following:

- Select the Enable for OTBI reporting check box on the Plan Options page of your supply, demand, or sales and
operations plan.

Note: You must run the plan after you enable it for OTBI reporting.

- Set up reporting hierarchies by configuring the Product and Time hierarchies in the dimension catalog named
Reporting Catalog. To configure the Product and Time hierarchies, use the Configure Planning Analytics task
in your Supply Chain Planning work area. Depending on the reports that you want to generate, move the
Product and Time hierarchies from the Available Hierarchies pane to the Selected Hierarchies pane. If you select
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multiple Product and Time hierarchies, ensure that you select a default hierarchy for the Product and Time
hierarchies. The default hierarchies are used by default in the predefined reports.

You can build reports by using the base measures available in your Supply Chain Planning work area. You can also
create user-defined measures based on the base measures by using the standard business intelligence tools.

Accessing the OTBI Reports

Perform these steps to access the OTBI reports:

1. In a Supply Chain Planning work area, open a plan that is enabled for OTBI reporting.
2. Click the Open button and then select a pane.
3. Inthe Open Table, Graph, or Tile Set dialog box, do one of the following:

o Search for your report.
o Filter the list by selecting Type and then Report.
4. Select a report and then click OK.
The OTBI report opens in the context of the current, open plan.

When you search for reports, the list of reports in the search results includes predefined reports and user-defined
reports created by you. You must save the user-defined reports into the Reports Components subfolder within the
Transactional Analysis Samples folder to make them available in the Supply Chain Planning work areas. The following
predefined reports are available only in the Supply Planning and Planning Central work areas:

Build Plan by End Item

Exception Summary by Item Order
Details by Item

Pegging Details by End Item

Plan Recommendations Summary Graph

Available Measures
The following measures are available in the Reports and Analytics work area:

Configure to Order Forecast Metrics: The following configure to order forecast metrics are available for demand
plans, and demand and supply plans:

o Final Option Demand Forecast
o Final Planning Percent
o Option Demand Forecast

Configure to order forecast metrics support dimensions, such as Plan, Time, Product, Organization,
Customer, Top Model, and Demand Class.

- Demand Management Metrics: The following demand management metrics are available for demand plans,
and demand and supply plans:

o Bookings Forecast
o Bookings History
o Bookings History Value
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Final Bookings Forecast
Final Shipments Forecast
Shipments Forecast
Shipments Forecast Value
Shipments History
Shipments History Value

Demand management metrics support dimensions, such as Time, Product, Organization, Customer, and
Demand Class.

- Exception Metrics: The following exception metrics are available for supply plans, and demand and supply

plans:

o

o

o

Exception Count
Exception Quantity
Exception Days
Exception Ratio
Exception Value

Exception metrics support dimensions, such as Plan, Time, Product, Organization, Customer, Supplier,
Manufacturing Resource, and Exception Type.

Order Metrics: The following order metrics are available for supply plans, and demand and supply plans:

Order Quantity
Implemented Supply Quantity
Order Value

Order metrics support dimensions, such as Plan, Time, Product, Organization, Order Details, and Order
Type.

- Pegging Metrics: The following pegging metric is available for supply plans, and demand and supply plans:

o

Pegged Quantity

Pegging metric supports dimensions, such as Plan, Time, Product, Organization, Customer, Supplier, End
Demand, and Order Type.
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- Sales and Operations Planning Metrics: The following sales and operations planning metrics are available for
sales and operations plans:
o Consensus Forecast

o Consensus Forecast Value
o Final Sales Forecast

o Final Sales Forecast Value
o Sales Forecast

o Sales Forecast Value
Sales and operations planning metrics support dimensions, such as Plan, Time, Product, Organization,
Customer, and Demand Class.

Define and Manage Plan Options

Define Scope Plan Options

Scope options determine the scope of the sales and operations plan. Define or modify scope plan options on the Create
Plan page, Scope tab or the Edit Plan Options page, Scope tab.

You can configure plan organizations, items, time horizon, and planning level for demand forecasting. You can also
define the filters for a plan, such as the hierarchy, level, and level members.

On the Scope tab, indicate which dimension catalog to use for your sales and operations plans. The dimension catalog is
a grouping of dimensions and hierarchies for use in plans. Use either the Default Catalog or create your own dimension
catalog.

The Scope tab includes the following sections for sales and operations plans:

Plan Organizations
Plan Items
Plan Parameters

Plan Organizations

Specify a hierarchy, level, and level members by which to filter the plan. Also, select the source system code to use
for filtering organizations. Fields in the Plan Organizations section are required. If you select a level that's above the
organization level, then the plan includes organizations that belong to that parent level.

Plan Items

Specify a hierarchy, level, and level members by which to filter specific items for demand planning. Your selections
are used in conjunction with your selections in the Plan Organizations section. ltems that belong to a parent level are
included. Fields in this section are required for sales and operations plan types.

Plan Parameters

You can set up your sales and operations planning at a weekly, monthly or quarterly level. For better performance,
Oracle recommends that you run your sales and operations plans at a monthly level. If you run your plan at the weekly
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level for two years, you have 104 weeks worth of data. The processing engine must process a larger volume of data,
which impacts performance. If you run your plan at the monthly level for two years, you have only 24 buckets, which
means better performance. For a long-range strategic planning horizon of three or more years, consider quarter-level
planning.

Note: When you define your sales and operations plans for longer horizons using a Gregorian calendar, you might
need to extend the calendar. Select the Build Gregorian Calendar schedule process to extend your Gregorian calendar
to ensure it goes out far enough for planning.

The following table describes the plan parameters for sales and operations plan types.

Parameter Definition

Plan Horizon Days Number of days in the plan. Set horizon days to forecast and plan for future needs. Minimize horizon
days to avoid long-running plans. Default is 550 days.

Planning Calendar Calendar used for forecasting and setting time level. The calendar must belong to the dimension
catalog associated with the plan.

Planning Time Level Planning time level that's used in a plan and is used by forecasting profiles. The sales and operations
plan can be generated in weekly, monthly, or quarterly time buckets. Time levels vary, depending on
the forecasting calendar that you select. Default value is Gregorian Month.

Measure Catalog Group multiple sets of measures for use in a plan. By enabling only those measures that are needed
for any specific plan, you can perform a focused analysis with improved performance. A planning
administrator can create and modify measure catalogs. Default value is Default S&OP Catalog.

Price List Price list used in revenue calculations. The default price list for use in value calculations is Item List
Price, defined in Items table for Organization and Item. Item List Price is always used to calculate
revenue, even if a collected price list is marked as the primary. However, if a collected price list is
marked as the primary and the Include When Deriving Selling Price checkbox is marked, the revenue is
calculated using the derived price.

Exception Set Lists exceptions to compute as part of a plan and also filters on Organizations and Categories for
computing exceptions.

Simulation Set Lists simulation sets to use in your plan. A simulation set is a set of adjustments to plan inputs. Apply
a simulation set to a plan to model different business scenarios, such as increasing available resource
capacity.

Related Topics

» How You Use Dimensions and Dimension Catalogs in Supply Chain Planning
- Considerations for Setting Up Dimension Catalogs
- Configure Archiving Parameters
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Demand Plan Options

Use the Demand tab in Plan Options to define the demand plan options. Demand planning is a separate planning
process from supply planning in many companies.

Define or modify demand plan options on the Create Plan or Edit Plan Options page, Demand tab in a Sales and
Operations Planning work area.

Related Topics
- Forecasting Profile Options for Demand Plans

Use Demand Plan Measures for Consensus Forecasting

Instead of generating a statistical forecast in your sales and operations plan, use a forecast measure in Oracle Demand
Management Cloud as the baseline for consensus forecasting in Sales and Operations Planning.

After you develop a consensus demand forecast in your sales and operations planning cycle, run your sales and
operations plan and then review and adjust the consensus forecast.

You can use a demand forecast measure as an input for aggregate supply planning. For example, your unconstrained
demand forecast might be calculated in a user-defined measure in your demand plan. You can run the sales and
operations plan with this demand forecast and then review the plan output. If you need to override this baseline
forecast, then you can edit the Adjusted Consensus Forecast measure and run the plan again to simulate the supply
impact due to this change in demand.

By loading a forecast measure from a Demand Management plan as the baseline of your consensus forecast, the
planning process recognizes that statistical demand forecasts are generated in your demand plan and not your sales
and operations plan. For example, the demand plan measure includes data for new product forecasts and modeled
events. In this case, you can't associate a forecasting profile with a sales and operations plan when loading a demand
measure to the Shipments Forecast.

Configure the Demand Plan Measure

Navigate to the Plan Options page, Demand tab to configure the demand plan measure for your sales and operations
plan.

Load measure data from demand plan to target measure: Select the check box to load a forecast measure
from a Demand Management plan to the Shipments Forecast measure in a sales and operations plan.

When selected, all associated forecast profiles are removed from your sales and operations plan.

From Plan: Select the Demand Management plan to use as the source of the forecast measure to load measure
data into a sales and operations plan.

The field displays any demand plan that uses a hybrid time hierarchy if the planning calendar of your sales and
operations plan is one of the calendars that was used in the creation of the hybrid time hierarchy. The planning
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calendar and planning time level of the sales and operations plan determine the level at which measure data is
copied.

For example, if you copy measure data from a demand plan for which the planning calendar is a Gregorian
hybrid hierarchy to a sales and operations plan that's defined at the Gregorian month, measure data gets
copied at the Gregorian month level.

Demand Measure: Select a forecast measure to load from a Demand Management plan.

Note: If the forecast measure to load from the demand plan is user-defined then you must ensure that
the measure is added to the End Item Demand measure group. This step adds the measure to the list that
appears in the Demand Measure field.

Forecasting Profile Options for Demand Plans

Demand plan options determine the forecasting profiles to include as part of a demand, demand and supply, or sales
and operations plan run.

Define forecasting profile options for a plan in a Supply Chain Planning work area on the Plan Options page, Demand
tab. The Demand tab isn't available for supply plans.

In the Forecast Profiles region, select which forecasting profiles are available for the plan run. You can also indicate the
amount of historical data used for forecast generation. When you run the plan, the forecast profiles run in the specified
order.

The demand planning engine generates statistical demand forecasts at different time levels such as day, week, or
month. For a demand plan, specify the time level in the Forecasting Time Level field on the Demand tab.

For a demand plan that uses a hybrid time hierarchy, the available forecasting time levels are parent levels of the Hybrid
time level for the hierarchy that you selected as the planning calendar on the Scope tab.

Note: For sales and operations plans, the demand planning engine can generate statistical demand forecasts at
weekly, monthly, or quarterly time levels. You specify the time level in the Planning Time Level field on the Plan
Options page, Scope tab.

Forecasting Profiles with Input Measures and Output Measures

In the Forecast Profiles region, specify which forecasting profiles to include as part of a plan. You can't edit the input
measure or output measure for a forecasting profile.

The following table lists the predefined forecasting profiles.

Forecasting Profile Name Input Measure Output Measure
Forecast Shipments Final Shipments History Shipments Forecast
Forecast Shipments Including Event Activity Final Shipments History Shipments Forecast

(Not available in the Planning Central or Sales
and Operations Planning work area)
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Forecasting Profile Name Input Measure Output Measure
Forecast Shipments Including Product Lifecycle  Final Shipments History Shipments Forecast

(Not available in the Planning Central work area)
Forecast Bookings Final Bookings History Bookings Forecast

Forecast Bookings Including Event Activity Final Bookings History Bookings Forecast

(Not available in the Planning Central or Sales
and Operations Planning work area)

Forecast Bookings Including Product Lifecycle = Final Bookings History Booking Forecast

(Not available in the Planning Central work area)

Analysis Set

An analysis set is an optional criterion used to apply a forecasting profile to a subset of a plan.

- If you don't select an analysis set, then the forecasting profile applies to the full scope of the plan.

- If you select an analysis set, then the forecasting profile is applied to only the subset of the plan scope defined
by the analysis set.

For example, you have an analysis set containing a specific set of products, and you select that analysis set for a
forecasting profile. The forecast is generated for the specific products included in both the analysis set and plan, instead
of for all the products in the plan.

Historical Buckets

Define the amount of historical data to use during the forecasting process. The statistical demand forecasting process
uses the number of buckets in this field to define the amount of historical data used.

The historical buckets substantially affect the demand forecast generated when you run the plan. Use at least 12 months
of history, but 18 to 36 months of history is the best practice. When setting the historical buckets, keep the following in
mind:

- Very long history affects plan runtimes and makes the forecast less relevant to current demand patterns.

- Less than 1year of history affects seasonal analysis. This includes both yearly seasonality and holiday impacts.

The historical buckets setting is the maximum amount of history used when generating a forecast. The actual amount
depends on the data available for a given item and organization. For each item and organization, the forecasting
process identifies all available historical data, removes any leading zero demand prior to the first positive demand point,
and generates a forecast.

History Start and End Dates

The plan definitions drive the history end date. The history start date is calculated based on the end date and historical
buckets.
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Forecast Buckets
Indicates how far into the future a demand forecast is generated and is driven by the planning horizon set for the plan.

Locked Forecast Buckets

Indicates the number of buckets from the end of historical data that don't receive a new forecast when you run the
demand plan.

Forecast End Date

Indicates the end date for a forecast that's generated when you run the plan. The end date is based on the planning
horizon and the current plan start date.

Define Supply Plan Options

For sales and operations plans, use the Plan Options page, Supply tab to set general and organization-specific supply
planning options. Use the General subtab to specify the supply plan attributes, aggregate plan attributes, and supply
constraints.

The Organizations and Schedules subtab lists the organizations specified on the Scope tab and the demand schedules
used to plan supply.

General
Supply Plan Attributes: Specify the supply plan attributes for the sales and operations plan.

- Select an assignment set.

- You can select the options to include purchase orders, transfer orders, work orders, or sales orders in the plan.

Aggregate Plan Attributes: Specify the aggregate plan attributes for the sales and operations plan.

- Planning Product Level: Specify the product level at which demands and the bill of resources are modeled in a
plan. You can set the product level as either item or Category. Item is the default setting.

- Category Level Members: Specify which items are planned at the category level. To select members, you must
select Category as the planning product level.

- Use Global Demand: Select to make the aggregate supply planning engine model demands globally. If
selected, then also specify the planning customer level.

Or, deselect to create a network with demand modeled at fulfillment warehouse organizations without
customer detail.

- Planning Customer Level: If you selected the Use global demand check box, then you can specify the
customer dimension level to use for aggregate planning. Specify the level at which to model customer demand
in your plan: Customer Site or Zone.

If you didn't select the Use global demand check box, then the planning customer level is set to None.
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Constraints: Specify the constraints for the sales and operations plans.

- Allow purchasing and transfer lead time compression: When the check box is selected, the lead time
compression exceptions are generated in a plan run. If the check box isn't selected, lead time constraints are
enforced. By default, the Allow purchasing and transfer lead time compression check box is selected.

- Consider supplier capacity constraints: Select to enforce supplier item capacity constraints at a component
category level by supplier location. You will still have visibility to the requirements for items within the category.
You can also continue to generate supplier requirements for unconstrained component categories if you
choose not to load available supplier capacity for those items.

- Consider processing lead time for assembly items: Select to include the processing lead time of an assembly
item during the aggregate supply planning step in the sales and operations planning process. By default,
processing lead times for assembly items aren't considered.

Aggregate supply planning uses bills of resources. The Aggregate Bill of Resources table provides a
representation of the critical component items and bottleneck resources required to make an assembly item. By
considering the processing lead time for assembly items, the Processing Lead Time attribute values in the ltems
table are included for assembly items. The processing lead time is used to offset the manufacturing start and
consumption of components and resources.

If the processing lead time of an assembly item is longer than a planning time period, then the consumption
of component items and resources occurs in the time period when manufacturing starts. Usage quantities
aren't spread across time periods. Also, aggregate supply planning doesn't accumulate lead times across
manufacturing stages to offset subassemblies.

- Consider work center capacity constraints: Select to enforce resource capacity constraints at the work center
level. You will still have visibility to resource loading within the work center. If you select this check box, you
can then select which work centers to constrain in manufacturing locations. You can also continue to generate
resource requirements for resources in unconstrained work centers.

- Constrained Work Center Level Members: If you selected Consider work center capacity constraints,
then you can also select the work center level members to constrain. The list of work centers is based on the
selections made in the Plan Organizations section on the Plan Options page, Scope tab. If you don't select any
work centers, then no resource capacity constraints are enforced.

Organizations and Schedules

Organizations: View organizations and their descriptions. The organizations are based on the organization level
members specified on the Plan Options page, Scope tab.

For each listed organization in the Subinventory Netting dialog box, select or deselect the check boxes under Enable
Netting to include or exclude subinventories from the sales and operations plan. During the collection process, data
is collected from the subinventories based on the organization configuration in the source system. If you enable
subinventory netting for a new subinventory in the source system, the sales and operations plan includes the new
subinventory when running the plan after the next collection process.

Demand Schedules: View the demand schedules used to plan supply, which references the same plan name in a sales
and operations plan.

- Supply Plan Input: Click the Select button to open the Supply Plan Input dialog box. In the Supply Plan Input
dialog box, select an end item demand measure by which to drive supply planning. The following are the
preconfigured measures that you can select, but you can also select a user-configured measure:

o Approved Consensus Forecast: The final demand forecast determined by collaborative review that has
received final approval for use in supply planning activities, expressed as a quantity.
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o Approved Final Bookings Forecast: The statistical demand forecast, based on bookings forecast demand
stream that has been reviewed and received final approval for use in supply planning activities.

o Approved Final Shipments Forecast: The statistical demand forecast, based on shipments forecast
demand stream that has been reviewed and received final approval for use in supply planning activities.

o Consensus Forecast: The weighted demand forecast that combines multiple stakeholder forecasts from
sales, marketing, and operations, expressed as a quantity and including any planner adjustments. The
unconstrained consensus forecast coming from the demand review process becomes the basis for
developing a constrained operating plan.

o Final Bookings Forecast: The bookings forecast, expressed as a quantity and including any planner
adjustments.

o Final Marketing Forecast: The marketing forecast based on user adjustments to the baseline marketing
forecast, expressed as a quantity.

o Final Sales Forecast: The final sales forecast including any user adjustments, expressed as a quantity.

o Final Shipments Forecast: The final forecast based on shipment history, expressed as a quantity and
including planner adjustments.

« Measure Levels: View the level at which the demand schedule is being consumed in Sales and Operations
Planning.

Configure Revenue Currency Parameters

You can prioritize constrained supply for product demands that generate the most revenue in currency in a sales and
operations plan.

When available supply is less than demand, the planning process prioritizes supply allocation to the product categories
with higher global revenues to maximize overall enterprise revenue. To configure the revenue currency parameters,
navigate to the Supply: Advanced Options dialog box, General tab in plan options.

When you configure revenue currency parameters, the planning process converts the item selling prices by organization
from local currency to base currency for planning revenue in currency. Revenues of product categories priced in

the local organization currencies of their respective countries can be considered uniformly by converting the local
currencies into one base currency using these currency conversion rates. Planning collects currency conversion rates
that don't vary by time. Therefore, the planning process uses a single consistent conversion rate to convert from a local
currency to a base currency across the plan horizon.

Note: To convert from alocal currency to a base currency, you must first define the currency for an organization.
Use the Maintain Supply Network Model task to verify that the Currency column is specified for the organizations
used in your sales and operations plan. Monitor the Review Plan Messages page to check for setup issues related to
currencies and conversion rates.

For external source systems, load currencies and conversion rates by using the file-based data import process. Use
the Currency, Currency Conversion Type, and Currency Conversion tabs in the Supply Chain Planning Currencies file
(ScpCurrencylmportTemplate.xlsm).

You can create what-if scenarios to simulate future changes in price to determine the global impact and risk on your
supply chain. Simulate changes in price by editing the Adjusted Price measure and then rerun the aggregate plan

with the data refresh option Do not refresh with current data selected. The price adjustments are made in the local
currency, but converted to base currency when running the plan to plan revenue in one currency. At the end of the plan
run, revenue is output in the local currency, even though the base currency was considered for the fulfillment of end
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item demands. This process ensures that there is consistent reporting of revenue and costs by organization in local
currencies.

Perform the following steps to configure the planning process for currency conversion in your sales and operations plan.

1. In an open sales and operations plan, navigate to the Plan Options page, Supply tab, and click the Advanced
Options button.

2. Inthe Supply: Advanced Options dialog box, General tab, expand the Revenue Currency Parameters section.

3. Select the Consider currency conversion rates to plan revenue check box.

Selecting this check box instructs the planning process to use a single base currency to prioritize demand
revenue in a constrained plan rather than planning revenue for each organization in the local currency.

4. Select the conversion type, which contains currencies and conversion rates between currencies.

5. Select the base currency code. This code is for the base currency used to plan revenue for constrained demand
in a single currency, which can be different than the local currency defined for an organization.

Click Done.

Related Topics
« Run a Sales and Operations Plan

« Overview of Simulations in Sales and Operations Planning

Calculate Financial Metrics Using Price Lists

You can determine the selling price of an item using a single price list or by averaging multiple price lists associated with
a plan.

You can use this selling price to calculate end demand values and financial metrics, such as revenue and margin. The
measures can be displayed in tables and graphs. The updated end demand values are displayed in the Supplies and
Demands, Exceptions, and Demand Fulfillment views in the supply plan output.

This functionality is available for constrained and unconstrained supply, demand and supply, and sales and operations
plans.

Here’s how you can calculate financial metrics using a price list in a plan.

Navigate to the Plan Inputs work area from the navigator.

From the Tasks menu, click Collect Planning Data.

Select Items in the Reference Data tab and Include Price List check box in the Demand Planning Data tab.
Click Submit to initiate the collections process.

On the Manage Plans page, create a new plan by selecting the price lists in the plan option to derive the selling
price for the item.

uhWNA

You also can edit the existing plan options to allow the price lists to derive the selling price.
6. Click Edit for the price list in the plan option.
Click Add in the Manage Price Lists window.
8. Select the Primary check box to indicate a primary price list.

N

You can select a user-defined price list or the Item list Price.
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9.

10.
1n

Enable the Include When Deriving Selling Price plan option for the price lists that must be used to calculate
the selling price. Select multiple price lists to compute the average selling price of the item.

The planning process performs all the necessary units of measure and base currency conversions and
represents them in the primary unit of measure. This value takes precedence over the Item List Price.

Click OK to save the options and run the plan.
Click Open in the plan output work area and search for the ltems view.

You can see that the plan has computed the Selling Price and Net Selling Price from the price list associated
with the plan.

In the Supplies and Demands view, the Selling Price is used to compute and display the End Demand Value for
the forecast.

I Note: This view is available in supply and demand, and supply plans.

Things to Consider When Calculating Financial Metrics Using Price Lists
Here's some additional information about this functionality.

- The Include When Deriving Selling Price check box is disabled for Item List Price since it is the default price list

for all calculations. The check box is enabled for user-defined price lists collected from Product Information
Management (Fusion source) or using file-based data integration (external source).

- The Selling Price is the same as the Item List Price if you don’t assign any user-defined price lists to the plan.

You can uncheck Include When Deriving Selling Price to consider the Item List price as the Selling Price.

- The Price measure is calculated for the price list you set as Primary. The planning process does not compute

the time-varying Price measure values for a price list that is not set as Primary and for which Include When
Deriving Selling Price is enabled.

- The Price measure calculated with a Primary price list is used to compute shipment or booking forecast value

measures. You also can use it to compute the value in a user-defined measure with an expression in a supply
plan.

Examples Showing How to Calculate Financial Metrics Using Price Lists

Example 1shows how the selling price of an item is derived from the price lists for price list details specified in Oracle
SCM. The price list and item price details are created in the Pricing work area.

The item KB-SS-PUMP106’s price is defined in two price lists in Pricing. In the price list SN PRICE: LIST1, the price is 98
USD, and in the price list SN PRICE LIST2, the price is 99 USD.

1.

2

3.
4.

Select the item’s price list and price details, and run the Collect Planning Data scheduled process. The details
are collected in Oracle SCP.

Create a plan, and add price lists SN PRICE LIST1and SN PRICE LIST2 in the Manage Price Lists in the plan
option.

Select the Include When Deriving Selling Price check box for both the lists.

Run the plan to see the item's Selling Price and Net Selling Price values in the Items view. These values are
calculated from the price lists associated with the plan.

Example 2 shows how the time-varying price is used to calculate the revenue in a sales and operations plan.

The planning process uses the time-varying price for revenue calculation when you mark a single price list as Primary,
and select Include When Deriving Selling Price in plan options.
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For example, the Revenue of 32,000 in March 2030 is calculated by multiplying the Constrained Forecast (200) and
Price (160).

The Selling Price value in the ltems table is computed as the average of the time-varying prices for an item in the plan
output.

If you mark more than one price list as Include When Deriving Selling Price in plan options, then the computed
average Selling Price is used in revenue calculations instead of the time-varying price.

Example 3 shows how the average selling price is derived for an item from price lists in a supply plan.

The item AS7311in an organization M1is collected with the following price list details from the source system:
Price List 1 with the price of 10 USD, effective from January 1st, 2022.
Price List 2 with the price of 11 USD, effective from February 2nd, 2022.
Price List 3 with the price of 9.5 Euros, effective from March 3rd, 2022.
Price List 4 with the price of 14 USD, effective from January 1st, 2022 to June 30th, 2022.

A supply plan is created with the plan horizon start date of July 29th, 2022. The supply planning process derives the
selling price for item AS7311 from price lists. Include When Deriving Selling Price is marked for all four price lists. The
default price list “Item List Price” is marked as Primary.

The items AS7311 and CM1234 have a collected list price as a selling price of 10 USD.

The currency of Organization M1is USD. The latest collected conversion rate from Euros to USD is 1.2, with the
conversion date effective from Jan 1st,2022. The price of 9.5 Euros from Price List 3 is converted to USD using the latest
conversion rate. The price of 14 USD from Price List 4 is ignored, as the To Date ends before the plan horizon start date.
So, the average selling price for the item AS7311is derived from Price List 1, Price List 2, and Price List 3 as 10.8 USD.

Since item CM1234 does not have any price list detail, the list price of the item is applied as a selling price of 10 USD in
the plan.

The financial metrics in the plan for item AS7311 are calculated based on the selling price derived from price lists
associated to the supply plan.

Report Resource Requirements by Assembly

To report resource requirements by assembly item in a sales and operations plan, select the Report resource
requirements by assembly check box in the plan options. The check box is located in the Supply: Advanced Options
dialog box, General tab.

You can associate resource and work center requirements with assembly items or product category mix. Use these
associations to better understand and adjust resource loading. You can gain insight for strategic requirements by
analyzing the product mix for assembly items produced in shared, constrained work centers for better rough-cut
capacity planning. You can leverage measures and reports that combine resource and product dimensions to quickly
validate sales opportunities for manufactured items.

When you select the Report resource requirements by assembly check box, the planning process uses measures
to analyze plan data. These measures have both resource and product as conforming dimensions to link resource
requirements to manufactured assembly items. The measures used to analyze plan data include the following:

Resource Requirements by Assembly ltem
Resource Quantity by Assembly Item
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Production Plan by Resource

The planning process creates the following views for you to analyze:

« The Resource Plan by Category and Quarter table combines the resource and product dimensions to help you
review and adjust resource loading.

- The Resource Plan by Category and Quarter graph compares Resource Requirements by Assembly Item with
Resource Availability.

You can simulate changes to resource usage quantities for assembly items in bills of resources and the Resource
Quantity by Assembly Item measure reflects the updates in your plans.

Note: Selecting the Report resource requirements by assembly check box can potentially slow down processing times
for your sales and operations plan.

Technical Control Parameters

You can use multithreading to decrease the overall runtime of a supply plan.

In the plan options, navigate to the Supply: Advanced Options dialog box, Technical tab and select the Enable
multithreading check box. When selected, the planning process implements multithreading during the plan run.

Configure Optimization Parameters

You can influence the plan results by configuring optimization parameters. By setting these parameters, you can better
control the plan output and decision-making process.

The following optimization parameters are available:

Penalty Cost Multiplier for Demand Backordering: The value by which the penalty cost for demand
backordering is multiplied. The default value for this global parameter is 100.

Penalty Cost Multiplier for Supplier Capacity Overloading: The value by which the penalty cost for supplier
capacity overloading is multiplied. The default value for this parameter is 1000. You can overload the supplier
category capacity to enforce demand due dates on time for assembly items. Set this parameter to -1to set a
hard constraint on the supplier category capacity.

Penalty Cost Multiplier for Resource Capacity Overloading: The value by which the penalty cost for resource
capacity overloading is multiplied. The default value for this parameter is 1000. You can overload the work
center capacity to enforce demand due dates on time for assembly items. Set this parameter to -1to set a hard
constraint on the work center capacity.

Penalty Cost Multiplier for Sourcing Allocation Violation: The value by which the penalty cost for violating the
sourcing allocation percentage is multiplied. The default value for this parameter is 100.

Perform the following steps to configure the optimization parameters in your sales and operations plan:

1. In an open sales and operations plan, navigate to the Edit Plan Options page, Supply tab, and click Select
Advanced Options.
2. Inthe Select Advanced Options dialog box, click the Optimization Parameters tab.
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3. Select the Use declining storage costs to avoid building inventory early check box to use the storage penalty
costs rolled up from the component items associated with an assembly item's bill of resources that decline over
the plan horizon. Unselect the check box to use the same storage penalty cost over the plan horizon.

4. Optionally, update the values for the optimization parameters:

o Penalty Cost Multiplier for Demand Backordering

o Penalty Cost Multiplier for Supplier Capacity Overloading
o Penalty Cost Multiplier for Resource Capacity Overloading
o Penalty Cost Multiplier for Sourcing Allocation Violation

Note: Oracle recommends consulting them before altering optimization parameters.

5. Click Reset to Default to remove your user-specific values.
6. Click Done.

Configure Optimization measure

Penalty Cost Multiplier for Demand Backordering is an editable measure that can influence plan results more precisely
than the global optimization parameter. The measure uses the value set for the global optimization parameter by
default. Adjust this value to increase the relative priority of fulfilling the end item demands. This measure gives you
granular level control to prioritize which demands to fulfill first.

For example, if a new assembly item consumes capacity on a constrained work center, you can increase the measure
value from 100 to 100,000 to prioritize fulfilling this new product.

Perform the following steps to use this measure to influence your plan results:

1. Add the Penalty Cost Multiplier for the Demand Backordering measure to the measure catalog of your sales and
operations plan.

2. Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog
box.

3. Create a table that uses this editable measure. You can adjust the measure values by organization, item, and
time.

Configure Supplier and Capacity Constraints

You can configure to constrain supplier capacity and resource capacity in a plan's options. With aggregate capacity
planning, you can constrain resource capacity for specific work centers and constrain supplied component items at the
product category level.

You have the flexibility to decide which capacity constraints to enforce in your plans and which ones not to enforce.
Configure these constraint parameters on the Plan Options page, Supply tab from the Sales and Operations work area.

You can configure supply constraints to enforce supplier category capacity and work center resource capacity for the
critical component items and bottleneck resources used in your aggregate bill of resources. For example, if a supplier
allocates a fixed amount of supply due to their own global constraints, or if a manufacturing facility cannot exceed a
known level of output, then you can enforce these constraints in your sales and operations plans.

Note: In a constrained plan, capacity utilization can exceed 100 percent for constrained work centers or supplier
component categories depending on the Optimization Parameters you configure in Supply Advanced Options.
Overloading can also occur in a constrained plan for unconstrained resources and suppliers.
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Exception management identifies where there are performance gaps. You can tailor predefined exceptions to your
specific requirements and use them in exception sets.

Supplier Capacity
To enforce supplier capacity, select the Consider supplier capacity constraints check box in the Constraints section on

the Plan Options page, Supply tab. The planning process constrains supplier capacity at the component category level,
not for an individual component item. You still have visibility to supplier item loading within the component category.

When constraining component categories, specify available supplier capacity for all items in the category. If you do not
want to constrain a component category in a constrained plan, then do not specify available supplier capacity for its
items.

In a supplier constrained plan, capacity utilization can exceed 100 percent for component categories depending on the
Optimization Parameters you configure in Supply Advanced Options.

For example, the default value for the Penalty Cost Multiplier for Supplier Capacity Overloading parameter is 1000. You
can overload the supplier category capacity to enforce demand due dates on time for assembly items.

Set this parameter to -1to set a hard constraint on the supplier category capacity. With this setting, the capacity
utilization cannot exceed 100 percent.

Supplier capacity overloading can still occur for supplied items in a constrained component category. The constraint is
enforced at the component category level.

Resource Capacity

To enforce resource capacity, select the Consider work center capacity constraints check box in the Constraints
section on the Plan Options page, Supply tab. The planning engine constrains resource capacity at the work center level,
not for an individual resource. You still have visibility to resource loading within the work center.

You can select which work centers to constrain in manufacturing locations in plan options. You can also continue to
generate resource requirements for resources in unconstrained work centers.

A work center containing resources without defined resource availability in either plan inputs or simulation set can’t be
constrained when running a plan with data refresh. You must load resource availability to constrain the work centers.
You can simulate adjustments to the Resource Availability measure when resource availability is defined for a work
center.

In a resource constrained plan, resource utilization can exceed 100 percent for constrained work centers depending on
the Optimization Parameters you configure in Supply Advanced Options.

For example, the default value for the Penalty Cost Multiplier for Resource Capacity Overloading parameter is 1000. You
can overload the work center capacity to enforce demand due dates on time for assembly items.

Set this parameter to -1to set a hard constraint on the work center capacity. With this setting, the capacity utilization
cannot exceed 100 percent.

In a resource constrained plan, resource utilization cannot exceed 100 percent for constrained work centers. However,
resource overloading can still occur for unconstrained work centers in the plan. An individual resource in a constrained
work center can be overloaded. The constraint is enforced at the work center level.
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Exceptions

Sales and Operations Planning provides predefined exceptions to use in constrained plans, such as Supplier Category
Capacity Overloaded and Work Center Overloaded. These exceptions detect when capacity utilization for supplier
component categories and work centers are fully loaded at 100 percent.

Run a Sales and Operations Plan

When you run a sales and operations plan, you can specify the scope of the plan that you want to run. For example, you
can generate the demand forecasts or supply replenishments, or both.

You can decide whether to refresh the plan's input data before running it. Also, you can run the plan immediately or you
can run the plan in the background at a set time or on a repetitive schedule, such as daily or weekly.

After you create a plan, you must run the plan to generate the data. In the Run Plan dialog box, Parameters tab, options
are sequenced in the order of operations: data refresh, scope, demand, and supply. The data refresh process runs first,
then the forecasting process runs, and then the output is used for planning calculations. You can configure the following
options for a sales and operations plan:

Data Refresh Options
- Scope Options
Demand Plan Run Options

- Supply Plan Run Options

Data Refresh Options

The following data refresh options are available:

- Do not refresh with current data: Select this option to run incremental what-if plan simulations. There is no
advancement of the plan start date.

- Refresh with current data: Select this option to refresh the complete plan with the latest collected data and
advance the plan start date. If you are running the plan for the first time, this is the only data refresh option
available and it is selected by default.

If you select this option for a sales and operations plan, the Plan demand and Plan supply check boxes in the
Scope Options section are selected by default and cannot be deselected.

Scope Options

Scope options restrict the focus of the replan. The following scope options are available:

Plan demand: Select to forecast demand when running a plan. If you selected Refresh with current data in the
Data Refresh Options section, then this option is selected by default.

Plan supply: Select for the planning process to calculate the supply when running the plan. The Plan supply
check box in the Scope Options section is available only when the Plan supply check box is selected on the
Plan Options page, Supply tab. If not selected, then the aggregate planning engine is not invoked as part of the
plan run. If selected, and you also select the Refresh with current data check box in the Data Refresh Options
section, then the Plan supply option is selected by default and cannot be deselected.
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- Archive plan: Select to archive data after you run the plan. The Archive plan option is available when the
Enable for archiving check box is selected in the Scope: Advanced Options dialog box, which you navigate to
from the Plan Options page, Scope tab. If the plan is enabled for archiving, then the measures in the measure
catalog specified in the Measure Catalog for Archival field will be archived.

Demand Plan Run Options

Use Demand Plan Run Options to generate a demand forecast. Select the forecasting profiles that you want to include
as part of the plan. If you do not select a forecasting profile, then the demand forecasting process does not run.

Supply Plan Run Options

The following supply plan run options are available for sales and operations plans:

Interactive: Select this option to run incremental what-if plan simulations. If you select Interactive, the
Schedule tab is disabled and the plan is set to run as soon as possible. When the plan run completes, the plan is
available for review.

Batch: If you select Batch, the Schedule tab becomes available where you can select to run the plan
immediately or set up a schedule for when to run the plan, such as weekly or monthly.

Running a Sales and Operations Plan

To run a sales and operations plan:

1. Open the Run Plan dialog box:

In the Navigator, click the Sales and Operations work area.
Click the Plans panel tab.
In the Tasks panel drawer, click the Manage Plans link.
Enter the search parameters and click the Search button.
e. Inthe Search Results region, select the plan that you want to run, click Actions, and then select Run.
2. Inthe Run Plan dialog box, Parameters tab, expand Details to review the plan options:

e ngoo

a. Inthe Data Refresh Options section, review the options and make appropriate selections.

Note: If you are running the plan for the first time, select Refresh with current data. This option
refreshes historical data, imports sales orders, and advances the plan start date to align with the
current date.

In the Scope Options section, select the options that you want for the plan run.

c. Inthe Demand Plan Run Options section, select the forecasting profiles that you want to include as a part
of the plan run.

d. Inthe Supply Plan Run Options section, select Interactive or Batch.

3. If you selected Batch in the Supply Plan Run Options section, click the Schedule tab to set up the frequency
parameters:

a. To run the plan immediately, select As soon as possible.

b. To run the plan in the background at a set time, select Using a schedule and then select a Frequency,
such as Daily or Weekly.
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Publish Plan Data

You can publish data for a plan in the Demand Management, Demand and Supply Planning, Planning Central,
Replenishment Planning, Sales and Operations Planning, or Supply Planning work area to a compressed file.

You can then use the file for data integration between your Supply Chain Planning application and other Oracle or
external applications.

By submitting a scheduled process from your Supply Chain Planning work area or the Scheduled Processes work area,
you can publish the data in a pivot table within your plan to a file on the content server of Oracle WebCenter Content.

Using APIs of Oracle's ERP integration service for automating the data integration between your Supply Chain Planning
Application and an external application, you can submit the scheduled process, check its status, and get the details of
the published document.

The file name is in the <plan name>_<pivot table name>.zip format.

Publish Plan Data from a Supply Chain Planning Work Area

Here's how you can publish data for your plan from your Supply Chain Planning work area:

1. Do one of the following to open the Publish Data dialog box:
o On the Manage Plans page, select the plan and click Actions > Publish Data.

The Publish Data dialog box opens.
o Open your plan and click Actions > Publish Data.

The Publish Data dialog box opens.

Optionally, enter submission notes for your scheduled process.

3. Onthe Parameters tab, optionally, select the Append request number to output file name check box.
Selecting this check box results in the request number being appended to the file name, which enables
easy identification of the file on the content server. The resulting file name (<plan name>_<pivot table
name>_<request number>) is also used as the document title.

If you don't select this check box, the document title is PUBLISHPLANDATA.
4. In Table Name, select the pivot table of your plan for which you want to publish data.

The available tables are enabled for the work area of the plan, and you have the required access to these tables.
5. In Source System, select the source system that's specified on the Scope tab of the Plan Options page for the
plan.
6. On the Schedule tab, specify whether you want to run the process as soon as possible or according to a
schedule.

If you publish the file according to a schedule, you can specify the frequency and start and end dates for the
process.
7. Click Submit.

The Status dialog box opens and displays the request number. Make a note of this number and then click OK.
You can use this number to search for the result of your request in the Scheduled Processes work area.

N
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If you appended this number to the compressed file's name, you can use this number to search for the file in
the File Import and Export work area. You can then download and check the file.

Publish Plan Data from the Scheduled Processes Work Area

Here's how you can publish data for your plan from the Scheduled Processes work area:

1.

L4

10.

On the Overview page, click the Schedule New Process button.

The Schedule New Process dialog box opens.
In Name, select the Publish Plan job, and click OK.

The Process Details dialog box opens.

To be notified when the process ends regardless of the result, select the Notify me when this process ends
check box.

Optionally, enter submission notes for your scheduled process.
On the Parameters tab, in Plan Name, select your plan.
Optionally, select the Append request number to output file name check box.

Selecting this check box results in the request number being appended to the file name, which enables
easy identification of the file on the content server. The resulting file name (<plan name>_<pivot table
name>_<request number>) is also used as the document title.

If you don't select this check box, the document title is PUBLISHPLANDATA.
In Table Name, select the pivot table of your plan for which you want to publish data.

The available tables are enabled for the work area of the plan, and you have the required access to these tables.

In Source System, select the source system that's specified on the Scope tab of the Plan Options page for the
plan.

To set a schedule for your request and notify other users about the result, click the Advanced button.
The Schedule and Notification tabs are displayed.

o Onthe Schedule tab, specify whether you want to run the process as soon as possible or according to a
schedule.

If you publish the file according to a schedule, you can specify the frequency and start and end dates for
the process.

o On the Notification tab, specify the recipients to whom result notifications should be sent and the
conditions under which the notifications are sent.

Click Submit.
The Confirmation dialog box opens and displays the process number. Make a note of this number, and click OK.
You can use this number to search for the result of your request in the Scheduled Processes work area.

If you appended this number to the compressed file's name, you can use this number to search for the file in
the File Import and Export work area. You can then download and check the file.
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Compare Sales and Operations Plans

Compare a sales and operations plan with another sales and operations plan or an archive of the same plan. You can
select a metric to show the difference between the plans.

Compare aggregate plan metrics: You can compare two plans and understand what changed at an aggregate level. For
example, you can compare metrics, such as Revenue, Production Plan, Resource Requirements, Projected Available
Balance, and Exceptions Count. The comparison of plans in a table or a graph displays the data for each plan side-by-
side. To see the differences between the plans, you can select the metrics in the Comparison Options tab when creating
or editing the table or graph. The Show Difference icon in the table or graph toolbar redraws the table or graph with the
selected difference metrics.

Note: If you compare sales and operations plans with different planning levels, you must compare from within the

plan that's planned at a higher level of aggregation. For example, if you compare a quarter-level plan with a month-
level plan, you must make the comparison from within the quarter-level plan. You can't make the comparison from

within the month-level plan.

The comparison metric options are the following:

Difference
Percent Difference
- Absolute Percent Difference

To compare a plan:

1. In the Navigator, click the Sales and Operations Planning work area.

2. From the Actions menu, select Compare and then click Plans.

3. Inthe Search and Select: Plan dialog box, search and select the plan that you want to compare with the current
plan, and click OK.
You can view the table or graph with both plans displayed.

Tip: Click the Graph icon on the toolbar of the table to view the results in a graph.

4. Click Show Difference to view the difference between the current plan and the comparison plan.
To stop comparing the plans, select the Cancel Compare from the Actions menu.

Review Plan Messages

In Supply Chain Planning, you can view root causes for technical plan process failures and the recommendations to fix
the issues.

After running a plan, open the Review Plan Messages table to review the warning and error messages generated by the
planning processes, such as forecast generation and supply plan generation. You can also review the recommendations
to address the warning and error conditions. Access the plan messages from either the Manage Plans page or the Edit
Plan page.

230
ORACLE



Oracle Fusion Cloud SCM Chapter 11
Using Sales and Operations Planning Sales and Operations Plans

Plan messages are available for all plan types (for example, Supply Plan or Sales and Operations Plan types) and are
accessible from your respective Supply Chain Planning work area. There are three message types:

- Warning: Indicates an issue that can result in a future run plan error if not resolved.
Error: Indicates a plan failure.

Recommendation: Indicates a recommendation to resolve a plan failure or how to achieve a better run
performance.

If you repeatedly run the plan, the same messages appear on the Review Plan Messages tab for each plan run. The
messages will have different process identifiers and submission times.

You can delete plan messages based on the submission date. On the Review Plan Messages tab, click the Purge button.
In the Purge Messages dialog box, enter a submission date with one of the operators: Equals, Before, On or before, After,
On or after, Between, or Not between.

Use the following steps to open the Review Plan Messages table from the Manage Plans page:

1. From a Supply Chain Planning work area, click the Task drawer and select Manage Plans.

2. Onthe Manage Plans page, search for a plan.

3. Inthe Search Results region, select a plan.

4. C(lick the Actions list and then select Review Plan Messages to access the Review Plan Messages tab.

From the Search Results region, you can export the messages to a Microsoft Excel spreadsheet.
Use the following steps to open the Review Plan Messages table from the Edit Plans page:

1. From a Supply Chain Planning work area, click the Task drawer and select Manage Plans.
2. Onthe Manage Plans page, search for a plan.

3. Inthe Search Results region, select a plan. Next, click the Actions list and then select Open.
4. On the Edit Plan page, click Open.

5. Inthe Open Table, Graph, or Tile Set dialog box, search for the Review Plan Messages table. Select the table and
then click OK.

6. On the Review Plan Messages tab, click the Search button.
7. Inthe Search Results region, view the plan messages.

From the Search Results region, you can export the messages to a Microsoft Excel spreadsheet.

Related Topics
- Actions to Manage Your Plans

» Overview of Supply Chain Planning Plan Types
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12 Analyze Sales and Operations Plans

Aggregate Build Plan View

Overview of the Aggregate Build Plan in Sales and Operations
Planning

The Aggregate Build Plan table in Sales and Operations Planning Cloud enables you to simultaneously view resource,
material, and supplier requirements in the context of demand for an assembly.

This report leverages the bill of resources used in aggregate supply planning that defines which component items
and resources are used in an assembly item. Use Aggregate Build Plan to focus on the components, resources, and
measures that are important to you. For example, you can analyze a material plan for a critical component and its
available supplier capacity.

The Aggregate Build Plan also gives you visibility into the upstream manufacturing of subassemblies and their
requirements for components and resources. You can quickly identify and reduce supply and resource bottlenecks as
well as understand the imbalance in resource capacity and component supply.

When you open the Aggregate Build Plan table for the first time, you will see an empty plan layout. You can configure
the layout of the Aggregate Build Plan table to show only the components, resources, and measures that you want

to see. You can also define criteria at a product category level for aggregate analysis across shared components and
resources.

After selecting the criteria that you want, the Aggregate Build Plan displays the end items, components, and resources
that you identified in the criteria. You can expand the root node to see the measures that you included in the layout

as well as the selected time level used for the columns. Whether or not you can edit a value in a cell is based on if the
measure is editable or not. If the measure is editable, then you can edit the measure in the Aggregate Build Plan.

Use the Drill to action to see additional information related to a table cell. The context of the cell is passed into the
resulting table or graph. You can also drill into the Aggregate Build Plan, which is currently supported only for assembly
items.

Related Topics
- Create Aggregate Build Plan Criteria

- Create an Aggregate Build Plan Layout

Create Aggregate Build Plan Criteria

When you open the Aggregate Build Plan table directly from a Sales and Operations Plan, you must select criteria to
specify which end items, components, and resources from the bill of resources that you want to view.

You can also drill into the Aggregate Build Plan from another report with end item context. In this case, the Aggregate
Build Plan displays criteria for all of the components and resources in the bill of resources for that assembly. You can
then select different criteria for your end items.
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Follow these steps to create the criteria for an aggregate build plan report:

1. Open a Sales and Operations plan:

a. Inthe Navigator, click the Sales and Operations Planning work area.
b. Click the Tasks panel tab.
c. Inthe Tasks panel drawer, click Manage Plans.
d. Search for and open your plan.
2. Open the Aggregate Build Plan table:

a. Click Actions.

b. Inthe Open Table, Graph, or Tile Set dialog box, search for Aggregate Build Plan.

c. Click OK.
3. Inthe Aggregate Build Plan view, click the Criteria list and then click Manage.
In the Manage Criteria dialog box, click Add and enter the values for Name, Description, and Access fields.
5. Inthe Details section, select Item or Category and then do one of the following:

P

o If your end item criteria is Item, then select an item and organization from the list. You can leave the
Organization field empty.
o If your end item criteria is Category, then select a catalog and category from the list.

6. Click Refresh Lists.

The refresh builds the list of components and resources used in the assembly of the selected end item or
category from the bill of resources.
7. Select the components and resources that you want to see in your report:

o Select All or a specific component for the item.
o Select All of a specific resource for the item.
8. C(lick Save and Close.

Related Topics
« Overview of the Aggregate Build Plan in Sales and Operations Planning

- Create an Aggregate Build Plan Layout

Create an Aggregate Build Plan Layout

When you work in the Aggregate Build Plan table in a Sales and Operations Planning work area, there is a predefined
layout to display certain measures for items and resources.

You can select which end items, components, and resources to display by first setting up criteria. Next, you can create
your own layout with preferred measures to display and for which time levels to display for the end items, components,
and resources. You create your own layout by using the Manage action from the Layout choice list in the Aggregate
Build Plan dialog box. You can set this layout as the default layout for all other sales and operations plans.

Follow these steps to create an Aggregate Build Plan layout.

1. Open a Sales and Operations plan:

a. Inthe Navigator, click the Sales and Operations Planning work area.
b. Click the Tasks panel tab.
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c. Inthe Tasks panel drawer, click Manage Plans.
d. Search for and open your plan.
2. Open the Aggregate Build Plan table:
a. Click Actions.
b. Inthe Open Table, Graph, or Tile Set dialog box, search for Aggregate Build Plan.
c. Click OK.
3. Inthe Aggregate Build Plan view, click the Layout list and then click Manage.
4. Inthe Manage Layouts dialog box, click the Add button and do the following:

a. Enter the values for Name, Description, Access, and Time fields.
b. Optionally, select the Default check box to make this layout the default layout.
5. Inthe Details section in the Manage Layouts dialog box, select your preferred measures in the Available column
and move them to the Selected column for the following subtabs:

o End Item Measures
o Component Measures
o Resource Measures
o Supplier Measures
6. When done, click Save and Close.

Related Topics
« Overview of the Aggregate Build Plan in Sales and Operations Planning

« Create Aggregate Build Plan Criteria

Resource Plan by Category and Quarter Views

The Resource Plan by Category and Quarter views provide you with capacity insight to simplify data analysis. The
table and graph also enable you to make quicker decisions to improve efficiency in your sales and operations planning
process.

Use the Resource Plan by Category and Quarter views to focus on assembly items linked to critical resources to ensure
that supply can meet strategic needs. The views simplify data analysis by highlighting product category mix for shared
work center resources and enables better rough-cut decisions for sales opportunities in constrained plans.

The Resource Plan by Category and Quarter table combines the resource and product dimensions to help you review
and adjust resource loading.

The Resource Plan by Category and Quarter graph compares Resource Requirements by Assembly Item with Resource
Availability. Resource Requirements by Assembly Item appears as a bar chart stacked by product category. The Resource
Availability measure has resource as a conforming dimension, not product, so it isn't associated with assembly items.

By using the graph to analyze resource loading, you can use both the Net Resource Availability (also a resource measure
not conforming to the product dimension) and Resource Quantity by Assembly ltem measures in the table to determine
how many more assembly items you can produce.

For example, a provider of tablet computers wants to increase Quarter 2 sales revenue. They must ensure that there
is enough capacity during the Supply Review phase of their sales and operations planning cycle. By analyzing the
Resource Plan by Category and Quarter graph, the planner can see there is available capacity in their constrained work
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center and the current requirements by product category. The planner then uses the Resource Plan by Category and
Quarter table to determine how much more product they can produce by category to consume the available capacity.
After a brief analysis, the planner adjusts Quarter 2 forecasts and runs a plan simulation to validate the changes before
approving the plan.

To report resource requirements by assembly item in a sales and operations plan, select the Report resource
requirements by assembly check box in the plan options. The check box is located in the Supply: Advanced Options
dialog box, General tab.

Use the Product Lifecycle Management Page Layout

Overview of the Product Lifecycle Management Page Layout

The Product Lifecycle Management page layout helps you to manage product introductions and retirements. On this
page layout, you can modify launch dates and discontinuation dates for products, while increasing or reducing baseline
forecasts.

The introduction or retirement of a product often affects the demand for a related product. When the product
introduction reduces the demand for the related product, the effect is termed as the cannibalization effect. When the
product introduction increases the demand for the related product, the effect is termed as the halo effect.

Using this page layout along with predefined forecasting profiles in demand, demand and supply, replenishment, and
sales and operations plans, you can do the following:

- Generate forecasts while allowing for the cannibalization or halo effect.
Plan for cannibalization of existing products, and avoid revenue loss.

Plan for the increased demand for related products on account of the halo effect.

I Note: The page layout isn’t available in the Planning Central work area.

Description of the Page Layout

The Product Lifecycle Management page layout consists of two panes:
- The top pane displays the predefined Manage Product Life Cycle by Item and Date table, using which you can
modify the launch and discontinuation dates for products.

- The bottom pane displays the predefined Manage Forecast During Product Life Cycle table, using which you
can modify the shipments or bookings forecast for products.

By default, both tables display products under the Category level 1level of the Product hierarchy in the Product
dimension.

The top table is dynamically linked to the bottom table; the former passes the highlighted selection in the Category level
1level to the latter.
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Note: If your products are in a different Product dimension level, you need to make a copy of the page layout and
its tables, modify the Product dimension level for the table copies, and ensure that the top table dynamically passes
the highlighted selection in the required Product dimension level to the bottom table. You can’t make changes to
predefined page layouts or the hierarchy levels and links of predefined tables.

Measures for Managing Dates for Product Lifecycle Management
The measures you use for managing dates in this page layout are as follows:

Launch Date: Use this measure to store the date when the product is available for sale in the market. The value
for this measure is collected or imported through the file-based data import (FBDI) template for Supply Chain
Planning measures.

- Adjusted Launch Date: Use this measure to modify the date when the product is available for sale in the market.
You can modify this measure on the page layout.

Final Launch Date: This measure displays the final value for the date when the product is available for sale

in the market. If the Adjusted Launch Date measure contains a value, that value is displayed by the Final
Launch Date measure. Otherwise, the value of the Launch Date measure is displayed by the Final Launch Date
measure.

The Final Launch Date measure is the default value for the LaunchDateMeasure forecasting parameter of
the Forecast Bookings Including Product Life Cycle and Forecast Shipments Including Product Life Cycle
forecasting profiles.

Discontinuation Date: Use this measure to store the date when the product is no longer available for sale in
the market. The value for this measure is collected or imported through the FBDI template for Supply Chain
Planning measures.

- Adjusted Discontinuation Date: Use this measure to modify the date when the product is no longer available for
sale in the market. You can modify this measure on the page layout.

Final Discontinuation Date: This measure displays the final value for the date when the product is no longer
available for sale in the market. If the Adjusted Discontinuation Date measure contains a value, that value is
displayed by the Final Discontinuation Date measure. Otherwise, the value of the Discontinuation Date measure
is displayed by the Final Discontinuation Date measure.

The Final Discontinuation Date measure is the default value for the DiscontinueDateMeasure forecasting
parameter of the Forecast Bookings Including Product Life Cycle and Forecast Shipments Including Product Life
Cycle forecasting profiles.

Measures for Managing Forecasts for Product Lifecycle Management

Note: By default, the predefined Manage Forecast During Product Life Cycle table displays shipments forecast
measures. If you want to generate a forecast that’s based on historical bookings, you need to click View > Measures >
Manage Measures, select the hidden and visible measures according to your requirement, and save the table layout.

The measures you use for managing the shipments forecast in this page layout are as follows:

- Shipments Forecast: This measure is the output measure for the predefined Forecast Shipments Including
Product Life Cycle forecasting profile. The measure stores the shipments forecast that's based on shipments
history.

- Adjusted Shipments Forecast: Use this measure to modify the shipments forecast for the product by using a
number. You can modify this measure on the page layout.
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- Change to Shipments Forecast Percentage: Use this measure to modify the shipments forecast for the product
by using a percentage. You can modify this measure on the page layout.

For example, to increase the shipments forecast by 75%, enter 0.75 for the Change to Shipments Forecast
Percentage measure. To decrease the shipments forecast by 25%, enter -0.25 for the Change to Shipments
Forecast Percentage measure.

Final Shipments Forecast: This measure displays the final value for the shipments forecast and is dynamically
updated in the Manage Forecast During Product Life Cycle table. If the Adjusted Shipments Forecast measure
contains a value, it's displayed by the Final Shipments Forecast measure. If the Change to Shipments Forecast
Percentage measure contains a value, the calculated value is displayed by the Final Shipments Forecast
measure. Otherwise, the value of the Shipments Forecast measure is displayed by the Final Shipments Forecast
measure.

If both the Adjusted Shipments Forecast and Change to Shipments Forecast Percentage measures contain
values, the percentage of the value in the Adjusted Shipments Forecast measure is calculated and displayed by
the Final Shipments Forecast measure.

The measures you use for managing the bookings forecast in this page layout are as follows:

Bookings Forecast: This measure is the output measure for the predefined Forecast Bookings Including Product
Life Cycle forecasting profile. The measure stores the bookings forecast that's based on bookings history.

- Adjusted Bookings Forecast: Use this measure to modify the bookings forecast for the product by using a
number. You can modify this measure on the page layout.

- Change to Bookings Forecast Percentage: Use this measure to modify the bookings forecast for the product by
using a percentage. You can modify this measure on the page layout.

For example, to increase the bookings forecast by 75%, enter 0.75 for the Change to Bookings Forecast
Percentage measure. To decrease the bookings forecast by 25%, enter -0.25 for the Change to Bookings
Forecast Percentage measure.

Final Bookings Forecast: This measure displays the final value for the bookings forecast and is dynamically
updated in the Manage Forecast During Product Life Cycle table. If the Adjusted Bookings Forecast measure
contains a value, it's displayed by the Final Bookings Forecast measure. If the Change to Bookings Forecast
Percentage measure contains a value, the calculated value is displayed by the Final Bookings Forecast measure.
Otherwise, the value of the Bookings Forecast measure is displayed by the Final Bookings Forecast measure.

If both the Adjusted Bookings Forecast and Change to Bookings Forecast Percentage measures contain values,
the percentage of the value in the Adjusted Bookings Forecast measure is calculated and displayed by the Final
Bookings Forecast measure.

Forecasting Profiles for Product Lifecycle Management
You use these predefined forecasting profiles for managing product life cycles:

Forecast Shipments Including Product Life Cycle: This forecasting profile generates a forecast on the basis of
historical shipments and the Final Launch Date and Final Discontinuation Date measures.

The forecasting profile is available for demand, demand and supply, replenishment, and sales and operations
plans.

Forecast Bookings Including Product Life Cycle: This forecasting profile generates a forecast on the basis of
historical bookings and the Final Launch Date and Final Discontinuation Date measures.

The forecasting profile is available for demand, demand and supply, and sales and operations plans.
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Other Points to Note

Note these other points about the functionality for managing the product life cycle:

If the Final Launch Date measure doesn’t contain a value or isn’'t present in the plan’s measure catalog, the
forecast is generated from the forecast start date of the plan.

The plan’s forecast start date is used if it's later than the value of the Final Launch Date measure.

If the Final Discontinuation Date measure doesn’t contain a value or isn’t present in the plan’s measure catalog,
the forecast is generated till the forecast end date of the plan.

The plan’s forecast end date is used if it’s earlier than the value of the Final Discontinuation Date measure.

If the date in the Final Launch Date measure is later than the date in the Final Discontinuation Date measure,
both measures are ignored, and the forecast is generated from the plan’s forecast start date to the plan’s
forecast end date.

- Optionally, you can use an override label for the Change to Shipments Forecast Percentage or Change to

Bookings Forecast Percentage measure in the Manage Forecast During Product Life Cycle table so that the
functionality of the page layout is better reflected. For example, you can use Launch and Cannibalization Factor
as the override label in the Format Measures dialog box.

Related Topics

Manage Page Layouts in Sales and Operations Planning

How You Generate Forecasts While Managing Product Life Cycles
Work with Page Layouts in Demand Management

Work with Page Layouts in Replenishment Planning

Create a Forecasting Profile

How You Generate Forecasts While Managing Product Life Cycles

To generate forecasts for your products while managing their life cycles, you can use the Product Lifecycle Management
page layout in your demand, demand and supply, replenishment, or sales and operations plan.

The following is the high-level procedure for forecasting for your products while using this page layout:

1. Set up your plan.

Include the predefined Forecast Bookings Including Product Life Cycle or Forecast Shipments Including Product Life
Cycle forecasting profile in your plan.

2. Perform the collections process or use the file-based data import (FBDI) templates for importing data.
Collect or import values for the Launch Date and Discontinuation Date measures for your products.
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3.

L

Do the following:
o If you want to generate the forecast on the basis of historical bookings, in the table, make the bookings
forecast measures visible, and hide the shipments forecast measures.
o If your products in your plan are in a different Product dimension level than what’s used in the tables, do
the following:
- Make a copy of the page layout.
- Make copies of the page layout’s tables, and select or hide the shipments forecast or bookings
forecast measures as you require.
- Change the Product dimension level for the copied tables.
- Ensure that the copy of the Manage Product Life Cycle by Item and Date table is dynamically linked
to the copy of the Manage Forecast During Product Life Cycle table, and that the top table passes the
highlighted selections in the required Product dimension level to the bottom table.

. Run the plan.

Open the plan, and view the information in the copy of the page layout.

If you're generating a forecast using shipments history, enter a value in the Adjusted Shipments Forecast or Change
to Shipments Forecast Percentage measure to view the result in the Final Shipments Forecast measure. Save your
changes in the table layout.

If you're generating a forecast using bookings history, enter a value in the Adjusted Bookings Forecast or Change
to Bookings Forecast Percentage measure to view the result in the Final Bookings Forecast measure. Save your
changes in the table layout.

If you must modify the launch date for a product, enter a value in the Adjusted Launch Date measure to view the
final date in the Final Launch Date measure. Save your changes in the table layout.

If you must modify the discontinuation date for a product, enter a value in the Adjusted Discontinuation Date
measure to view the final date in the Final Discontinuation Date measure. Save your changes in the table layout.
Run the plan again to view the forecasts for the required periods for your products.

If required, modify the value in the Adjusted Bookings Forecast, Change to Bookings Forecast Percentage, Adjusted
Shipments Forecast, or Change to Shipments Forecast Percentage measure. Save your changes in the table layout.

Related Topics

» Overview of the Product Lifecycle Management Page Layout
- Manage Page Layouts in Sales and Operations Planning

« Work with Page Layouts in Demand Management

- Work with Page Layouts in Replenishment Planning
 Create a Forecasting Profile
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135 Archive Plans

Overview of Plan Archival

Supply Chain Planning provides two archival types, one that a planner can run for a plan and another archive type that
only an administrator with proper security privileges can set up for MAPE statistics.

For a planner, plan archival enables you to archive measures in a plan with plan context and save multiple versions of a
plan's archived measures over time. When you archive a plan, you archive a set of measures contained in the measure
catalog that you chose as the archive measure catalog for the plan.

Note: You can create archives for demand, supply, integrated demand and supply, and sales and operations plans.
Archival isn't available for Oracle Planning Central.

Plan Archives

Plan archival enables you to save multiple versions of the plan where you archive the key measures at a point in time.
The Waterfall Analysis and Trend Analysis tables and graphs use the plan archive to compare the current plan's data
to past versions of the plan. When viewing past versions of the plan, you can see the impact of strategic and tactical
changes made to the plan. You can also compare the individual archives to the plan by selecting Compare > Archive
from the Actions menu in a plan.

For example, you archive a plan in May and then market conditions in September cause adjustments to be made to
the plan. You can analyze the impact of the adjustments on the plan by viewing the changes in the key performance
indicators between the plan version archived in May and the current plan.

A supply chain planner can run the archiving process from an open plan by selecting the Archive option from the
Actions menu. A planner can also run the archiving process by selecting the Archive plan check box on the Run Plan
page. Alternatively, you can run the archive process independently of running the plan by selecting the Archive option
from the Actions menu on the Manage Plans page.

Before you can archive a plan, you must enable the plan for archiving and set up the archiving parameters. The
parameters that you configure determine the time hierarchy, time level, and the measure catalog to use for the archives.
Set up the archiving parameters in the Scope: Advanced Options dialog box, which you navigate to from the Plan
Options page, Scope tab.

It's good practice to back up your archive data by making a full copy of your plan that includes archives. You can access
the backup plan data in the event of any temporary issue with the plan of record. On the other hand, if you want to
create a standalone plan to simulate a business scenario, you probably don't need to include archived measures.

MAPE Archives

An administrator with the correct security privileges can create an archive for MAPE statistics by running the Build
Plan Archive scheduled process from the Tools work area. Generally, a supply chain planner doesn't have the privileges
to create a MAPE archive. However, an administrator with the required privileges can see the Enable for MAPE
calculations check box in the Build Archive dialog box. The administrator can create archives at weekly, monthly, or
quarterly time levels. The archive level pertains to the planning time level, so the administrator would archive a quarter-
level plan at the quarter level.
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Note: To calculate predefined measures for demand plans and sales and operations plans that use archived data, you
must use a MAPE archive. The statistics calculated for the MAPE archive are used to generate the Waterfall Analysis
and Trend Analysis tables and graphs.

Related Topics
» Configure Archiving Parameters

« Copy aPlan

Configure Archiving Parameters

Before you can archive plans, you must enable the archiving options.

Note: You can create archives for demand, supply, demand and supply, and sales and operations plans. Archival isn't
available in Oracle Planning Central.

To configure the archiving plan options:

1. In a work area for Oracle Fusion Cloud Supply Chain Planning, open a plan and then select Edit Plan Options
from the Actions menu.

2. On the Plan Options page, Scope tab, click the Select Advanced Options button.

3. Inthe Scope: Advanced Options dialog box, Archive Options section, review and make changes to the archive
parameters for the plan.

Parameter Description

Enable for archiving Select to set parameters used to archive measure data for your plan. When selected, the
archiving options are enabled.

Archive Time Hierarchy Select the time hierarchy to use to archive the measure data for the plan, such as Gregorian
calendar.
For a demand plan that uses a hybrid time hierarchy, the field value is defaulted to the hybrid
time hierarchy that you selected as the planning calendar and can't be changed.

Archive Time Level Select the time level to archive measure data for the plan, such as day or week. The time level is
based on the selection made for the archive time hierarchy.
For a demand plan that uses a hybrid time hierarchy, the field value is defaulted to the Hybrid

time level corresponding to the hybrid time hierarchy that you selected as the planning
calendar and can't be changed.

Measure Catalog for Archival Select the measure catalog to use for archiving.
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Parameter Description

Note:
Oracle recommends that you create a measure catalog containing only measures that
provide insight to the plan's changes instead of archiving every measure in the plan.

Do not delete archives Select if you don't want to delete any archives for the plan.

Delete archives automatically Select to automatically delete archives when the archives are older than the Most Recent Days
to Keep parameter.

Most Recent Days to Keep Enter the number of days for which to retain archives. Archives older than this number of days
are automatically deleted.

4. C(Click Done.

Related Topics
« Overview of Plan Archival in Supply Chain Planning

Overview of Archival for Calculating MAPE Statistics

A Supply Chain Planning administrator with the Manage Rolling Archives security privilege can create archives for the
calculation of the MAPE statistics at a week or month level.

These archives are used to calculate predefined measures for demand plans and sales and operations plans that use
archived data. The administrator runs the Build Plan Archive scheduled process from the Tools work area.

Shipments or bookings measures are required in the archive for MAPE statistics calculations, based on the measure
used to create the forecast. If your plan forecasts shipments data, then only the shipments forecast measures are
needed. If your plan forecasts bookings data, then only the bookings measures are needed. The following shipments or
bookings measures are required:

- Final Shipments Forecast

- Final Shipments Forecast 3 Months Ago

- Final Shipments Forecast 3 Months Ago Latest Archive
- Final Bookings Forecast

- Final Bookings Forecast 3 Months Ago

- Final Bookings Forecast 3 Months Ago Latest Archive

To use the archives in a waterfall or trend analysis, select the Use MAPE calculations check box in the Selector Tool
Comparison Options tab.

MAPE archives created on a rolling basis can be referenced in a user-defined measure expression that uses the Archive
function. The archive type is a parameter of this function. The valid values for archive type are "Rolling" and "Adhoc."

243
ORACLE



Oracle Fusion Cloud SCM Chapter 13
Using Sales and Operations Planning Archive Plans

Related Topics
- Archival for Calculating MAPE Statistics

Archival for Calculating MAPE Statistics

A Supply Chain Planning administrator with the Manage Rolling Archives security privilege can create archives for the
calculation of the MAPE statistics at a week or month level.

Perform the following steps to run the Build Plan Archive schedule process:

1. In the Navigator, under the Tools section, click the Scheduled Processes link to access the Scheduled
Processes page.

2. Access the Process Details page for the Build Plan Archive process:

On the Schedule Processes page, click the Schedule New Process button.

In the Schedule New Process dialog box, click the Name list, and then click the Search link.

In the Search and Select: Name dialog box, enter Build Plan Archive and click Search.

Select Build Plan Archive and click OK to return to the Schedule New Process dialog box.
e. Inthe Schedule New Process dialog box, click OK.

3. Inthe Process Details dialog box, select the plan to archive and then click the Advanced button.

4. On the Parameters tab, select Do not delete archives or Delete archives automatically.

e ngoo

If you select to delete archives automatically, enter a number in the Most Recent Days to Keep field. The archive
process automatically deletes older archives based on this parameter.

5. Select the Enable for MAPE calculations check box and enter or select the following parameters:

a. Archive Time Hierarchy: Select the calendar to use for the archive.
b. Archive Time Level: Select the time level to use for the archive.
c. Measure Catalog for Archival: Select the measure catalog to use when archiving.

Note: Oracle recommends that you create a measure catalog for archived measures instead of
archiving every measure in the plan.

d. Use default archive name: Select to use the default archive name.
e. Use user-defined archive name: Select to overwrite the default name with a user-defined name.
6. Click the Schedule tab to set up the frequency parameters.

o To run the plan immediately, select As soon as possible.

o Torun the plan in the background at a set time, select Using a schedule. Next, select a Frequency, such
as Monthly or Weekly, to create MAPE rolling archives for use in waterfall and trend analyses.

7. Click Submit.

Related Topics
» Overview of Archival for Calculating MAPE Statistics
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Delete Archives

A planner can automatically delete plan archives by setting parameters in the Scope: Advanced Options dialog box,
accessed from the Plan Options page, Scope tab.

Only a Supply Chain Planning administrator with the Manage Rolling Archives security privilege can delete MAPE
archives. In the Tools work area, the administrator can use the Delete Plan Archive schedule process to clean up
unwanted archived data versions. You can delete the archives of a plan based on an archive version, a time range, or all
archives for a plan.

Note: When you use the Delete Plan action, the process not only deletes the plan, but it also deletes all of the archive
versions associated with that plan.

Perform the following steps to run the Delete Plan Archive schedule process:

1. In the Navigator, under the Tools section, click the Scheduled Processes link to access the Scheduled
Processes page.
2. Access the Process Details page for the Delete Plan Archive process:

On the Schedule Processes page, click the Schedule New Process button.

In the Schedule New Process dialog box, click the Name list, and then click the Search link.

In the Search and Select: Name dialog box, enter Delete Plan Archive and click Search.

Select Delete Plan Archive and click OK to return to the Schedule New Process dialog box.

e. Inthe Schedule New Process dialog box, click OK.

3. Inthe Process Details dialog box, select the plan that you want to delete the archives for and then click the
Advanced button.

4. On the Parameters tab, in the Plan section, select one of the following options, which are only available to
administrators with the Manage Rolling Archives security privilege:

angowo

a. Include MAPE archives
b. Delete MAPE archives only
5. On the Parameters tab, in the Archive Parameters section, configure the following parameters:

a. Archives to delete
b. Delete archives with time range

The Delete Plan Archive process filters the selected archive parameters by which MAPE archiving option you
selected in the Plan section.

6. Click the Schedule tab to set up the frequency parameters.

a. To run the plan immediately, select As soon as possible.

b. To run the plan in the background at a set time, select Using a schedule and then select a frequency,
such as Monthly or Weekly.

7. Click Submit.
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14 Extract Plan Data

Overview of Planning Measure Data Extractions from
Plan Output

Planning information is an important component of supply chain analytics. It's important to extract planning measure
data from any plan to build offline reports or integrate with any external system.

Planners can use the Export Plan Data action from the Manage Plans page to run the Prepare Supply Chain Planning
Data for Export scheduled process. You can also run the process or schedule as a job from the Scheduled Processes
page under the Tools menu in the Navigator.

When analyzing a plan, you can extract detail supply chain planning multidimensional plan output data, including
measures and hierarchies. The extract is based on the measure catalog and dimension catalog assigned to the plan.
The Prepare Supply Chain Planning Data for Export scheduled process extracts plan output data into a set of files for
external reporting and analysis.

The extract process exports plan data to WebCenter Content in the comma-separated value (CSV) data format. This
extract includes measure data, including any measures that you configured that are either stored or calculated. For
calculated measures, the planning process extracts the data after evaluating the measure expressions. The extract is
based on the measure catalog and dimension catalog assigned to the plan and includes user-defined hierarchies and
levels. Supporting information such as hierarchies for multidimensional analysis is also exported.

Before you can run the Prepare Supply Chain Planning Data for Export scheduled process for a plan, you must:

1. As a one-time setup, create an application integration with login credentials.

a. Navigate to the Setup and Maintenance work area and select the Manage Setup Content task.
b. Onthe Manage Integration of Additional Applications page, set up the following:

- Application Name: SCP_BICC_REST_CREDENTIALS

- Full URL: Enter the host name of the application. For example: https://
example.fa.app.oraclecloud.com

- Partner Name: SCP_BICC_REST_CREDENTIALS

- Security Policy: oracle/wss_username_token_over_ssl_client_policy

2. Ensure that the user running the extract has access to the Upload and Download Data from On-Premise System
to Cloud System role (OBIA_EXTRACTTRANSFORMLOAD_RWD).

3. Configure the extract options for your plan. Navigate to the Plan Options page, Scope tab and click the
Advanced Options button. In the Scope: Advanced options dialog box, in the Extract Options section, configure
the extract parameters.

4. Navigate to the Manage Plans page and select a plan. Select Export Plan Data to run the Prepare Supply Chain
Planning Data for Export scheduled process.

You can extract data at the lowest level from any of these plan types:
Demand plan
Demand and Supply plan

Replenishment plan
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- Sales and Operations plan

-« Supply plan

Configure Plan Extract Parameters

Before you can select the Export Plan Data action from the Manage Plans page, you must configure the extract options
for your plan.

1. Navigate to the Plan Options page, Scope tab and click the Select Advanced Options button.
In the Scope: Advanced options dialog box, in the Extract Options section, select the Enable for extract check
box to enable plan data to be extracted.

3. Configure the extract parameters for the plan.

Dimension Catalog for Extract

Select a dimension catalog to use for the extract process. The list of values includes all dimension catalogs valid for
the plan type. The list of hierarchies included in this list must be a subset of the hierarchies available in the dimension
catalog associated with the plan. The list of hierarchies includes preconfigured and user-defined hierarchies. Note the
following:

- The maximum number of levels per hierarchy is limited to 10 levels.

- The maximum number of hierarchies in the segment dimension is limited to two hierarchies.

Measure Catalog for Extract

Select a measure catalog to use for the extract process. The list of values includes all measure catalogs valid for this
plan type. The measure catalog must contain only the measures that are part of the measure catalog for the plan. The
planning process evaluates measures with expressions and includes the results in the extract.

Extract Time Hierarchy

Select a time hierarchy to use for the extract process. Data extraction is done only at the lowest level for all dimensions
except for the time dimension. You can have only one time hierarchy per plan and it must be part of the dimension
catalog used for the extract process. If it contains other time hierarchies, the extract process ignores them for extract.

The extract time hierarchy depends on the plan type, the planning calendar associated with the plan, and the planning
time level. Validation rules apply for the Extract Time Hierarchy field, based on the type of plan.
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When the planning calendar options are Extract Time options must be
Planning Calendar
= Planning Time Level Extract Time Hisarchy Extract Time Lewvel
~ Maonth Gregorian Calendar Month, Quarter or Year
Greogorian Calendar . . . .
Supply Plan Day Any valid time hierarchy in plan Any supported time levels
. Week or Perlod Same Manufacturing Calendar of the plan Planning Time Level or above
Manufacturing Calendar e = . .
Char Any valid time hierarchy in plan Ay supported time levels
Greogorian Calendar  [Manth Gregarian Calendar Month, Quarter or Year
Demand Flan Manufacturing Calendar Week or Period Same Manufacturing Calendar of the plan Planning Time Level or above
Fiscal Calendar Manth Same Fiscal Calendar of the plan Month or Quarter
Day Any valid time hierarchy in plan Any supported time levels
- Manth Gragorian Calendar honth, Quarter or Year
Greogorian Calendar 5
Sales and Cuarter Gregorian Calendar Cluarter or Year
Operations Manufacturing Calendar| Week or Period Same Manufacturing Calendar of the plan| Planning Time Level or above
Flan ) Manth Same Flscal Calendar of the plan Month or Quarter
Fizcal Calendar
Cuarter Same Fiseal Calendar of the plan Cluarter
. Greogorian Calendar | Manth Gregorian Calendar Manth, Quarter or Year
Replenishment
. Week or Perlod Sarne Manufacturing Calendar of the plan|Planning Time Level or above
Flan Manufacturing Calendar o 5 . N
Dy Any valid tlime hierarchy in plan Any supported time levels

For a demand plan that uses a hybrid time hierarchy, the value in the Extract Time Hierarchy field is automatically set
to the hybrid time hierarchy that you selected as the planning calendar and can't be changed.

Extract Time Level

Select a specific time level to extract. The list of values includes all levels based on the plan type and your selection in
the Extract Time Hierarchy field. The valid values and defaults are as follows:

- Manufacturing calendar: Week, Period (Default is Week)
- Fiscal Calendar: Month, Quarter (Default is Month)
- Gregorian Calendar: Month, Year (Default is Month)

The extract time level depends on the plan type, the planning calendar associated with the plan, and the planning time
level. The Extract Time Level selection is subject to validation for each plan type.
Plan Type Rule

Supply plan Largest supply planning bucket or above. For example:

- If Supply Planning Buckets are O days, 52 weeks, then the Extract Time Level can be Week or

Period.
- If Supply Planning Buckets are 365 days, 13 Periods, then the Extract Time Level can only be
Period.
Demand plan Planning time level of the plan or above.
Demand and Supply plan Largest supply planning bucket or above. For example:

- If Supply Planning Buckets are O days, 52 weeks, then the Extract Time Level can be Week or

Period.
- If Supply Planning Buckets are 365 days, 13 Periods, then the Extract Time Level can only be
Period.
Sales and Operations plans Planning time level of the plan or above.
Replenishment plan Planning time level of the plan or above.
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For a demand plan that uses a hybrid time hierarchy, in the Extract Time Level field, you can select a parent of the
Hybrid time level for the hybrid time hierarchy that you selected as the planning calendar. For a manufacturing hybrid
hierarchy, you can select the Week or Period level. For a Gregorian hybrid hierarchy, you can select the Month, Quarter,
or Year level. For a fiscal hybrid hierarchy, you can select the Month, Quarter, or Year level.

Files Created by the Plan Extract Process

The plan extract process generates a set of files. Some files have file names that begin with DATA and have a .csv.gz file
extension. These files are compressed, comma-separated value (CSV) files.

The extract process also generates a set of files with file names that begin with META and have a .mdcsv.gz extension
for its internal use. You can ignore the META files.

Every plan extract results in the following DATA files:

File generated Description of file

Dimension Data The plan extract process generates one dimension data file for each dimension selected for the extract
process. This file contains all of the level members with their associated relationships for all hierarchies
in that dimension.

Dimension Definition The plan extract process generates one dimension definition file for each extract and contains the
names of the hierarchies and levels.

Measure Data The plan extract process generates one measure data file for each set of measures that share the same
dimensionality. This file contains the measure values by the different dimensions.

Measure Definition The plan extract process generates one measure definition file for each extract and contains the
names, data types, expressions, granularity, and aggregation rules of the measure.

The extract process generates the dimension definition and measure definition files to help you understand the
content of the data files, but they aren't essential for reporting or analysis. These files contain translatable strings in the
language of the planner performing the extract.

Naming Conventions for Extracted DATA Files

In addition to the DATA prefix and .csv.gz file extension, the data file names follow a specific naming pattern. You can
search the content server for this name pattern to get the required files for download.

- Dimension file name patterns
o Dimension data file:

Dimension ~
1D of the Plan code BICCExtract  Run of the
D of the extract MNama is Schedule SCP Extract
ES5 jeb avallable in logs Job I Jeb

DATA -.-Es:pct:'ue'nextra:l: Dy msc_xd tprd internallD_dyd i81CC ot |'1:' ateT -;cs\.-'.gz
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DATA_joblD_scpdbviewextract_planlD_msc_xtr_hierarchy_map_v-BICCJoblD_DateTime.csv
Dimension file name parts Description
jobID The job ID of the extract scheduled process.
planiD The ID of the plan. This name is available in log files.
Dimension code The dimension code that the hierarchies in the file belong to. Used in the dimension data file,

but not the dimension definition file.

BICCJobID The job ID of the extract scheduled job of the Bl Cloud Connector (BICC) tool.

DateTime Date and time the extract scheduled process began.

- Measure file name patterns

o Measure data file:

Dimensionality s
Dof the Plan,  group code BICCExtract  Run of the
D of the extract Marme is Schedule SCF Extract
ESS Job available inlogs Job D ob
DATA! job E sepdbyiewextract 1Oy mse_xf 1135 internall O_dyd 10 MEcsv.gz

o Measure definition file:

DATA_joblD_scpdbviewextract_planlD_msc_xtr_measure_map_v-BICCJoblD_DateTime.csv

Measure file name parts Description

jobID The job ID of the extract scheduled process.

planiD The ID of the plan. This name is available in log files.

Dimensionality group code Name of the dimensionality group code. Used in the measure data file, but not the measure

definition file.

BICCJobID The job ID of the extract scheduled job of the Bl Cloud Connector (BICC) tool.

DateTime Date and time the extract scheduled process began.
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Dimension Data Files Created by the Plan Extract Process

The plan extract process generates one dimension data file for each dimension and contains all of the hierarchies in
that dimension. Each dimension file contains information for all of the selected hierarchies.

For example, if the planner selects two product hierarchies, an item appears twice--once for each hierarchy.

Column name

HIERARCHY_ID

[dimension]_LVL_MEMBER_ID

BASE_MBR_NAME

L2-MBR_ID

L2_MBR_NAME

L3-MBR_ID

L3_MBR_NAME

L4-MBR_ID

L4_MBR_NAME

L5-MBR_ID

L5_MBR_NAME

L6-MBR_ID

L6_MBR_NAME

L7-MBR_ID

L7_MBR_NAME

ORACLE

Content

Internal hierarchy identifier

ID of the lowest-level member. Each dimension file contains its own lowest level member. For example:

» PRD_LVL_MEMBER_ID
+ ORG_LVL_MEMBER_ID

Name of the lowest level member

Level 2 member ID

Level 2 member name

Level 3 member ID

Level 3 member name

Level 4 member ID

Level 4 member name

Level 5 member ID

Level 5 member name

Level 6 member ID

Level 6 member name

Level 7 member ID

Level 7 member name
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Column name Content
L8-MBR_ID Level 8 member ID
L8_MBR_NAME Level 8 member name
L9-MBR_ID Level 9 member ID
L9_MBR_NAME Level 9 member name
L10-MBR_ID Level 10 member ID
L10_MBR_NAME Level 10 member name
SR_BASE_MBR_ID Internal use only

Dimension Definition Files Created by the Plan Extract
Process

The dimension definition file contains information for all of the dimensions and hierarchies specified in the dimension
catalog for extract. The plan extract process creates only one file per extract.

Column name Description
DIMENSION_ID Unique ID of the dimension
HIERARCHY_ID Unique ID of the hierarchy
BASE_LEVEL_ID Lowest level (Level 1) ID
LEVEL_2_ID Level 21D

LEVEL_3_ID Level 31D

LEVEL_4_ID Level 41D

LEVEL_5_ID Level 51D

LEVEL_6_ID Level 6 ID
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Column name Description
LEVEL_7_ID Level 7ID
LEVEL_8_ID Level 81D
LEVEL_9_ID Level 9 ID
LEVEL_10_ID Level 10 ID
DIMENSION_CODE Unique code for the dimension
DIMENSION_NAME Dimension name
HIERARCHY_NAME Hierarchy name
BASE_LEVEL_NAME Base level name
LEVEL_2_NAME Level 2 name
LEVEL_3_NAME Level 3 name
LEVEL_4_NAME Level 4 name
LEVEL_5_NAME Level 5 name
LEVEL_6_NAME Level 6 name
LEVEL_7_NAME Level 7 name
LEVEL_8_NAME Level 8 name
LEVEL_9_NAME Level 9 name
LEVEL_10_NAME Level 10 name
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Measure Data Files Created by the Plan Extract Process

The plan extract process generates one measure data file for each set of measures that share the same dimensionality
or granularity. Use the measure definition file to obtain more details about the measure, including its full name,
description, aggregation methods, and so on.

The following table is an example measure data file for a specific dimensionality with a selected list of measures. The
actual format depends on the dimensionality and the measures selected by users for extract.

Column name Description

PLAN_ID ID of the plan

PRD_LVL_MEMBER_ID Product dimension lowest level member ID
ORG_LVL_MEMBER_ID Organization dimension lowest level member ID
TIM_LVL_MEMBER_ID Time dimension lowest level member ID
FACT_DATE Date

AVG_DAILY_DMD

GROSS_MARGIN_PCT

IN_TRANSIT

INV_TURNS

ITEM_STD_COST

Value of this measure

Value of this measure

Value of this measure

Value of this measure

Value of this measure

ONHAND Value of this measure
PAB Value of this measure
PAB_VALUE Value of this measure
PO_QTY Value of this measure
PR_QTY Value of this measure

PROJECTED_ONHAND

ORACLE

Value of this measure
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Column name Description

SCHED_RCPT Value of this measure
SS Value of this measure
TF_QTY Value of this measure
TOTAL_DEMAND Value of this measure
TOTAL_DEMAND_VALUE Value of this measure
TOTAL_SUPPLY Value of this measure
TTL_END_ITEM_CST Value of this measure
GROSS_MARGIN Value of this measure

The extract process generates one measure data file for each set of measures that share the same dimensionality or
granularity. The measure data files contain information for all measures that share that same dimensionality. A list

of predefined dimensionality groups is listed in the Dimensionality Group Codes Used by the Plan Extract Process
topic. The lowest level of each of these dimensions appears in each file. They will be different for each dimensionality,
based on the dimensions that are part of that group. Each measure column name is a measure code from the measure
definition file. Use the measure definition file to obtain more details about the measure, including its full name,
description, aggregation, and so on.

Measure Definition Files Created by the Plan Extract
Process

The measure definition file contains information for all of the measures specified in the measure catalog for extract. The
plan extract process creates only one file per extract.

Column name Description

GRANULARITY_ID Dimensionality group ID

POSITION Internal use only

MEASURE_CODE Used as the column name in measure data files
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Column name Description
MEASURE_ID ID that uniquely identifies a measure
NAME Name of the measure
DESCRIPTION Brief description of the measure
DATA_TYPE Data type
EXPRESSION Internal use only
AGGR_ORDER Aggregation rule:

1= Calculate, then aggregate

2 = Aggregate, then calculate

AGGR_METHOD_OTHER Aggregation method on dimensions other than the Time dimension
AGGR_METHOD_TIME Aggregation method on the Time dimension
WEIGHTED_BY ID of the measure to be used when aggregation method is WAVG (weighted average)

The MEASURE_CODE column in this file contains all the measure codes for all measures. The actual measure data
files use this measure code as data column name. Using this code, you can look up additional information about the
measure in the definition file. Note that the expression indicated is only for internal use and is already evaluated before
the extract. Aggregation methods (Sum, Latest, Average, Weighted Average, and so on) can be used to configure your
analytics to aggregate these measures across various dimensions.

Dimension Codes Used by the Plan Extract Process

The plan extract process uses preconfigured dimension codes related to a list of valid dimension.

Code Dimension name
tim Time

res Resource

cus Customer

prd Product
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Code Dimension name
org Organization
dcs Demand Class
sup Supplier
fcm Forecasting Method
cto Configure to Order
src Source
exp Exception Type
ord Order Type
cig Decomposition Method
seg Segment

Dimensionality Group Codes Used by the Plan Extract
Process

The extracted files use codes related to a list of valid dimensionality groups. Dimensionality group codes shown in this
topic list all of the valid preconfigured dimension groups.

For example, code 125 is for all measures that are dimensioned only by the Organization, Product, and Time dimensions.
The measure data file for that dimensionality contains all measures extracted for that dimensionality.

Dimensionality Group Code Dimensionality Group
10 org, prd, tim, cus, cto
15 org, prd

20 org, res, tim

25 tim
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Dimensionality Group Code Dimensionality Group
35 org, prd, tim, cus
40 org, prd, res, tim, cus, sup, exp
45 org, prd, tim, sup
50 org, prd, tim, cus, sup, src
55 org, prd, tim, cus, dcs, ord
60 org, prd, tim, ord
65 org, prd, tim, cus, sup, dcs, ord
70 org, prd, tim, sup, ord
75 org, prd, dcs
95 org, prd, cus, dcs, fcm, clg, tim, cto
100 org, prd, tim, cus, dcs, cto
105 org, prd, cus
110 org, prd, cus, dcs
125 org, prd, tim
130 org, prd, tim, cus
135 org, prd, tim, cus, dcs
145 prd, tim, cus
150 prd, tim, cus, dcs
155 org, prd, tim, cus, sup, dcs
160 prd, cus
165 org, prd, tim, exp
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Dimensionality Group Code Dimensionality Group
170 org, tim
175 prd
180 org, prd, tim, cus, dcs, fcm, clg
185 org, prd, cus, dcs, fcm, clg
190 org, prd, cus, fcm, clg
260

ORACLE



Oracle Fusion Cloud SCM Chapter 15
Using Sales and Operations Planning Simulations and Simulation Sets

15 Simulations and Simulation Sets

Overview of Simulations

You can perform simulations directly in a sales and operations plan. Make demand and supply changes in a sales and
operations plan and run the plan. You can then analyze plan output coming from these changes.

You can make adjustments to editable measures and entity attribute values within the same plan, or make a plan copy
that references a base plan. When you make a copy, you can use the plan comparison feature to analyze the differences
between plan runs.

If you use the same plan to simulate plan changes rather than making a copy, use the Archive plan action to create an
ad hoc archive. Then, use plan comparison to analyze the differences between the plan and the archived version.

Overview of Simulation Sets

Simulation sets provide a way to override key parameters coming from plan inputs. You can make these edits directly in
a simulation set.

Some examples of the types of edits are item prices and lead time, and component usage and effective dates in the bill
of resources. You can also save plan edits made to attribute values by copying these changes to a simulation set.

For Sales and Operations Planning, the following tables are relevant for simulation sets:

- Aggregate Bill of Resource
ltems
Resources

- Suppliers

Additionally, you can access the Resource Availability and Supplier Capacity tables from the Resources and Suppliers
tables, respectively.

Create a Simulation Set

Perform the following steps to create a simulation set from the Plan Inputs work area:

1. In the Navigator, click the Plan Inputs work area link.
2. On the Plan Inputs page, click the Open button.
3. Inthe Open Table, Graph, or Tile Set dialog box, do the following:

a. Inthe Search drop-down list, select: Name.
b. Inthe Search text box, enter the name of a table, such as Items or Resources.
c. Click the Search icon button.
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d. Select the Items (or Research) table and click OK.
4. On the Plan Inputs page, Items tab (or Resources tab), click the Search button.
5. Inthe Search Results region, select one or more rows and do the following:

a. Click Actions and then select Add to Simulation Set.

b. Inthe Add to Simulation Set dialog box, click the Search: Simulation Set down arrow for a list of values,
and then click Create Simulation Set.

c. Inthe Create Simulation Set dialog box, in the Simulation Set field, enter the name of the simulation set
you want to create.

d. Click Save and Close.
e. Inthe Add to Simulation Set dialog box, click Save and Close.

Related Topics
« Edit a Simulation Set

» Overview of Simulation Sets

« Simulations in Supply Planning

« Copy Data to Simulation Sets in Supply Planning
« Add Data from Plan Inputs to Simulation Sets

Edit a Simulation Set

Perform the following steps to edit a simulation set from the Plan Inputs work area:

1. In the Navigator, click the Plan Inputs work area link.
2. On the Plan Inputs page, click the Plans panel tab.
3. Inthe Plans panel drawer, do the following:

a. Expand thelist of Simulation Sets.
b. Select a simulation set, right-click on it and select Open.
4. On the Simulation Set page, click Open and then select Full Pane.
5. Inthe Open Table, Graph, or Tile Set dialog box, select a table, such as Resources or Items, and then click OK.

On the Simulation Set page, a new tab opens for the table that you selected, such as the Resources tab or the
Items tab.

6. Inthe Search region, click Search.

7. Inthe Search Results region, select one or more rows. Click Actions and then select Edit from the drop-down
list.

8. In the edit dialog box, you can edit some of the attributes and drill down to additional tables, depending on the
table that you accessed. For example:

o For the Resources table, you can change the Bottleneck value. You can also drill down to the Resource
Availability table.
o For the Items table, you can change the Processing Lead Time value. You can also drill down to the
Suppliers table.
9. When done, click OK to return to the Simulation Set page. Changed rows and fields are marked with small
colored dots.
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Related Topics
« Create a Simulation Set

 Edit a Simulation Set from a Spreadsheet
« Overview of Simulation Sets
« Simulate Demand and Supply Changes

Edit a Simulation Set from a Spreadsheet

You can download simulation set data into a spreadsheet, make edits, including certain updates, additions, and
deletions, and then upload it back to the simulation set.

In the Plan Inputs work area, while working with the Items or Supplies and Demands table in a simulation set, use the
Edit in Spreadsheet option in the Actions menu to download the table rows into a Microsoft Excel file.

Note: Before working with spreadsheets, you must download and install the desktop integration installer that is
available under Navigator > Tools. Otherwise, you can't download information into or upload information from
spreadsheets.

To edit the data in the Items or Supplies and Demands table of the simulation set in a Microsoft Excel spreadsheet,
follow these steps:

1. Inthe Plan Inputs work area, click the Plans panel tab.

Note: The simulation set can also be edited from the Planning Central, Sales and Operations Planning, and
Supply Planning work areas. However, the Supplies and Demands table is available in the simulation set only
when it is edited in the Supply Planning work area.

2. Inthe Plans panel drawer, do the following:

a. Expand the list of simulation sets.

b. Select the simulation set that you want to edit, right-click, and click Open. The simulation set opens.
In the Open menu, select Full Pane. The Open Table, Graph, or Tile Set dialog box opens.
Select the Items or Supplies and Demands table, and click OK. The table opens in a page in the simulation set.
Perform a search for the table rows in the simulation set.

In the Actions menu for the table, click Edit in Spreadsheet. A dialog box opens and prompts you to save or
open a Microsoft Excel file.

7. Open the spreadsheet. The Connect dialog box opens and prompts you to connect to the URL for the
application.

8. C(lick Yes. A dialog box opens and prompts you to type your credentials.

9. Sign in with your credentials for the Oracle Fusion Cloud Applications Suite. The spreadsheet is refreshed with
the data in the simulation set.

ouhuw
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10. Edit the data.

Task

To add an item to the Items table of the
simulation set

To create an order in the Supplies and
Demands table of the simulation set

To edit a row

To delete a row

Chapter 15
Simulations and Simulation Sets

Steps

Click the Add Item icon in the Items menu of the spreadsheet, and provide values in the Add
Item dialog box that opens. You can add an existing item or create an item that is based on an
existing item.

Click the Create Order icon in the Supplies and Demands menu of the spreadsheet, and
provide values in the Create Order dialog box that opens. (Not applicable to sales and
operations planning.)

Modify the values in the row cells that are not grayed out. A symbol appears in the cell under
the Changed column for the row.

Click the corresponding cell in the Mark for Deletion column. A symbol appears in the cell to
mark the table row for deletion. To deselect the row, click the cell again.

11. Click the Upload icon in the Items or Supplies and Demands menu. In the Upload Options dialog box that
appears, select the check boxes for the options that you want to use, and click OK. The data is uploaded to the

simulation set.

12. Save the simulation set. The changes are displayed and marked with colored symbols.

13. Save and close the spreadsheet.

Simulate Statistical Demand Forecast

The Statistical Demand Forecast generates demand forecasts coming from overrides made to demand history. This
simulation projects future demand at aggregate time levels by using actual and adjusted history.

To simulate statistical demand forecast, do the following:

1. Save data changes in your plan and then select the Run Plan action.
2. Inthe Run Plan dialog box, do the following:

noo

In the Data Refresh Options section, select Do not refresh with current data.
In the Scope Options section, select Plan demand.
In the Demand Plan Run Options section, select Forecast Shipments.

d. Inthe Supply Plan Run Options section, select Interactive.

3. Click OK to run the plan.
4. Run the plan.

ORACLE
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Simulate Changes to Demand and Supply

In Sales and Operations Planning, you can simulate the effects of edits to a plan and analyze the supply changes in the
plan output.

You can model supply scenarios to accommodate an increase in demand or see the impact of changes to any of these
supply parameters:

Resource availability for a planning resource in an organization
- Supplier capacity available for a supplier item
- Supplier cost to evaluate changes in purchasing cost
Item prices to evaluate changes in revenue
Item lead times
- Safety stock to evaluate changes in projected inventory
- Sourcing percentages to simulate changes in both purchasing and shipping costs and capacities

Usage quantities and effective dates in bill of resources

Simulating Changes to Demand Forecasts

You can make manual adjustments to demand forecasts as part of a collaborative forecasting process. For example,
a difference in value between the Sales Forecast and the Consensus Forecast might necessitate an override to the
Adjusted Consensus Forecast measure.

Simulating Changes to Resource and Supplier Availability

You can simulate changes in available resource capacity by editing the Resource Availability measure. For example, you
can increase resource availability by adding an extra shift.

You can simulate changes in available supplier capacity by editing the Supplier Capacity Available measure. For
example, you can increase component item availability for a supplier.

Simulating Changes to Production Levels

You can adjust the production levels in a sales and operations plan to override the initial production plan driven by
net demand, existing supplies, and sourcing. You can simulate changes to production quantities to shift production
between assembly items that share constrained work center resources in a highly constrained plan or smooth
production levels in an unconstrained plan. You can also set production levels for the assembly items manufactured in
multiple organizations.

You can load the Production Plan measure data from Supply Planning to the Adjusted Production Plan measure in
Sales and Operations Planning and run a plan simulation. Using the Load Measures from Other Plans process, you
can copy the tactical production plan data from a supply plan to a sales and operations plan. You can then run a sales
and operations plan simulation to update the supply measures such as Production Plan, Resource Requirements, and
Projected Available Balance.

A typical Sales and Operations Planning process has a monthly cycle with product family level reviews and a plan
horizon that is between 18 and 24 months. A tactical supply plan is detailed with more focus on transactional planning
at item, organization, and day levels. You can load measure data from your tactical supply plans to overlay the
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production plan data into your sales and operations plan and project capacity requirements and inventory levels as part
of your Supply Review process. After you make strategic decisions in your sales and operations plan, the approved plan
results can be fed into your tactical supply plans as a demand schedule for execution.

For example, a provider of fitness equipment can’t meet surging pandemic demand. Capacity is fully utilized for the
coming months for critical resources. Some new products are being launched and delaying their first shipment dates
must be avoided as per directives from senior management. Setting the production levels for these new products,
ensures new products are manufactured on time even at the expense of further delays in fulfilling orders for mature
product lines.

Add the Adjusted Production Plan and Final Production Plan measures to the measure catalog of your sales and
operations plan. Then, run your plan with the Refresh with current data option selected before using these measures in
tables and graphs. Here’s additional information about the measures:

- Adjusted Production Plan is an editable measure used to override the initial production plan.

Final Production Plan is a calculated measure used as the Disaggregation Basis field for Adjusted Production
Plan and, by default, is equal to NVL(Adjusted Production Plan, Production Plan).

- The Work Orders measure data is treated as firm in your sales and operations plan, whereas production levels
can be adjusted below this quantity. The exception Production Less Than Work Orders detects instances where
Production Plan is less than Work Orders. Add this exception to the user-defined exception set associated with
your plan options.

- The Production Plan measure in Supply Planning is the total quantity of make orders in a time bucket and is the
sum of all make planned orders, work orders, non-standard work orders, and by-product supply. It is equivalent
to the Production Plan that is calculated in Sales and Operations Planning.

- When loading Production Plan measure data from Supply Planning to the Adjusted Production Plan measure
in Sales and Operations Planning, the measure data is aggregated in a supply plan before copying it to a sales
and operations plan. Both Production Plan and Adjusted Production Plan measures are dimensioned by item,
organization, and time.

- The Production Plan data is aggregated in Supply Planning to the Sales and Operations Planning time level:
for example, from daily buckets to monthly time periods before data is copied to the Adjusted Production Plan
measure.

- The Production Plan data is also aggregated in Supply Planning to the Sales and Operations Planning
aggregate item level if modeled in the target plan. For example, assembly end items within a catalog are
aggregated to the parent category per the Plan ltems Hierarchy and Planning Product Level Items settings in
the plan options of the sales and operations plan before the data is copied to the Adjusted Production Plan
measure.

Simulating Changes to Bill of Resources

Within a plan, you can edit usage quantities and effective dates for an Organization, Assembly Item, and component or
resource combination in the bill of resources. If you copy to a simulation set after making edits to a bill of resources in
the plan, select all of the bill of resources rows to copy for the Organization and Assembly Item combination.

You can edit a bill of resources for an Organization and Assembly Item combination in a simulation set. If you used the
file-based data import (FBDI) template, you must first add all of the rows for the bill of resource to the simulation set
from the Plan Inputs work area.

Within a simulation set, you can also add records to simulate adding a new component to a bill of resources for
engineering or design reasons. You can reference a simulation set for a plan in Plan Options.

You must run a plan with the Refresh with current data option to overlay bill of resources changes made in or copied to
a simulation set. Before you run the plan, associate the simulation set to the plan in Plan Options.
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You can also run the Create Bills of Resources scheduled process to automatically create bills of resources. You would
then use the Aggregate Bill of Resources table to modify the bills of resources in the designated output simulation set.
The following example illustrates using the effective date ranges to model different resource quantities to ramp up a
new resource:

ORG Assembly Resource Resource Quantity Effective Start Date  Effective End Date
M1 AS301 R4 0.375 12/02/2021 01/31/2022
M1 AS301 R4 0.25 02/01/2022 12/31/2023

You can add new and modified records in the Aggregate Bill of Resources table to another simulation set for future
reuse.

Simulating Changes to Item Price, Item Cost, and Lead Time

You can simulate changes in item price by editing the Adjusted Price measure in a table and rerun the plan. For
example, you can evaluate the potential revenue coming from a price increase before changing the actual price. You can
also edit the Selling Price in a simulation set in the Items table to overlay in a plan.

You can edit the Standard Cost in the Items table in a plan. You can also edit the Standard Cost in a simulation set in the
Items table to overlay in a plan. You can also edit the Adjusted Supplier Cost measure in a table, such as the Supplier
Plan by Month table.

You can edit Preprocessing Lead Time, Processing Lead Time, and Postprocessing Lead Time in a simulation set in the
Items table to overlay in a plan. Next, run the plan to evaluate lead time changes.

Simulating Changes to Safety Stock

You can override item safety stock levels by editing the Adjusted Safety Stock measure in a table and then rerun the
plan to simulate the changes. For example, you can determine the impact on Carrying Cost measure changes that
would arise due to changes in inventory levels represented by the Projected Available Balance measure.

You can also use the Load Measures from Other Plans task to copy tactical safety stock data from a supply plan or a
demand and supply plan to a sales and operations plan. After you run the Load Measures from Other Plans process, you
can then run a sales and operations plan simulation to update supply measures such as Production Plan, Purchases,
and Projected Available Balance. For example, you can copy safety stock measure data at the item and organization
level in the Material Plan to the Adjusted Safety Stock measure for simulation and analysis at the product family level in
the Aggregate Build Plan.

On the Load Measures from Other Plans page:

In the Source Measure field, select the Safety Stock measure.

In the Target Measure field, select the Adjusted Safety Stock measure.

Note: Selecting the Create new combinations check box doesn't insert new item and organization combinations
from the source plan into the target plan. Instead, the planning process inserts new demand combinations from the
source plan that don't already exist in the target plan.
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Use the Orchestrate Load Measures scheduled process to load measures one time or on a repetitive schedule. You can
also configure a job set that contains the Orchestrate Load Measures process job followed by the Batch Run Plan job to
sequence and automate these two planning processes.

Simulating Changes to Sourcing Allocation Percentage

Use the preconfigured Sourcing Allocation table for simulating changes to sourcing rule allocation percentages
modeled by the Sourcing Allocation Percentage measure.

Simulating Supply Scenarios: Procedures

To simulate supply scenarios in a plan, do the following:

1. Save data changes in your plan and then select the Run Plan action.
2. Inthe Run Plan dialog box, do the following:

a. Inthe Data Refresh Options section, select Do not refresh with current data.
b. Inthe Scope Options section, select Plan supply.
c. Inthe Supply Plan Run Options section, select Interactive.

3. Click OK to run the plan.

4. Run the plan.

To simulate supply scenarios in a simulation set, do the following:

1. Save data changes in your simulation set.
2. Associate the simulation set to a plan in Plan Options and then select the Save and Run action.
3. Inthe Run Plan dialog box, do the following:

a. Inthe Data Refresh Options section, select Refresh with current data.
b. Inthe Supply Plan Run Options section, select Batch.

4. Click OK to run the plan.

5. Run the plan.
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16 Troubleshooting

Resolve Error MSC-2806379

This topic guides you on how you can resolve error MSC-2806379 that may be displayed when you view a table or
graph.

The error is displayed when you view a table or graph that you don't own for your Oracle Fusion Cloud Supply Chain
Planning product, and the table or graph contains too much data.

The error text is as follows: "You can't view this table or graph because the underlying data or analysis produces too
much data. (MSC-2806379)

"To resolve this issue, make a copy of the table or graph because you aren't the owner of it, change configurations to
reduce the data set, and try again. For example, limit the use of measures with different dimensionalities, reduce the
number of measures with complex expressions, such as lead or lag functions, or check measure filter configuration.
Refer to Incident ID <number> on <server name> server."

Follow these steps to resolve the error:

1. If the table or graph is open, in the toolbar, click Actions > Save Table As or Actions > Save Graph As.
Otherwise, do the following:
a. Click Actions > Manage Tables, Graphs, and Analysis Sets.
b. Inthe Manage Tables, Graphs, and Analysis Sets dialog box, search for your table or graph, and select it.
c. Click Actions > Duplicate.
2. In the dialog box, provide the name and description for the copied table or graph.
Provide other details for the copied table or graph.
3. Click Save and Edit.
4. In the Configure Table or Configure Graph dialog box, do the following:

o On the Measures tab, on the Selected Measures pane, select the measures that you can remove from the
table or graph, and move them to the Available Measures pane.

For example, limit the use of measures with complex expressions.

o Onthe Members tab, on the Selected Members pane, select the members that you can remove from the
table or graph, and move them to the Available Members pane.

For example, on the Selected Members pane, retain only one organization or a few products according to
your business requirements. You can use the Advanced Filter dialog box to reduce the number of members
that are displayed by the table or graph.

o On the Measure Filters tab, add filters to reduce the amount of data returned by your table or graph.
o On the Layout tab, add filters to your table or graph.

For example, if your table includes the Organization level, you can use the level as a filter that restricts the
returned data to the selected member.

5. Click Save and Close.
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Related Topics
« Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets
« Use Advanced Options in the Selector Tool
« Configure Filters for Graphs

Resolve Error MSC-2806380

This topic guides you on how you can resolve error MSC-2806380 that may be displayed when you view a table or
graph.

The error is displayed when you view a table or graph that you own for your Oracle Fusion Cloud Supply Chain Planning
product, and the table or graph contains too much data.

The error text is as follows: "You can't view this table or graph because the underlying data or analysis produces too
much data. (MSC-2806380)

"To resolve this issue change configurations to reduce the data set, and try again. For example, limit the use of
measures with different dimensionalities, reduce the number of measures with complex expressions, such as lead or lag
functions, or check measure filter configuration. Refer to Incident ID <number> on <server name> server."

Follow these steps to resolve the error:

1. If the table or graph is open, in the toolbar, click Actions > Configure Table or Actions > Configure Graph.
Otherwise, do the following:
a. Click Actions > Manage Tables, Graphs, and Analysis Sets.
b. Inthe Manage Tables, Graphs, and Analysis Sets dialog box, search for your table or graph, and select it.
c. Click Actions > Edit.
2. In the Selector Tool, do the following:

o On the Measures tab, on the Selected Measures pane, select the measures that you can remove from the
table or graph, and move them to the Available Measures pane.

For example, limit the use of measures with complex expressions.

o Onthe Members tab, on the Selected Members pane, select the members that you can remove from the
table or graph, and move them to the Available Members pane.

For example, on the Selected Members pane, retain only one organization or a few products according to
your business requirements. You can use the Advanced Filter dialog box to reduce the number of members
that are displayed by the table or graph.

o Onthe Measure Filters tab, add filters to reduce the amount of data returned by your table or graph.
o On the Layout tab, add filters to your table or graph.

For example, if your table includes the Organization level, you can use the level as a filter that restricts the
returned data to the selected member.

3. Click Save and Close.
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Related Topics
« Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

« Use Advanced Options in the Selector Tool
- Configure Filters for Graphs
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